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Welcome to The GIMP 
The GIMP is a multiplatform photo manipulation tool. GIMP is an acronym for GNU Image 
Manipulation Program. The GIMP is suitable for a variety of image manipulation tasks, 
including photo retouching, image composition, and image construction. 

It has many capabilities. It can be used as a simple paint program, an expert quality 
photo retouching program, an online batch processing system, a mass production image 
renderer, an image format converter, etc. 

GIMP is expandable and extensible. It is designed to be augmented with plug-ins and 
extensions to do just about anything. The advanced scripting interface allows everything 
from the simplest task to the most complex image manipulation procedures to be easily 
scripted. 

One of The GIMP's strengths is its free availability from many sources for many operating 
systems. Most GNU/Linux distributions include The GIMP as a standard application. The 
GIMP is also available for other operating systems such as Microsoft Windows or Apple's 
Mac OS X (Darwin). The GIMP is not freeware. It is a Free Software application covered by 
the General Public License (GPL license). The GPL provides users with the freedom to 
access and alter the source code that makes up computer programs. 

Authors 
The first version of the GIMP was written by Peter Mattis and Spencer Kimball. Many other 
developers have contributed more recently, and thousands have provided support and 
testing. GIMP releases are currently being orchestrated by Sven Neumann and Mitch 
Natterer and many other people called the GIMP-Team. 

The GIMP-Help system 
The GIMP-Help system provides you with the information necessary to understand how to 
use The GIMP. You can get context sensitive help while using GIMP by pressing the F1 key. 
Help on specific menu items can be accessed by pressing the F1 key while the mouse 
focuses the menu item. Read on to begin your GIMP journey. 

Features and Capabilities 
The following list is a short overview of some of the features and capabilities which GIMP 
offers you: 

• A full suite of painting tools including brushes, a pencil, an airbrush, cloning, etc. 

• Tile-based memory management so image size is limited only by available disk 
space 

• Sub-pixel sampling for all paint tools for high-quality anti-aliasing 

• Full Alpha channel support for working with transparency 

• Layers and channels

• A procedural database for calling internal GIMP functions from external programs, 
such as Script-Fu 

• Advanced scripting capabilities

• Multiple undo/redo (limited only by disk space) 

• Transformation tools including rotate, scale, shear and flip 

• File formats supported include GIF, JPEG, PNG, XPM, TIFF, TGA, MPEG, PS, PDF, PCX, 
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BMP and many others 

• Selection tools including rectangle, ellipse, free, fuzzy, bezier and intelligent 

• Plug-ins that allow for the easy addition of new file formats and new effect filters 
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What's New in The GIMP? 
GIMP 1.0 evolved gradually into the very stable and widely used 1.2 release. Three years 
later, as the GIMP development came closer to the next stable release, they decided that 
the level of fundamental change to the inner workings of the program justified calling the 
new stable version 2.0. GIMP 2.0.0 was released on March 23, 2004. For GIMP 2.2, the 
developers aimed at a short cycle, adding a number of important features that did not 
require instability-inducing low level changes. GIMP 2.2.0 was released on December 19, 
2004. This section briefly describes the new features that were added in GIMP 2.2, as well 
as the features that were introduced in GIMP 2.0. 

Here is a brief summary of some of the most important new features introduced in GIMP 
2.2. There are many other smaller changes that long-time users will notice and appreciate 
(or complain about!). There are also important changes at the level of plugin 
programming and script-fu creating that are not covered here. 

Interoperability and standards support 
• You can drag-and-drop or copy-and-paste image data from the GIMP to any 

application which supports image/png drops (currently Abiword and Kword at least) 
and image/xml+svg drops ( Inkscape supports this one). So you can copy-and-paste 
curves into the GIMP from Inkscape, and then drag a selection into Abiword to 
include it inline in your document. 

• Patterns can now be any supported GtkPixbuf format, including png, jpeg, xbm and 
others. 

• GIMP can load gradients from SVG files, and palettes from ACT and RIFF files. 

• Drag-and-drop support has been extended. You can now drop files and URIs onto an 
image window, where they will be opened in the existing image as new layers. 

Shortcut editor 
You can now edit your shortcuts in a dedicated dialog, as well as continue to use the little-
known dynamic shortcuts feature (which has been there since 1.2). 

Plug-in previews 
We have provided a standard preview widget for plug-in authors which greatly reduces 
the amount of code required to support previews. David Odin has integrated this widget 
into all the current filters, so that now many more filters in the GIMP include a preview 
which updates in real time, and the various previews behave much more consistently. 

Real-time previews of transform operations 
The transform tools (shear, scale, perspective and rotate) can now show a real-time 
preview of the result of the operation when the tool is in "Traditional" mode. Previously, 
only a transforming grid was shown. 

GNOME Human Interface Guide conformance 
A lot of work has been done on making the GIMP's interface simpler and more usable for 
newcomers. Most dialogs now follows the GNOME HIG to the best of our knowledge. In 
addition, dialogs have separated out or removed many "Advanced" options, and replaced 
them with sane defaults or hidden them in an expander. 
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GTK+ 2.4 migration 
• Menus use the GtkUIManager to generate menu structure dynamically from XML 

data files. 

• A completely revamped File Chooser is used everywhere in the GIMP for opening or 
saving files. The best thing about it is that it lets you create a set of "bookmarks", 
making it possible to navigate quickly and easily to commonly used directories. 

• GIMP now Supports fancy ARGB cursors when they are available on the system. 

Basic vector support 
Using the GFig plug-in, the GIMP now supports the basic functionality of vector layers. The 
GFig plug-in supports a number of vector graphics features such as gradient fills, Bezier 
curves and curve stroking. It is also the easiest way to create regular or irregular 
polygons in the GIMP. In the GIMP 2.2, you can create GFig layers, and re-edit these layers 
in GFig afterwards. This level of vector support is still quite primitive, however, in 
comparison to dedicated vector-graphics programs such as Inkscape. 

Also . . . 
There are many other smaller user-visible features. A rapid-fire list of some of those 
features is below. 

• It is now possible to run the GIMP in batch mode without an X server. 

• We have a GIMP binary (GIMP-console) which is not linked to GTK+ at all. 

• Improved interface for extended input devices

• Editable toolbox: You can now decide which tools should be shown in the Toolbox, 
and their order. In particular, you can add any or all of the Color Tools to the Toolbox 
if you wish to. 

• Histogram overlays R, G and B histograms on the Value histogram, and calculates 
the histogram only for the contents of the selection. 

• Shortcuts are now shared across all GIMP windows. 
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Running GIMP 
Most often, you start GIMP either by clicking on an icon (if your system is set up to 
provide you with one), or by typing gimp on a command line. If you have multiple 
versions of the GIMP installed, you may need to type gimp-2.2 to get the latest version. 
You can, if you want, give a list of image files on the command line after the program 
name, and they will automatically be opened by GIMP as it starts. It is also possible, 
though, to open files from within GIMP once it is running. 

In most operating systems, you can set things up so that various types of image files are 
"associated" with GIMP, and cause it to start automatically when icons for them are 
double-clicked. 

If you want to cause a certain file type to automatically open in GIMP, you should 
associate it with "gimp-remote" ("gimp-win-remote" under Windows) rather than with 
"gimp". The gimp-remote program is an auxiliary that comes with gimp. If gimp is not 
already running on the system when gimp-remote is executed, it is started and the image 
given as argument to gimp-remote is loaded. If gimp is already running, though, the 
image is simply loaded into the already-running program. 

Command Line Arguments 
Ordinarily you don't need to give any arguments when starting GIMP, but here is a list of 
some that may at one time or anther be useful. This is not a complete list; on Unix 
systems you can get a complete list by running man gimp in a terminal window. 

Known platforms 
The GIMP is the most widely supported image manipulation available today. The platforms 
that The GIMP is known to work on include GNU/Linux, Apple Mac OS X (Darwin), Microsoft 
Windows 95, 98, Me, XP, NT4, and 2000, OpenBSD, NetBSD, FreeBSD, Solaris, SunOS, AIX, 
HP-UX, Tru64, Digital UNIX, OSF/1, IRIX, OS/2, and BeOS. 

The GIMP can easily be ported to other operating systems because of its source code 
availability. 

Language 
All being well, GIMP detects the system language. This may fail on some machines and 
you may want use another language. It is possible to change the language: 

In LINUX: in console mode, type LANGUAGE=en GIMP or LANG=en GIMP replacing en by 
fr, de, ... according to the language you want. 

In WINDOWS XP: Control Panel/System/ Advanced/"Environment" button/ In "System 
Variables" area: "Add" button: Enter LANG for Name and fr or de... for Value. Watch out! 
You have to click on three successive "OK" to validate your choice. 

If you often change language, you can create a batch file. Open NotePad. Type the 
following commands (for french for instance): set lang=fr cd c:\Program Files\GIMP-2.0\bin 
GIMP-2.2.exe Save this file as GIMP-FR.BAT (or another name, but always with a .BAT 
extension. Create shortcut and drag it to your desktop. 

Start/Programs/ Accessories/System Tools/System Informations/Tools/System 
Configuration Utility/"Environment" tab/"New" button: Enter LANG for Name and fr or de... 
for Value. 

Under Window 95 and Windows 98, add the line set lang=fr in the "C:\autoexec.bat" file. 

Go to System Preferences, click on the International icon, and in the Language tab, the 
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desired language should be the first in the list. 
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Starting GIMP the first time 
The first time you run GIMP, it goes through a series of steps to set up options and 
directories. This process creates a subdirectory of your home directory called .gimp­2.2. 
All of the information about the choices you make here goes into that directory. If you 
later remove that directory, or rename it as something like .gimp­2.2.bak, then the next 
time you start GIMP, it will go through the whole setup sequence again, creating a new 
.gimp­2.2 directory. You can exploit this if you want to explore the effect of different 
choices without destroying your existing installation, or if you have screwed things up so 
badly that your existing installation needs to be nuked. 

For the most part, setting up GIMP is very easy, and you can just accept the defaults at 
each step, and possibly adjust things later using the Preferences dialog. The main thing 
you might want to give a little thought to at the start is the amount of memory to allocate 
for GIMP's tile cache. 

Here is a walk-through of the setup process: 

1. Since this window mentions the GNU General Public License you know it is truly a 
Welcome dialog you are entering into. Also, note the "Continue" button. The GIMP does 
not even ask that you agree to it, merely whether you want to continue. Feel free to 
press the continue button. 

  

2. The purpose of this screen is only to make the user aware of the GIMP personal 
settings directory, subdirectories and files creation process, before it begins. You just 
have to have a look and click to proceed. 
  

GNU Image Manipulation Program
Generated by docbook2odf

Page 10 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

3. This window shows you the files that GIMP will create. It will have some complaints 
if you told it to install some place that it don't have permission to be. There is a scroll 
bar to see all the things GIMP has created for you. 
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4. Setting your memory usage is not an easy thing. So much depends on what your 
needs are for the GIMP and what hardware you have to work with. You have two 
options at this point. Go with the default value the developers have set here, or 
determine the best value. A brief tile-cache explanation. might help you determine this 
value. The tile-cache information might also be helpful to you if you are encountering 
memory problems when using the GIMP. 

On a Unix system, /tmp might be a good place for the swap. 
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Main Windows in GIMP 
The screenshot above shows the most basic arrangement of GIMP windows that can be 
used effectively. Three windows are shown: 

The Main Toolbox: This is the heart of the GIMP. It contains the highest level menu, plus a 
set of icon buttons that can be used to select tools, and more. 

Tool options: Docked below the main Toolbox is a Tool Options dialog, showing options for 
the currently selected tool (in this case, the Rectangle Select tool). 

An image window: Each image open in GIMP is displayed in a separate window. Many 
images can be open at the same time: the limit is set only by the amount of system 
resources. It is possible to run GIMP without having any images open, but there are not 
very many useful things to do then. 

Layers Dialog: This dialog window shows the layer structure of the currently active image, 
and allows it to be manipulated in a variety of ways. It is possible to do a few very basic 
things without using the Layers dialog, but even moderately sophisticated GIMP users find 
it indispensible to have the Layers dialog available at all times. 

Brushs/Patterns/Gradients: The docked dialog below the layer dialog shows the dialogs for 
managing brushes, patterns and gradients. 

This is a minimal setup. There are over a dozen other types of dialogs used by GIMP for 
various purposes, but users typically create them when they are needed and close them 
when they are not. Knowledgeable users generally keep the Toolbox (with Tool Options) 
and Layers dialog around at all times. The Toolbox is essential to many GIMP operations; 
in fact, if you close it, GIMP will exit. (You are asked to confirm that you want to do this, 
though.) The Tool Options are actually a separate dialog, shown docked to the Main 
Toolbox in the screenshot. Knowledgeable users almost always have them set up this 
way: it is very difficult to use tools effectively without being able to see how their options 
are set. The Layers dialog comes into play whenever you work with an image that has 
multiple layers: once you advance beyond the very most basic stages of GIMP expertise, 
this means almost always. And finally, of course, the necessity of having images 
displayed in order to work with them is perhaps obvious. 

If your GIMP layout gets trashed, fortunately the arrangement shown in the screenshot is 
pretty easy to recover. In the File menu from the Main Toolbox, selecting File Dialogs 
Create New Dock Layers, Channels, and Paths will give you a Layers dialog just like the 
one shown. In the same menu, selecting File Dialogs Tool Options gives you a new Tool 
Options dialog, which you can then dock below the Main Toolbox. (The section on Dialogs 
and Docking explains how to dock dialogs.) There is no need to be able to create a new 
Main Toolbox, because you cannot get rid of the one you have without causing GIMP to 
exit. 

Unlike some other programs, GIMP does not give you the option of putting everything—
controls and image displays—all into a single comprehensive window. The GIMP 
developers have always felt that this is a poor way of working, because it forces the 
program to perform a wide range of functions that are much better done by a dedicated 
window manager. Not only would this waste a lot of programmer time, it is almost 
impossible to do in a way that works correctly across all of the operating systems GIMP is 
intended to run on. 

Earlier versions of the GIMP (up to GIMP 1.2.5) were very profligate with dialogs: 
advanced users often had half a dozen or more dialogs open at once, scattered all over 
the screen and very difficult to keep track of. GIMP 2.0 is much better in this respect, 
because it allows dialogs to be docked together in a flexible way. (The Layers dialog in the 
screenshot actually contains four dialogs, represented by tabs: Layers, Channels, Paths, 
and Undo.) The system takes a little while to learn, but once you learn it, we hope that 
you will like it. 
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The following sections will walk you through the components of each of the windows 
shown in the screenshot, explaining what they are and how they work. Once you have 
read them, plus the section describing the basic structure of GIMP images, you should 
have learned enough to use GIMP for a wide variety of basic image manipulations. You 
can then look through the rest of the manual at your leisure (or just experiment) to learn 
the almost limitless number of more subtle and specialized things that are possible. Have 
fun! 

The Main Toolbox 
The Main Toolbox is the heart of the GIMP. It is the only part of the application that you 
cannot duplicate or close. Here is a quick tour of what you will find there. 

In the Toolbox, as in most parts of GIMP, moving the mouse on top of something and 
letting it rest for a moment will usually bring up a "tooltip" message that may help you 
understand what the thing is or what you can do with it. Also, in many cases you can 
press the F1 key to get help about the thing that is underneath the mouse. 

Toolbox Menu: This menu is special: it contains some commands that cannot be found in 
the menus that are attached to images. (Also some that can.) These include commands 
for setting preferences, creating certain types of dialogs, etc. The contents are described 
systematically in the Toolbox Menu section. 

Tool icons: These icons are buttons that activate tools for a wide variety of purposes: 
selecting parts of images, painting on them, transforming them, etc. The Toolbox 
Introduction section gives an overview of how to work with tools, and each tool is 
described systematically in the Tools chapter. 

Foreground/Background colors: The color areas here show you GIMP's current foreground 
and background colors, which come into play in many operations. Clicking on either one 
of them brings up a color selector dialog that allow you to change to a different color. 
Clicking on the double-headed arrow swaps the two colors, and clicking on the small 
symbol in the lower left corner resets them to black and white. 

Brush/Pattern/Gradient The symbols here show you GIMP's current selections for: the 
Paintbrush, used by all tools that allow you to paint on the image ("painting" includes 
operations like erasing and smudging, by the way); for the Pattern, which is used in filling 
selected areas of an image; and for the Gradient, which comes into play whenever an 
operation requires a smoothly varying range of colors. Clicking on any of these symbols 
brings up a dialog window that allows you to change it. 

Active Image: (This is a new feature in GIMP 2.2) In GIMP, you can work with many images 
at once, but at any given moment, one of them is the "active image". Here you find a 
small iconic representation of the active image. Clicking on it brings up a dialog with a list 
of all the currently open images, allowing you to make a different one active if you want 
to. (Clicking on the window where the image is displayed will accomplish the same thing, 
though.) 

The "Active Image" preview is disabled by default. If you want it, you can enable it in the 
Toolbox Preferences tab. 

At every start, GIMP selects a tool (the brush), a color, a brush and a pattern by default, 
always the same. If you want GIMP to select the last tool, color, brush and pattern you 
used when quitting your previous session, check the "Set input device settings on exit" in 
Preferences/Input Devices. 

Image Window 
In GIMP, each image that you have open is displayed in its own separate window. (In 
some cases, multiple windows may all display the same image, but this is unusual.) We 
will begin with a brief description of the components that are present by default in an 
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ordinary image window. Some of these, in fact, can be made to disappear using 
commands in the View menu; but you will probably find that you don't want to do that. 

Title Bar: At the top of the image window you will probably see a emphasis bar, showing 
the name of the image and some basic information about it. The emphasis bar is actually 
provided by the windowing system, not by GIMP itself, so its appearance may vary with 
different operating systems, window managers, and/or themes. In the Preferences dialog 
you can customize the information that appears here, if you want to. 

Image Menu: Directly below the emphasis bar appears the Image Menu (unless it has 
been suppressed). This menu gives you access to nearly every operation you can perform 
on an image. (There are some "global" actions that can only be accessed via the Toolbox 
menu.) You can also get the Image Menu by right-clicking inside the image  , or by left-
clicking on the little "arrow" symbol in the upper left corner, if for some reason you find 
one of these more convenient. More: most menu operations can also be activated from 
the keyboard, using Alt plus an "accelerator" key underlined in the menu emphasis. More: 
you can define your own custom shortcuts for menu actions, if you enable Use Dynamic 
Keyboard Shortcuts in the Preferences dialog. 

Menu Button: Clicking on this little button gives you the Image Menu, except in a column 
instead of a row. Mnemonics users who don't want the menu bar visible can acces to this 
menu by pressing the Shift F10 key. 

Ruler: In the default layout, rulers are shown above and to the left of the image, 
indicating coordinates within the image. You can control what type of coordinates are 
shown if you want to. By default, pixels are used, but you can change to other units, using 
the Units setting described below. 

One of the most important uses of rulers is to create guides. If you click on a ruler and 
drag into the image display, a guideline will be created, which you can use to help you 
position things accurately. Guides can be moved by clicking on them and dragging, or 
deleted by dragging them out of the image display. 

QuickMask Toggle: At the lower left corner of the image display is a small button that 
toggles on or off the Quick Mask, which is an alternate, and often extremely useful, way 
of viewing the selected area within the image. For more details see QuickMask. 

Pointer Coordinates: In the lower left corner of the window is a rectangular area used to 
show the current pointer coordinates (that is, the mouse location, if you are using a 
mouse), whenever the pointer is within the image boundaries. The units are the same as 
for the rulers. 

Units menu: (This feature is new in GIMP 2.2; it does not appear in GIMP 2.0). By default, 
the units used for the rulers and several other purposes are pixels. You can change to 
inches, cm, or several other possibilities using this menu. (If you do, note that the setting 
of "Dot for dot" in the View menu affects how the display is scaled: see Dot for Dot for 
more information. 

Zoom button: (This feature is new in GIMP 2.2; it does not appear in GIMP 2.0). There are 
a number of ways to zoom the image in or out, but this menu is perhaps the simplest. 

Status Area: The Status Area appears below the image display. Most of the time, by 
default, it shows which part of the image is currently active, and the amount of system 
memory that the image is consuming. You can customize the information that appears 
here, by changing your Preferences. When you perform time-consuming operations, the 
status area changes temporarily to show what operation is being performed, and its state 
of progress.  

Cancel Button: At the lower right corner of the window appears the Cancel button. If you 
start a complex, time-consuming operation (most commonly a plug-in), and then decide, 
while it is being computed, that you didn't really want to do it after all, this button will 
cancel it immediately. 

There are a few plug-ins that respond badly to being canceled, possibly leaving corrupted 

GNU Image Manipulation Program
Generated by docbook2odf

Page 16 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 
pieces of images behind. 

Navigation control: This is a small cross-shaped button at the lower right corner of the 
image display. Clicking on it, and holding the left mouse button down, brings up a window 
showing a miniature view of the image, with the displayed area outlined. You can pan to a 
different part of the image by moving the mouse while keeping the button depressed. For 
large images of which only a small part is displayed, the navigation window is often the 
most convenient way of getting to the part of the image you are looking for. (See 
Navigation Dialog for other ways to access the Navigation Window). (If your mouse has a 
middle-button, click-drag with it to span across the image). 

Inactive Padding Area: This padding area seperates the active image display and the 
inactive padding area, so you're able to distinguish between them. You cannot apply any 
Filters or Operations in generall on the inactive area. 

Image Display: The most important part of the image window is, of course, the image 
display or canvas. It occupies the central area of the window, surrounded by a yellow 
dotted line showing the image boundary, against a neutral gray background. You can 
change the zoom level of the image display in a variety of ways, including the Zoom 
setting described below. 

Image Window Resize Toggle: If this button is pressed, the image itself will be resized if 
the image window is resized. 

Dialogs and Docking 

Docking Bars 
In GIMP 2.0 and 2.2, you have a lot of flexibility about the arrangement of dialog windows 
on your screen. Instead of placing each dialog in its own window, you can group them 
together using docks. A "dock" is a container window that can hold a collection of 
persistent dialogs, such as the Tool Options dialog, Brushes dialog, Palette dialog, etc. 
Docks cannot, however, hold image windows: each image always has its own separate 
window. They also can't hold non-persistent dialogs, such as the Preferences dialog or the 
New Image dialog. 

 

Each dock has a set of docking bars, as highlighted in the adjoining figure. These are thin 
gray bars, very unobtrusive and easy not to notice: most people don't realize that they 
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exist until they are specifically pointed out. 

Docking Drag Handles 
Each dockable dialog has a drag handle area, as highlighted in the figure on the right. You 
can recognize this by the fact that the cursor changes to a hand shape when the pointer 
is over the drag handle area. To dock a dialog, you simply click on its drag handle area, 
and drag it onto one of the docking bars in a dock. 

  

You can drag more than one dialog onto the same docking bar. If you do, they will turn 
into tabs, represented by iconic symbols at the top. Clicking on the tab handle will bring a 
tab to the front, so that you can interact with it. 

Image Menu 
Some docks contain an Image Menu: a menu listing all of the images open in GIMP, and 
displaying the name of the image whose information is shown in the dock. You can use 
the Image Menu to select a different image (don't confuse this menu for the Image Menu 
that is the Menu of the active image on your screen). If the Auto button is depressed, 
then the menu always shows the name of GIMP's currently active image, that is, the 
image you are currently working on. 
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By default, a "Layers, Channels, and Paths" dock shows an Image Menu at the top, and 
other types of docks do not. You can always add or remove an Image Menu, however, 
using the "Show Image Menu" toggle in the Tab menu, as described below. (Exception: 
you cannot add an Image Menu to the dock that contains the Toolbox.) 

Tab Menu 

 

In each dialog, you can access a special menu of tab-related operations by pressing the 
Tab Menu button, as highlighted in the figure on the right. Exactly which commands are 
shown in the menu varies a bit from dialog to dialog, but they always include operations 
for creating new tabs, or closing or detaching tabs. 
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The Tab menu gives you access to the following commands: 
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Basic GIMP Concepts 
This section is intended to give you a brief introduction to the basic concepts and 
terminology you will need to understand in order to make sense of the rest of the 
documentation. Everything here is explained in much greater depth elsewhere. With a 
few exceptions, we have avoided cluttering this section with a lot of links and cross-
references: everything mentioned here is so high-level that you should easily be able to 
locate it in the index. 
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Working with Images 

Image types 
It is tempting to think of an image as something that corresponds with a single display 
window, or to a single file such as a JPEG file, but really a Gimp image is a rather 
complicated structure, containing a stack of layers plus several other types of objects: a 
selection mask, a set of channels, a set of paths, an "undo" history, etc. In this section we 
are going to take a detailed look at all of the components of an image, and the things you 
can do with them. 

The most basic property of an image is its mode. There are three possible modes: RGB, 
grayscale, and indexed. RGB stands for Red-Green-Blue, and indicates that each point in 
the image is represented by a "red" level, a "green" level, and a "blue" level. Because 
every humanly distinguishable color can be represented as a combination of red, green, 
and blue, RGB images are full-color. Each color channel has 256 possible intensity levels. 
More details in Color Models 

In a grayscale image, each point is represented by a brightness value, ranging from 0 
(black) to 255 (white), with intermediate values representing different levels of gray. 

  

  

Essentially the difference between a grayscale image and an RGB image is the number of 
"color channels": a grayscale image has one; an RGB image has three. An RGB image can 
be thought of as three superimposed grayscale images, one colored red, one green, and 
one blue. 

Actually, both RGB and grayscale images have one additional color channel, called the 
alpha channel, representing opacity. When the alpha value at a given location in a given 
layer is zero, the layer is completely transparent, and the color at that location is 
determined by what lies underneath. When alpha is maximal, the layer is opaque, and the 
color is determined by the color of the layer. Intermediate alpha values correspond to 
varying degrees of translucency: the color at the location is a proportional mixture of 
color from the layer and color from underneath. 
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In Gimp, every color channel, including the alpha channel, has a range of possible values 
from 0 to 255; in computing terminology, a depth of 8 bits. Some digital cameras can 
produce image files with a depth of 16 bits per color channel. Gimp cannot load such a 
file without losing resolution. In most cases the effects are too subtle to be detected by 
the human eye, but in some cases, mainly where there are large areas with slowly 
varying color gradients, the difference may be perceptible. 

 

The third type, indexed images, is a bit more complicated to understand. In an indexed 
image, only a limited set of discrete colors are used, usually 256 or less. These colors 
form the "colormap" of the image, and each point in the image is assigned a color from 
the colormap. Indexed images have the advantage that they can be represented inside a 
computer in a way that consumes relatively little memory, and back in the dark ages 
(say, ten years ago), they were very commonly used. As time goes on, they are used less 
and less, but they are still important enough to be worth supporting in Gimp. (Also, there 
are a few important kinds of image manipulation that are easier to implement with 
indexed images than with continuous-color RGB images.) 

Some very commonly used types of files (including GIF and PNG) produce indexed images 
when they are opened in Gimp. Many of Gimp's tools don't work very well on indexed 
images–and many filters don't work at all–because of the limited number of colors 
available. Because of this, it is usually best to convert an image to RGB mode before 
working on it. If necessary, you can convert it back to indexed mode when you are ready 
to save it 

Gimp makes it easy to convert from one image type to another, using the Mode command 
in the Image menu. Some types of conversions, of course (RGB to grayscale or indexed, 
for example) lose information that cannot be regained by converting back in the other 
direction. 

If you are trying to use a filter on an image, and it appears grayed out in the menu, 
usually the cause is that the image (or, more specifically, the layer) you are working on is 
the wrong type. Many filters can't be used on indexed images. Some can be used only on 
RGB images, or only on grayscale images. Some also require the presence or absence of 
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an alpha channel. Usually the fix is to convert the image to a different type, most 
commonly RGB. 

QuickMask 

 

The selection tools sometimes show their limits when they have to be used for creating a 
complex selection. In these cases, using the QuickMask can make things much easier. 
Simply put, the QuickMask allows you to paint a selection instead of just tracing its 
outline. 

Overview 
Normally when you create a selection in GIMP, you see it represented by the "marching 
ants" that trace along its outline. But really there may be a lot more to a selection than 
the marching ants show you: in GIMP a selection is actually a full-fledged grayscale 
channel, covering the image, with pixel values ranging from 0 (unselected) to 255 (fully 
selected). The marching ants are drawn along a contour of half-selected pixels. Thus, 
what the marching ants show you as either-or–inside or outside the boundary–is really 
just a slice through a continuum. 

The QuickMask is GIMP's way of showing you the full structure of the selection. Activating 
it also gives you the ability to interact with the selection in new, and substantially more 
powerful, ways. To activate the QuickMask, click on the small red-outlined button at the 
lower left of the image window. The button is a toggle, so clicking it again will return you 
to normal marching-ant mode. You can also activate the QuickMask by selecting in the 
image window menu Select Toggle QuickMask , or by using the ShiftQ shortcut. 

Activating the QuickMask shows you the selection as though it were a translucent screen 
overlying the image, whose transparency at each pixel indicates the degree to which that 
pixel is selected. By default the mask is shown in red, but you can change this if another 
mask color would be more convenient. The less a pixel is selected, the more it is obscured 
by the mask. Fully selected pixels are shown completely clear. 

When you are in QuickMask mode, many image manipulations act on the selection 
channel rather than the image itself. This includes, in particular, paint tools. Painting with 
white causes the painted pixels to be selected; painting with black causes them to be 
unselected. You can use any of the paint tools, as well as the bucket fill and gradient fill 
tools, in this way. Advanced users of the GIMP learn that "painting the selection" is the 
easiest and most effective way to delicately manipulate it. 

To save the selection done by the Quickmask to a new channel; Make sure that there is a 
selection and that Quickmask is not active in the image window. Select in the image 
menu Select/Save to Channel. This will create a new channel in the channel dialog called 
SelectionMask 1. 

When QuickMask is active, Cut and Paste act on the selection rather than the image. You 
can sometimes make use of this as the most convenient way of transferring a selection 
from one image to another. 
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You can learn more on Quickmask and Selection masks in the section dedicated to the 
channel dialog. 

Layers 
A good way to visualize a GIMP image is as a stack of transparencies: in GIMP 
terminology, each individual transparency is called a layer. There is no limit, in principle, 
to the number of layers an image can have: only the amount of memory available on the 
system. It is not uncommon for advanced users to work with images containing dozens of 
layers. 

The organization of layers in an image is shown by the Layers dialog, which is the second 
most important type of dialog window in GIMP, after the Main Toolbox. The appearance of 
the Layers dialog is shown in the adjoining illustration. How it works is described in detail 
in the Layers Dialog section, but we will touch on some aspects of it here, in relation to 
the layer properties that they display. 

Each open image has at any time a single active drawable. A "drawable" is a GIMP 
concept that includes layers, but also several other types of things, such as channels, 
layer masks, and the selection mask. (Basically, a "drawable" is anything that can be 
drawn on with painting tools.) If a layer is currently active, it is shown highlighted in the 
Layers dialog, and its name is shown in the status area of the image window. If not, you 
can activate it by clicking on it. If none of the layers are highlighted, it means the active 
drawable is something other than a layer. 

In the menubar above an image window, you can find a menu called Layer, containing a 
number of commands that affect the active layer of the image. The same menu can be 
accessed by right-clicking in the Layers dialog. 

Layer properties 
Each layer in an image has a number of important attributes: 

The Selection 
Often when you operate on an image, you only want part of it to be affected. In GIMP, you 
make this happen by selecting that part. Each image has a selection associated with it. 
Most, but not all, GIMP operations act only on the selected portions of the image. 

 

There are many, many situations where creating just the right selection is the key to 
getting the result you want, and often it is not very easy to do. For example, in the above 
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image, suppose I want to cut the tree out from its background, and paste it into a 
different image. In order to do this, I need to create a selection that contains the tree and 
nothing but the tree. It is difficult because the tree has a very complex shape, and in 
several spots is hard to distinguish from the objects behind it. 

 

Now here is a very important point, and it is crucial to understand this. Ordinarily when 
you create a selection, you see it as a dashed line enclosing a portion of the image. The 
idea you could get from this is that the selection is a sort of container, with the selected 
parts of the image inside, and the unselected parts outside. This concept of the selection 
is okay for many purposes, but it is not really correct. 

Actually the selection is implemented as a channel. In terms of its internal structure, it is 
identical to the red, green, blue, and alpha channels of an image. Thus, the selection has 
a value defined at each pixel of the image, ranging between 0 (unselected) and 255 (fully 
selected). The advantage of this approach is that it allows some pixels to be partially 
selected, by giving them intermediate values between 0 and 255. As you will see, there 
are many situations where it is desirable to have smooth transitions between selected 
and unselected regions. 

What, then, is the dashed line that appears when you create a selection? 

It is a contour line, dividing areas that are more than half selected from areas that are 
less than half selected. 

 

You should always bear in mind, when looking at the dashed line that represents the 
selection, that it only tells you part of the story. If you want to see the selection in 
complete detail, the easiest way is to click the QuickMask button in the lower left corner 
of the image window. This causes the selection to be shown as a translucent overlay atop 
the image. Selected areas are unaffected; unselected areas are reddened. The more 
completely selected an area is, the less red it appears. 

QuickMask mode, and its uses, are described in detail below. Meanwhile, if you are 
following this discussion by trying things out in GIMP, you should know that many 
operations work differently in QuickMask mode, so go ahead and toggle it off again for 
now (by clicking the QuickMask button once more). 

 

Feathering 
With the default settings, the basic selection tools, such as the Rectangle Select tool, 
create sharp selections. Pixels inside the dashed line are fully selected, and pixels outside 
completely unselected. You can verify this by toggling QuickMask: you see a clear 
rectangle with sharp edges, surrounded by uniform red. In the Tool Options, however, is a 
checkbox called "Feather edges". If you enable this, the tool will instead create graduated 
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selections. The feather radius, which you can adjust, determines the distance over which 
the transition occurs. 

If you are following along, try this out with the Rectangle Select tool, and then toggle 
QuickMask. You will now see that the clear rectangle has a fuzzy edge. 

Feathering is particularly useful when you are cutting and pasting, in helping the pasted 
object to blend smoothly and unobtrusively with its surroundings. 

Actually, it is possible to feather a selection at any time, even if it was originally created 
as a sharp selection. You can do this from the image menu, by choosing Select Feather . 
This brings up a dialog that allows you to set the feather radius. You can do the opposite--
sharpen a graduated selection into an all-or-nothing selection--by choosing Select 
Sharpen . 

For technically oriented readers: feathering works by applying a Gaussian blur to the 
selection channel, with the specified blurring radius. 

Making a selection partially transparent 
You can set layer opacity, but you cannot do that directly for a selection. It is quite useful 
to make the image of a glass transparent. You can achieve this by using these methods: 

• For simple selections, use the Eraser tool with the wanted opacity. 

• For complex selections: use the command Selection Floating to create a floating 
selection. This creates a new layer called "Floating Selection". Activate it and use 
the opacity slider to get the wanted opacity. Then anchor the selection: outside the 
selection, the mouse pointer comes with an anchor icon. When you click, the floating 
selection disappears from the Layer Dialog and the selection is at the right place 
and partially transparent (anchoring works this way only if a selection tool is 
activated : you can also use the command in the context menu that you get by right 
clicking on the selected layer in the layer dialog). 

And, if you use this function frequently: CtrlC to copy the selection, CtrlV to paste it, 
creating so a floating selection, adapt the opacity then make Layer/New Layer that 
pastes the floating selection into the new layer. You can also create a shortcut for 
the New Layer command to use keys only. 

• Another way: Layer Mask Layer mask to add a layer mask to the layer with the 
selection, initializing it with the selection. Then use a brush with the wanted opacity 
to paint the selection with black, i-e paint it with transparency. Then 
Layer/Mask/Apply Layer Mask. See . 

Undoing 
Almost anything you do to an image in GIMP can be undone. You can undo the most 
recent action by choosing Edit Undo from the image menu, but this is done so frequently 
that you really should memorize the keyboard shortcut, Ctrl Z . 

Undoing can itself be undone. After having undone an action, you can redo it by choosing 
Edit Redo from the image menu, or use the keyboard shortcut, Ctrl Y . It is often helpful to 
judge the effect of an action by repeatedly undoing and redoing it. This is usually very 
quick, and does not consume any extra resources or alter the undo history, so there is 
never any harm in it. 

If you undo one or more actions and then operate on the image in any way except by 
using Undo or Redo, it will no longer be possible to redo those actions: they are lost 
forever. The solution to this, if it creates a problem for you, is to duplicate the image and 
then operate on the copy. ( Not the original, because the undo/redo history is not copied 
when you duplicate an image.) 

If you often find yourself undoing and redoing many steps at a time, it may be more 
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convenient to work with the Undo History dialog, a dockable dialog that shows you a 
small sketch of each point in the Undo History, allowing you to go back or forward to that 
point by clicking. 

Undo is performed on an image-specific basis: the "Undo History" is one of the 
components of an image. GIMP allocates a certain amount of memory to each image for 
this purpose. You can customize your Preferences to increase or decrease the amount, 
using the Environment page of the Preferences dialog. There are two important variables: 
the minimal number of undo levels, which GIMP will maintain regardless of how much 
memory they consume, and the maximum undo memory, beyond which GIMP will begin 
to delete the oldest items from the Undo History. 

Even though the Undo History is a component of an image, it is not saved when you save 
the image using GIMP's native XCF format, which preserves every other image property. 
When the image is reopened, it will have an empty Undo History. 

The implementation of Undo by GIMP is rather sophisticated. Many operations require 
very little Undo memory (e.g., changing visibility of a layer), so you can perform long 
sequences of them before they drop out of the Undo History. Some operations (changing 
layer visibility is again an example) are compressed, so that doing them several times in 
a row produces only a single point in the Undo History. However, there are other 
operations that may consume a lot of undo memory. Most filters are examples of this: 
because they are implemented by plug-ins, the GIMP core has no really efficient way of 
knowing what they have changed, so it has no way to implement Undo except by 
memorizing the entire contents of the affected layer before and after the operation. You 
might only be able to perform a few such operations before they drop out of the Undo 
History. 

Things that cannot be Undone 
Most actions that alter an image can be undone. Actions that do not alter the image 
generally cannot be. This includes operations such as saving the image to a file, 
duplicating the image, copying part of the image to the clipboard, etc. It also includes 
most actions that affect the image display without altering the underlying image data. 
The most important example is zooming. There are, however, exceptions: toggling 
QuickMask on or off can be undone, even though it does not alter the image data. 

There are a few important actions that do alter an image but cannot be undone: 

Filters, and other actions performed by plugins or scripts, can be undone just like actions 
implemented by the GIMP core, but this requires them to make correct use of GIMP's 
Undo functions. If the code is not correct, a plugin can potentially corrupt the Undo 
History, so that not only the plugin but also previous actions can no longer properly be 
undone. The plugins and scripts distributed with GIMP are all believed to be set up 
correctly, but obviously no guarantees can be given for plugins you obtain from other 
sources. Also, even if the code is correct, canceling a plugin while it is running can 
sometimes leave the Undo History corrupted, so it is best to avoid this unless you have 
accidentally done something whose consequences are going to be very harmful. 

Grids and Guides 
You will probably have it happen many times that you need to place something in an 
image very precisely, and find that it is not easy to do using a mouse. Often you can get 
better results by using the arrow keys on the keyboard (which move the affected object 
one pixel at a time, or 25 pixels if you hold down the Shift key), but GIMP also provides 
you with two other aids to make positioning easier: grids and guides. 
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The Image Grid 

 

Each image has a grid. It is always present, but by default it is not visible until you 
activate it by toggling View Show Grid in the image menu. If you want grids to be present 
more often than not, you can change the default behavior by checking "Show grid" in the 
Image Window Appearance page of the Preferences dialog. (Note that there are separate 
settings for Normal Mode and Fullscreen Mode.) 

The default grid appearance, set up when you install GIMP, consists of plus-shaped black 
crosshairs at the grid line intersections, with grid lines spaced every 10 pixels both 
vertically and horizontally. You can customize the default grid using the Default Image 
Grid page of the Preferences dialog. If you only want to change the grid appearance for 
the current image, you can do so by choosing Image Configure Grid from the image 
menu: this brings up the Configure Grid dialog. 
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Not only can a grid be helpful for judging distances and spatial relationships, it can also 
permit you to align things exactly with the grid, if you toggle View Snap to Grid in the 
image menu: this causes the pointer to "warp" perfectly to any grid line located within a 
certain distance. You can customize the snap distance threshold by setting "Snap 
distance" in the Tool Options page of the Preferences dialog, but most people seem to be 
happy with the default value of 8 pixels. (Note that it is perfectly possible to snap to the 
grid even if the grid is not visible. It isn't easy to imagine why you might want to do this, 
though.) 

Guides 

 

In addition to the image grid, GIMP also gives you a more flexible type of positioning aid: 
guides. These are horizontal or vertical lines that you create by clicking on one of the 
rulers and dragging into the image. You can create as many guides as you like, positioned 
whereever you like. To move a guide after you have created it, activate the Move tool in 
the Toolbox (or press the M key), you can then click and drag a guide. To delete a guide, 
simply drag it outside the image. Holding down the Shift key, you can move everything 
but a guide, using the guides as an effective alignment aid. 

As with the grid, you can cause the pointer to snap to nearby guides, by toggling View 
Snap to Guides in the image menu. If you have a number of guides and they are making 
it difficult for you to judge the image properly, you can hide them by toggling View Show 
Guides . It is suggested that you only do this momentarily, otherwise you may get 
confused the next time you try to create a guide and don't see anything happening. 

If it makes things easier for you, you can change the default behavior for guides in the 
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Image Window Appearance page of the Preferences dialog. Disabling "Show guides" is 
probably a bad idea, though, for the reason just given. 

Another use for guides: the Guillotine plugin can use guides to slice an image into a set of 
sub-images. 

See also Guides in Glossary. 

Paths 

  

A path is a one-dimensional curve. Paths are used for two main purposes: 

• A closed path can be converted into a selection.

• An open or closed path can be stroked, that is, painted on the image, in a variety of 
ways. 

Paths can be created and manipulated using the Path tool. Paths, like layers and 
channels, are components of an image. When an image is saved in GIMP's native XCF file 
format, any paths it has are saved along with it. The list of paths in an image can be 
viewed and operated on using the Paths dialog. If you want to move a path from one 
image to another, you can do so by copying and pasting using the popup menu in the 
Paths dialog, or by dragging an icon from the Paths dialog into the destination image's 
window. 
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GIMP paths belong to a mathematical type called "Bezier paths". What this means in 
practical terms is that they are defined by anchors and handles. "Anchors" are points the 
path goes through. "Handles" define the direction of a path when it enters or leaves an 
anchor point: each anchor point has two handles attached to it. 

Paths can be very complex. If you create them by hand using the Path tool, unless you are 
obsessive they probably won't contain more than a few dozen anchor points (often many 
fewer); but if you create them by transforming a selection into a path, or by transforming 
text into a path, the result can easily contain hundreds of anchor points, or even 
thousands. 

A path may contain multiple components. A "component" is a part of a path whose 
anchor points are all connected to each other by path segments. The ability to have 
multiple components in paths allows you to convert them into selections having multiple 
disconnected parts. 

Each component of a path can be either open or closed: "closed" means that the last 
anchor point is connected to the first anchor point. If you transform a path into a 
selection, any open components are automatically converted into closed components by 
connecting the last anchor point to the first anchor point with a straight line. 

Path segments can be either straight or curved. A path all of whose segments are straight 
is called "polygonal". When you create a path segment, it starts out straight, because the 
handles for the anchor points are initially placed directly on top of the anchor points, 
yielding handles of zero length, which produce straight-line segments. You can make a 
segment curved by dragging a handle away from one of the anchor points. 

One nice thing about paths is that they are very light in terms of resource consumption, 
especially in comparison with images. Representing a path in RAM only requires storing 
the coordinates of its anchors and handles: 1K of memory is enough to hold quite a 
complex path, but not enough to hold even a 20x20 pixel RGB layer. Therefore, it is quite 
possible to have literally hundreds of paths in an image without putting any significant 
stress of your system. (How much stress managing them would put on you is, of course, 
another question.) Even a path with thousands of segments consumes minimal resources 
in comparison to a typical layer or channel. 

Paths and Selections 
GIMP lets you transform the selection for an image into a path; it also lets you transform 
paths into selections. For information about the selection and how it works, see the 
Selection section. 

When you transform a selection into a path, the path closely follows the "marching ants". 
Now, the selection is a two-dimensional entity, but a path is a one-dimensional entity, so 
there is no way to transform the selection into a path without losing information. In fact, 
any information about partially selected areas (i.e., feathering) will be lost when the 
selection is turned into a path. If the path is transformed back into a selection, the result 
is an all-or-none selection, similar to what would be obtained by executing "Sharpen" from 
the Select menu. 

Paths and Text 
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A text item created using the Text tool can be transformed into a path using the Create 
path from text button in the Tool Options for the Text tool. This can be useful for several 
purposes, including: 

• Stroking the path, which gives you many possibilities for fancy text. 

• More importantly, transforming the text. Converting text into a path, then 
transforming the path, and finally either stroking the path or converting it to a 
selection and filling it, often leads to much higher-quality results than rendering the 
text as a layer and transforming the pixel data. 

Paths and SVG files 
SVG, standing for "Scalable Vector Graphics", is an increasingly popular file format for 
vector graphics, in which graphical elements are represented in a resolution-independent 
format, in contrast to raster graphics; in which graphical elements are represented as 
arrays of pixels. GIMP is mainly a raster graphics program, but paths are vector entities. 

Fortunately, paths are represented in SVG files in almost exactly the same way they are 
represented in GIMP. (Actually fortune has nothing to do with it: GIMP's path handling was 
rewritten for GIMP 2.0 with SVG paths in mind.) This compatibility makes it possible to 
store GIMP paths as SVG files without losing any information. You can access this 
capability in the Paths dialog. 

It also means that GIMP can create paths from SVG files saved in other programs, such as 
Inkscape or Sodipodi, two popular open-source vector graphics applications. This is nice 
because those programs have much more powerful path-manipulation tools than GIMP 
does. You can import a path from an SVG file using the Paths dialog. 

The SVG format handles many other graphical elements than just paths: among other 
things, it handles figures such as squares, rectangles, circles, ellipses, regular polygons, 
etc. GIMP 2.0 cannot do anything with these entities, but GIMP 2.2 can load them as 
paths. 

Creating paths is not the only thing GIMP can do with SVG files. It can also open SVG files 
as GIMP images, in the usual way. 

Brushes 
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A brush is a pixmap or set of pixmaps used for painting. GIMP includes a set of 10 "paint 
tools", which not only perform operations that you would think of as painting, but also 
operations such as erasing, copying, smudging, lightening or darkening, etc. All of the 
paint tools, except the ink tool, use the same set of brushes. The brush pixmaps 
represent the marks that are made by single "touches" of the brush to the image. A brush 
stroke, usually made by moving the pointer across the image with the mouse button held 
down, produces a series of marks spaced along the trajectory, in a way specified by the 
characteristics of the brush and the paint tool being used. 

Brushes can be selected by clicking on an icon in the Brushes dialog. GIMP's current 
brush is shown in the Brush/Pattern/Gradient area of the Toolbox. Clicking on the brush 
symbol there is one way of activating the Brushes dialog. 

When you install GIMP, it comes presupplied with a number of basic brushes, plus a few 
bizarre ones that serve mainly to give you examples of what is possible (i. e., the "green 
pepper" brush in the illustration). You can also create new brushes, or download them and 
install them so that GIMP will recognize them. 

GIMP can use several different types of brushes. All of them, however, are used in the 
same way, and for most purposes you don't need to be aware of the differences when 
you paint with them. Here are the available types of brushes: 

One category that GIMP does not have is full-fledged procedural brushes: brushes whose 
marks are calculated procedurally, instead of being taken from a fixed pixmap. (Actually 
this is not quite correct: the Ink tool uses a procedural brush, but it is the only one 
available in GIMP.) A more extensive implementation of procedural brushes is a goal of 
future development for GIMP. 

In addition to the brush pixmap, each GIMP brush has one other important property: the 
brush Spacing. This represents the distance between consecutive brush-marks when a 
continuous brushstroke is painted. Each brush has an assigned default value for this, 
which can be modified using the Brushes dialog. 

Gradients 
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A gradient is a set of colors arranged in a linear order. The most basic use of gradients is 
by the Blend tool, sometimes known as the "gradient tool" or "gradient fill tool": it works 
by filling the selection with colors from a gradient. You have many options to choose from 
for controlling the way the gradient colors are arranged within the selection. There are 
also other important ways to use gradients, including: 

When you install GIMP, it comes presupplied with a large number of interesting gradients, 
and you can add new ones that you create or download from other sources. You can 
access the full set of available gradients using the Gradients dialog, a dockable dialog 
that you can either activate when you need it, or keep around as a tab in a dock. The 
"current gradient", used in most gradient-related operations, is shown in the 
Brush/Pattern/Gradient area of the Toolbox. Clicking on the gradient symbol in the Toolbox 
is an alternative way of bringing up the Gradients dialog. 

  

A few useful things to know about GIMP's gradients:

• The first four gradients in the list are special: they use the Foreground and 
Background colors from the Toolbox Color Area, instead of being fixed. FG to BG 
(RGB) is the RGB representation of the gradient from the Foreground color to the 
Background color in Toolbox. FG to BG (HSV counter-clockwise) represents the hue 
succession in Color Circle from the selected hue to 360°. FG to BG (HSV clockwise 
represents the hue succession in Color Circle from the selected hue to 0°. With FG to 
transparent , the selected hue becomes more and more transparent. You can modify 
these colors by using the Color Selector. Thus, by altering the foreground and 
background colors, you can make these gradients transition smoothly between any 
two colors you want. 

• Gradients can involve not just color changes, but also changes in opacity. Some of 
the gradients are completely opaque; others include transparent or translucent 
parts. When you fill or paint with a non-opaque gradient, the existing contents of the 
layer will show through behind it. 

• You can create new custom gradients, using the Gradient Editor. You cannot modify 
the gradients that are supplied with GIMP, but you can duplicate them or create new 
ones, and then edit those. 

The gradients that are supplied with GIMP are stored in a system gradients folder. By 
default, gradients that you create are stored in a folder called gradients in your personal 
GIMP directory. Any gradient files (ending with the extension .ggr) found in one of these 
folders, will automatically be loaded when you start GIMP. You can add more directories to 
the gradient search path, if you want to, in the Gradients tab of the Data Folders pages of 
the Preferences dialog. 
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New in GIMP 2.2 is the ability to load gradient files in SVG format, used by many vector 
graphics programs. To make GIMP load an SVG gradient file, all you need to do is place it 
in the gradients folder of your personal GIMP directory, or any other folder in your 
gradient search path. 

You can find a large number of interesting SVG gradients on the web, in particular at 
OpenClipArt Gradients . You won't be able to see what these gradients look like unless 
your browser supports SVG, but that won't prevent you from downloading them. 

Patterns 
A pattern is an image, usually small, used for filling regions by tiling, that is, by placing 
copies of the pattern side by side like ceramic tiles. A pattern is said to be tileable if 
copies of it can be adjoined left-edge-to-right-edge and top-edge-to-bottom-edge without 
creating obvious seams. Not all useful patterns are tileable, but tileable patterns are 
nicest for many purposes. (A texture, by the way, is the same thing as a pattern.) 

  

In GIMP there are three main uses for patterns:

• With the Bucket Fill tool, you can choose to fill a region with a pattern instead of a 
solid color. 

• With the Clone tool, you can paint using a pattern, with a wide variety of paintbrush 
shapes. 

• When you stroke a path or selection, you can do it with a pattern instead of a solid 
color. You can also use the Clone tool as your choice if you stroke the selection using 
a painting tool. 

Note: Patterns do not need to be opaque. If you fill or paint using a pattern with 
translucent or transparent areas, then the previous contents of the area will show through 
from behind it. This is one of many ways of doing "overlays" in GIMP. 

When you install GIMP, it comes presupplied with a few dozen patterns, which seem to 
have been chosen more or less randomly. You can also add new patterns, either ones you 
create yourself, or ones you download from the vast number available online. 

GIMP's current pattern, used in most pattern-related operations, is shown in the 
Brush/Pattern/Gradient area of the Toolbox. Clicking on the pattern symbol brings up the 
Patterns dialog, which allows you to select a different pattern. You can also access the 
Patterns dialog by menu, or dock it so that it is present continuously. 

To add a new pattern to the collection, so that it shows up in the Patterns dialog, you need 
to save it in a format GIMP can use, in a folder included in GIMP's pattern search path. 
There are several file formats you can use for patterns: 

To make a pattern available, you place it in one of the folders in GIMP's pattern search 
path. By default, the pattern search path includes two folders, the system patterns 
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folder, which you should not use or alter, and the patterns folder inside your personal 
GIMP directory. You can add new folders to the pattern search path using the Pattern 
Folders page of the Preferences dialog. Any PAT file (or, in GIMP 2.2, any of the other 
acceptable formats) included in a folder in the pattern search path will show up in the 
Patterns dialog the next time you start GIMP. 

There are countless ways of creating interesting patterns in GIMP, using the wide variety 
of available tools and filters -- particularly the rendering filters. You can find tutorials for 
this in many locations, including the Gimp home page. Some of the filters have options 
that allow you to make their results tileable. Also, the Tileable Blur filter allows you to 
blend the edges of an image in order to make it more smoothly tileable. 

  

Also of interest are a set of pattern-generating scripts that come with GIMP: you can find 
them in the Toolbox menu, under Xtns Script-Fu Patterns . Each of the scripts creates a 
new image filled with a particular type of pattern: a dialog pops up that allows you to set 
parameters controlling the details of the appearance. Some of these patterns are most 
useful for cutting and pasting; others serve best as bumpmaps. 

Palettes 
A palette is a set of discrete colors. In GIMP, palettes are used mainly for two purposes: 

• They allow you to paint with a selected set of colors, in the same way an oil painter 
works with colors from a limited number of tubes. 

• They form the colormaps of indexed images. An indexed image can use a maximum 
of 256 different colors, but these can be any colors. The colormap of an indexed 
image is called an "indexed palette" in GIMP. 

Actually neither of these functions fall very much into the mainstream of GIMP usage: it is 
possible to do rather sophisticated things in GIMP without ever dealing with palettes. Still, 
they are something that an advanced user should understand, and even a less advanced 
user may need to think about them in some situations, as for example when working with 
GIF files. 
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When you install GIMP, it comes supplied with several dozen predefined palettes, and you 
can also create new ones. Some of the predefined palettes are commonly useful, such as 
the "Web" palette, which contains the set of colors considered "web safe"; many of the 
palettes seem to have been chosen more or less whimsically. You can access all of the 
available palettes using the Palettes dialog. This is also the starting point if you want to 
create a new palette. 

 

Double-clicking on a palette in the Palettes dialog brings up the Palette Editor, showing 
the colors from the palette you clicked on. You can use this to paint with the palette: 
clicking on a color sets GIMP's foreground to that color, as shown in the Color Area of the 
Toolbox. Holding down the Ctrl key while clicking, on the other hand, sets GIMP's 
background color to the color you click on. 

You can also, as the name implies, use the Palette Editor to change the colors in a palette, 
so long as it is a palette that you have created yourself. You cannot edit the palettes that 
are supplied with GIMP; however you can duplicate them and then edit the copies. 

When you create palettes using the Palette Editor, they are automatically saved as soon 
as you exit GIMP, in the palettes folder of your personal GIMP directory. Any palette files 
in this directory, or in the system palettes directory created when GIMP is installed, are 
automatically loaded and shown in the Palettes dialog the next time you start GIMP. You 
can also add other folders to the palette search path using the Palette Folders page of the 
Preferences dialog. 

GIMP palettes are stored using a special file format, in files with the extension .gpl. It is a 
very simple format, and they are ASCII files, so if you happen to obtain palettes from 
another source, and would like to use them in GIMP, it probably won't be very hard to 
convert them: just take a look at any .gpl and you will see what to do. 

Colormap 

GNU Image Manipulation Program
Generated by docbook2odf

Page 38 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 
Confusingly, GIMP makes use of two types of palettes. The more noticeable are the type 
shown in the Palettes dialog: palettes that exist independently of any image. The second 
type, indexed palettes, form the colormaps of indexed images. Each indexed image has 
its own private indexed palette, defining the set of colors available in the image: the 
maximum number of colors allowed in an indexed palette is 256. These palettes are 
called "indexed" because each color is associated with an index number. (Actually, the 
colors in ordinary palettes are numbered as well, but the numbers have no functional 
significance.) 

 

The colormap of an indexed image is shown in the Indexed Palette dialog , which should 
not be confused with the Palettes dialog. The Palettes dialog shows a list of all of the 
palettes available; the Colormap dialog shows the colormap of the currently active image, 
if it is an indexed image - otherwise it shows nothing. 

You can, however, create an ordinary palette from the colors in an indexed image---
actually from the colors in any image. To do this, choose Import Palette from the right-
click popup menu in the Palettes dialog: this pops up a dialog that gives you several 
options, including the option to import the palette from an image. (You can also import 
any of GIMP's gradients as a palette.) This possibility becomes important if you want to 
create a set of indexed images that all use the same set of colors. 

When you convert an image into indexed mode, a major part of the process is the 
creation of an indexed palette for the image. How this happens is described in detail in . 
Briefly, you have several methods to choose from, one of which is to use a specified 
palette from the Palettes dialog. 

Thus, to sum up the foregoing, ordinary palettes can be turned into indexed palettes 
when you convert an image into indexed mode; indexed palettes can be turned into 
ordinary palettes by importing them into the Palettes dialog. 

Text and Fonts 
  

One of the greatest improvements of GIMP 2.0 over GIMP 1.2 is in the handling of text. In 
GIMP 2.0 and 2.2, each text item goes in a separate Text layer, and you can come back 
later to the layer and edit the text in it. You can also move the text around in the image, 
or change the font, or the font size. You can use any font available on your system. You 
can control justification, indentation, and line spacing. 

Actually, you can operate on a text layer in the same ways as any other layer, but doing 
so often means giving up the ability to edit the text without losing the results of your 
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work. 

 

To understand some of the idiosyncrasies of text handling, it may help for you to realize 
that a text layer contains more information than the pixel data that you see: it also 
contains a representation of the text in a text-editor format. You can see this in the text-
editor window that pops up while you are using the Text tool. Every time you alter the 
text, the image layer is redrawn to reflect your changes. 

Now suppose you create a text layer, and then operate on it in some way that does not 
involve the Text tool: rotate it, for example. Suppose you then come back and try to edit it 
using the Text tool. As soon as you edit the text, the Text tool will redraw the layer, wiping 
out the results of the operations you performed in the meantime. 

Because this danger is not obvious, the Text tool tries to protect you from it. If you 
operate on a text layer, and then later try to edit the text, a message pops up, warning 
you that your alterations will be undone, and giving you three options: (1) edit the text 
anyway; (2) cancel; (3) create a new text layer with the same text as the existing layer, 
leaving the existing layer unchanged. 
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Getting Unstuck
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Stuck! 
All right, okay: you're stuck. You're trying to use one of the tools on an image, and nothing 
is happening, and nothing you try makes any difference. Your fists are starting to clench, 
and your face is starting to feel warm. Are you going to have to kill the program, and lose 
all your work? This sucks! 

Well, hold on a second. This happens pretty frequently, even to people who've used the 
GIMP for a long time, but generally the cause is not so hard to figure out (and fix) if you 
know what to look at. Lets be calm, and go through a checklist that will probably get you 
GIMPing happily again. 
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Common causes of GIMP non-
responsiveness 
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Concepts for the Intermediate 
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Plugins

Introduction 
One of the nicest things about GIMP is how easily its functionality can be extended, by 
using plugins. GIMP plugins are external programs that run under the control of the main 
GIMP application and interact with it very closely. Plugins can manipulate images in 
almost any way that users can. Their advantage is that it is much easier to add a 
capability to GIMP by writing a small plugin than by modifying the huge mass of complex 
code that makes up the GIMP core. Many valuable plugins have C source code that only 
comes to 100-200 lines or so. 

Several dozen plugins are included in the main GIMP distribution, and installed 
automatically along with GIMP. Most of them can be accessed through the Filters menu (in 
fact, everything in that menu is a plugin), but a number are located in other menus. In 
many cases you can use one without ever realizing that it is a plugin: for example, the 
"Normalize" function for automatic color correction is actually a plugin, although there is 
nothing about the way it works that would tell you this. 

In addition to the plugins included with GIMP, many more are available on the net. A large 
number can be found at the GIMP Plugin Registry, a web site whose purpose is to provide 
a central repository for plugins. Creators of plugins can upload them there; users in 
search of plugins for a specific purpose can search the site in a variety of ways. 

Anybody in the world can write a GIMP plugin and make it available over the web, either 
via the Registry or a personal web site, and many very valuable plugins can be obtained 
in this way  some are described elsewhere in the User's Manual. With this freedom from 
constraint comes a certain degree of risk, though: the fact that anybody can do it means 
that there is no effective quality control. The plugins distributed with GIMP have all been 
tested and tuned by the developers, but many that you can download were just hacked 
together in a few hours and then tossed to the winds. Some plugin creators just don't 
care about robustness, and even for those who do, their ability to test on a variety of 
systems in a variety of situations is often quite limited. Basically, when you download a 
plugin, you are getting something for free, and sometimes you get exactly what you pay 
for. This is not said in an attempt to discourage you, just to make sure you understand 
reality. 

Plugins, being full-fledged executable programs, can do any of the things that any other 
program can do, including install back-doors on your system or otherwise compromise its 
security. Don't install a plugin unless it comes from a trusted source. 

These caveats apply as much to the Plugin Registry as to any other source of plugins. The 
Registry is available to any plugin creator who wants to use it: there is no systematic 
oversight. Obviously if the maintainers became aware that something evil was there, they 
would remove it. (That hasn't happened yet.) There is, however, for GIMP and its plugins 
the same warranty as for any other free software: namely, none. 

Plugins have been a feature of GIMP for many versions. However, plugins written for one 
version of GIMP can hardly ever be used successfully with other versions. They need to be 
ported: sometimes this is easy, sometimes not. Many plugins are already available in 
several versions. Bottom line: before trying to install a plugin, make sure that it is written 
for your version of GIMP. 

Using Plugins 
For the most part you can use a plugin like any other GIMP tool, without needing to be 
aware that it is a plugin. But there are a few things about plugins that are useful to 
understand. 
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One is that plugins are generally not as robust as the GIMP core. When GIMP crashes, it is 
considered a very serious thing: it can cost the user a lot of trouble and headache. When 
a plugin crashes, the consequences are usually not so serious. In most cases you can just 
continuing working without worrying about it. 

Because plugins are separate programs, they communicate with the GIMP core in a 
special way: The GIMP developers call it "talking over a wire". When a plugin crashes, the 
communication breaks down, and you will see an error message about a "wire read 
error". 

When a plugin crashes, GIMP gives you a very ominous-looking message telling you that 
the plugin may have left GIMP in a corrupted state, and you should consider saving your 
images and exiting. Strictly speaking, this is quite correct, because plugins have the 
power to alter almost anything in GIMP, but for practical purposes, experience has shown 
that corruption is actually quite rare, and many users just continue working and don't 
worry about it. Our advice is that you simply think about how much trouble it would cause 
you if something went wrong, and weigh it against the odds. 

Because of the way plugins communicate with GIMP, they do not have any mechanism for 
being informed about changes you make to an image after the plugin has been started. If 
you start a plugin, and then alter the image using some other tool, the plugin will often 
crash, and when it doesn't will usually give a bogus result. You should avoid running more 
than one plugin at a time on an image, and avoid doing anything to the image until the 
plugin has finished working on it. If you ignore this advice, not only will you probably 
screw up the image, you will probably screw up the undo system as well, so that you 
won't even be able to recover from your foolishness. 

Installing New Plugins 
The plugins that are distributed with GIMP don't require any special installation. Plugins 
that you download yourself do. There are several scenarios, depending on what OS you 
are using and how the plugin is structured. In Linux it is usually pretty easy to install a 
new plugin; in Windows, it is either easy or very hard. In any case, the two are best 
considered separately. 

Linux 
Most plugins fall into two categories: small ones whose source code is distributed as a 
single .c file, and larger ones whose source code is distributed as a directory containing 
multiple files including a Makefile. 

For a simple one-file plugin, call it borker.c, installing it is just a matter of running the 
command gimptool-2.0 --install borker.c. This command compiles the plugin and installs it 
in your personal plugin directory, ~/gimp­2.2/plugins unless you have changed it. This 
will cause it to be loaded automatically the next time you start GIMP. You don't need to be 
root to do these things; in fact, you shouldn't be. If the plugin fails to compile, well, be 
creative. 

Once you have installed the plugin, how do you activate it? The menu path is determined 
by the plugin itself, so to answer this you need to either look at the documentation for the 
plugin (if there is any), or launch the Plugin Description dialog (from Xtns/Plugins Details) 
search the plug-in by its name and look ot the Tree view tab. If you still don't find, finally 
explore the menus or look at the source code in the Register section -- whichever is 
easiest. 

For more complex plugins, organized as a directory with multiple files, there ought to be a 
file inside called either INSTALL or README, with instructions. If not, the best advice is to 
toss the plugin in the trash and spend your time on something else: any code written with 
so little concern for the user is likely to be frustrating in myriad ways. 

Some plugins (specifically those based on the GIMP Plugin Template) are designed to be 

GNU Image Manipulation Program
Generated by docbook2odf

Page 46 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 
installed in the main system GIMP directory, rather than your home directory. For these, 
you will need to be root to perform the final stage of installation (when issuing the make 
install command). 

If you install in your personal plugin directory a plugin that has the same name as one in 
the system plugin directory, only one can be loaded, and it will be the one in your home 
directory. You will receive messages telling you this each time you start GIMP. This is 
probably a situation best avoided. 

Windows
Windows is a much more problematic environment for building software than Linux. Every 
decent Linux distribution comes fully supplied with tools for compiling software, and they 
are all very similar in the way they work, but Windows does not come with such tools. It is 
possible to set up a good software-building environment in Windows, but it requires either 
a substantial amount of money or a substantial amount of effort and knowledge. 

What this means in relation to GIMP plugins is the following: either you have an 
environment in which you can build software, or you don't. If you don't, then your best 
hope is to find a precompiled version of the plugin somewhere (or persuade somebody to 
compile it for you), in which case you simply need to put it into your personal plugin 
directory. If you do have an environment in which you can build software (which for 
present purposes means an environment in which you can build GIMP), then you no doubt 
already know quite a bit about these things, and just need to follow the Linux instructions. 

If you would like to set up a build environment, and are ready for the heroism involved, 
you can find a reasonably recent description of how to go about it in the GIMP Wiki, at 
HowToCompileGimp/MicrosoftWindows . Since it is a Wiki, anybody is free to edit it, so 
please keep it up to date by adding advice based on your own experiences. 

Macintosh 
We could use some material here.

Writing Plugins 
If you want to learn how to write a plugin, you can find plenty of help at the GIMP 
Developers web site, developer.gimp.org. GIMP is a complex program, but the 
development team has made strenuous efforts to flatten the learning curve for plugin 
writing: there are good instructions and examples, and the main library that plugins use 
to interface with GIMP (called "libgimp") has a well-documented API. Good programmers, 
learning by modifying existing plugins, are often able to accomplish interesting things 
after just a couple of days of work. 
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Using Script-Fu Scripts 
Script-Fu is what the Windows world would call "macros" But Script-Fu is more powerful 
than that. Script-Fu is based on an interpreting language called Scheme, and works by 
using querying functions to the Gimp database. You can do all kinds of things with Script-
Fu, but an ordinary Gimp user will probably use it for automating things that: 

• You want to do frequently. 

• Are really complicated to do, and hard to remember. 

Remember that you can do a whole lot with Script-Fu. The scripts that come with Gimp 
can be quite useful, but they can also serve as models for learning Script-Fu, or at least as 
a framework and source of modification when you make your own script. Read the Script-
Fu Tutorial in the next section if you want to learn more about how to make scripts. 

We will describe some of the most useful scripts in this chapter, but we won't cover them 
all. There are simply too many scripts. Some of the scripts are also very simple and you 
will probably not need any documentation to be able to use them. 

Script-Fu (a dialect of Scheme) isn't the only scripting language available for Gimp. But 
Script-Fu is the only scripting language that is installed by default. Other available 
scripting extensions are Perl and Tcl. You can download and install both extensions at the 
Gimp Plugin Registry. 

One of the great things about Script-Fu is that you can share your script with all your 
Gimp friends. There are many scripts that come with Gimp by default, but there are also 
vast quantities of scripts that are available for download all around the Internet. 

If you have downloaded a script, copy or move it to your scripts directory. It can be found 
in the Preferences: Folders Scripts . 

Do a refresh by using Exts Script-Fu Refresh Scripts from the toolbox. The script will now 
appear in one of your menus. If you don't find it, look for it under the root file menu 
filters. If it doesn't appear at all, something was wrong with the script (e.g. it contains 
syntax errors). 

A common error when you are dealing with Script-Fus is that you simply bring them up 
and press the OK button. When nothing happens, you probably think that the script is 
broken or buggy, but there is most likely nothing wrong with it. 

Think again. Did you really read the information in the dialog, or did you just press the 
button? If you forgot an input the script needs, or if you gave it the wrong input, the script 
will fail. One of the most common errors is that the font specified in the script dialog 
hasn't been installed on your system. So please check the information in the dialog 
before blaming the script. 

There are two kinds of Script-Fus -- standalone scripts and image-dependent scripts. You 
will find the standalone variants under Xtns Script-Fu Type of Script in the main toolbox 
menu, and the image-dependent scripts are placed under Script-Fu Type of Script in the 
image menu. 

We will not try to describe every script in depth. Most Script-Fus are very easy to 
understand and use. At the time of this writing, the following types are installed by 
default: 

• Patterns 

• Web page themes 

• Logos 

• Buttons 

• Utils 
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• Make Brush 

• Misc. 

These are scripts that perform operations on an existing image. In many ways they are 
like the plug-ins in the Filters menu. The following script groups are installed by default: 

• Alchemy 

• Alpha to logo 

• Animators 

• Decor 

• Render 

• Selection 

• Shadow 

• Stencil Ops 

• Utils 
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Chapter
Using GIMP as a Beginner 
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Files 
The GIMP is capable of reading and writing a large variety of graphics file formats. With 
the exception of GIMP's native XCF file type, file handling is done by plug-ins. Thus, it is 
relatively easy to extend GIMP to new file types when the need arises. 

Not all file types are equally good for all purposes. This part of the documentation should 
help you understand the advantages and disadvantages of each type. 

Creating new Files 
You can create new files in GIMP by using the following menuitem: File New . This opens 
the Create a new image dialog, where you can modify the initial width and height of the 
file or using the standard values. More information about this dialog can be found in . 

Opening Files 
There are several ways of opening an existing image in GIMP: 

• Open File 

The most obvious is to open it using a menu, by choosing File Open from either the 
Toolbox menu or an image menu. This brings up a File Chooser dialog, allowing you 
to navigate to the file and click on its name. This method works well if you know the 
name of the file you want to open, and where it is located. It is not so convenient if 
you want to find the file on the basis of a thumbnail. 

 

GIMP 2.2 introduced a new File Chooser that provides several features to help you 
navigate quickly to the file you are looking for. Perhaps the most important is the 
ability to create "bookmarks" for folders that you use often. Your list of bookmarks 

GNU Image Manipulation Program
Generated by docbook2odf

Page 51 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 
appears on the left side of the dialog. The ones at the top ( "Home", "Desktop", etc) 
come automatically; the others you create using the "Add" button at the bottom of 
the list. Double-clicking on a bookmark takes you straight to that directory. 

At the center of the dialog appears a listing of the contents of the selected directory. 
Subdirectories are shown at the top of the list, files below them. By default all files in 
the directory are listed, but you can restrict the listing to image files of a specific 
type using the File Type selection menu that appears beneath the directory listing. 

When you click on a file entry in the listing, if it is an image file, a preview will 
appear on the right side of the dialog, along with some basic information about the 
properties of the image. Note that previews are cached when they are generated, 
and there are some things you can do that may cause a preview to be incorrect. If 
you suspect that this may be happening, you can force a new preview to be 
generated by holding down the Ctrl key and clicking in the Preview area. 

One thing that strikes many people when they first see the File Open dialog is that 
there is no way to enter the name of the file using the keyboard. Actually this can be 
done, but the feature is a bit hidden: if you type CtrlL with the dialog focused, an 
"Open Location" dialog pops up, with a space to type the file name. This dialog is 
described in more detail below. 

In the great majority of cases, if you select a file name from the list, and click the 
"Open" button in the lower right corner or the dialog, GIMP will automatically 
determine the file type for you. On rare occasions, mainly if the file type is unusual 
and the name lacks a meaningful extension, this may fail. If this happens, you can 
tell GIMP specifically what type of file it is by expanding the "Select File Typ" option 
at the bottom of the dialog, and choosing an entry from the list that appears. More 
commonly, though, if GIMP fails to open an image file, it is either corrupt or not in a 
supported format. 

• Open Location 

If instead of a file name, you have a URI (i.e., a web address) for the image, you can 
open it using the menu, by choosing File Open Location from either the Toolbox 
menu or an image menu. This brings up a small dialog that allows you to enter (or 
paste) the URI. 

  

• Open Recent 

If the image is one that you previously created using GIMP, perhaps the easiest way 
to open it is from the menu, using File Open Recent . This gives you a scrollable list 
of the images you have most recently worked on in, with icons beside them. You 
need only select the one you want, and it will be opened. 

• File Browser 

If you have associated the file type of the image with GIMP, either when you 
installed GIMP or later, then you can navigate to the file using a file manager (such 
as Nautilus in Linux, or Windows Explorer in Windows), and once you have found it, 
double-click on the icon. If things are set up properly, this will cause the image to 
open in GIMP. 

• Drag and Drop 
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Alternatively, once you have found the file, you can click on its icon and drag it into 
the GIMP Toolbox. (If instead you drag it into an existing GIMP image, it will be added 
to that image as a new layer or set of layers.) 

For many applications, you can click on a displayed image (a full image, not just a 
thumbnail) and drag it into the GIMP toolbox. 

• Copy and Paste 

For some applications, if the application gives you a way of copying the image to the 
clipboard, you can then open the image in GIMP by choosing File Acquire Paste as 
New from the Toolbox menu. Support for this is somewhat variable, however, so your 
best bet is to try it and see whether it works. 

• Image Browser 

In Linux, you might want to take a look at a program called gthumb, an image-
management application that in several ways nicely complements GIMP. In gthumb, 
you can cause an image to open in GIMP either by right-clicking on the icon and 
selecting GIMP from among the list of options, or by dragging the icon into the GIMP 
Toolbox. See the gthumb home page for more information. Other similar applications 
: gqview, xnview 

When you open a file, using the File menu or any other method, GIMP needs to determine 
what type of file it is. Unless there is no alternative, GIMP does not simply rely on the 
extension (such as ".jpg") to determine the file type, because extensions are not reliable: 
they vary from system to system; any file can be renamed to have any extension; and 
there are many reasons why a file name might lack an extension. Instead, GIMP first tries 
to recognize a file by examining its contents: most of the commonly used graphics file 
formats have "magic headers" that permit them to be recognized. Only if the magic yields 
no result does GIMP resort to using the extension. 

Saving Files 
There are several commands for saving images. A list, and information on how to use 
them, can be found in the section covering the File menu. 

GIMP allows you to save the images you create in a wide variety of formats. It is 
important to realize that the only format capable of saving all of the information in an 
image, including layers, transparency, etc., is GIMP's native XCF format. Every other 
format preserves some image properties and loses others. When you save an image, 
GIMP tries to let you know about this, but basically it is up to you to understand the 
capabilities of the format you choose. 

 

As stated above, there is no file format, with the exception of GIMP's native XCF format, 
that is capable of storing all the data in a GIMP image. When you ask to save an image in 
a format that will not completely represent it, GIMP notifies you of this, tells you what kind 
of information will be lost, and asks you whether you would like to "export" the image in a 
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form that the file type can handle. Exporting an image does not modify the image itself, 
so you do not lose anything by doing this. 

When you close an image (possibly by quitting GIMP), you are warned if the image is 
"dirty"; that is, if it has been changed without subsequently being saved. Saving an image 
in any file format will cause the image to be considered "not dirty", even if the file format 
does not represent all of the information from the image. 
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Drawing Simple Objects 
In this section, you will learn how to create simple objects in Gimp. It's pretty easy once 
you figure out how to do it. Gimp provides a huge set of Tools and Shortcuts which most 
new users get lost in. 

Drawing a Straight Line 
Let's begin by painting a straight line. The easiest way to create a straight line is by using 
your favorite painting tool, the mouse and the keyboard. 

 

Create a new image. Select your favorite painting tool or use the pencil, if in doubt. Select 
a foreground color, but be sure that the foreground and background colors are different. 

 

Create a starting point by clicking on the image display area with the left mouse button. 
Your canvas should look similar to . 
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Now, hold down the Shift button on your keyboard and move the mouse away from the 
starting point you created. You'll see a thin line indicating how the line will look. 

 

If you're satisfied with the direction and length of the line, click the left mouse button 
again to finish the line. The Gimp displays a straight line now. If the line doesn't appear, 
check the foreground and background colors and be sure that you kept the Shift key 
pressed while painting. You can keep creating lines by continuing to hold the Shift key and 
creating additional end points. 

Creating a Basic Shape 
Drawing shapes is not the main purpose for using GIMP. However, you may create shapes 
by either painting them using the technique described in or by using the selection tools. 
Of course, there are various other ways to paint a shape, but we'll stick to the easiest 
ones here. So, create a new image and check that the foreground and background colors 
are different. 
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Basic shapes like rectangles, triangles or ellipses, can be created using the selection 
tools. This tutorial uses a rectangular selection as an example. So, choose the rectangular 
selection tool and create a new selection: press and hold the left mouse button while you 
move the mouse to another position in the image (illustrated in figure ). The selection is 
created when you release the mouse button. For more information about key modifiers 
see selection tools. 

 

After creating the selection, you can either create a filled or an outlined shape with the 
foreground color of your choice. If you go for the first option, choose a foreground color 
and fill the selection with the bucket fill tool. If you choose the latter option, create an 
outline by using theStroke selection menu item from the Edit menu. If you're satisfied 
with the result, remove the selection. 
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Creating and Using Selections 

Moving a Selection 

 

After creating a rectangular, elliptic or free selection, or when you are using the Magic 
wand, the default mouse pointer is the moving cross. Click-and-drag then allows you to 
move the selection and its contents, while the initial position remains empty. 

If you only want to move the selection border and not its contents, then press the Alt key 
and click-and-drag the selection. 

Sometimes the Alt key is used by the window manager and you move the image window 
instead of the selection. If this is the case, you have two possibilities: 

1. Select the move tool and change the "Affect" option. 

2. Try to use the AltShift or AltCtrl keys to move the selection. 

Moving a selection without emptying its initial position is more complicated: while 
pressing the Ctrl key, move the mouse pointer a little bit, then also press the Alt key, then 
click-and-drag the selection. This can be done more easily by using the Move tool in 
Selection mode. 

Moving a selection automatically creates a floating layer (floating selection). See Floating 
selection . The mouse pointer then looks like an anchor when it is outside of the selection. 
This means that the selection will be permanently anchored at the place you choose 
when you click the mouse button. 

As soon as this floating selection is created in the Layer dialog (and you can create it with 
Selection/Float), you can use the keyboard arrow keys to move the selection horizontally 
or vertically. 

Creating a Free Selection 
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When using the lasso to select an object, some parts of the object and its proximity may 
be incorrectly either selected or not selected. You can correct these defects by pressing 
the Shift or Ctrl keys while using the lasso. Here is how to do it: While pressing Shift, draw 
the new border with the lasso and close the selection, including a part of the first 
selection. As soon as you release the mouse button, both selections are added together. 
You could subtract the extra part of the first selection in a similar way by pressing Ctrl. 

To correct selection defects precisely, use the Quick Mask. 
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Dialogs and Docking 

Creating Dialogs 
Most dockable dialogs can be created in more than one way, but all of them can be 
created using the File Dialogs menu from the Main Toolbox, or by using the Add command 
in the Tab menu from any dialog. As a convenience, there are also three pre-built docks 
you can create using the File Dialogs Create New Dock menu path from the Main Toolbox: 

Just because you have a lot of flexibility does not mean that all choices are equally good. 
There are at least two things we recommend: 

1. Keep the Tool Options dialog docked directly beneath the Main Toolbox at all times. 

2. Keep the Layers dialog around at all times, in a separate dock from the Main 
Toolbox, with an Image Menu above it. (Use "Show Image Menu" in the dialog Tab menu 
to display the Image menu if you have somehow lost it.) 

Removing Tabs 

 

If you want to remove a dialog from a dock, there are two ways you can do it. First, if you 
click on the drag handle area and drag the dialog away, releasing it someplace other than 
a docking bar, it will form a new dock in its own right. Second, clicking on the "Close Tab" 
button (highlighted in the figure to the right) will close the frontmost dialog. 
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How to Set Your Tile Cache 
A low value for tile cache means that Gimp sends data to the disk very quickly, not 
making real use of the available RAM, and making the disks work for no real reason. Too 
high a value for tile cache, and other applications start to have less system resources, 
forcing them to use swap space, which also makes the disks work too hard; some of them 
may even terminate or start to malfunction due lack of RAM. 

How do you choose a number for the Tile Cache size? Here are some tips to help you 
decide what value to use, as well as a few tricks: 

• The easiest method is to just forget about this and hope the default works. This was 
a usable method when computers had little RAM, and most people just tried to make 
small images with GIMP while running one or two other applications at the same 
time. If you want something easy and only use GIMP to make screenshots and logos, 
this is probably the best solution. 

• If you have a modern computer with plenty of memory–say, 512 MB or more–setting 
the Tile Cache to half of your RAM will probably give good performance for GIMP in 
most situations without depriving other applications. Probably even 3/4 of your RAM 
would be fine. 

• Ask someone to do it for you, which in the case of a computer serving multiple users 
at the same time can be a good idea: that way the administrator and other users do 
not get mad at you for abusing the machine, nor do you get a badly underperfoming 
GIMP. If it is your machine and only serves a single user at a given time, this could 
mean money, or drinks, as price for the service. 

• Start changing the value a bit each time and check that it goes faster and faster 
with each increase, but the system does not complain about lack of memory. Be 
forewarned that sometimes lack of memory shows up suddenly with some 
applications being killed to make space for the others. 

• Do some simple math and calculate a viable value. Maybe you will have to tune it 
later, but maybe you have to tune it anyway with the other previous methods. At 
least you know what is happening and can get the best from your computer. 

Let's suppose you prefer the last option, and want to get a good value to start with. First, 
you need to get some data about your computer. This data is the amount of RAM installed 
in your system, the operating system's swap space available, and a general idea about 
the speed of the disks that store the operating system's swap and the directory used for 
GIMP's swap. You do not need to do disk tests, nor check the RPM of the disks, the thing is 
to see which one seems clearly faster or slower, or whether all are similar. You can 
change GIMP's swap directory in the Folders page of the Preferences dialog. 

The next thing to do is to see how much resources you require for other apps you want to 
run at the same time than GIMP. So start all your tools and do some work with them, 
except GIMP of course, and check the usage. You can use applications like free or top, 
depending in what OS and what environment you use. The numbers you want is the 
memory left, including file cache. Modern Unix keeps a very small area free, in order to be 
able to keep large file and buffer caches. Linux's free command does the maths for you: 
check the column that says "free", and the line "-/+ buffers/cache". Note down also the 
free swap 

Now time for decisions and a bit of simple math. Basically the concept is to decide if you 
want to base all Tile Cache in RAM, or RAM plus operating system swap: 

Do you change applications a lot? Or keep working in GIMP for a long time? If you spend a 
lot of time in GIMP, you can consider free RAM plus free swap as available; if not, you 
need to go to the following steps. (If you're feeling unsure about it, check the following 
steps.) If you are sure you switch apps every few minutes, only count the free RAM and 
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just go to the final decision; no more things to check. 

Does the operating system swap live in the same physical disk as GIMP swap? If so, add 
RAM and swap. Otherwise go to the next step. 

Is the disk that holds the OS swap faster or the same speed as the disk that holds the 
GIMP swap? If slower, take only the free RAM; if faster or similar, add free RAM and swap. 

You now have a number, be it just the free RAM or the free RAM plus the free OS swap. 
Reduce it a bit, to be on the safe side, and that is the Tile Cache you could use as a good 
start. 

As you can see, all is about checking the free resources, and decide if the OS swap is 
worth using or will cause more problems than help. 

There are some reasons you want to adjust this value, though. The basic one is changes 
in your computer usage pattern, or changing hardware. That could mean your 
assumptions about how you use your computer, or the speed of it, are no longer valid. 
That would require a reevaluation of the previous steps, which can drive you to a similar 
value or a completly new value. 

Another reason to change the value is because it seems that GIMP runs too slowly, while 
changing to other applications is fast: this means that GIMP could use more memory 
without impairing the other applications. On the other hand, if you get complaints from 
other applications about not having enough memory, then it may benefit you to not let 
GIMP hog so much of it. 

If you decided to use only RAM and GIMP runs slowly, you could try increasing the value a 
bit, but never to use also all the free swap. If the case is the contrary, using both RAM and 
swap, and you have problems about lack of resources, then you should decrease the 
amount of RAM available to GIMP. 

Another trick is to put the Swap Dir on a very fast disk, or on a different disk than the one 
where most of your files reside. Spreading the operating system swap file over multiple 
disks is also a good way to speed things up, in general. And of course, you might have to 
buy more RAM or stop using lots of programs at the same time: you can not expect to edit 
a poster on a computer with 16MB and be fast. 

You can also check what memory requirements your images have. The larger the images, 
and the number of undos, the more resources you need. This is another way to choose a 
number, but it is only good if you always work with the same kind of images, and thus the 
real requirements do not vary. It is also helpful to know if you will require more RAM 
and/or disk space. 
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Chapter
Using GIMP as an Intermediate 
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Using the Quickmask 
Open an image or begin a new document;

Activate the Quickmask using the left-bottom button in the image window. If a selection is 
present the mask is initialized with the content of the selection; 

Choose any drawing tool. Paint on the Quick Mask using black color to remove selected 
areas and white color to add selected areas. You can use grey colors to get partially 
selected areas. 

You can also use selection tools and fill these selections with the Bucket Fill tool. This does 
not destroy the Qmask selections! 

Toggle off the Quickmask using the left-bottom button in the image window: the selection 
will be displayed with its marching ants. 
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Creating New Layers 
There are several ways to create new layers in an image. Here are the most important 
ones: 

• Selecting Layer New Layer in the image menu. This brings up a dialog that allows 
you to set the basic properties of the new layer; see the New Layer dialog section for 
help with it. 

• Selecting Layer Duplicate Layer in the image menu. This creates a new layer, that is 
a perfect copy of the currently active layer, just above the active layer. 

• When you "cut" or "copy" something, and then paste it using Ctrl-V or Edit Paste , 
the result is a "floating selection", which is a sort of temporary layer. Before you can 
do anything else, you either have to anchor the floating selection to an existing 
layer, or convert it into a normal layer. If you do the latter, the new layer will be 
sized just large enough to contain the pasted material. 
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Paths 

Stroking a Path 

 

Paths do not alter the appearance of the image pixel data unless they are stroked, using 
Edit Stroke Path from the image menu or the Paths dialog right-click menu, or the "Stroke 
Path" button in the Tool Options dialog for the Path tool. 

 

Choosing "Stroke Path" by any of these means brings up a dialog that allows you to 
control the way the stroking is done. You can choose from a wide variety of line styles, or 
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you can stroke with any of the Paint tools, including unusual ones such as the Clone tool, 
Smudge tool, Eraser, etc. 

You can further increase the range of stroking effects by stroking a path multiple times, or 
by using lines or brushes of different widths. The possibilities for getting interesting 
effects in this way are almost unlimited. 

Transforming Paths 
Each of the Transform tools (Rotate, Scale, Perspective, etc) can be set to act specifically 
on paths, using the "Affect:" option in the tool's Tool Options dialog. This gives you a 
powerful set of methods for altering the shapes of paths without affecting other elements 
of the image. 

By default a Transform tool, when it is set to affect paths, only acts on a single path: the 
active path for the image, which is shown highlighted in the Paths dialog. You can make a 
transformation affect more than one path, and possibly other things as well, using the 
"transform lock" buttons in the Paths dialog. Not only paths, but also layers and channels, 
can be transform-locked. If you transform one element that is transform-locked, all others 
will be transformed in the same way. So, for example, if you want to scale a layer and a 
path by the same amount, click the transform-lock buttons so that "chain" symbols 
appear next to the layer in the Layers dialog, and the path in the Paths dialog; then use 
the Scale tool on either the layer or the path, and the other will automatically follow. 

GNU Image Manipulation Program
Generated by docbook2odf

Page 67 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

Working with Digital Camera Photos 

Introduction 
One of the most common uses of the GIMP is to fix digital camera images that for some 
reason are less than perfect. Maybe the image is overexposed or underexposed; maybe 
rotated a bit; maybe out of focus: these are all common problems for which GIMP has 
good tools. The purpose of this chapter is to give you an overview of those tools and the 
situations in which they are useful. You will not find detailed tutorials here: in most cases 
it is easier to learn how to use the tools by experimenting with them than by reading 
about them. (Also, each tool is described more thoroughly in the Help section devoted to 
it.) You will also not find anything in this chapter about the multitude of "special effects" 
that you can apply to an image using GIMP. You should be familiar with basic GIMP 
concepts before reading this chapter, but you certainly don't need to be an expert–if you 
are, you probably know most of this anyway. And don't hesitate to experiment: GIMP's 
powerful "undo" system allows you to recover from almost any mistake with a simple 
CtrlZ. 

Most commonly the things that you want to do to clean up an imperfect photo are of four 
types: improving the composition; improving the colors; improving the sharpness; and 
removing artifacts or other undesirable elements of the image. 

Improving Composition 

Rotating an Image 
It is easy, when taking a picture, to hold the camera not quite perfectly vertical, resulting 
in a picture where things are tilted at an angle. In GIMP, the way to fix this is to use the 
Rotate tool. Activate this by clicking its icon in the Toolbox, or by pressing the "R" key 
capitalized) while inside the image. Make sure the Tool Options are visible, and at the top, 
make sure for "Affect:" that the left button ("Transform Layer") is selected. If you then 
click the mouse inside the image and drag it, you will see a grid appear that rotates as 
you drag. When the grid looks right, click rotate or press the enter key, and the image will 
be rotated. 

Now as a matter of fact, it isn't so easy to get things right by this method: you often find 
that things are better but not quite perfect. One solution is to rotate a bit more, but there 
is a disadvantage to that approach. Each time you rotate an image, because the rotated 
pixels don't line up precisely with the original pixels, the image inevitably gets blurred a 
little bit. For a single rotation, the amount of blurring is quite small, but two rotations 
cause twice as much blurring as one, and there is no reason to blur things more than you 
have to. A better alternative is to undo the rotation and then do another, adjusting the 
angle. 

Fortunately, GIMP provides another way of doing it that is considerably easier to use: in 
the Rotate Tool Options, for the Transform Direction you can select "Backward 
(Corrective)". When you do this, instead of rotating the grid to compensate for the error, 
you can rotate it to line up with the error. If this seems confusing, try it and you will see 
that it is quite straightforward. 

Note: New in GIMP 2.2 is the option to preview the results of transformations, instead of 
just seeing a grid. This makes it easier to get things right on the first try. 

After you have rotated an image, there will be unpleasant triangular "holes" at the 
corners. One way to fix them is to create a background that fills the holes with some 
unobtrusive or neutral color, but usually a better solution is to crop the image. The 
greater the rotation, the more cropping is required, so it is best to get the camera aligned 
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as well as possible when you take the picture in the first place. 

Cropping 
When you take a picture with a digital camera, you have some control over what gets 
included in the image but often not as much as you would like: the result is images that 
could benefit from trimming. Beyond this, it is often possible to enhance the impact of an 
image by trimming it so that the most important elements are placed at key points. A rule 
of thumb, not always to be followed but good to keep in mind, is the "rule of thirds", 
which says that maximum impact is obtained by placing the center of interest one-third of 
the way across the image, both widthwise and heightwise. 

To crop an image, activate the Crop tool in the Toolbox, or by pressing the "C" key 
(capitalized) while inside the image. With the tool active, clicking and dragging in the 
image will sweep out a crop rectangle. It will also pop up a dialog that allows you to 
adjust the dimensions of the crop region if they aren't quite right. When everything is 
perfect, hit the Crop button in the dialog. 

Improving Colors 

Automated Tools 
In spite of sophisticated exposure-control systems, pictures taken with digital cameras 
often come out over- or under-exposed, or with color casts due to imperfections in 
lighting. GIMP gives you a variety of tools to correct colors in an image, ranging to 
automated tools that run with a simple button-click to highly sophisticated tools that give 
you many parameters of control. We will start with the simplest first. 

GIMP gives you five automated color correction tools. Unfortunately they don't usually 
give you quite the results you are looking for, but they only take a moment to try out, and 
if nothing else they often give you an idea of some of the possibilities inherent in the 
image. Except for "Auto Levels", you can find them in the Layer menu, by following the 
menu path Layer Colors Auto in the image menu. 

Here they are, with a few words about each:

Those are the automated color adjustments: if you find that none of them quite does the 
job for you, it is time to try one of the interactive color tools. All of these, except one, can 
be accessed via Tools->Color Tools in the image menu. After you select a color tool, click 
on the image (anywhere) to activate it and bring up its dialog. 

Exposure Problems 
The simplest tool to use is the Brightness/Contrast tool. It is also the least powerful, but in 
many cases it does everything you need. This tool is often useful for images that are 
overexposed or underexposed; it is not useful for correcting color casts. The tool gives 
you two sliders to adjust, for "Brightness" and "Contrast". If you have the option 
"Preview" checked (and almost certainly you should),you will see any adjustments you 
make reflected in the image. When you are happy with the results, press Okay and they 
will take effect. If you can't get results that you are happy with, press Cancel and the 
image will revert to its previous state. 

A more sophisticated, and only slightly more difficult, way of correcting exposure 
problems is to use the Levels tool. The dialog for this tool looks very complicated, but for 
the basic usage we have in mind here, the only part you need to deal with is the "Input 
Levels" area, specifically the three triangular sliders that appear below the histogram. We 
refer you to the Levels Tool Help for instructions; but actually the easiest way to learn how 
to use it is to experiment by moving the three sliders around, and watching how the 
image is affected. (Make sure that "Preview" is checked at the bottom of the dialog.) 
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A very powerful way of correcting exposure problems is to use the Curves tool. This tool 
allows you to click and drag control points on a curve, in order to create a function 
mapping input brightness levels to output brightness levels. The Curves tool can replicate 
any effect you can achieve with Brightness/Contrast or the Levels tool, so it is more 
powerful than either of them. Once again, we refer you to the Curves Tool Help for 
detailed instructions, but the easiest way to learn how to use it is by experimenting. 

The most powerful approach to adjusting brightness and contrast across an image, for 
more expert GIMP users, is to create a new layer above the one you are working on, and 
then in the Layers dialog set the Mode for the upper layer to "Multiply". The new layer 
then serves as a "gain control" layer for the layer below it, with white yielding maximum 
gain and black yielding a gain of zero. Thus, by painting on the new layer, you can 
selectively adjust the gain for each area of the image, giving you very fine control. You 
should try to paint only with smooth gradients, because sudden changes in gain will give 
rise to spurious edges in the result. Paint only using shades of gray, not colors, unless you 
want to produce color shifts in the image. 

Actually, "Multiply" is not the only mode that is useful for gain control. In fact, "Multiply" 
mode can only darken parts of an image, never lighten them, so it is only useful where 
some parts of an image are overexposed. Using "Divide" mode has the opposite effect: it 
can brighten areas of an image but not darken them. Here is a trick that is often useful for 
bringing out the maximum amount of detail across all areas of an image: 

Duplicate the layer (producing a new layer above it). 

Desaturate the new layer.

Apply a Gaussian blur to the result, with a large radius (100 or more). 

Set Mode in the Layers dialog to Divide.

Control the amount of correction by adjusting opacity in the Layers dialog, or by using 
Brightness/Contrast, Levels, or Curves tools on the new layer. 

When you are happy with the result, you can use Merge Down to combine the control 
layer and the original layer into a single layer. 

In addition to "Multiply" and "Divide", you may every so often get useful effects with other 
layer combination modes, such as "Dodge", "Burn", or "Soft Light". It is all too easy, 
though, once you start playing with these things, to look away from the computer for a 
moment and suddenly find that you have just spent an hour twiddling parameters. Be 
warned: the more options you have, the harder it is to make a decision. 

Adjusting Hue and Saturation 
In our experience, if your image has a color cast---too much red, too much blue, etc---the 
easiest way to correct it is to use the Levels tool, adjusting levels individually on the red, 
green, and blue channels. If this doesn't work for you, it might be worth your while to try 
the Color Balance tool or the Curves tool, but these are much more difficult to use 
effectively. (They are very good for creating certain types of special effects, though.) 

Sometimes it is hard to tell whether you have adjusted colors adequately. A good, 
objective technique is to find a point in the image that you know should be either white or 
a shade of gray. Activate the Color Picker tool (the eyedropper symbol in the Toolbox), and 
click on the aforesaid point: this brings up the Color Picker dialog. If the colors are 
correctly adjusted, then the red, green, and blue components of the reported color should 
all be equal; if not, then you should see what sort of adjustment you need to make. This 
technique, when well used, allows even color-blind people to color-correct an image. 

If your image is washed out---which can easily happen when you take pictures in bright 
light---try the Hue/Saturation tool, which gives you three sliders to manipulate, for Hue, 
Lightness, and Saturation. Raising the saturation will probably make the image look 
better. In same cases it is useful to adjust the lightness at the same time. ( "Lightness" 
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here is similar to "Brightness" in the Brightness/Contrast tool, except that they are formed 
from different combinations of the red, green, and blue channels.) The Hue/Saturation 
tool gives you the option of adjusting restricted subranges of colors (using the buttons at 
the top of the dialog), but if you want to get natural-looking colors, in most cases you 
should avoid doing this. 

Even if an image does not seemed washed out, often you can increase its impact by 
pushing up the saturation a bit. Veterans of the film era sometimes call this trick 
"Fujifying", after Fujichrome film, which is notorious for producing highly saturated prints. 

When you take pictures in low light conditions, in some cases you have the opposite 
problem: too much saturation. In this case too the Hue/Saturation tool is a good one to 
use, only by reducing the saturation instead of increasing it. 

Adjusting Sharpness 

Unblurring 
If the focus on the camera is not set perfectly, or the camera is moving when the picture 
is taken, the result is a blurred image. If there is a lot of blurring, you probably won't be 
able to do much about it with any technique, but if there is only a moderate amount, you 
should be able to improve the image. 

The most generally useful technique for sharpening a fuzzy image is called the Unsharp 
Mask. In spite of the rather confusing name, which derives from its origins as a technique 
used by film developers, its result is to make the image sharper, not "unsharp". It is a 
plug-in, and you can access it as Filters->Enhance->Unsharp Mask in the image menu. 
There are two parameters, "Radius" and "Amount". The default values often work pretty 
well, so you should try them first. Increasing either the radius or the amount increases 
the strength of the effect. Don't get carried away, though: if you make the unsharp mask 
too strong, it will amplify noise in the image and also give rise to visible artifacts where 
there are sharp edges. 

Sometimes using Unsharp Mask can cause color distortion where there are strong 
contrasts in an image. When this happens, you can often get better results by 
decomposing the image into separate Hue-Saturation-Value (HSV) layers, and running 
Unsharp Mask on the Value layer only, then recomposing. This works because the human 
eye has much finer resolution for brightness than for color. See the sections on 
Decompose and Compose for more information. 

Next to "Unsharp Mask" in the Filters menu is another filter called Sharpen, which does 
similar things. It is a little easier to use but not nearly as effective: our recommendation is 
that you ignore it and go straight to Unsharp Mask. 

In some situations, you may be able to get useful results by selectively sharpening 
specific parts of an image using the Blur or Sharpen tool from the Toolbox, in "Sharpen" 
mode. This allows you to increase the sharpness in areas by painting over them with any 
paintbrush. You should be restrained about this, though, or the results will not look very 
natural: sharpening increases the apparent sharpness of edges in the image, but also 
amplifies noise. 

Reducing Graininess 
When you take pictures in low-light conditions or with a very fast exposure time, the 
camera does not get enough data to make good estimates of the true color at each pixel, 
and consequently the resulting image looks grainy. You can "smooth out" the graininess 
by blurring the image, but then you will also lose sharpness. There are a couple of 
approaches that may give better results. Probably the best, if the graininess is not too 
bad, is to use the filter called Selective Blur, setting the blurring radius to 1 or 2 pixels. 
The other approach is to use the Despeckle filter. This has a nice preview, so you can play 
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with the settings and try to find some that give good results. When graininess is really 
bad, though, it is often very difficult to fix by anything except heroic measures (i.e., 
retouching with paint tools). 

Softening 
Every so often you have the opposite problem: an image is too crisp. The solution is to 
blur it a bit: fortunately blurring an image is much easier than sharpening it. Since you 
probably don't want to blur it very much, the simplest method is to use the "Blur" plug-in, 
accessed via Filters->Blur->Blur from the image menu. This will soften the focus of the 
image a little bit. If you want more softening, just repeat until you get the result you 
desire. 

Removing Unwanted Objects from an Image 
There are two kinds of objects you might want to remove from an image: first, artifacts 
caused by junk such as dust or hair on the lens; second, things that were really present 
but impair the quality of the image, such as a telephone wire running across the edge of a 
beautiful mountain landscape. 

Despeckling 
A good tool for removing dust and other types of lens grunge is the Despeckle filter, 
accessed as Filters->Enhance->Despeckle from the image menu. Very important: to use 
this filter effectively, you must begin by making a small selection containing the artifact 
and a small area around it. The selection must be small enough so that the artifact pixels 
are statistically distinguishable from the other pixels inside the selection. If you try to run 
despeckle on the whole image, you will hardly ever get anything useful. Once you have 
created a reasonable selection, activate Despeckle, and watch the preview as you adjust 
the parameters. If you are lucky, you will be able to find a setting that removes the junk 
while minimally affecting the area around it. The more the junk stands out from the area 
around it, the better your results are likely to be. If it isn't working for you, it might be 
worthwhile to cancel the filter, create a different selection, and then try again. 

If you have more than one artifact in the image, it is necessary to use Despeckle on each 
individually. 

Garbage Removal 
The most useful method for removing unwanted "clutter" from an image is the Clone tool, 
which allows you to paint over one part of an image using pixel data taken from another 
part (or even from a different image). The trick to using the clone tool effectively is to be 
able to find a different part of the image that can be used to "copy over" the unwanted 
part: if the area surrounding the unwanted object is very different from the rest of the 
image, you won't have much luck. For example, if you have a lovely beach scene, with a 
nasty human walking across the beach who you would like to teleport away, you will 
probably be able to find an empty part of the beach that looks similar to the part he is 
walking across, and use it to clone over him. It is quite astonishing how natural the results 
can look when this technique works well. 

Consult the Clone Tool Help for more detailed instructions. Cloning is as much an art as a 
science, and the more you practice at it, the better you will get. At first it may seem 
impossible to produce anything except ugly blotches, but persistence will pay off. 

In some cases you may be able to get good results by simply cutting out the offending 
object from the image, and then using a plug-in called "Resynthesizer" to fill in the void. 
This plug-in is not included with the main GIMP distribution, but it can be obtained from 
the author's Resynthesizer web site. As with many things, your mileage may vary. 
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Removing Red-eye 
When you take a flash picture of somebody who is looking directly toward the camera, the 
iris of the eye can bounce the light of the flash back toward the camera in such a way as 
to make the eye appear bright red: this effect is called "red eye", and looks very bizarre. 
Many modern cameras have special flash modes that minimize red-eye, but they only 
work if you use them, and even then they don't always work perfectly. Interestingly, the 
same effect occurs with animals, but the eyes may show up as other colors, such as 
green. 

GIMP does not include a special tool for removing red-eye, but it isn't all that hard to do. 
Basically the idea is to zoom the area around the eye so that it is nice and large and easy 
to work with; then make a selection of the red part of the eye and a bit of the area around 
it; feather the selection so that you don't create sharp-looking edges; and finally 
desaturate the red channel inside the selection using one of the color tools---Levels, 
Curves, or Hue/Saturation. It takes a little practice the first few times, but once you have 
the technique mastered, you should be able to quickly and easily create quite a natural 
looking eye color. 

If you would like a more automated approach, you can try downloading a recently created 
redeye plug-in from the GIMP Plug-in Registry. We have not received any feedback so far 
about how well it works. It comes in source code form, so you will need to be able compile 
it in order to use it. (See Installing New Plug-ins for information on how to do this.) 

Saving Your Results 

Files 
What file format should you use to save the results of your work, and should you resize it? 
The answers depend on what you intend to use the image for. 

• If you intend to open the image in GIMP again for further work, you should save it in 
GIMP's native XCF format (i. e., name it something.xcf), because this is the only 
format that guarantees that none of the information in the image is lost. 

• If you intend to print the image on paper, you should avoid shrinking the image, 
except by cropping it. The reason is that printers are capable of achieving much 
higher dot resolutions than video monitors---600 to 1400 dots per inch for typical 
printers, as compared to 72 to 100 dots per inch for monitors. A 3000 x 5000 image 
looks huge on a monitor, but it only comes to about 5 inches by 8 inches on paper at 
600 dpi. There is usually no good reason to expand the image either: you can't 
increase the true resolution that way, and it can always be scaled up at the time it is 
printed. As for the file format, it will usually be fine to use JPEG at a quality level of 
75 to 85. In rare cases, where there are large swaths of nearly uniform color, you 
may need to set the quality level even higher or use a lossless format such as TIFF 
instead. 

• If you intend to display the image on screen or project it with a video projector, bear 
in mind that the highest screen resolution for most commonly available systems is 
1600 x 1200, so there is nothing to gain by keeping the image larger than that. For 
this purpose, the JPEG format is almost always a good choice. 

• If you want to put the image on a web page or send it by email, it is a good idea to 
make every effort to keep the file size as small as possible. First, scale the image 
down to the smallest size that makes it possible to see the relevant details (bear in 
mind that other people may be using different sized monitors and/or different 
monitor resolution settings). Second, save the image as a JPEG file. In the JPEG save 
dialog, check the option to "Preview in image window" , and then adjust the Quality 
slider to the lowest level that gives you acceptable image quality. (You will see in the 
image the effects of each change.) Make sure that the image is zoomed at 1:1 while 
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you do this, so you are not misled by the effects of zooming. 

See the File Formats section for more information. 

Printing Your Photos 
[This needs to be written.]

EXIF Data 
Modern digital cameras, when you take a picture, add information to the data file about 
the camera settings and the circumstances under which the picture was taken. This data 
is included in JPEG or TIFF files in a structured format called EXIF. For JPEG files, GIMP is 
capable of maintaining EXIF data, if it is built appropriately: it depends on a library called 
"libexif" , which may not be available on all systems. If GIMP is built with EXIF support 
enabled, then loading a JPEG file with EXIF data, and resaving the resulting image in JPEG 
format, will cause the EXIF data to be preserved unchanged. This is not, strictly speaking, 
the right way for an image editor to handle EXIF data, but it is better than simply 
removing it, which is what earlier versions of GIMP did. 

If you would like to see the contents of the EXIF data, you can download from the registry 
an Exif Browser plug-in . If you are able to build and install it on your system, you can 
access it as Filters->Generic->Exif Browser from the image menu. (See Installing New 
Plug-ins for help.) 
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Preparing your Images for the Web 
One of the most common purposes GIMP is used for is to prepare images for adding them 
to a web site. This means that images should look as nice as possible while keeping the 
file size as small as possible. This little step-by-step guide will tell you how to achieve a 
smaller file size with minimal degradation of image quality. 

Images with an Optimal Size/Quality Ratio 
An optimal image for the web depends upon the image type and the file format you have 
to use. If you want to put a photograph with a lot of colors online, you have to use JPEG as 
your primary file format. If your image contains fewer colors, that is, if it is not a 
photograph, but is more a drawing you created (such as a button or a screenshot), you 
would be better off using PNG format. We will guide you through the process of doing this. 

First, open the image as usual. I have opened our Wilber as an example image. 

 

The image is now in RGB mode, with an additional Alpha channel (RGBA). There is usually 
no need to have an alpha channel for your web image. You can remove the alpha channel 
by flattening the image. 

If you open a photograph, you probably won't have to remove the alpha channel, because 
a photograph doesn't usually have one, so the file is already opened in RGB mode. 

After you have flattened the image, you are able to save the image in PNG format for 
your web site. 

You can save your image in PNG format with the default settings, but using maximum 
compression. Doing this will have no negative affects on the quality of the picture, as it 
would have with JPEG format. If your image is a photograph with lots of colors, you would 
be better off saving it as jpeg. The main thing is to find the best tradeoff between quality 
and compression. You can find more information about this topic in . 

Reducing the File Size Even More 
If you want to reduce the size of your image a bit more, you could convert your image to 
Indexed mode. That means that all of the colors will be reduced to only 256 values. 
Converting images with smooth color transitions or gradients to indexed mode will often 
give poor results, because it will turn the smooth gradients into a series of bands. This 
method is also not recommended for photographs because it will make the image look 
coarse and grainy. 
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Use the Convert Mode Dialog to convert your RGB image to indexed mode. 

After you have converted the image to indexed mode, you are once again able to save 
your image in PNG format. 

Saving Images with Transparency 
There are two different approaches used by graphic file formats for supporting 
transparent image areas: simple binary transparency and alpha transparency. Simple 
binary transparency is supported in GIF format. Here, one color from the indexed color 
palette is marked as the transparent color. Alpha transparency is supported in PNG 
format. Here, the transparency information is stored in a separate channel, the Alpha 
channel. 

There is usually no need to save images in GIF format any more, because PNG supports 
all the features of GIF and offers additional features (e.g., alpha transparency). 
Nevertheless, this format is still used for animations. 

First of all, we will use the same image as in the previous tutorials, Wilber the GIMP 
mascot. 

 

To save an image with alpha transparency, you must have an alpha channel. To check if 
the image has an alpha channel, go to the channel dialog and verify that an entry for 
"Alpha" exists, besides Red, Green and Blue. If this is not the case, add a new alpha 
channel from the layers menu. 

You can now remove the background layer to get a completely transparent background, 
or create a gradient from color to transparency. You are only limited by your imagination. 
To demonstrate the cabilities of alpha transparency, we'll make a soft glow in the 
background around our Wilber. 

After you're done with your image, you can save it in PNG format. 
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Adding New Brushes 
To add a new brush, after either creating or downloading it, you need to save it in a 
format GIMP can use. The brush file needs to be placed in the GIMP's brush search path, 
so that GIMP is able to index and display it in the Brushes dialog. You can hit the Refresh 
button, which reindexes the brush directory. GIMP uses three file formats for brushes: 

 

To make a brush available, place it in one of the folders in GIMP's brush search path. By 
default, the brush search path includes two folders, the system brushes folder, which you 
should not use or alter, and the brushes folder inside your personal GIMP directory. You 
can add new folders to the brush search path using the Brush Folders page of the 
Preferences dialog. Any GBR, GIH, or VBR file included in a folder in the brush search path 
will show up in the Brushes dialog the next time you start GIMP, or as soon as you press 
the Refresh button in the Brushes dialog. 

When you create a new parametric brush using the Brush Editor, it is automatically saved 
in your personal brushes folder. 

There are a number of web sites with downloadable collections of GIMP brushes. Rather 
than supplying a list of links that will soon be out of date, the best advice is to do a search 
with your favorite search engine for "Gimp brushes". There are also many collections of 
brushes for other programs with painting functionality. Some can be converted easily into 
GIMP brushes, some require special conversion utilities, and some cannot be converted at 
all. Most fancy procedural brush types fall into the last category. If you need to know, look 
around on the web, and if you don't find anything, look for an expert to ask. 
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Chapter
Using GIMP as an Expert 
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Text 

Embellishing Text 

  

There are many things you can do to vary the appearance of text beyond just rendering it 
with different fonts or different colors. By converting a text item to a selection or a path, 
you can fill it, stroke the outlines, transform it, or generallly apply the whole panoply of 
GIMP tools to get interesting effects. As a demonstration of some of the possibilities, try 
out the "logo" scripts in the Toolbox menu, at Xtns Script-Fu Logos . Each of these scripts 
allows you to enter some text, and then creates a new image showing a logo constructed 
out of that text. If you would like to modify one of these scripts, or construct a logo script 
of your own, the Using Script-Fu and Script-Fu Tutorial sections should help you get 
started. Of course, you don't need Script-Fu to create these sorts of effects, only to 
automate them. 

Adding Fonts 
For the most authoritative and up-to-date information on fonts in GIMP, consult the Fonts 
in GIMP 2.0 page at the GIMP web site. This section attempts to give you a helpful 
overview. 

GIMP uses the FreeType 2 font engine to render fonts, and a system called Fontconfig to 
manage them. GIMP will let you use any font in Fontconfig's font path; it will also let you 
use any font it finds in GIMP's font search path, which is set on the Font Folders page of 
the Preferences dialog. By default, the font search path includes a system GIMP-fonts 
folder (which you should not alter, even though it is actually empty), and a fonts folder 
inside your personal GIMP directory. You can add new folders to the font search path if it is 
more convenient for you. 

FreeType 2 is a very powerful and flexible system. By default, it supports the following 
font file formats: 

• TrueType fonts (and collections) 

• Type 1 fonts 

• CID-keyed Type 1 fonts 

• CFF fonts 

• OpenType fonts (both TrueType and CFF variants) 
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• SFNT-based bitmap fonts 

• X11 PCF fonts 

• Windows FNT fonts 

• BDF fonts (including anti-aliased ones) 

• PFR fonts 

• Type42 fonts (limited support) 

You can also add modules to support other types of font files. See FREETYPE 2 for more 
information. 

Linux

On a Linux system, if the Fontconfig utility is set up as usual, all you need to do to add a 
new font is to place the file in the directory ~/.fonts. This will make the font available 
not only to GIMP, but to any other program that uses Fontconfig. If for some reason you 
want the font to be available to GIMP only, you can place it in the fonts subdirectory of 
your personal GIMP directory, or some other location in your font search path. Doing 
either will cause the font to show up the next time you start GIMP. If you want to use it in 
an already running GIMP, press the Refresh button in the Fonts dialog. 

Windows

The easiest way to install a font is to drag the file onto the Fonts directory and let the 
shell do its magic. Unless you've done something creative, it's probably in its default 
location of C:\windows\fonts or C:\winnt\fonts. Sometimes double-clicking on a font 
will install it as well as display it; sometimes it only displays it. This method will make the 
font available not only to GIMP, but also to other Windows applications. 

To install a Type 1 file, you need both the .pfb and .pfm files. Drag the one that gets an 
icon into the fonts folder. The other one doesn't strictly need to be in the same directory 
when you drag the file, since it uses some kind of search algorithm to find it if it's not, but 
in any case putting it in the same directory does no harm. 

In principle, GIMP can use any type of font on Windows that FreeType can handle; 
however, for fonts that Windows can't handle natively, you should install them by placing 
the font files in the fonts folder of your personal GIMP directory, or some other location 
in your font search path. The support Windows has varies by version. All that GIMP runs 
on support at least TrueType, Windows FON, and Windows FNT. Windows 2000 and later 
support Type 1 and OpenType. Windows ME supports OpenType and possibly Type 1 (but 
the most widely used Windows GIMP installer does not officially support Windows ME, 
although it may work anyway). 

GIMP uses Fontconfig to manage fonts on Windows as well as Linux. The instructions 
above work because Fontconfig by default uses the Windows fonts directory, i. e., the 
same fonts that Windows uses itself. If for some reason your Fontconfig is set up 
differently, you will have to figure out where to put fonts so that GIMP can find them: in 
any case, the fonts folder of your personal GIMP directory should work. 

Font Problems 
Problems with fonts have probably been responsible for more GIMP 2 bug reports than 
any other single cause, although they have become much less frequent in the most 
recent releases in the 2.0 series. In most cases they have been caused by malformed font 
files giving trouble to Fontconfig. If you experience crashes at startup when GIMP scans 
your font directories, the best solution is to upgrade to a version of Fontconfig newer than 
2.2.0. As a quick workaround you can start gimp with the ­­no­fonts command-line 
option, but then you will not be able to use the text tool. 

Another known problem is that Pango 1.2 cannot load fonts that don't provide an Unicode 
character mapping. (Pango is the text layout library used by GIMP.) A lot of symbol fonts 
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fall into this category. On some systems, using such a font can cause GIMP to crash. 
Updating to Pango 1.4 will fix this problem and makes symbol fonts available in GIMP. 

A frequent source of confusion occurs on Windows systems, when GIMP encounters a 
malformed font file and generates an error message: this causes a console window to pop 
up so that you can see the message. Do not close that console window. It is harmless, 
and closing it will shut down GIMP. When this happens, it often seems to users that GIMP 
has crashed. It hasn't: closing the console window causes Windows to shut GIMP down. 
Unfortunately, this annoying situation is caused by an interaction between Windows and 
the libraries that GIMP links to: it cannot be fixed within GIMP. All you need to do, though, 
if this happens, is minimize the console window and ignore it. 
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Rendering a Grid 
How can you create a grid that is actually part of the image? You can't do this using the 
image grid: that is only an aid, and is only visible on the monitor or in a screenshot. You 
can, however, use the Grid plugin to render a grid very similar to the image grid. 
(Actually, the plugin has substantially more options.) 

See also Grid and Guides. 
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A Script-Fu Tutorial 
In this training course, we'll introduce you to the fundamentals of Scheme necessary to 
use Script-Fu, and then build a handy script that you can add to your toolbox of scripts. 
The script prompts the user for some text, then creates a new image sized perfectly to 
the text. We will then enhance the script to allow for a buffer of space around the text. We 
will conclude with a few suggestions for ways to ramp up your knowledge of Script-Fu. 

This section as adapted from a tutorial written for the Gimp 1 User Manual by Mike Terry. 

Getting Acquainted With Scheme 

Let's Start Scheme'ing
The first thing to learn is that: 

Every statement in Scheme is surrounded by parentheses (). 

The second thing you need to know is that: 

The function name/operator is always the first item in the parentheses, and the 
rest of the items are parameters to the function. 

However, not everything enclosed in parentheses is a function -- they can also be items in 
a list -- but we'll get to that later. This notation is referred to as prefix notation, because 
the function prefixes everything else. If you're familiar with postfix notation, or own a 
calculator that uses Reverse Polish Notation (such as most HP calculators), you should 
have no problem adapting to formulating expressions in Scheme. 

The third thing to understand is that: 

Mathematical operators are also considered functions, and thus are listed first 
when writing mathematical expressions. 

This follows logically from the prefix notation that we just mentioned. 

Examples Of Prefix, Infix, And Postfix Notations
Here are some quick examples illustrating the differences between prefix, infix, and 
postfix notations. We'll add a 1 and 3 together: 

• Prefix notation: + 1 3 (the way Scheme will want it) 

• Infix notation: 1 + 3 (the way we "normally" write it) 

• Postfix notation: 1 3 + (the way many HP calculators will want it) 

Practicing In Scheme
Now, let's practice what we have just learned. Start up Gimp, if you have not already 
done so, and choose Xtns Script-Fu Console . This will start up the Script-Fu Console 
window, which allows us to work interactively in Scheme. In a matter of moments, the 
Script-Fu Console will appear: 

The Script-Fu Console Window
At the bottom of this window is an entry-field entitled Current Command. Here, we can 
test out simple Scheme commands interactively. Let's start out easy, and add some 
numbers: 
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(+ 3 5)�������� � �

������

Typing this in and hitting Enter yields the expected answer of 8 in the center window. 

Now, what if we wanted to add more than one number? The "+" function can take two or 
more arguments, so this is not a problem: 

(+ 3 5 6)�������� � � �
������

This also yields the expected answer of 14. 

So far, so good -- we type in a Scheme statement and it's executed immediately in the 
Script-Fu Console window. Now for a word of caution.... 

Watch Out For Extra Parens
If you're like me, you're used to being able to use extra parentheses whenever you want 
to -- like when you're typing a complex mathematical equation and you want to separate 
the parts by parentheses to make it clearer when you read it. In Scheme, you have to be 
careful and not insert these extra parentheses incorrectly. For example, say we wanted to 
add 3 to the result of adding 5 and 6 together: 

3 + (5 + 6) + 7= ?�������� � � � � � � �
������

Knowing that the + operator can take a list of numbers to add, you might be tempted to 
convert the above to the following: 

(+ 3 (5 6) 7)�������� � � � �
������

However, this is incorrect -- remember, every statement in Scheme starts and ends with 
parens, so the Scheme interpreter will think that you're trying to call a function named 
"5" in the second group of parens, rather than summing those numbers before adding 
them to 3. 

The correct way to write the above statement would be: 

(+ 3 (+ 5 6) 7)�������� � � � � �
������

Make Sure You Have The Proper Spacing, Too
If you are familiar with other programming languages, like C/C++, Perl or Java, you know 
that you don't need white space around mathematical operators to properly form an 
expression: 

3+5, 3 +5, 3+ 5�������� � � � �
������

These are all accepted by C/C++, Perl and Java compilers. However, the same is not true 
for Scheme. You must have a space after a mathematical operator (or any other function 
name or operator) in Scheme for it to be correctly interpreted by the Scheme interpreter. 

Practice a bit with simple mathematical equations in the Script-Fu Console until you're 
totally comfortable with these initial concepts. 
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Variables And Functions 
Now that we know that every Scheme statement is enclosed in parentheses, and that the 
function name/operator is listed first, we need to know how to create and use variables, 
and how to create and use functions. We'll start with the variables. 

Declaring Variables
Although there are a couple of different methods for declaring variables, the preferred 
method is to use the let* construct. If you're familiar with other programming languages, 
this construct is equivalent to defining a list of local variables and a scope in which 
they're active. As an example, to declare two variables, a and b, initialized to 1 and 2, 
respectively, you'd write: 

(let* (��������� ��
(a 1)������������������� �
(b 2)������������������� �

)����������������
(+ a b)���������������� � �

)���������
������

or, as one line: 

(let* ( (a 1) (b 2) ) (+ a b) )�������� � � � � � � � � � �
������

You'll have to put all of this on one line if you're using the console window. In general, 
however, you'll want to adopt a similar practice of indentation to help make your scripts 
more readable. We'll talk a bit more about this in the section on White Space. 

This declares two local variables, a and b, initializes them, then prints the sum of the two 
variables. 

What Is A Local Variable?
You'll notice that we wrote the summation (+ a b) within the parens of the let* expression, 
not after it. 

This is because the let* statement defines an area in your script in which the declared 
variables are usable; if you type the (+ a b) statement after the (let* ...) statement, you'll 
get an error, because the declared variables are only valid within the context of the let* 
statement; they are what programmers call local variables. 

The General Syntax Of let*
The general form of a let* statement is: 

(let* ( variables ) expressions )�������� � � � � �
������

where variables are declared within parens, e.g., (a 2), and expressions are any valid 
Scheme expressions. Remember that the variables declared here are only valid within the 
let* statement -- they're local variables. 

White Space
Previously, we mentioned the fact that you'll probably want to use indentation to help 
clarify and organize your scripts. This is a good policy to adopt, and is not a problem in 
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Scheme -- white space is ignored by the Scheme interpreter, and can thus be liberally 
applied to help clarify and organize the code within a script. However, if you're working in 
Script-Fu's Console window, you'll have to enter an entire expression on one line; that is, 
everything between the opening and closing parens of an expression must come on one 
line in the Script-Fu Console window. 

Assigning A New Value To A Variable
Once you've initialized a variable, you might need to change its value later on in the 
script. Use the set! statement to change the variable's value: 

(let* ( (theNum 10) ) (set! theNum (+ theNum \�������� � � � � � � � � �
theNum)) )�������� �

������

Try to guess what the above statement will do, then go ahead and enter it in the Script-Fu 
Console window. 

The "\" indicates that there is no line break. Ignore it (don't type it in your Script-Fu 
console and don't hit Enter), just continue with the next line. 

Functions
Now that you've got the hang of variables, let's get to work with some functions. You 
declare a function with the following syntax: 

(define (name param­list) expressions)�������� � � �
������

where name is the name assigned to this function, param-list is a space-delimited list of 
parameter names, and expressions is a series of expressions that the function executes 
when it's called. For example: 

(define (AddXY inX inY) (+ inX inY) )�������� � � � � � � �
������

AddXY is the function's name and inX and inY are the variables. This function takes its 
two parameters and adds them together. 

If you've programmed in other imperative languages (like C/C++, Java, Pascal, etc.), you 
might notice that a couple of things are absent in this function definition when compared 
to other programming languages. 

• First, notice that the parameters don't have any "types" (that is, we didn't declare 
them as strings, or integers, etc.). Scheme is a type-less language. This is handy and 
allows for quicker script writing. 

• Second, notice that we don't need to worry about how to "return" the result of our 
function -- the last statement is the value "returned" when calling this function. Type 
the function into the console, then try something like: 

(AddXY (AddXY 5 6) 4)������������ � � � �
����������

Lists, Lists And More Lists 
We've trained you in variables and functions, and now enter the murky swamps of 
Scheme's lists. 
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Defining A List
Before we talk more about lists, it is necessary that you know the difference between 
atomic values and lists. 

You've already seen atomic values when we initialized variables in the previous lesson. An 
atomic value is a single value. So, for example, we can assign the variable "x" the single 
value of 8 in the following statement: 

(let* ( (x 8) ) x)�������� � � � � �
������

(We added the expression x at the end to print out the value assigned to x-- normally you 
won't need to do this. Notice how let* operates just like a function: The value of the last 
statement is the value returned.) 

A variable may also refer to a list of values, rather than a single value. To assign the 
variable x the list of values 1, 3, 5, we'd type: 

(let* ( (x '(1 3 5))) x)�������� � � � � � �
������

Try typing both statements into the Script-Fu Console and notice how it replies. When you 
type the first statement in, it simply replies with the result: 

8��������
������

However, when you type in the other statement, it replies with the following result: 

(1 3 5)�������� � �
������

When it replies with the value 8 it is informing you that x contains the atomic value 8. 
However, when it replies with (1 3 5), it is then informing you that x contains not a single 
value, but a list of values. Notice that there are no commas in our declaration or 
assignment of the list, nor in the printed result. 

The syntax to define a list is: 

'(a b c)��������� � �
������

where a, b, and c are literals. We use the apostrophe (') to indicate that what follows in 
the parentheses is a list of literal values, rather than a function or expression. 

An empty list can be defined as such: 

'()��������
������

or simply: 

()��������
������

Lists can contain atomic values, as well as other lists: 

(let*��������
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(�����������

(x����������������
'("The Gimp" (1 2 3) ("is" ("great" () ) ) )������������������� � � � � � � � � � �

)����������������
)������������

x������������
)���������

������

Notice that after the first apostrophe, you no longer need to use an apostrophe when 
defining the inner lists. Go ahead and copy the statement into the Script-Fu Console and 
see what it returns. 

You should notice that the result returned is not a list of single, atomic values; rather, it is 
a list of a literal ("The Gimp"), the list (1 2 3), etc. 

How To Think Of Lists
It's useful to think of lists as composed of a "head" and a "tail." The head is the first 
element of the list, the tail the rest of the list. You'll see why this is important when we 
discuss how to add to lists and how to access elements in the list. 

Creating Lists Through Concatenation (The Cons Function)
One of the more common functions you'll encounter is the cons function. It takes a value 
and prepends it to its second argument, a list. From the previous section, I suggested that 
you think of a list as being composed of an element (the head) and the remainder of the 
list (the tail). This is exactly how cons functions -- it adds an element to the head of a list. 
Thus, you could create a list as follows: 

(cons 1 '(2 3 4) )�������� � � � � �
������

The result is the list (1 2 3 4). 

You could also create a list with one element: 

(cons 1 () )�������� � � �
������

You can use previously declared variables in place of any literals, as you would expect. 

Defining A List Using The list Function
To define a list composed of literals or previously declared variables, use the list function: 

(list 5 4 3 a b c)�������� � � � � � �
������

This will compose and return a list containing the values held by the variables a, b and c. 
For example: 

(let* (�������� ��
(a 1)������������������ �
(b 2)������������������ �
(c 3)������������������ �

)���������������
(list 5 4 3 a b c)��������������� � � � � � �

)��������
������
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This code creates the list (5 4 3 1 2 3). 

Accessing Values In A List
To access the values in a list, use the functions car and cdr, which return the first element 
of the list and the rest of the list, respectively. These functions break the list down into the 
head::tail construct I mentioned earlier. 

The car Function
car returns the first element of the list (the head of the list). The list needs to be non-null. 
Thus, the following returns the first element of the list: 

(car '("first" 2 "third"))�������� � � �
������

which is: 

"first"��������
������

The cdr function
cdr returns the rest of the list after the first element (the tail of the list). If there is only 
one element in the list, it returns an empty list. 

(cdr '("first" 2 "third"))�������� � � �
������

returns: 

(2 "third")�������� �
������

whereas the following: 

(cdr '("one and only"))�������� � � �
������

returns: 

()��������
������

Accessing Other Elements In A List
OK, great, we can get the first element in a list, as well as the rest of the list, but how do 
we access the second, third or other elements of a list? There exist several "convenience" 
functions to access, for example, the head of the head of the tail of a list (caadr), the tail 
of the tail of a list (cddr), etc. 

The basic naming convention is easy: The a's and d's represent the heads and tails of 
lists, so 

(car (cdr (car x) ) )�������� � � � � �
������
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could be written as: 

(cadar x)�������� �
������

To view a full list of the list functions, refer to the Appendix, which lists the available 
functions for the version of Scheme used by Script-Fu. 

To get some practice with list-accessing functions, try typing in the following (except all 
on one line if you're using the console); use different variations of car and cdr to access 
the different elements of the list: 

(let* (�������� �
(x '( (1 2 (3 4 5) 6) 7 8 (9 10) )����������������� �� � � � � � � �� �� �� � �
)�����������������

)��������������
; place your car/cdr code here�������������� � � � � �

)��������
������

Try accessing the number 3 in the list using only two function calls. If you can do that, 
you're on your way to becoming a Script-Fu Master! 

In Scheme, a semicolon (";") marks a comment. It, and anything that follows it on the 
same line, are ignored by the script interpreter, so you can use this to add comments to 
jog your memory when you look at the script later. 

Your First Script-Fu Script 
Do you not need to stop and catch your breath? No? Well then, let's proceed with your 
fourth lesson -- your first Script-Fu Script. 

Creating A Text Box Script
One of the most common operations I perform in Gimp is creating a box with some text in 
it for a web page, a logo or whatever. However, you never quite know how big to make 
the initial image when you start out. You don't know how much space the text will fill with 
the font and font size you want. 

The Script-Fu Master (and student) will quickly realize that this problem can easily be 
solved and automated with Script-Fu. 

We will, therefore, create a script, called Text Box, which creates an image correctly sized 
to fit snugly around a line of text the user inputs. We'll also let the user choose the font, 
font size and text color. 

Editing And Storing Your Scripts
Up until now, we've been working in the Script-Fu Console. Now, however, we're going to 
switch to editing script text files. 

Where you place your scripts is a matter of preference -- if you have access to Gimp's 
default script directory, you can place your scripts there. However, I prefer keeping my 
personal scripts in my own script directory, to keep them separate from the factory-
installed scripts. 

In the .gimp­2.2 directory that Gimp made off of your home directory, you should find a 
directory called scripts. Gimp will automatically look in your .gimp­2.2 directory for a 
scripts directory, and add the scripts in this directory to the Script-Fu database. You 
should place your personal scripts here. 
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The Bare Essentials
Every Script-Fu script defines at least one function, which is the script's main function. 
This is where you do the work. 

Every script must also register with the procedural database, so you can access it within 
Gimp. 

We'll define the main function first: 

(define (script­fu­text­box inText inFont inFontSize inTextColor))�������� � � � � �
������

Here, we've defined a new function called script-fu-text-box that takes four parameters, 
which will later correspond to some text, a font, the font size, and the text's color. The 
function is currently empty and thus does nothing. So far, so good -- nothing new, nothing 
fancy. 

Naming Conventions
Scheme's naming conventions seem to prefer lowercase letters with hyphens, which I've 
followed in the naming of the function. However, I've departed from the convention with 
the parameters. I like more descriptive names for my parameters and variables, and thus 
add the "in" prefix to the parameters so I can quickly see that they're values passed into 
the script, rather than created within it. I use the prefix "the" for variables defined within 
the script. 

It's Gimp convention to name your script functions script-fu-abc, because then when 
they're listed in the procedural database, they'll all show up under script-fu when you're 
listing the functions. This also helps distinguish them from plug-ins. 

Registering The Function
Now, let's register the function with Gimp. This is done by calling the function script-fu-
register. When Gimp reads in a script, it will execute this function, which registers the 
script with the procedural database. You can place this function call wherever you wish in 
your script, but I usually place it at the end, after all my other code. 

Here's the listing for registering this function (I will explain all its parameters in a minute): 

������
(script­fu­register��������
"script­fu­text­box" ;func name���������� ������������������������ �
"Text Box" ;menu label���������� � ���������������������������������� �
"Creates a simple text box, sized to fit\���������� � � � � � � �
around the user's choice of text,\������������ � � � � �
font, font size, and color." ;description������������ � � � � ��������������

"Michael Terry" ;author���������� � �����������������������������
"copyright 1997, Michael Terry" ;copyright notice���������� � � � ������������� �
"October 27, 1997" ;date created���������� � � �������������������������� �
"" ;image type that the script works on���������� ��������������������� � � � � � �
SF­STRING "Text:" "Text Box" ;a string variable���������� ������ ��������� � ��� � �
SF­FONT "Font:" "Charter" ;a font variable���������� �������� ��������� ���� � �
SF­ADJUSTMENT "Font size" '(50 1 1000 1 10 0 1)���������� �� � ����� � � � � � �

;a spin­button������������������������������������������������������ �
SF­COLOR "Color:" '(0 0 0) ;color variable���������� ������� �������� � � ����� �

)��������
(script­fu­menu­register "script­fu­text­box" "<Toolbox>/Xtns/Script­�������� � �

Fu/Text")
������
������

If you save these functions in a text file with a .scm suffix in your script directory, then 
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choose Xtns Script-Fu Refresh Scripts , this new script will appear as Xtns Script-Fu Text 
Text Box . 

If you invoke this new script, it won't do anything, of course, but you can view the 
prompts you created when registering the script (more information about what we did is 
covered next). 

Finally, if you invoke the Procedure Browser -- Xtns Procedure Browser ), you'll notice that 
our script now appears in the database. 

Steps For Registering The Script
To register our script with Gimp, we call the function script-fu-register, fill in the seven 
required parameters and add our script's own parameters, along with a description and 
default value for each parameter. 

The Required Parameters

• The name of the function we defined. This is the function called when our script is 
invoked (the entry-point into our script). This is necessary because we may define 
additional functions within the same file, and Gimp needs to know which of these 
functions to call. In our example, we only defined one function, text-box, which we 
registered. 

• The location in the menu where the script will be inserted. The exact location of the 
script is specified like a path in Unix, with the root of the path being either toolbox or 
right-click. 

If your script does not operate on an existing image (and thus creates a new image, 
like our Text Box script will), you'll want to insert it in the toolbox menu -- this is the 
menu in Gimp's main window (where all the tools are located: the selection tools, 
magnifying glass, etc.). 

If your script is intended to work on an image being edited, you'll want to insert it in 
the menu that appears when you right-click on an open image. The rest of the path 
points to the menu lists, menus and sub-menus. Thus, we registered our Text Box 
script in the Text menu of the Script-Fu menu of the Xtns menu of the toolbox ( Xtns 
Script-Fu Text Text Box ). 

If you notice, the Text sub-menu in the Script-Fu menu wasn't there when we began 
-- Gimp automatically creates any menus not already existing. 

• A description of your script, to be displayed in the Procedure Browser. 

• Your name (the author of the script). 

• Copyright information. 

• The date the script was made, or the last revision of the script. 

• The types of images the script works on. This may be any of the following: RGB, 
RGBA, GRAY, GRAYA, INDEXED, INDEXEDA. Or it may be none at all -- in our case, 
we're creating an image, and thus don't need to define the type of image on which 
we work. 

Registering The Script's Parameters
Once we have listed the required parameters, we then need to list the parameters that 
correspond to the parameters our script needs. When we list these params, we give hints 
as to what their types are. This is for the dialog which pops up when the user selects our 
script. We also provide a default value. 

This section of the registration process has the following format: 
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Param Type Description Example

SF-VALUE Accepts numbers and 
strings. Note that quotes 
must be escaped for default 
text, so better use SF-
STRING. 

42

SF-STRING Accepts strings. "Some text"

SF-COLOR Indicates that a color is 
requested in this parameter. 

'(0 102 255)

SF-TOGGLE A checkbox is displayed, to 
get a Boolean value. 

TRUE or FALSE

SF-IMAGE If your script operates on an 
open image, this should be 
the first parameter after the 
required parameters. Gimp 
will pass in a reference to 
the image in this parameter. 

3

SF-DRAWABLE If your script operates on an 
open image, this should be 
the second parameter after 
the SF-IMAGE param. It 
refers to the active layer. 
Gimp will pass in a reference 
to the active layer in this 
parameter. 

17

Giving Our Script Some Guts 
Let us continue with our training and add some functionality to our script. 

Creating A New Image
In the previous lesson, we created an empty function and registered it with Gimp. In this 
lesson, we want to provide functionality to our script -- we want to create a new image, 
add the user's text to it and resize the image to fit the text exactly. 

Once you know how to set variables, define functions and access list members, the rest is 
all downhill -- all you need to do is familiarize yourself with the functions available in 
Gimp's procedural database and call those functions directly. So fire up the DB Browser 
and let's get cookin'! 

Let's begin by making a new image. We'll create a new variable, theImage, set to the 
result of calling Gimp's built-in function gimp-image-new. 

As you can see from the DB Browser, the function gimp-image-new takes three 
parameters -- the image's width, height and the type of image. Because we'll later resize 
the image to fit the text, we'll make a 10x10 RGB image. We'll store the image's width 
and sizes in some variables, too, as we'll refer to and manipulate them later in the script. 

(define (script­fu­text­box inText inFont inFontSize inTextColor)�������� � � � � �
(let*��������

(��������������
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; define our local variables����������������� � � � �
; create a new image:����������������� � � � �
(theImageWidth 10)����������������� ��
(theImageHeight 10)����������������� �
(theImage (car����������������� � �

(gimp­image­new��������������������������������
theImageWidth���������������������������������
theImageHeight���������������������������������
RGB���������������������������������
)��������������������������������

)���������������������������
)�����������������
(theText) ;a declaration for the text����������������� ����� � � � �

;we create later������������������������������� � �
������

Note: We used the value RGB to specify that the image is an RGB image. We could have 
also used 0, but RGB is more descriptive when we glance at the code. 

You should also notice that we took the head of the result of the function call. This may 
seem strange, because the database explicitly tells us that it returns only one value -- the 
ID of the newly created image. However, all Gimp functions return a list, even if there is 
only one element in the list, so we need to get the head of the list. 

Adding A New Layer To The Image
Now that we have an image, we need to add a layer to it. We'll call the gimp-layer-new 
function to create the layer, passing in the ID of the image we just created. (From now on, 
instead of listing the complete function, we'll only list the lines we're adding to it. You can 
see the complete script here.) Because we've declared all of the local variables we'll use, 
we'll also close the parentheses marking the end of our variable declarations: 

;create a new layer for the image:�������� � � � � � �
(theLayer�����������

(car���������������������
(gimp­layer­new��������������������������
theImage���������������������������
theImageWidth���������������������������
theImageHeight���������������������������
RGB­IMAGE���������������������������
"layer 1"��������������������������� �
100���������������������������
NORMAL���������������������������
)��������������������������

)����������������������
)������������

) ;end of our local variables��������� � � � � �
������

Once we have the new layer, we need to add it to the image: 

(gimp­image­add­layer theImage theLayer 0)������� � � �
������

Now, just for fun, let's see the fruits of our labors up until this point, and add this line to 
show the new, empty image: 

(gimp­display­new theImage)�������� �
������

Save your work, select Xtns Script-Fu Refresh Scripts , run the script and a new image 
should pop up. It will probably contain garbage (random colors), because we haven't 
erased it. We'll get to that in a second. 
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Adding The Text
Go ahead and remove the line to display the image (or comment it out with a ; as the first 
character of the line). 

Before we add text to the image, we need to set the background and foreground colors so 
that the text appears in the color the user specified. We'll use the gimp-context-set-
back/foreground functions: 

(gimp­context­set­background '(255 255 255) )�������� � � � �
(gimp­context­set­foreground inTextColor)�������� �

������

With the colors properly set, let's now clean out the garbage currently in the image by 
filling the drawable with the background color: 

(gimp­drawable­fill theLayer BACKGROUND­FILL)�������� � � �
������

With the image cleared, we're ready to add some text: 

(set! theText�������� �
(car����������������������

(gimp­text­fontname���������������������������
theImage theLayer���������������������������� �
0 0���������������������������� �
inText����������������������������
0����������������������������
TRUE����������������������������
inFontSize PIXELS���������������������������� �
"Sans")����������������������������

)�����������������������
)�������� ��

������

Although a long function call, it's fairly straightforward if you go over the parameters 
while looking at the function's entry in the DB Browser. Basically, we're creating a new 
text layer and assigning it to the variable theText. 

Now that we have the text, we can grab its width and height and resize the image and 
the image's layer to the text's size: 

(set! theImageWidth (car (gimp­drawable­width theText) ) )�������� � ��� � �� � �
(set! theImageHeight (car (gimp­drawable­height theText) ) )�������� � �� � � � �

(gimp­image­resize theImage theImageWidth theImageHeight 0 0)�������� � � � � �

(gimp­layer­resize theLayer theImageWidth theImageHeight 0 0)�������� � � � � �
������

If you're like me, you're probably wondering what a drawable is when compared to a 
layer. The difference between the two is that a drawable is anything that can be drawn 
into, including layers but also channels, layer masks, the selection, etc; a layer is a more 
specific version of a drawable. In most cases, the distinction is not important. 

With the image ready to go, we can now re-add our display line: 

(gimp­display­new theImage)�������� �
������

Save your work, refresh the database and give your first script a run! 
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Clearing The Dirty Flag
If you try to close the image created without first saving the file, Gimp will ask you if you 
want to save your work before you close the image. It asks this because the image is 
marked as dirty, or unsaved. In the case of our script, this is a nuisance for the times 
when we simply give it a test run and don't add or change anything in the resulting image 
-- that is, our work is easily reproducible in such a simple script, so it makes sense to get 
rid of this dirty flag. 

To do this, we can clear the dirty flag after displaying the image: 

(gimp­image­clean­all theImage)�������� �
������

This will set dirty count to 0, making it appear to be a "clean" image. 

Whether to add this line or not is a matter of personal taste. I use it in scripts that 
produce new images, where the results are trivial, as in this case. If your script is very 
complicated, or if it works on an existing image, you will probably not want to use this 
function. 

Extending The Text Box Script 

Handling Undo Correctly
When creating a script, you want to give your users the ability to undo their actions, 
should they make a mistake. This is easily accomplished by calling the functions gimp-
undo-push-group-start and gimp-undo-push-group-end around the code that manipulates 
the image. You can think of them as matched statements that let Gimp know when to 
start and stop recording manipulations on the image, so that those manipulations can 
later be undone. 

If you are creating a new image entirely, it doesn't make sense to use these functions 
because you're not changing an existing image. However, when you are changing an 
existing image, you most surely want to use these functions. 

Undoing a script works nearly flawlessly when using these functions. 

Extending The Script A Little More
Now that we have a very handy-dandy script to create text boxes, let's add two features 
to it: 

• Currently, the image is resized to fit exactly around the text -- there's no room for 
anything, like drop shadows or special effects (even though many scripts will 
automatically resize the image as necessary). Let's add a buffer around the text, and 
even let the user specify how much buffer to add as a percentage of the size of the 
resultant text. 

• This script could easily be used in other scripts that work with text. Let's extend it so 
that it returns the image and the layers, so other scripts can call this script and use 
the image and layers we create. 

Modifying The Parameters And The Registration Function
To let the user specify the amount of buffer, we'll add a parameter to our function and the 
registration function: 

(define (script­fu­text­�������� �
box inTest inFont inFontSize inTextColor inBufferAmount)� � � � �
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(let*��������

(��������������
; define our local variables����������������� � � � �
; create a new image:����������������� � � � �
(theImageWidth 10)����������������� ��
(theImageHeight 10)����������������� �
(theImage (car����������������� � �

(gimp­image­new��������������������������������
theImageWidth���������������������������������
theImageHeight���������������������������������
RGB���������������������������������
)��������������������������������

)���������������������������
)�����������������
(theText) ;a declaration for the text����������������� ���������� � � � �

;we create later������������������������������������ � �

(theBuffer) ;added����������������� ��������
(theLayer����������������� �

(car���������������������������
(gimp­layer­new�������������������������������
theImage��������������������������������
theImageWidth��������������������������������
theImageHeight��������������������������������
RGB­IMAGE��������������������������������
"layer 1"�������������������������������� �
100��������������������������������
NORMAL��������������������������������
)�������������������������������

)���������������������������
)�����������������

) ;end of our local variables�������������� � � � � �

[Code here]��������� �
)�������

������

������
(script­fu­register��������
"script­fu­text­box" ;func name���������� ������������������������ �
"Text Box" ;menu label���������� � ���������������������������������� �
"Creates a simple text box, sized to fit\���������� � � � � � � �
around the user's choice of text,\������������ � � � � �
font, font size, and color." ;description������������ � � � � ��������������

"Michael Terry" ;author���������� � �����������������������������
"copyright 1997, Michael Terry" ;copyright notice���������� � � � ������������� �
"October 27, 1997" ;date created���������� � � �������������������������� �
"" ;image type that the script works on���������� ��������������������� � � � � � �
SF­STRING "Text:" "Text Box" ;a string variable���������� ������ ��������� � ��� � �
SF­FONT "Font:" "Charter" ;a font variable���������� �������� ��������� ���� � �
SF­ADJUSTMENT "Font size" '(50 1 1000 1 10 0 1)���������� �� � ����� � � � � � �

;a spin­button������������������������������������������������������ �
SF­COLOR "Color:" '(0 0 0) ;color variable���������� ������� �������� � � ����� �
SF­ADJUSTMENT "Buffer amount" '(35 0 100 1 10 1 0)���������� �� � � � � � � � �

;a slider������������������������������������������������������ �
)��������
(script­fu­menu­register "script­fu­text­box" "<Toolbox>/Xtns/Script­�������� � �

Fu/Text")
������
������

Adding The New Code
We're going to add code in two places: right before we resize the image, and at the end of 
the script (to return the new image, the layer and the text). 
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After we get the text's height and width, we need to resize these values based on the 
buffer amount specified by the user. We won't do any error checking to make sure it's in 
the range of 0-100% because it's not life-threatening, and because there's no reason why 
the user can't enter a value like "200" as the percent of buffer to add. 

(set! theBuffer (* theImageHeight (/ inBufferAmount 100) ) )�������� � � � � � � � �

(set! theImageHeight (+ theImageHeight theBuffer theBuffer) )�������� � � � � � �
(set! theImageWidth (+ theImageWidth theBuffer theBuffer) )�������� � �� � �� � �

������

All we're doing here is setting the buffer based on the height of the text, and adding it 
twice to both the height and width of our new image. (We add it twice to both dimensions 
because the buffer needs to be added to both sides of the text.) 

Now that we have resized the image to allow for a buffer, we need to center the text 
within the image. This is done by moving it to the (x, y) coordinates of (theBuffer, 
theBuffer). I added this line after resizing the layer and the image: 

(gimp­layer­set­offsets theText theBuffer theBuffer)�������� � � �
������

Go ahead and save your script, and try it out after refreshing the database. 

All that is left to do is return our image, the layer, and the text layer. After displaying the 
image, we add this line: 

(list theImage theLayer theText)�������� � � �
������

This is the last line of the function, making this list available to other scripts that want to 
use it. 

To use our new text box script in another script, we could write something like the 
following: 

(set! theResult (script­fu­text­box�������� � � �
"Some text"������������������������� � �
"Charter" "30"������������������������� �
'(0 0 0)������������������������� � �
"35"�������������������������
)������������������������

)��������
(gimp­image­flatten (car theResult))�������� � �

������

Congratulations, you are on your way to your Black Belt of Script-Fu! 
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Creating Shortcuts to Menu Functions 
Many functions which are accessible via the image menu have a default keyboard 
shortcut. You may want to create a new shortcut for a command that you use a lot and 
doesn't have one or, more rarely, edit an existing shortcut. There are two methods for 
doing this. 

First, you have to activate this capability by checking the Use dynamic keyboard 
shortcuts option in the Interface item of the Preferences menu. This option is usually not 
checked, to prevent accidental key presses from creating an unwanted shortcut. 

While you're doing that, also check the Save keyboard shortcuts on exit option so that 
your shortcut will be saved. 

To create a keyboard shortcut, simply place the mouse pointer on a command in the 
menu: it will then be highlighted. Be careful that the mouse pointer doesn't move and 
type a sequence of three keys, keeping the keys pressed. You will see this sequence 
appear on the right of the command. 

If you type a sequence which has already been used, the command which is associated 
with this shortcut will be executed and no new shortcut will be created. 

It is best to use the CtrlAltKey sequence for your custom shortcuts. 

 

You get to this Editor by clicking on Configure keyboard shortcuts in the "Interface" item 
of the Preferences menu. 

As shown in this dialog, you can select the command you want to create a shortcut for, in 
the "Action" area. Then you type your key sequence as above. In principle, the Space bar 

GNU Image Manipulation Program
Generated by docbook2odf

Page 99 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 
should clear a shortcut. (In practice, it clears it, but doesn't delete it.) 

This shortcut editor also allows you to control the tool parameter settings with the 
keyboard. At the top of this dialog, you can find a Context menu that takes you to the tool 
parameters. To make your work easier, tool types are marked with small icons. 

Custom Keyboard shortcuts are stored in one of Gimp's hidden directory 
(/home/[username]/.gimp­2.2/menurc) under Linux, and C:\Documents and 
Settings\[Username]\.gimp­2.2\menurc under Windows XP. It is a simple text file that 
you can transport from one computer to another. 
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The GIH dialog box 

  

This dialog box has several options not easy to understand. They allow you to determine 
the way your brush is animated. 
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Creating a brush with variable size 
You can create a brush with a size which will vary by rotating the mouse wheel or by 
using the keyboard arrow keys. 

1. Start with opening the Brush dialog by double_clicking on the Brush area in 
Toolbox, or by going through File Dialogs Brushes . 

2. Click on the New Brush button to open the Brush Editor dialog. Name your brush at 
once, "Dynamic" for instance. Your brush will appear in the Brush Dialog with a blue 
corner. 

• Check the Enable this controller box. 

• Scroll through the Events list and select Scroll up (Shift). Avoid Scroll up (Ctrl) 
because Ctrl is yet used by tools to turn to the Color Picker mode. 

• Click on the Edit button to open a window that allows you to assign an action to 
the selected event. If an action is assigned to the event yet, the window opens on 
this event; else, click on the small triangular button close to the Context item to 
drop the list down. Scroll through this list and select the context-brush-radius-
increase item. (You could choose context-brush-radius-increase-skip). Click on OK. 

• Do the same way to assign the "context-brush-radius-decrease" action to the 
"Scroll down (Shift)" event to decrease the brush size. 

3. Save your brush by clicking on the Save button in the Brush Editor. 

Now, if you have selected your Dynamic brush, when you work with a tool that has a 
"Brush" option while pressing the Shift key, the brush size will vary by using the mouse 
wheel. This change will be visible in real time in the brush area of the Toolbox and in the 
Brush Dialog. 

By enabling the "Main Keyboard" tab, you can, in the same way, assign an action to the 
events of the keyboard arrow keys. 

Actions are not removed from the window when you delete the brush. You have to delete 
them manually by clicking on the Delete button after selecting them. 
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Chapter
Toolbox 

GNU Image Manipulation Program
Generated by docbook2odf

Page 103 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

The Toolbox 
The GIMP provides a comprehensive toolbox in order to quickly perform basic tasks such 
as making selections or drawing paths. The many tools contained within The GIMP 's 
toolbox are discussed in detail here. 

The GIMP has a diverse assortment of tools that let you perform a large variety of tasks. 
The tools can be thought of as falling into five categories: Selection tools, which specify or 
modify the portion of the image that will be affected by subsequent actions; Paint tools, 
which alter the colors in some part of the image; Transform tools, which alter the 
geometry of the image; Color tools, which alter the distribution of colors across the entire 
image; and Other tools, which don't fall into the other four categories. 

(In case you're curious, in Gimp lingo a "tool" is a way of acting on an image that requires 
access to its display, either to let you indicate what you want to do by moving the pointer 
around inside the display, or to show you interactively the results of changes that you 
have made. But if you want to think of a tool as a saw, and an image as a piece of wood, 
it probably won't do you a great deal of harm.) 

Most tools can be activated by clicking on an icon in the Toolbox. Some, however (namely, 
the Color tools), are accessible only via the menus, either as Tools->Color Tools or as 
Layer->Colors. Every tool, in fact, can be activated from the Tools menu; also, every tool 
can be activated from the keyboard using an accelerator key. 

In the default setup, created when GIMP is first installed, not all tools show icons in the 
Toolbox: the Color tools are omitted. You can customize the set of tools that are shown in 
the Toolbox using the Tools dialog. There are two reasons you might want to do this: first, 
if you only rarely use a tool, it might be easier to find the tools you want if the distracting 
icon is removed; second, if you use the Color tools a lot, you might find it convenient to 
have icons for them easily available. In any case, regardless of the Toolbox, you can 
always access any tool at any time using the Tools menu from an image menubar. 

The shape of the cursor changes when it is inside an image, to one that indicates which 
tool is active. 

Tool Options 

 

If you have things set up like most people do, activating a tool causes its Tool Options 
dialog to appear below the Toolbox. If you don't have things set up this way, you probably 
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should: it is very difficult to use tools effectively without being able to manipulate their 
options. 

The Tool Options appear beneath the Toolbox in the default setup. If you lose it somehow, 
you can get it back by creating a new Tool Options dialog using File->Dialogs->Tool 
Options, and then docking it below the Toolbox. See the section on Dialogs and Docking if 
you need help. 

Each tool has its own specific set of options. The choices you make for them are kept 
throughout the session, until you change them. In fact, the tool options are maintained 
from session to session. The persistence of tool options across sessions can sometimes be 
an annoying nuisance: a tool behaves very strangely, and you can't figure out why until 
you remember that you were using some unusual option the last time you worked with it, 
two weeks ago. 

At the bottom of the Tool Options dialog appear four buttons: 

• Save Options to

This button allows you to save the settings for the current tool, so that you can 
restore them later. It brings up a small dialog allowing you to give a name to the 
array of saved options. When you Restore options, only saved sets for the active tool 
are shown, so you need not worry about including the name of the tool when you 
assign a name here. 

• Restore Options

This button allows you to restore a previously saved set of options for the active 
tool. If no option-sets have ever been saved for the active tool, the button will be 
insensitive. Otherwise, clicking it will bring up a menu showing the names of all 
saved option sets: choosing a menu entry will apply those settings. 

• Delete Options

This button allows you to delete a previously saved set of options for the active tool. 
If no option-sets have ever been saved for the active tool, the button will be 
insensitive. Otherwise, clicking it will bring up a menu showing the names of all 
saved option sets: choosing a menu entry will delete those settings. 

• Reset Options

This button resets the options for the active tool to their default values. 
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Selection Tools

Common Features
Selection tools are designed to select regions from images or layers so you can work on 
them without affecting the unselected areas. Each tool has its own individual properties, 
but the selection tools also share a number of options and features in common. These 
common features are described here; the variations are explained in the following 
sections for each tool specifically. If you need help with what a "selection" is in GIMP, and 
how it works, see Selection. 

There are six selection tools:

• Rectangle Select

• Ellipse Select

• Free Select (the Lasso)

• Select Contiguous Regions (the Magic Wand)

• Select by Color

• Select Shapes from Image (Intelligent Scissors)

In some ways the Path tool can also be thought of as a selection tool: any closed path can 
be converted into a selection. It also can do a great deal more, though, and does not 
share the same set of options with the other selection tools. 

Key modifiers (Defaults) 
The behavior of selection tools is modified if you hold down the Ctrl, Shift, and/or Alt keys 
while you use them. 

Advanced users find the modifier keys very valuable, but novice users often find them 
confusing. Fortunately, it is possible for most purposes to use the Mode buttons 
(described below) instead of modifier keys. 

Options 
Here we describe the tool options that apply to all selection tools: options that apply only 
to some tools, or that affect each tool differently, are described in the sections devoted to 
the individual tools. The current settings for these options can be seen in the Tool Options 
dialog, which you should always have visible when you are using tools. (Most users keep 
it docked directly below the Toolbox.) To make the interface consistent, the same options 
are presented for all selection tools, even though some of them don't have any effect for 
some of the tools. 

Additional information 
When moving a selection beyond the boundaries of the image canvas, the selection will 
be cropped to the image area. Selections can exist on the visible canvas only. Selection 
movements and changes are, however, kept in the undo buffer should you need to repair 
an error. 

Rectangle Selection Tool
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The Rectangle Selection tool is designed to select rectangular regions of an image: it is 
the most basic of the selection tools, but very commonly used. For information on 
selections and how they are used in GIMP see Selections; for information on features 
common to all selection tools see Selection Tools. 

This tool is also used for rendering a rectangle on an image. To render a filled rectangle, 
create a rectangular selection, and then fill it using the Bucket Fill tool. To create a 
rectangular outline, the simplest and most flexible approach is to create a rectangular 
selection and then stroke it. 

If you want to round the edges of a rectangular selection, the easiest method is using 
Select Rounded Rectangle from the image menu. 

How to Activate
• From the image menu bar Tools Selection Tools Rect Select ; 

• By clicking on the tool icon  in the ToolBox, 

• By using the keyboard shortcut R. 

Key modifiers
See Selection Tools for help with modifier keys that affect all these tools in the same way. 
Only effects that are specific to the Rectangle Select tool are explained here. 

• Ctrl: Pressing the Ctrl key after starting your selection, and holding it down until you 
are finished, causes your starting point to be used as the center of the selected 
rectangle, instead of a corner. Note that if you press the Ctrl key before starting to 
make the selection, the resulting selection will be subtracted from the existing 
selection. 

• Shift: Pressing the Shift key after starting your selection, and holding it down until 
you are finished, constrains the selection to be square. Note that if you press the 
Shift key before starting to make the selection, the resulting selection will be added 
to the existing selection. 

• Ctrl Shift : Pressing both keys after starting your selection combines the two effects, 
giving you a square selection centered on your starting point. Note that pressing 
these keys before starting your selection intersects the resulting selection with the 
existing one. 

Tool Options
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See Selection Tools for help with options that are common to all these tools. Only options 
that are specific to the Rectangle Select tool are explained here. 

Ellipse Selection Tool 

 

The Ellipse Selection tool is designed to select circular and elliptical regions from an 
image, with high-quality anti-aliasing if you want it. For information on selections and how 
they are used in GIMP see Selections; for information on features common to all selection 
tools see Selection Tools. 

This tool is also used for rendering a circle or ellipse on an image. To render a filled 
ellipse, create an elliptical selection, and then fill it using the Bucket Fill tool. To create an 
elliptical outline, the simplest and most flexible approach is to create an elliptical 
selection and then stroke it. However, the quality of anti-aliasing with this approach is 
rather crude. A higher quality outline can be obtained by creating two elliptical selections 
with different sizes, subtracting the inner one from the outer one; however this is not 
always easy to get right. 

How to Activate 
The Ellipse Selection Tool can be activated from an image menu as Tools Selection 
Tools Ellipse Select ; from the Toolbox by clicking on the tool icon  ; or from the 

keyboard using the shortcut e. 
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Key modifiers 
See Selection Tools for help with modifier keys that affect all these tools in the same way. 
Only effects that are specific to the Ellipse Select tool are explained here. 

• Ctrl: Pressing the Ctrl key after starting your selection, and holding it down until you 
are finished, causes your starting point to be used as the center of the selected 
ellipse, instead of a corner of the rectangle that may contain it. Note that if you 
press the Ctrl key before starting to make the selection, the resulting selection will 
be subtracted from the existing selection. 

• Shift: Pressing the Shift key after starting your selection, and holding it down until 
you are finished, constrains the selection to be a circle. Note that if you press the 
Shift key before starting to make the selection, the resulting selection will be added 
to the existing selection. 

• Ctrl Shift : Pressing both keys combines the two effects, giving you a circular 
selection centered on your starting point. 

Options 

 

See Selection Tools for help with options that are common to all these tools. Only options 
that are specific to the Ellipse Select tool are described here. 

You can access to the Ellipse Selection options by double-clicking on the  icon. 

Free Selection Tool (Lasso) 
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The Free Selection tool, or Lasso, lets you create a selection by drawing it free-hand with 
the pointer, while holding down the left mouse button (or, for a stylus, pressing it against 
the tablet). When you release the mouse button, the selection is closed by connecting the 
current pointer location to the start location with a straight line. You can go outside the 
edge of the image display and come back in if you want to. The Lasso is often a good tool 
to use for "roughing in" a selection; it is not so good for precise definition. Experienced 
users find that it is often convenient to begin with the lasso tool, but then switch to 
QuickMask mode for detail work. 

For information on selections and how they are used in GIMP see Selections. For 
information on features common to all selection tools see Selection Tools. 

The Free Selection tool is much easier to use with a tablet than with a mouse. 

How to Activate 
The Lasso Tool can be activated from an image menu as Tools Selection Tools Free 
Select ; from the Toolbox by clicking on the tool icon  ; or from the keyboard using the 

shortcut f. 

Key modifiers 
The Free Select tool does not have any special key modifiers, only the ones that affect all 
selection tools in the same way. See Selection Tools for help with these. 

Options 

 

The Free Select tool has no special tool options, only the ones that affect all selection 
tools in the same way. See Selection Tools for help with these. 
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Fuzzy Selection Tool (Magic Wand) 

 

The Fuzzy Select (Magic Wand) tool is designed to select areas of the current layer or 
image based on color similarity. It starts selecting when you click at a spot in the image, 
and expands outward like water flooding low-lying areas, selecting contiguous pixels 
whose colors are similar to the starting pixel. You can control the threshold of similarity by 
dragging the mouse downward or to the right: the farther you drag it, the larger the 
selected region. And you can reduce the selection by dragging upwards or to the left. 

When using this tool, it is very important to pick the right starting point. If you select the 
wrong spot, you might get something very different from what you want, or even the 
opposite. 

The Wand is a good tool for selecting objects with sharp edges. It is fun to use, so 
beginners often start out using it a lot. You will probably find, however, that the more you 
use it, the more frustrated you become with the difficulty of selecting exactly what you 
what, no more, no less. Perhaps the most frustrating aspect is that after you have 
released the mouse button, you can't make small adjustments to the threshold: you have 
to start over again from scratch. More experienced users find that the Path and Color 
Select tools are often more efficient, and use the Wand less. Still, it is useful for selecting 
an area within a contour, or touching up imperfect selections. It often works very well for 
selecting a solid-colored (or nearly solid-colored) background area. 

Note that as the selected area expands outward from the center, it does not only 
propagate to pixels that touch each other: it is capable of jumping over small gaps. The 
distance it can jump over is set in the Tool Options page of the Preferences dialog: the 
"Default threshold" for Finding Continguous Regions. By raising or lowering this value, you 
can make the Magic Wand either more or less aggressive. (Filling with the Bucket Fill and 
Blend tools will also be affected.) 

How to Activate 
The Magic Wand Tool can be activated from an image menu as Tools Selection Tools 
Fuzzy Select ; from the Toolbox by clicking on the tool icon  ; or from the keyboard 

using the shortcut z. ("Z" stands for "Zauber", the German word for Magic.) 

Key modifiers (Defaults) 
The Fuzzy Select tool does not have any special key modifiers, only the ones that affect 
all selection tools in the same way. See Selection Tools for help with these. 

Options 
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See Selection Tools for help with options that are common to all these tools. Only options 
that are specific to the Magic Wand tool are explained here. 

Select By Color Tool

 

The Select by Color tool is designed to select areas of an image based on color similarity. 
It works a lot like the Fuzzy Select tool ("Magic Wand"). The main difference between 
them is that the Magic Wand selects contiguous regions, with all parts connected to the 
starting point by paths containing no large gaps; while the Select by Color tool selects all 
pixels that are sufficiently similar in color to the pixel you click on, regardless of where 
they are located. Also, clicking and dragging in the image has no effect on the Select by 
Color tool. 

How to Activate
The Select By Color Tool can be activated from an image menu as Tools Selection 
Tools Select by Color ; from the Toolbox by clicking on the tool icon  ; or from the 

keyboard using the shortcut Shift CtrlC 

Key modifiers (Defaults)
The select by color tool does not have any special key modifiers, only the ones that affect 
all selection tools in the same way. See Selection Tools for help with these. 

Options
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See Selection Tools for help with options that are common to all these tools. Only options 
that are specific to the Select by Color tool are explained here. Note that they are the 
same options as the Magic Wand tool has. 

Regarding moving selection, this tool does'nt work like others: when selection by color is 
created, you can move it only if you select another selection tool... 

Scissors Tool

 

The Intelligent Scissors tool is an interesting piece of equipment: it has some features in 
common with the Lasso, some features in common with the Path tool, and some features 
all its own. It is useful when you are trying to select a region defined by strong color-
changes at the edges. To use the Scissors, you click to create a set of "control nodes" at 
the edges of the region you are trying to select. The tool produces a continuous curve 
passing through these control nodes, following any high-contrast edges it can find. If you 
are lucky, the path that the tool finds will correspond to the contour you are trying to 
select. 

Each time you left-click with the mouse, you create a new control point, which is 
connected to the last control point by a curve that tries to follow edges in the image. To 
finish, click on the first point (the cursor changes to indicate when you are in the right 
spot). You can adjust the curve by dragging the control nodes, or by clicking to create 
new control nodes. When you are satisfied, click anywhere inside the curve to convert it 
into a selection. 

Be sure not to click inside the curve until you are completely done adjusting it. Once you 
have converted it into a selection, undoing takes you back to zero, and you will have to to 
start constructing the curve again from scratch if you need to change it. Also be sure not 
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to switch to a different tool, or again all of your carefully created control nodes will be 
lost. (But you still can transform your selection into a path and work it with the Path tool.) 

Unfortunately, there seem to be some problems with the edge-following logic for this tool, 
with the result that the selections it creates tend to be pretty crude in a lot of cases. A 
good way to clean them up is to switch to QuickMask mode, and use paint tools to paint 
in the problematic parts. On the whole, most people find the Path tool to be more useful 
than the Scissors, because, even though it does not have the intelligent edge-finding 
capability, the paths it produces persist until you delete them, and can be altered at any 
time. 

How to Activate
The Intelligent Scissors can be activated from an image menu as Tools Selection Tools 
Intelligent Scissors ; from the Toolbox by clicking on the tool icon  ; or from the 

keyboard using the shortcut i. 

Key modifiers (Defaults)
The Scissor tool does not have any special key modifiers, only the ones that affect all 
selection tools in the same way. See Selection Tools for help with these. 

Options

 

See Selection Tools for help with options that are common to all these tools. Only options 
that are specific to the Intelligent Scissors tool are explained here. 
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Brush Tools

Common Features

 

The GIMP Toolbox includes nine "brush tools", all grouped together at the bottom (in the 
default arrangement). The feature they all have in common is that all of them are used by 
moving the pointer across the image display, creating brushstrokes. Four of them – the 
Pencil, Paintbrush, Airbrush, and Ink tools – behave like the intuitive notion of "painting" 
with a brush. The others use a brush to modify an image in some way rather than paint 
on it: the Eraser erases; the Clone tool copies from a pattern or image; the Convolve tool 
blurs or sharpens; the Dodge/Burn tool lightens or darkens; and the Smudge tool smears. 

The advantages of using GIMP with a tablet instead of a mouse probably show up more 
clearly for brush tools than anywhere else: the gain is fine control is invaluable. These 
tools also have special "Pressure sensitivity" options that are only usable with a tablet. 

In addition to the more common "hands-on" method, it is possible to apply brush tools in 
an automated way, by creating a selection or path and then "stroking" it. You can choose 
to stroke with any of the brush tools, including nonstandard ones such as the Eraser, 
Smudge tool, etc., and any options you set for the tool will be applied. See the section on 
Stroking for more information. 

Brush tools work not only on image layers, but on other types of drawable objects as well: 
layer masks, channels, and the selection. To apply a brush tool to a layer mask or 
channel, simply make it the image's active drawable by clicking on it in the Layers dialog 
or Channels dialog. To apply a brush tool to the selection, switch to QuickMask mode. 
"Painting the selection" in this way is a very powerful method for efficiently creating 
precise selections. 

Key modifiers
• Ctrl: Holding down the Ctrl key has a special effect on every brush tool except the 

ink tool. For the Pencil, Paintbrush, Airbrush, Eraser, and Smudge tools, it switches 
them into "color picker" mode, so that clicking on an image pixel causes GIMP's 
foreground to be set to the active layer's color at that point (or, for the Eraser, 
GIMP's background color). For the Clone tool, the Ctrl key switches it into a mode 
where clicking sets the reference point for copying. For the Convolve tool, the Ctrl 
key switches between blur and sharpen modes; the the Dodge/Burn tool, it switches 
between dodging and burning. 
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• Straight Line Shift: Holding down the Shift key has the same effect on all brush tools: 

it places the tool into straight line mode. To create a straight line with any of the 
brush tools, first click on the starting point, then press the Shift key. As long as you 
hold it down, you will see a thin line connecting the previously clicked point with the 
current pointer location. If you click again, while continuing to hold down the Shift 
key, a straight line will be rendered. You can continue this process to create a series 
of connected line segments. 

• Ctrl Shift : Holding down both keys puts the tool into constrained straight line mode. 
This is similar to the effect of the Shift key alone, except that the orientation of the 
line is constrained to the nearest multiple of 15 degrees. Use this if you want to 
create perfect horizontal, vertical, or diagonal lines. 

Tool Options

 

Many tool options are shared by several brush tools: these are described here. Options 
that apply only to one specific tool, or to a small number of tools, are described in the 
sections devoted to those tools. 

Further Information
Advanced users may be interested to know that brush tools actually operate at a sub-
pixel level, in order to avoid producing jagged-looking results. One consequence of this is 
that even if you work with a hard-edged brush, such as one of the Circle brushes, pixels 
on the edge of the brushstroke will only be partially affected. If you need to have all-or-
nothing effects (which may be necessary for getting a good selection, or for cutting and 
pasting, or for operating pixel-by-pixel at a high zoom level), there are two things you can 
do: (1) for painting, use the Pencil tool, which makes all brushes perfectly hard and 
disables sub-pixel anti-aliasing, or (2) for other types of brush tools, check the "Hard 
edge" box in the Tool Options. 

Bucket Fill
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This tool fills a selection with the current foreground color. If you Shift+click and use the 
Bucket tool, it will use the background color instead. Depending on how the tool options 
are set, the Bucket Fill tool will either fill the entire selection, or only parts whose colors 
are similar to the point you click on. The tool options also affect the way transparency is 
handled. 

The amount of fill depends on what Fill Threshold you have specified. The fill threshold 
determines how far the fill will spread (similar to the way in which the magic wand works). 
The fill starts at the point where you click and spreads outward until the color or alpha 
value becomes "too different". 

When you fill objects in a transparent layer (such as letters in a text layer) with a different 
color than before, you may find that a border of the old color still surrounds the objects. 
This is due to a low fill-threshold in the Bucket Fill options dialog. With a low threshold, the 
bucket tool won't fill semi-transparent pixels, and they will stand out against the fill 
because they have kept their original color. If you want to fill areas that are totally 
transparent, you have to choose right-click|Select|Select All, and make sure that the 
layer's "Keep Transparency" button (in the Layers dialog) is unchecked. If the Keep 
Transparency button is checked, only the opaque parts of the layer will be filled, and if 
you don't use the Select All command, only the opaque "island" that you clicked on will be 
filled. 

Activate Tool
• The Bucket Fill can be called in the following order, from the image-menu: Tools/ 

Paint Tools/Bucket Fill. 

• The Tool can also be called by clicking the tool icon:  

Key modifiers (Defaults)

Options

Gradient Tool
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This tool fills the selected area with a gradient blend of the foreground and background 
colors by default, but there are many options. To make a blend, drag the cursor in the 
direction you want the gradient to go, and release the mouse button when you feel you 
have the right position and size of your blend. The softness of the blend depends on how 
far you drag the cursor. The shorter the drag distance, the sharper it will be. 

There are an astonishing number of things you can do with this tool, and the possibilities 
may seem a bit overwhelming at first. The two most important options you have are the 
Gradient and the Shape. Clicking the Gradient button in the tool options brings up a 
Gradient Select window, allowing you to choose from among a variety of gradients 
supplied with GIMP; you can also construct and save custom gradients. 

For Shape, there are 11 options: Linear, Bilinear, Radial, Square, Conical (symmetric), 
Conical (asymmetric), Shapeburst (angular), Shapeburst (spherical), Shapeburst 
(dimpled), Spiral (clockwise), and Spiral (counterclockwise); these are described in detail 
below. The Shapeburst options are the most interesting: they cause the gradient to follow 
the shape of the selection boundary, no matter how twisty it is. Unlike the other shapes, 
Shapeburst gradients are not affected by the length or direction of the line you draw: for 
them as well as every other type of gradient you are required to click inside the selection 
and move the mouse, but a Shapeburst appears the same no matter where you click or 
how you move. 

Check out the Difference option in the Mode menu, where doing the same thing (even 
with full opacity) will result in fantastic swirling patterns, changing and adding every time 
you drag the cursor. 

Activate Tool
• The Blend Tool can be called in the following order, from the image-menu: Tools/ 

Paint Tools/ Blend. 

• The Tool can also be called by clicking the tool icon:  

Key modifiers (Defaults)

Options

Painting Tools (Pencil, Paintbrush, Airbrush)
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The tools in this group are GIMP's basic painting tools, and they have enough features in 
common to be worth discussing together in this section. Features common to all brush 
tools are described in the Common Features section. Features specific to an individual 
tool are described in the section devoted to that tool. 

The Pencil is the crudest of the tools in this group: it makes hard, non-anti-aliased 
brushstrokes. The Paintbrush is intermediate: it is probably the most commonly used of 
the group. The Airbrush is the most flexible and controllable: it is the only one for which 
the amount of paint applied depends on the speed of brush movement. This flexibility 
also makes it a bit more difficult to use than the Paintbrush, however. 

All of these tools share the same brushes, and the same options for choosing colors, 
either from the basic palette or from a gradient. All are capable of painting in a wide 
variety of modes. 

Key modifiers

Options

Pencil

 

The Pencil tool is used to draw free hand lines with a hard edge. The pencil and 
paintbrush are similar tools. The main difference between the two tools is that although 
both use the same type of brush, the pencil tool will not produce fuzzy edges, even with a 
very fuzzy brush. It does not even do anti-aliasing. 

Why would you want to work with such a crude tool? Perhaps the most important usage is 
when working with very small images, such as icons, where you operate at a high zoom 
level and need to get every pixel exactly right. With the pencil tool, you can be confident 
that every pixel within the brush outline will be changed in exactly the way you expect. 
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If you want to draw straight lines with the Pencil (or any of several other paint tools), click 
at the starting point, then hold down Shift and click at the ending point. 

Activate Tool
• The Pencil Tool can be called in the following order, from the image-menu: Tools 

Paint Tools Pencil 

• The Tool can also be called by clicking the tool icon:  

• or by clicking on the N keyboard shortcut. 

Key modifiers (Defaults)

Options

 

See the Brush Tools Overview for a description of tool options that apply to many or all 
brush tools. 

Paintbrush Tool
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The paintbrush tool paints fuzzy brush strokes. All strokes are rendered using the current 
brush. 

Activate Tool
• You can call the Paintbrush Tool in the following order, from the image-menu: Tools/ 

Paint Tools/Paintbrush . 

• The Tool can also be called by clicking the tool icon:  

• or by using the P keyboard shortcut. 

Key modifiers (Defaults)

Options

 

See the Brush Tools Overview for a description of tool options that apply to many or all 
brush tools. 
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Eraser

 

The Eraser is used to remove areas of color from the current layer or from a selection of 
this layer. If the Eraser is used on something that does not support transparency (a 
selection mask channel, a layer mask, or the Background layer if it lacks an alpha 
channel), then erasing will show the background color, as displayed in the Color Area of 
the Toolbox (in case of a mask, the selection will be modified). Otherwise, erasing will 
produce either partial or full transparency, depending on the settings for the tool options. 

If you need to erase some group of pixels completely, leaving no trace behind of their 
previous contents, you should check the "Hard edge" box in the Tool Options. Otherwise, 
sub-pixel brush placement will cause partial erasure at the edges of the brush-stroke, 
even if you use a hard-edged brush. 

If you use GIMP with a tablet, you may find it convenient to treat the reverse end of the 
stylus as an eraser. To make this work, all you need to do is click the reverse end on the 
Eraser tool in the Toolbox. Because each end of the stylus is treated as a separate input 
device, and each input device has its own separate tool assignment, the reverse end will 
then continue to function as an Eraser as long as you don't select a different tool with it. 

How to Activate
The Eraser can be activated from an image menu as Tools Paint Tools Eraser ; from 
the Toolbox by clicking on the tool icon  ; or from the keyboard using the shortcut E. 

Key modifiers
See the Brush Tools Overview for a description of key modifiers that have the same effect 
on all brush tools. 

• Ctrl: For the Eraser, holding down the Ctrl key puts it into "color picker" mode, so 
that it selects the color of any pixel it is clicked on. Unlike other brush tools, 
however, the Eraser sets the background color rather than the foreground color. This 
is more useful, because on drawables that don't support transparency, erasing 
replaces the erased areas with the current background color. 

• Alt: For the Eraser, holding down the Alt key switches it into "anti-erase" mode, as 
described below in the Tool Options section. Note that on some systems, the Alt key 
is trapped by the Window Manager. If this happens to you, you may be able to use 
Shift-Alt instead. 

Tool Options
See the Brush Tools Overview for a description of tool options that apply to many or all 
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brush tools. 

 

See the Brush Tools Overview for a description of tool options that apply to many or all 
brush tools. The Eraser tool has only one special option (Anti-Erase), but the Opacity 
control is mentioned here as well because its name may be a bit confusing. 

Airbrush Tool

  

Activate Tool
• The Airbrush Tool can be called from the image-menu: Tools/ Paint Tools/Airbrush . 

• The Tool can also be called by clicking the tool icon:  

Key modifiers (Defaults)

Options
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See the Brush Tools Overview for a description of tool options that apply to many or all 
brush tools. 

Ink Tool

 

The Ink tool uses a simulation of an ink pen with a controllable nib to paint solid brush 
strokes with an antialiased edge. The size, shape and angle of the nib can be set to 
determine how the strokes will be rendered. 

Activate Tool
• You can call the Ink Tool in the following order, from the image-menu: Tools/ Paint 

Tools/Ink . 

• You can also call this Tool by clicking on the tool icon:  
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Key modifiers (Defaults)

Options

 

See the Brush Tools Overview for a description of tool options that apply to many or all 
brush tools. 

Clone Tool

 

The Clone tool uses the current brush to copy from an image or pattern. It has many uses: 
one of the most important is to repair problem areas in digital photos, by "painting over" 
them with pixel data from other areas. This technique takes a while to learn, but in the 
hands of a skilled user it is very powerful. Another important use is to draw patterned 
lines or curves: see Patterns for examples. 

If you want to clone from an image, instead of a pattern, you must tell GIMP which image 
you want to copy from. You do this by holding down the Ctrl key and clicking in the 
desired source image. Until you have set the source in this way, you will not be able to 
paint with the Clone tool: the tool cursor tells you this by showing a "forbidden" symbol. 
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If you clone from a pattern, the pattern is tiled; that is, when the point you are copying 
from moves past one of the edges, it jumps to the opposite edge and continues, as 
though the pattern were repeated side-by-side, indefinitely. When you clone from an 
image this does not happen: if you go beyond the edges of the source, the Clone tool 
stops producing any changes. 

You can clone from any drawable (that is, any layer, layer mask, or channel) to any other 
drawable. You can even clone to or from the selection mask, by switching to QuickMask 
mode. If this means copying colors that the target does not support (for example, cloning 
from an RGB layer to an Indexed layer or a layer mask), then the colors will be converted 
to the closest possible approximations. 

How to Activate
The Clone tool can be activated from an image menu as Tools Paint Tools Clone ; from 
the Toolbox by clicking on the tool icon  ; or from the keyboard using the shortcut c, 

or S under GIMP-2.10. 

Key modifiers
See the Brush Tools Overview for a description of key modifiers that have the same effect 
on all brush tools. 

Tool Options

 

See the Brush Tools Overview for a description of tool options that apply to many or all 
brush tools. 

Further Information
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Convolve (Blur/Sharpen)

 

The Convolve tool uses the current brush to locally blur or sharpen your image. Blurring 
with it can be useful if some element of your image stands out too much, and you would 
like to soften it. If you want to blur a whole layer, or a large part of one, you will probably 
be better off using one of the Blur Filters. The direction of a brushstroke has no effect: if 
you want directional blurring, use the Smudge tool. 

In "Sharpen" mode, the tool works by increasing the contrast where the brush is applied. 
A little bit of this may be useful, but overapplication will produce noise. Some of the 
Enhancement Filters, particularly the Unsharp Mask, do a much cleaner job of sharpening 
areas of a layer. 

You can create a more sophisticated sharpening brush using the Clone tool. To do this, 
start by duplicating the layer you want to work on, and run a sharpening filter, such as 
Unsharp Mask, on the copy. Then activate the Clone tool, and in its Tool Options set 
Source to "Image source" and Alignment to "Registered". Set the Opacity to a modest 
value, such as 10. Then Ctrl-click on the copy to make it the source image. If you now 
paint on the original layer, you will mix together, where the brush is applied, the 
sharpened version with the unsharpened version. 

Both blurring and sharpening work incrementally: moving the brush repeatedly over an 
area will increase the effect with each additional pass. The Rate control allows you to 
determine how quickly the modifications accumulate. The Opacity control, however, can 
be used to limit the amount of blurring that can be produced by a single brushstroke, 
regardless of how many passes are made with it. 

How to Activate
The Convolve tool can be activated from an image menu as Tools Paint Tools 
Convolve ; from the Toolbox by clicking on the tool icon  ; or from the keyboard using 

the shortcut V. 

Key modifiers
See the Brush Tools Overview for a description of key modifiers that have the same effect 
on all brush tools. 

• Ctrl: Holding down the Ctrl key toggles between Blur and Sharpen modes; it reverses 
the setting shown in the Tool Options. 

Tool Options
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See the Brush Tools Overview for a description of tool options that apply to many or all 
brush tools. 

Dodge or Burn

 

The Dodge or Burn tool uses the current brush to lighten or darken the colors in your 
image. The mode will determine which type of pixels are affected. 

Activate Tool
• The Dodge or Burn Tool can be called in the following order, from the image-menu: 

Tools/ Paint Tools /DodgeBurn. 

• The Tool can also be called by clicking the tool icon:  

Key modifiers (Defaults)

Options
 

GNU Image Manipulation Program
Generated by docbook2odf

Page 128 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

See the Brush Tools Overview for a description of tool options that apply to many or all 
brush tools. 

Smudge Tool

 

The Smudge tool uses the current brush to smudge colors on the active layer or a 
selection. It takes color in passing and uses it to mix it to the next colors it meets, on a 
distance you can set. 

Activate Tool
• The Smudge Tool can be called in the following order, from the image-menu: Tools 

Paint Tools Smudge. 

• The Tool can also be called by clicking the tool icon:  
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• or by pressing the S key on keyboard. 

Key modifiers (Defaults)

Options

 

See the Brush Tools Overview for a description of tool options that apply to many or all 
brush tools. 
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Transform Tools

Common Features

 

Inside the Transformation tool dialog, you will find seven tools to modify the presentation 
of the image or the presentation of an element of the image, selection, layer or path. 
Each transform tool has an Option dialog and an Information dialog to set parameters. 

Move Tool

 

The Move Tool is used to move layers, selections or guides. It works also on texts. 

Activate Tool
• The Move Tool can be called in the following order, from the image-menu: Tools 

Transform Tools Move 

• The Tool can also be called by clicking the tool icon:  

or by the M keyboard shortcut. 

• The Move tool is automatically activated when you create a guide. 

Holding down the space bar changes the active tool to Move temporarily. The Move 
tool remains active as long as the space bar is held down. The original tool is 
reactivated after releasing the space bar. 

Default behaviour 
By default, this tool works on the active layer and the Select a Layer or a Guide option is 
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checked. Let's suppose that your image has more than one layer, a selection and a guide. 
The mouse pointer takes the shape of the familiar 4-way arrow when it passes over the 
image elements originating from the active layer; then, click-and-drag will move the 
active layer. When the mouse pointer is on an image element originating from a non-
active layer or on a guide, it looks like a small hand; then, click-and-drag will move this 
layer or this guide. 

To move a selection frame, without moving its content, Use the CtrlAlt key-combination. 
This has the same action as selecting " Selection" in Affect. 

Key modifiers (Defaults)

Options

 

Crop and Resize Tool

 

The Crop Tool is used to crop or clip an image or layer. This tool is often used to remove 
borders, or to eliminate unwanted areas to provide you with a more focused working 
area. It is also useful if you need a specific image size that does not match the original 
dimensions of your image. 

To use the tool, click inside the image and drag out a rectangular region before releasing 
the mouse button. When you click, a dialog pops up showing you the dimensions of the 
crop region, and allowing you to perform various actions. If you want to alter the crop 
region, you can do so either by clicking and dragging on the corners, or by changing the 
values in the dialog. When you are ready, you can complete the operation either by 
clicking inside the crop region, or by pressing the Crop or Resize buttons on the dialog. 
(See below for what these mean.) 

If you find that the dialog gets in your way more than it helps you, you can prevent it from 
appearing by holding down the Shift key when you first click on the image. Working this 
way means altering the crop region by dragging the corners, and executing the operation 
by clicking inside the image. 
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Activate Tool
• The Crop Tool can be called way the following way, from the image-menu: Tools 

Transform Tools Crop and Resize . 

• The Tool can also be called by clicking the tool icon:  

A different and quicker way to crop selections is using the Image Crop Image function 
in the Image menu. 

Key modifiers (Defaults)

Options

 

Rotate Tool

 

Overview
This tool is used to rotate the active layer, a selection or a path. When you click on the 
image or the selection with this tool, a grid or an outline is superimposed and a Rotation 
Information dialog is opened. There, you can set the rotation axis, marked with a point, 
and the rotation angle. You can do the same by dragging the mouse pointer on the image 
or the rotation point. 

Activate Tool
• You can call the Rotate tool in the following order, from the image-menu: Tools 

Transform Tools Rotate 

• The Tool can also be called by clicking the tool icon:  in the Toolbox. 

• or by using the ShiftR key combination. 
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Key modifiers (Defaults)
Rotation tool options  

The Rotation Information dialog window  

Scale Tool

 

Overview
The Scale Tool is used to scale layers, selections or paths (the Object). 

When you click on image with the tool the Scaling Information dialog box is opened, 
allowing to change separately Width and Height. At the same time a Preview with a grid 
or an outline is superimposed on the object and handles appear on corners that you can 
click and drag to change these dimensions. A small circle appears at center of the 
Preview allowing to move this preview. 

Activate Tool
• The Scale Tool can be called in the following order, from the image-menu: Tools 

Transform Tools Scale 

• The Tool can also be called by clicking the tool icon:  

• or by using the Shift T key combination. 

Key modifiers (Defaults)

Options
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The Scaling Information dialog window  

Shear Tool

 

Shear tool is used to shift one part of an image, a layer, a selection or a path to a 
direction and the other part to the opposite direction. For instance, a horizontal shearing 
will shift the upper part to the right and the lower part to the left. A rectangle becomes a 
diamond. This is not a rotation: the image is distorted. To use this tool after selecting, 
click on the image or the selection: a grid is surperimposed and the Shearing Information 
dialog is opened. By dragging the mouse pointer on the image you distort the image, 
horizontally or vertically according to the the direction given to the pointer. When you are 
satisfied, click on the Shear button in the info dialog to validate. 

Activate Tool
• The Shear Tool can be called in the following order, from the image-menu: Tools 

Transform Tools Shear 
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• The Tool can also be called by clicking the tool icon:  

• or by using the ShiftS key combination. 

Options

 

Shearing Information window  

Perspective Tool

 

The Perspective Tool is used to change the perspective of the active layer content, of the 
selection boundaries or of a path. When you click on the image, according to the Preview 
type you have selected, a rectangular frame or a grid pops up around the selection (or 
around the whole layer if there is no selection), with a handle on each of the four corners. 
By moving these handles by click-and-drag, you can modify the perspective. At the same 
time, a "Transformation informations " pop up, which lets you valid the transformation. At 
the center of the element, a point lets you move the element by click-and-drag. 

Activate Tool
• The Perspective Tool can be called in the following order, from the image-menu: 

Tools/ Transform Tools/Perspective . 
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• The Tool can also be called by clicking the tool icon:  

Key modifiers (Defaults)

Options

 

The dialog window of the "Perspective" tool  

Flip Tool

 

The Flip tool provides the ability to flip layers or selections either horizontally or vertically. 
When a selection is flipped, a new layer with a Floating Selection is created. You can use 
this tool to create reflexions. 

Activate Tool
• The Flip Tool can be called in the following order, from the image-menu: Tools/ 

Transform Tools/Flip . 

• The Tool can also be called by clicking the tool icon:  
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Key modifiers (Defaults)

Options
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Color Tools

Color Balance Tool
The color balance tool modifies the color balance of the active selection or layer. 

Activate Tool
The Color Balance Tool can be called in the following order, from the image-menu: Tools/ 
Color Tools/Color Balance . 

Options

 

Hue-Saturation Tool
The Hue-Saturation tool is used to adjust hue, saturation and lightness levels on a range 
of color weights for the selected area or active layer. 

Activate Tool
You can call the Hue-Saturation Tool in the following order, from the image-menu: Tools/ 
Color Tools/Hue-Saturation . 

Options
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Colorize Tool
The Colorize tool renders the active layer or selection into a greyscale image seen 
through a colored glass. See HSV Color Model for Hue, Saturation, Luminosity. 

Activate Tool
The Colorize Tool can be called in the following order, from the image-menu: Tools/ Color 
Tools/Colorize . 

Options

 

Brightness-Contrast tool
The Brightness-Contrast tool adjusts the brightness and contrast levels for the active 
layer or selection. This tool is easy to use, but relatively unsophisticated. The Levels and 
Curve tools allow you to make the same types of adjustments, but also give you the 
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ability to treat bright colors differently from darker colors. Generally speaking, the BC tool 
is great for doing a "quick and dirty" adjustment in a few seconds, but if the image is 
important and you want it to look as good as possible, you will use one of the other tools. 

In GIMP 2.4, a new way of operating this tool has been added: by clicking the mouse 
inside the image, and dragging while keeping the left mouse button down. Moving the 
mouse vertically changes the brightness; moving horizontally changes the contrast. When 
you are satisfied with the result, you can either press the "OK" button on the dialog, or hit 
the Return key on your keyboard. 

Activate Tool
The Brightness-Contrast Tool can be called from an image menu: Tools Color Tools 
Brightness-Contrast . If you find yourself using this tool often, you can add it to the 
Toolbox using the Tools dialog. 

Options

Threshold Tool
The Threshold tool transforms the current layer or the selection into a black and white 
image, where white pixels represent the pixels of the image whose Value is in the 
threshold range, and black pixels represent pixels with Value out of the threshold range. 

You can use it to enhance a black and white image (a scanned text for example) or to 
create selection masks. 

As this tool creates a black and white image, the anti-aliasing of the original image 
disappears. If this poses a problem, rather use the Levels tool. 

Activate Tool
The Threshold Tool can be called in the following order, from the image-menu: Tools Color 
Tools Threshold, 

or by clicking on the  icon in Toolbox if this tool has been installed in it. You can do that 
through the Tool dialog. 

Options

 

Using Threshold and Quick Mask to create a selection mask 
That's not always the case, but an element you want to extract from an image can stand 
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out well against the background. In this case, you can use the Threshold tool to select this 
element as a whole. Grokking the GIMP described a method based on a channel mask, 
but now, using the Quick mask is easier. 

First start decomposing you image into its RGB and HSV components by using the 
Decompose filter. A new grey-scaled image is created and the components are displayed 
as layers in the Layer Dialog. These layers come with a thumbnail but it is too small for an 
easy study. You can, of course, increase the size of this preview with the dialog menu (the 
small triangular button), but playing with the "eyes " is more simple to display the wanted 
layer in the decompose image. Select the layer that isolates the element the best. 

 

 

 

Call the Threshold tool from the decompose image. By moving the black cursor, fit 
threshold to isolate the best the element you want to extract. This will probably not be 
perfect: we will enhance the result with the selection mask we are going to create. 

Make sure you have selected the right layer when you call the Threshold tool: when it is 
opened, you can't change to another layer. 
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Make sure the image displaying the selected layer is active and copy it to the clipboard 
with CtrlC. 

Now, make the original image active. Click on the Quick Mask button at the bottom-left 
corner of the image window: the image gets covered with a red (default) translucent 
mask. This red color does not suit well to our image with much red: go to the Channel 
Dialog, activate the "Quick mask" channel and change this color with the Edit Channel 
Attributs. Come back to the original image. Press CtrlV to paste the previously copied 
layer. 

 

Voilà. Your selection mask is ready: you can improve the selection as usually. When the 
selection is ready, disable the Quick mask by clicking again on its button: you will see the 
marching ants around the selection. 

 
 

GNU Image Manipulation Program
Generated by docbook2odf

Page 143 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

We used the Zoom to work at a pixel level, the Lasso to remove large unwanted areas,the 
pencil (to get hard limits), black paint to remove selected areas, white paint to add 
selected areas, especially for stem. 

Levels tool 
The Level tool provides features similar to the Histogram tool but can also change the 
intensity range of the active layer or selection. 

Activate Tool 
You can call the Level Tool in the following order, from the image-menu: Tools Color Tools 
Levels 

Options 

 

Although this tool is not present in Tool box, nevertheless it has a Tool Option Dialog 
under the Toolbox. These options are described here: 
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Curves Tool
The Curves tool is the most sophisticated tool used to adjust the tonality of images. 

Activate Tool
The Curves Tool can be called in the following order, from the image-menu: Tools/ Color 
Tools/Curves . 

Adjust Color Curves

 

Although this tool is not present in Tool box, nevertheless it has a Tool Option Dialog 
under the Toolbox. These options are described here: 

Posterize Tool
This tool is designed to intelligently weigh the pixel colors of the selection or active layer 
and reduce the number of colors while maintaining a semblance of the original image 
characteristics. 

Activate Tool
The Posterize Dialog can be called in the following order, from the image-menu: Tools 
Color Tools Posterize 

or by double-cliking on the  icon in ToolBox, if Color Tools have been added to it. 
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Options
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Other

Path Tool

 

The Path tool allows to create complex selections called Bezier Curves, a bit like Lasso but 
with all the adaptability of vectorial curves. You can edit your curve, you can paint with 
your curve, or even save, import, and export the curve. You can also use paths to create 
geometrical figures. Paths have their own dialog box: Dialog. 

Activate Tool
• You can call the Path Tool in the following order, from the image-menu: Tools Paths . 

• The Tool can also be called by clicking the tool icon:  

• or by using the B keyboard shortcut. 

Key modifiers (Defaults)

Options
See The "Path" concept. 

Color Picker Tool
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The Color Picker Tool is used to select a color on the active layer. By clicking a point on a 
layer, you can change the active color to that which is located under the pointer. The 
Sample Merge option lets you grab the color as it is in the image, resulting of the 
combination of all layers. 

Activate Tool
• The Color Picker Tool can be called in the following order, from the image-menu: 

Tools Color Picker. 

• The Tool can also be called by clicking the tool icon:  

If you hold Ctrl key down while using a paint tool, mouse pointer turns to the color-
picker icon. If you click then, you select the color pointed by the color-picker as 
foreground color. Color-picker dialog is not opened during this operation. 

Key modifiers (Defaults)

Options

 

Magnify Tool

 

The Magnify Tool is used to change the zoom level of your working image. If you only click 
on the image, the zoom is applied to the whole image. But you can also click-and-drag 
the mouse pointer to create a zoom rectangle. Then, the action of this rectangle is better 
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understood if the "Allow window resizing" option is unchecked: you can see that the 
content of this rectangle will be enlarged or reduced so that its biggest dimension fit the 
corresponding dimension of the image window (if the biggest dimension of the rectangle 
is width, then it will fit the width of the image window). 

Activate Tool
• The Magnify Tool can be called in the following order, from the image-menu: Tools 

Magnify . 

• The Tool can also be called by clicking the tool icon:  

Key modifiers (Defaults)

Options

 

Zoom menu 
Using the Magnify tool is not the only way to zoom an image. The Zoom menu provides 
access to several functions for changing the image magnification level. For example, you 
can easily choose an exact magnification level from this menu. 

Measure Tool

 

The Measure Tool is used to gain knowledge about pixel distances in your working image. 
By clicking and holding the mouse button, you can determine the angle and number of 
pixels between the point of click and where the mouse pointer is located. The information 
is displayed on the status bar or can also be displayed in the Info Window. 

When you pass the mouse pointer over the end point it turns to a move pointer. Then if 
you click you can resume the measure. 
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Status Bar
Informations are displayed in the status bar, at the bottom of the Image window. The 
status bar shows a pair of numbers. The first number is the distance between the origine 
point and the mouse pointer. Mostly the measure unit is shown as Pixel. The second 
number is the angle in every quadrant, from 0° to 90°. 

Activate Tool
• You can call the Measure Tool in the following order, from the image-menu: Tools 

Measure . 

• You can also access to it by clicking the tool icon:  

Key modifiers

Options

Measuring surfaces 
You can't measure surfaces directly, but you can use the Histogram that gives you the 
number of pixels in a selection. 

Texttool

 

The Text tool places text into an image. When you click on an image with this tool the 
Text Editor dialog is opened where you can type your text, and a text layer is added in the 
Layer Dialog. In the Text Option dialog, you can change the font, color and size of your 
text, and justify it, interactively. 

Activate Tool 
• The Text Tool can be called in the following order, from the image-menu: Tools Text . 

• The Tool can also be called by clicking the tool icon:  

• or by using the T keyboard shortcut. 

Options 
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Text Editor 
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Color and Indicator Area 

Color Area 

 

Indicator Area 

 

This part of the Toolbox shows the currently selected brush, pattern, and gradient. 
Clicking on any of them brings up a dialog that allows you to change it. 

Active image area 
A thumbnail of the active image can be displayed in this area if the "Display Active 
Image" option is checked in Preferences/Toolbox. 
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Chapter
Dialogs 
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Dialog introduction 
Dialogs are the most common means of setting options and controls in the GIMP. The 
most important dialogs are explained in this section. 
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Image structure related dialogs 

Layers dialog 

 

The Layers dialog is the main interface to edit, modify and manage your layers. You can 
think of layers as a stack of slides or clothes on your body. Using layers, you can 
construct an image of several conceptual parts, each of which can be manipulated 
without affecting any other part of the image. Layers are stacked on top of each other. 
The bottom layer is the background of the image, and the components in the foreground 
of the image come above it. 

  

  

Activate Dialog 
The Layer dialog can be called in many ways :

• from the toolbox-menu: File Dialog Layers 

• from the image-menu: Dialog Layers 

• from an other dialog-menu: Add Tab Layers 

• from the (default) shortcut: CtrlL 

Using the Layerdialog 
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Layer masks 

 

Channels dialog 

 

The Channels dialog is the main interface to edit, modify and manage your channels. 
Channels have a double usage. This is why the dialog is divided into two parts: the first 
part for color channels and the second part for selection masks. 

Color channels: Color channels apply to the image and not to a specific layer. Basically, 
three primary colors are necessary to render all the wide range of natural colors. As other 
digital software, the Gimp uses Red, Green, and Blue as primary colors. The first and 
primary channels display the Red, Green, and Blue values of each pixel in your image. In 
front of each channel is a thumbnail displaying a grayscale representation of each 
channel, where white is 100% and black is 0% of the primary color. Alternatively, if your 
image is not a colored but a Grayscale image, there is only one primary channel called 
Gray. For an Indexed image with a fixed number of known colors there is also only one 
primary channel called Indexed. Then there is a optional channel called Alpha. This 
channel displays transparency values of each pixel in your image. In front of this channel 
is a thumbnail displaying a grayscale representation of the transparency where white is 
opaque and visible, and black is transparent and invisible. If you create your image 
without transparency then the Alpha channel is not present, but you can add it from the 
Layers dialog menu. Also, if you have more than one layer in your image, Gimp 
automatically creates an Alpha channel. 
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Gimp doesn't support CMYK or YUV color models.

 

The right image is decomposed in three color channels (red, green, and blue) and the 
Alpha channel for transparency. On the right image the transparency is displayed as a 
gray checkerboard. In the color channel white is always white because all the colors are 
present and black is black. The red hat is visible in the red channel but quite invisible in 
the other channels. This is the same for plain green and blue which are visible only in 
their own channels and invisible in others. 

Calling the Dialog 
The Channel dialog can be activated in many ways :

• from the toolbox-menu: File Dialogs Channels 

• from the image-menu: Dialogs Channels 

• from another dialog-menu: Add Tab Channels 

Using the Channeldialog 

Overview 

The top channels are the color channels and the optional Alpha channel. They are always 
organized in the same order and they cannot be erased. Selection masks are described 
below and displayed as a list in the dialog. Every channel appears in the list in form of a 
thumbnail. A right-click in a channel thumbnail opens the channel menu. 

Channel attributes 

Every channel is shown in the list with its own attributes. The main attribute is the 
name of the channel itself. You can edit selection masks by double-clicking on their 

name. A double_click on the thumbnail opens a full dialog where you can also set the 
visual aspect of the channel in the image window. In front of the thumbnail there is an 
eye icon:  by clicking on it you define whether the channel is visible or not. As a result of 
this visibility, the view of the image changes in the image window and a white image 
becomes yellow if you remove the view of the blue because yellow is the complementary 
color for blue. If you remove the view of the Alpha channel, everything becomes 
transparent and nothing else than a grey checkerboard is visible. The aspect of this 
virtual background can be changed in the Preferences. The chain icon  enables grouping 
of channels for operations on multiple channels. 

Activated channels appear highlighted in blue in the dialog. If you click on a channel in 
the list you toggle activation of the corresponding channel. Disabling a color channel red, 
blue, or green has severe consequencies. For instance if you disable the blue channel, all 
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pixels from now on added to the image will not have blue component, and so a white 
pixel will have the yellow complementary color. 

Managing channels 

Under the channel list is a set of buttons allowing you to perform some basic operations 
on channel list. 

Channels Menu 

 

Selection masks 

 

Channels can be used to save and restore your selections. Clicking on the Quick mask 
button on the Image window automatically creates a new channel called Qmask and 
saves the displayed active selection to a thumbnail in front of the channel.There are 
many selection tools in the Gimp like rectangular selection tool or fuzzy selection for 
continuous selections. Selection Masks are a graphical way to build selections into a gray 
level channel where white pixels are selected and black pixels are not selected. Therefore 
gray pixels are partially selected. You can think of them as feathering the selection, a 
smooth transition between selected and not selected. This is important to avoid the ugly 
pixelization effect when you fill the selection or when you erase its content after isolating 
a subject from background. 
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Using Selectionmasks 

Once the channel is initialized, selected (highlighted in blue), visible (eye-icon in the 
dialog), and displayed as you want (color and opacity attributes), you can start to work 
with all the paint tools. The colors used are important. If you paint with some color other 
than white, grey, or black, the color Value (luminosity) will be used to define a gray 
(medium, light, or dark). When your mask is painted, you can transform it to a selection 
by clicking on the Channel to selection button or from the context menu. 

You can work in selection masks not only with the paint tool but also with other tools. For 
instance, you can use the selection tools to fill areas uniformly with gradients or patterns. 
By adding many selection masks in your list you can easily compose very complex 
selections. One can say that a selection mask is to a selection as a layer is to an image. 

As long as a selection mask is activated you are working in the mask and not in the 
image. To work in the image you have to deactivate all selection masks. Don't forget also 
to stop displaying masks in the image by removing the eye icon. Check also that all RGB 
and Alpha channels are activated and displayed in the image. 

Quick Mask 

 

A Quick Mask is a Selection Mask intended to be used temporarily to paint a selection. 
Temporarily means that, unlike a normal selection mask, it will not be saved in the list 
after its transformation to selection. The selection tools sometimes show their limits when 
they have to be used for doing complex drawing selection, as progressive. In this case, 
using the QuickMask is a good idea which can give very good results. 

Activate Tool 

• The QuickMask can be activated in the following order, from the image-menu: 
Select/Toggle QuickMask. 

• The QuickMask can also be activated by clicking the left-bottom button showed in 
red on the screenshot. 

• It can also be activated by using Shift+Q shortcut. 

Creating a Quick Mask 

To initialize a Quick Mask, click the bottom-left button in the image window. If a 
selection was active in your image, then its content appears unchanged while the 

border is covered by a tranlucent red color. If no selection was active then all the image is 
covered by a tranlucent red color. At every moment you can hide the maskby clicking on 
the eye icon  in front of the QMask. From the channel dialog you can double click on the 
name or the thumbnail to edit the QMask attributes. Then you can changethe Opacity and 
its filling color. Once a quick mask is initialized click on it to be sure it is selected and blue 
highlighted in the list, and start to paint on it with any Gimp paint tool. The mask is coded 
in gray tones, so you must use white or gray to decrease the area limited by the mask 
and black to increase it. The area painted in light or dark gray will be transition areas for 
the selection like feathering. When your mask is ready, click again on the bottom-left 
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button in the image window and the quick maskwill be removed from the channel list and 
converted to aselection. Quick mask's purpose is to paint a selection and its transitions 
with the paint tools without worrying about managing selection masks. It's a good way to 
isolate asubject in a picture because once the selection is made you only have to remove 
its content (or inverse if the subject is in the selection). 

Using Quick Mask's 

Screenshot of the image window with activated QuickMask. The QuickMask is filled with a 
gradient from black (left) to white (right). 

The QuickMask is now disabled and a selection is initialised from the QuickMask, which 
was filled by a gradient before. You see the selection borders in the middle of the image. 

A stroke is now added during the enabled selection. The key is, that the black color will 
have no opacity of the resulting stroke (right) and white color will have a full opacity of 
the stroke (left). 

After the QuickMask Button is pressed, the command generates a temporary 8-bit (0-255) 
channel, on which the progressive selection work is stored. If a selection is already 
present the mask is initialized with the content of the selection. Once QuickMask has 
been activated, the image is covered by a red semi-transparent veil. This one representes 
the non-selected pixels. Any paint tool can be used to create the selection on the 
QuickMask. They should use only greyscale color, conforming the channel properties, 
white enabling to define the future selected place. The selection will be displayed as soon 
as the QuickMask will be toggled but its temporary channel will not be available anymore. 

To save in a channel the selection done with the Quickmask select in the image menu 
Select/Save to Channel 

Usage 

Open an image or begin a new document. 

Activate the Quickmask using the left-bottom button in the image window. If a selection is 
present the mask is initialized with the content of the selection. 

Choose a drawing tool and use it with greyscale colors on the QuickMask. 

Deactivate the Quickmask using the left-bottom button in the image window. 

Path dialog 

 

The Paths dialog is used to manage paths, allowing you to create or delete them, save 
them, convert them to and from selections, etc. 
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The Paths dialog is a dockable dialog; see the section on Dialogs and Docking for help on 
manipulating it. It can be activated in several ways: 

Dialog call 
• From the Toolbox menu: File Dialogs Paths . 

• From the Toolbox menu: File Dialogs Create New Dock Layers, Channels, and Paths . 
This gives you a dock containing three dialogs, with the Paths dialog one of them. 

• From an image menu: Dialogs Paths . 

• From the Tab menu in any dockable dialog: Add Tab Paths . 

Using the Paths dialog 
Each path belongs to one image: paths are components of images just like layers. The 
Paths dialog shows you a list of all paths belonging to the currently active image: 
switching images causes the dialog to show a different list of paths. If the Paths dialog is 
embedded in a "Layers, Channels, and Paths" dock, you can see the name of the active 
image in the Image Menu at the top of the dock. (Otherwise, you can add an Image Menu 
to the dock by choosing "Show Image Menu" from the Tab menu.) 

If you are familiar with the Layers dialog, you have a head start, because the Paths dialog 
is in several ways similar. It shows a list of all paths that exist in the image, with four 
items for each path: 

If the list is non-empty, at any given moment one of the members is the image's active 
path, which will be the subject of any operations you perform using the dialog menu or 
the buttons at the bottom: the active path is shown highlighted in the list. Clicking on any 
of the entries will make it the active path. 

Right-clicking on any entry in the list brings up the Paths Menu. You can also access the 
Paths Menu from the dialog Tab menu. 

Buttons 
The buttons at the bottom of the Paths dialog all correspond to entries in the Paths menu 
(accessed by right-clicking on a path list entry), but some of them have extra options 
obtainable by holding down modifier keys while you press the button. 

Paths Menu 
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The Paths menu can be brought up by right-clicking on a path entry in the list in the Paths 
dialog, or by choosing the top entry ("Paths Menu") from the Paths dialog Tab menu. This 
menu gives you access to most of the operations that affect paths. 

Colormap dialog 

 

The Colormap (Indexed Palette is a better name) dialog allows you to edit the colormap of 
an indexed image. (If the mode of the active image is RGB or Grayscale instead of 
Indexed, the dialog is empty and unusable.) This is a dockable dialog; see the section on 
Dialogs and Docking for help on manipulating it. It can be activated in two ways: 

Dialog call 
• From the Toolbox menu: File Dialogs Colormap 
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• From the image menu: Dialogs Colormap 

Colormaps and Indexed Images 
In an Indexed image, colors are assigned to pixels by an indirect method, using a lookup 
table called a colormap. In GIMP, the maximum number of entries in a colormap is 256. 
For a maximum-sized colormap, each index from 0 to 255 is assigned an arbitrary RGB 
color. There are no rules restricting the colors that can be assigned to an index or the 
order they appear in: any index can be assigned any color. 

In an Indexed image, instead of being assigned a color directly (as happens in RGB and 
Grayscale images), each pixel is assigned an index. To determine the color that should be 
shown for that pixel, GIMP looks up the index in the image's colormap. Each indexed 
image has its own private colormap. 

It is important to realize that the colors in the colormap are the only colors available for 
an indexed image (that is, unless you add new colors to the colormap). This has a major 
effect on many gimp operations: for example, in a pattern fill, GIMP will usually not be 
able to find exactly the right colors in the colormap, so it will approximate them by 
Dithering. If the colormap is too limited or poorly chosen, this can easily produce very 
poor image quality. 

The Colormap dialog allows you to alter the colormap for an image, either by creating 
new entries, or by changing the colors for the existing entries. If you change the color 
associated with a given index, you will see the changes reflected throughout the image, 
as a color shift for all pixels that are assigned that index. The entries are numbered with 0 
in the upper left corner, 1 to its right, etc. 

Using the Colormap dialog 
Here are the operations you can perform using this dialog: 

If you make a mistake, you can undo it by focusing the pointer in the image whose 
colormap you have changed, and then pressing Ctrl-Z or choosing Edit Undo in the image 
menu. 

This dialog provides the most commonly used methods for altering the colormap for an 
indexed image. The color tools, such as Brightness/Contrast, Hue/Saturation, etc, do not 
operate on indexed images. There are a few plug-ins that do so, including the 
"Normalize", "Color Enhance", and "Stretch Contrast" operations, and it is possible to 
create others as well. 

Histogram dialog 
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The Histogram dialog shows you information about the statistical distribution of color 
values in the image that is currently active. This information is often useful when you are 
trying to color balance an image. However, the Histogram dialog is purely informational: 
nothing you do with it will cause any change to the image. If you want to perform a 
histogram-based color correction, use the Levels tool. 

Dialog call 
This is a dockable dialog; see the section on Dialogs and Docking for help on 
manipulating it. It can be activated in two ways: 

• From the Toolbox menu: File Dialogs Histogram 

• From the image menu: Dialogs Histogram 

About Histograms 
In GIMP, each layer of an image can be decomposed into one or more color channels: for 
an RGB image, into R, G, and B channels; for a grayscale image, into a single Value 
channel. Layers that support transparency have an additional channel, the alpha channel. 
Each channel supports a range of intensity levels from 0 to 255 (integer valued). Thus, a 
black pixel is encoded by 0 on all color channels; a white pixel by 255 on all color 
channels. A transparent pixel is encoded by 0 on the alpha channel; an opaque pixel by 
255. 

For RGB images, it is convenient to define a Value "pseudochannel". This is not a real 
color channel: it does not reflect any information stored directly in the image. Instead, the 
Value at a pixel is given by the equation V = max(R,G,B). Essentially, the Value is what 
you would get at that pixel if you converted the image to Grayscale mode. 

For more information on channels, please consult the Working with Images section. 

Using the Histogram dialog 

Navigation Dialog 

 

The Navigation dialog is designed to offer easy movement around the active image if the 
zoom is set higher than what the image window can display. If this is the case, there is an 
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inversely colored rectangle that shows the location of the current view area in respect to 
the image. This rectangular outline can be dragged to change the viewing region. 

Activate the dialog 
The Navigation window dialog can be called in many ways : 

• from the toolbox-menu: File/ Dialogs/ Navigation 

• from the image-menu: Dialogs/ Navigation 

• from the image-menu: View/ Navigation window, the Shift+Ctrl+N will call the 
Navigation Window. 

• from another dialog-menu: Add Tab/ Navigation 

You can access more quickly to it (but without the zoom functions) by clicking on the 
icon, at the right bottom corner of the image window. 

Using the Navigation Dialog 

Undo History dialog 

 

This dialog shows you a list of the actions you have most recently performed on an 
image, with a small sketch that attempts to illustrate the changes produced by each. You 
can revert the image to any point in its Undo History simply by clicking on the right entry 
in the list. For more information on GIMP's Undo mechanism and how it works, see the 
section on Undoing. 

Activate the dialog 
The Undo History dialog is a dockable dialog; see the section on Dialogs and Docking for 
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help on manipulating it. It can be activated in several ways: 

• From the Toolbox menu: File Dialogs Undo History . 

• From the Toolbox menu: File Dialogs Create New Dock Layers, Channels, and Paths . 
This gives you a dock containing four dialogs, with the Undo History dialog one of 
them. 

• From an image menu: Edit Undo History . 

• From an image menu: Dialogs Undo History . 

• From the Tab menu in any dockable dialog: Add Tab Undo History . 

Using the Undo History dialog 
The most basic thing you can do is to select a point in the Undo History by clicking on it in 
the list. You can go back and forth between states in this way as much as you please, 
without losing any information or consuming any resources. In most cases, the changes 
are very fast. 

At the bottom of the dialog are three buttons:
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Image content related dialogs 

Colors dialog 

 

The Channel dialog lets you manage and pick up new colors. It is divided into five 
separate parts: GIMP, CMYK, Triangle, Watercolor and Scales. You can use the eyedropper, 
which is the last button of the dialog, to pick up a color anywhere on your screen. 

Activate Dialog 
The dialog can be called in the following ways : 

• from the toolbox-menu: File Dialogs Colors 

• from the toolbox: click on the current Foreground or Background color. 

• from the image-menu: Dialogs Colors 

• from an other dialog-menu: Add Tab Colors 

Using the dialog 

Brushes dialog 
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The Brushes dialog is used to select a brush, for use with painting tools: see the Brushes 
section for basic information on brushes and how they are used in GIMP. The dialog also 
gives you access to several functions for manipulating brushes. You can select a brush by 
clicking on it in the list: it will then be shown in the Brush/Pattern/Gradient area of the 
Toolbox. A few dozen basic brushes come pre-installed with GIMP, along with a few 
assorted bizarre ones that mainly serve to show you the range of possibilities. You can 
also create custom brushes using the Brush Editor, or by saving images in a special brush 
file format. 

Activate Dialog 
The Brushes dialog is a dockable dialog; see the section on Dialogs and Docking for help 
on manipulating it. It can be activated in several ways: 

• From the Toolbox menu: File Dialogs Brushes . 

• From the Toolbox menu: File Dialogs Create New Dock Brushes, Patterns, and 
Gradients . This gives you a dock containing three dialogs, with the Brushes dialog 
one of them. 

• From the Toolbox, by clicking on the brush symbol in the Brush/Pattern/Gradient 
area. 

• From an image menu: Dialogs Brushes . 

• From the Tab menu in any dockable dialog: Add Tab Brushes . 

• From the Tool Options dialog for any of the paint tools, by clicking on the Brush icon 
button, you get a popup with similar functionality that permits you to quickly choose 
a brush from the list; if you clic on the button present on the right botton of the 
popup, you open the real brush dialog. Note that, depending on your Preferences, a 
brush selected with the popup may only apply to the currently active tool, not to 
other paint tools. See the Tool Option Preferences section for more information. 

Using the brush dialog 
The functions performed by these buttons can also be accessed from the dialog pop-up 
menu, activated by right-clicking anywhere in the brush grid/list, or by choosing the top 
item, Brushes menu, from the dialog Tab menu. 

Brush Editor 
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The Brush Editor allows you either to view the brush parameters of a brush supplied by 
GIMP, and you can't change them, or to create a custom brush from a geometrical shape, 
a circle, a square, a diamond. This editor has several elements: 

The dialog bar: As with all dialog windows, a click on the small triangle prompts a menu 
allowing you to set the aspect of the Brush Editor. 

The title bar: To give a name to your brush. 

The preview area: Brush changes appear in real time in this preview. 

Settings:

Patterns dialog 

 

In GIMP, a pattern is a small image used to fill areas by placing copies of side by side. See 
the Patterns section for basic information on patterns and how they can be created and 
used. 

You can use them with Bucket Fill et Clone tools and the Fill with pattern command. 
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The Patterns dialog is used to select a pattern, by clicking on it in a list or grid view: the 
selected pattern will then be shown in the Brush/Pattern/Gradient area of the Toolbox. A 
few dozen more or less randomly chosen patterns are supplied with GIMP, and you can 
easily add new patterns of your own. 

Activate Dialog 
The Patterns dialog is a dockable dialog; see the section on Dialogs and Docking for help 
on manipulating it. It can be activated in several ways: 

• From the Toolbox menu: File Dialogs Patterns . 

• From the Toolbox menu: File Dialogs Create New Dock Brushes, Patterns, and 
Gradients . This gives you a dock containing three dialogs, with the Patterns dialog 
one of them. 

• From the Toolbox, by clicking on the pattern symbol in the Brush/Pattern/Gradient 
area. 

• From an image menu: Dialogs Patterns . 

• From the Tab menu in any dockable dialog: Add Tab Patterns . 

• From the Tool Options dialog for the Clone tool, by clicking on the Pattern icon 
button. This option appears because the Clone tool is capable of painting with 
patterns. 

Using the pattern dialog 

Gradients dialog 

 

The Gradients dialog offers a gradient palette which is used to select a gradient -- a set of 
colors arranged in a linear scale -- for use with the Blend tool and numerous other 
operations. It also gives you access to several functions for manipulating gradients. You 
can select a gradient by clicking on it in the list: it will then be shown in the 
Brush/Pattern/Gradient area of the Toolbox. A few dozen nice gradients come pre-installed 
with GIMP. You can create more using the Gradient Editor. General information about 
gradients and how they are used in GIMP can be found in the Gradients section. 

The first four gradients are particular: they reproduce the gradient between Foreground 
and background colors of toolbox in different ways. 

Activate Dialog 
The Gradients dialog is a dockable dialog; see the section on Dialogs and Docking for help 
on manipulating it. It can be activated in several ways: 
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• From the Toolbox menu: File Dialogs Gradients . 

• From the Toolbox menu: File Dialogs Create New Dock Brushes, Patterns, and 
Gradients . This gives you a dock containing three dialogs, with the Gradients dialog 
one of them. 

• From the Toolbox, by clicking on the current gradient in the Brush/Pattern/Gradient 
area. 

• From an image menu: Dialogs Gradients . 

• From the Tab menu in any dockable dialog: Add Tab Gradients . 

• From the image by using the G shortcut. 

Using the Gradients dialog 
The most basic, and most commonly used, operation with the dialog is simply to click on 
one of the gradients in the scrollable list, in order to make it GIMP's current gradient, 
which will then be used by any operation that involves a gradient. 

If you double-click on a gradient, you open the Gradient Editor where you will be able to 
edit its name. Note, however, that you are only allowed to change the names of gradients 
that you have created yourself, not the ones that come pre-installed with GIMP. If you try 
to rename a pre-installed gradient, you will be able to edit the name, but as soon as you 
hit return or click somewhere else, the name will revert to its original value. It is a general 
rule that you cannot alter the resources that GIMP pre-installs for you: brushes, patterns, 
gradients, etc; only ones that you create yourself. 

The buttons at the bottom of the dialog allow you to operate on gradients in several 
ways: 

The functions performed by these buttons can also be accessed from the dialog pop-up 
menu, activated by right-clicking anywhere in the gradient list. The menu also gives you 
one additional function: 

Gradient Editor 

 

The Gradient Editor allows you to edit the colors in a gradient. It can only be used on 
gradients you have created yourself (or on a copy of a system gradient), not on system 
gradients that come pre-installed with GIMP. This is a sophisticated tool that may take a 
bit of effort to understand. The concept behind it is that a gradient can be decomposed 
into a series of adjoining segments, with each segment consisting of a smooth transition 
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from the color on the left edge to the color on the right edge. The Gradient Editor allows 
you to pack together any number of segments, with any colors you want for the left and 
right edges of each segment, and with several options for the shape of the transition from 
left to right. 

How to Activate the Gradient Editor 

You can activate the Gradient Editor in several ways: 

• By double-clicking on the gradient stripe in the Gradient dialog. 

• From the context menu you get by right clicking on the selected gradient name. 

• By clicking on the Edit gradient button in the Gradient Dialog. 

• From the Gradient Menu you get by clicking on the small triangle representing the 
Tab Menu in the Gradient Dialog. 

Display 

Gradient Editor Menu 

 

You can access the Gradient Editor menu either by right-clicking on the gradient display, 
or by choosing the top item in the dialog's tab menu. The menu allows you to set the left 
and right edge colors for each segment, and control the transition from one color to the 
other. 

The following commands can be found in the menu: 

There is no "undo" available within the Gradient Editor, so be careful! 

Palettes 
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A palette is a set of discrete colors, in no particular order. See the Palettes section for 
basic information on palettes and how they can be created and used. 

The Palettes dialog is used to select a palette, by clicking on it in a list or grid view. A few 
dozen more or less randomly chosen palettes are supplied with GIMP, and you can easily 
add new palettes of your own. The Palettes dialog also give you access to several 
operations for creating new palettes or manipulating the ones that already exist. 

The Palettes dialog is not the same thing as the Index Palette dialog, which is used to 
manipulate the colormaps of indexed images. 

Activate Dialog 
The Palettes dialog is a dockable dialog; see the section on Dialogs and Docking for help 
on manipulating it. It can be activated in several ways: 

• From the Toolbox menu: File Dialogs Palettes . 

• From an image menu: Dialogs Palettes . 

• From the Tab menu in any dockable dialog: Add Tab Palettes . 

Using the Palettes dialog 
Clicking on a palette in the dialog makes it GIMP's active palette. This does not really 
have any significance, though. Double-clicking on a palette brings up the Palette Editor, 
which allows you to set GIMP's foreground or background colors by clicking on colors in 
the palette display. 

Double-clicking on a palette name (in List View mode) lets you to edit the name. Note 
that you are only allowed to change the names of palettes that you have added yourself, 
not those that are supplied with GIMP. If you edit a name that you are not allowed to 
change, it will revert back to its previous value as soon as you hit return or move the 
pointer focus elsewhere. 

Palettes Menu 
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The Palettes Menu can be accessed by right-clicking in the Palettes dialog, or by choosing 
the top item from the dialog Tab menu. 

Palette Editor 

 

The Palette Editor is used mainly for two purposes: first, for setting GIMP's foreground or 
background colors (as shown in the Color Area of the Toolbox) to selected colors from the 
palette; second, for modifying the palette. You can activate the Palette Editor for any 
palette in the Palettes dialog, but you can only modify palettes that you have created 
yourself, not the palettes that are supplied when you install GIMP. (You can, however, 
duplicate any palette and then edit the newly created copy.) If you modify a palette, the 
results of your work will automatically be saved when you exit from GIMP. 

How to Activate the Palette Editor 

The Palette Editor is only accessible from the Palettes dialog: you can activate it by 
double-clicking on a palette, or by pressing the "Edit Palette" button at the bottom, or by 
choosing "Edit Palette" from the Palettes Menu. 

The Palette Editor is a dockable dialog; see the section on Dialogs and Docking for help on 
manipulating it. 

Using the Palette Editor 

If you click on a color box in the palette display, GIMP's foreground color will be set to the 
selected color: you can see this in the Color Area of the Toolbox. If you hold down the Ctrl 
key while clicking, GIMP's background color will be set to the selected color. 

Double-clicking on a color not only sets the foreground, it also brings up a color editor 
that allows you to modify the selected palette entry. (This only happens if the palette is 
one you are allowed to modify: that is, one you have added to GIMP yourself.) 

Right-clicking in the palette display area brings up the Palette Editor menu. It's functions 
are mainly the same as those of the buttons at the bottom of the dialog. 

Below the palette display area, at the left, appears a text entry area that shows the name 
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of the selected color (or "Unnamed" if it does not have one). This information has no 
functional significance, and is present only to serve you as a memory aid. 

To the right of the name entry is a spinbutton that allows you to set the number of 
columns used to display the palette. This only affects the display, not how the palette 
works. If the value is set to 0, a default will be used. 

At the bottom of the dialog are a set of buttons, which mostly match the entries in the 
Palette Editor menu, accessible by right-clicking in the palette display area. Here are the 
buttons: 

Palette Editor Menu 

 

The Palette Editor Menu can be accessed by right-clicking on the palette display in the 
Palette Editor, or by choosing the top entry from the dialog Tab menu. The operations in it 
can also be executed using the buttons at the bottom of the Palette Editor dialog. 

Fonts dialog 

 

The Fonts dialog is used for selecting fonts for the Text tool. It also allows you to refresh 
the list of available fonts, if you add new ones to your system while GIMP is running. 

Activate Dialog 
The Fonts dialog is a dockable dialog; see the section on Dialogs and Docking for help on 
manipulating it. It can be activated in several ways: 

• From the Toolbox menu: File Dialogs Fonts . 

• From the image menu bar: Dialogs Fonts . 

• From the Tab menu in any dockable dialog: Add Tab Fonts . 

• From the Tool Options for the Text tool. If you click on the "Font" button, a Font-
selector pops up. In the lower right corner is a button that, if pressed, brings up the 
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Fonts dialog. 

Using the Fonts dialog 
The most basic thing you can do is to select a font by clicking on it: this font will then be 
used by the Text tool. If instead of clicking and releasing, you hold down the left mouse 
button with the pointer positioned over the font example ("Aa"), a window showing a 
larger text example will pop up ("Pack my box with five dozen liquor jugs."). 
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Image management related dialogs 

Buffers dialog

 

Buffers are temporary repositories for image data, created when you cut or copy part of a 
drawable (a layer, layer mask, etc.). You can save a document in this buffer in two ways: 
Edit Buffer Copy Named or Edit Buffer Cut Named A dialog pops up asking you to name a 
buffer to store the data in. There is no hard limit on the number of named buffers you can 
create, although, of course, each one consumes a share of memory. 

The Buffers dialog shows you the contents of all existing named buffers, and allows you 
to operate on them in several ways. It also shows you, at the top, the contents of the 
Global Buffer, but this is merely a display: you can't do anything with it. 

The Buffers dialog is a dockable dialog; see the section on Dialogs and Docking for help 
on manipulating it. It can be activated in several ways: 

• From the Toolbox menu: File Dialogs Buffer . 

• From an image menu: Dialogs Buffer , or Edit Buffer Paste Named . 

• From the Tab menu in any dockable dialog: Add Tab Buffer . 

Named buffers are not saved across sessions. The only way to save their contents is to 
paste them into images. 

 

In the Tab menu for the Buffers dialog, you can choose between View as Grid and View as 
List. In Grid mode, the buffers are laid out in a rectangular array. In List mode, they are 
lined up vertically, with each row showing a preview of the contents of the buffer, its 
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name, and its pixel dimensions. 

 

Clicking on a buffer in the display area makes it the active buffer, i. e., the one that will 
be used for paste commands executed with the Buffers Menu or the buttons at the 
bottom of the dialog. Double-clicking on a buffer causes its contents to be pasted to the 
active image; this is a quick way of executing the "Paste Buffer" command. 

At the bottom of the dialog are four buttons. The operations they perform can also be 
accessed from the Buffers Menu that you get by right clicking on the active buffer. 

• Paste Buffer

This command pastes the contents of the selected buffer into the active image, as a 
floating selection. The only difference between this and the ordinary Paste command 
is that it uses the selected buffer rather than the global clipboard buffer. 

• Paste Buffer Into

This command pastes the contents of the selected buffer into the active image's 
selection, as a floating selection. The only difference between this and the ordinary 
Paste Into command is that it uses the selected buffer rather than the global 
clipboard buffer. 

• Paste Buffer as New

This command creates a new single-layer image out of the contents of the selected 
buffer. The only difference between this and the ordinary Paste as New command is 
that it uses the selected buffer rather than the global clipboard buffer. 

• Delete Buffer

This command deletes the selected named buffer, no questions asked. You cannot 
delete the Global Buffer. 

You can change the size of the buffer previews in the dialog using the "Preview Size" 
submenu of the dialog's Tab menu. 

Images dialog 

 

The Images Dialog displays the list of open images on your screen; each of them is 
represented with a thumbnail. This dialog is useful when you have many overlapping 
images on your screen: thus, you can raise the wanted image to foreground. 
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The Images dialog is a dockable dialog; see the section on Dialogs and Docking for help 
on manipulating it. It can be activated in several ways: 

• From the Toolbox menu: File Dialogs Images . 

• From an image menu: Dialogs Images . 

• From the Tab menu in any dockable dialog: Add Tab Ihmages . 

Grid/List modes, Previews size 
As in all dialogs with thumbnails, the Tab menu gives you the possibility of adapting 
thumbnail display to your liking. See Docking 

Using the Images dialog 
At the top of the dialog appears the name of the currently selected image, if the "Show 
Image Selection" option is checked in Tab Menu. Useless if you have selected Grid mode: 
anyway, the name is displayed. 

At center, open images appear, as a list or a grid, according to the selected mode. The 
current image is highlighted in list mode, outlined in grid mode. With a double click. With 
a simple click on an image name, you raise this image to the foreground of your screen. 
With a simple click you select this image so that buttons can act on it. 

• Raise this image's display: The selected image appears at the foreground of your 
screen. 

• Create a new display for this image: Duplicates the image window (not the image) of 
the selected image. 

• Delete: this button is not working. 

Document History dialog 

 

The History Dialog displays the list of the documents you have opened in previous 
sessions. It is more complete than the list you get with the "Open Recent" command. 

Activate Dialog 
You can access to this dialog in different ways: 

• From the toolbox-menu and the image Menu bar: File Open Recent Document 
History 

• From the image Menu-bar: Dialogs Document History 
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Options 
The scroll bar allows you to browse all images you have opened before. 

The Open the selected entry button allows you to open the image you have selected. 
With "Shift" key pressed, it raises an image hidden behind others. With "Ctrl" key pressed, 
it opens the Open Image dialog. 

The Remove the selected entry button allows you to remove an image from the History 
dialog. The image is removed from the recently open images list also. But the image itself 
is not deleted. 

The Recreate Preview button updates preview in case of change. With "Shift" key pressed, 
it acts on all previews. With "Ctrl" key pressed, previews that can't be found out are 
deleted. 

Templates 

Dialog 

 

Templates are templates for an image format to be created. Gimp offers you a lot of 
templates and you can create your owns. When you create a New image, you can access 
to the list of existing templates but you can't manage them. The "Templates" dialog 
allows you to manage all these templates. 

The Templates dialog is a dockable dialog; see the section on Dialogs and Docking for 
help on manipulating it. It can be activated in two ways: 

• From the Toolbox menu: File Dialogs Templates . 

• From an image menu: Dialogs Templates . 

In the Tab menu for the Templates dialog, you can choose between View as Grid and View 
as List. In Grid mode, templates are laid out in a rectangular array of identical icons 
(unless you gave them a particular icon, as we will see later). Only the name of the 
selected template is displayed. In List mode, they are lined up vertically; icons are 
identical too; all names are displayed. 

In this Tab menu, the Preview Size option allows you to change the size of thumbnails. 

Using the Templates dialog 
You select a template by clicking on its icon. Right clicking reveals a local menu that 
offers the same functions as buttons. 

The buttons at the bottom of the dialog allow you to operate on templates in several 
ways: 
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Edit Template 

 

The dialog allows you to set the specifications of the selected template. 

You can access to this editor by clicking on the Edit Template button in the Templates 
dialog. 

The Advanced Options dialog  

These are options that will mainly be of interest to more advanced users. 
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Misc dialogs 

Tools dialog 

 

The Tools dialog is used mainly to control the appearance of the Toolbox. It allows you to 
customize the set of tools for which icons are shown in the Toolbox, and the order in 
which the icons are arranged. Probably the most common use for it is to make the Color 
tools available directly from the Toolbox. You can also use the Tools dialog to select a tool 
by clicking on its symbol, but for this purpose you might as well just use the Toolbox. 

The Tools dialog is a dockable dialog; see the section on Dialogs and Docking for help on 
manipulating it. It can be activated in several ways: 

• From the Toolbox menu: File Dialogs Tools . 

• From an image menu: Dialogs Tools . 

• From the Tab menu in any dockable dialog: Add Tab Tools . 

Grid/List modes 
In the Tab menu, you can choose between View as Grid and View as List. In Grid mode, 
the tools are laid out in a rectangular array. In List mode, they are lined up vertically, with 
each row showing the tool name, tool icon, and an "eye" icon if the tool is currently visible 
in the Toolbox. 

Using the Tools dialog 
The most basic thing you can do is to select a tool by clicking on its icon: this has the 
same effect as clicking on an icon in the Toolbox. You can do this in either List or Grid 
mode: the other functions of the dialog are available only in List mode. 

The most important function of the Tools dialog is to let you choose which tools to make 
visible in the Toolbox, by toggling the "eye" icons that appear on the left side of each row 
in List mode. In particular, if you use the Color tools a lot, you may benefit from toggling 
visibility on for them here. 

You can also change the order of tools in the Toolbox, by clicking on an item in the Tools 
dialog, in List mode, and dragging it up or down in the list. If you screw things up, you can 
always press the "Reset" button at the bottom of the dialog, to restore the defaults for 
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order and visibility. 

Right-clicking inside the dialog produces the Tools menu, which gives you an alternative 
way of toggling visibility or restoring the defaults. 

Preferences 

Introduction 

 

The preferences dialog can be accessed from the Toolbox menu, as File Preferences . It 
lets you customize many aspects of the way GIMP works. The following sections detail the 
settings that you can customize, and what they affect. This information applies 
specifically to Gimp 2.2, but the settings for Gimp 2.0 are similar enough that you should 
be able to understand them based on the explanations here. 

All of the Preferences information is stored in a file called gimprc in your personal GIMP 
directory, so if you are a "power user" who would rather work with a text editor than a 
graphical interface, you can alter preferences by editing that file. If you do, and you are 
on a Linux system, then man gimprc will give you a lot of technical information about the 
contents of the file and what they are used for. 

New Image Preferences 
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This tab lets you customize the default settings for the New Image dialog. See the New 
Image Dialog section for an explanation of what each of the values means. 

Default Image Grid 
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This page lets you customize the default properties of GIMP's grid, which can be toggled 
on or off using View Show Grid from the image menu. The settings here match those in 
the Configure Image Grid dialog, which can be used to reconfigure the grid for an existing 
image, by choosing Image Configure Grid from the image menu. See the Configure Grid 
dialog section for information on the meaning of each of the settings. 

Interface 
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Theme 
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This page lets you select a theme, which determines many aspects of the appearance of 
the GIMP user interface, including the set of icons used, their sizes, fonts, spacing allowed 
in dialogs, etc. Two themes are supplied with GIMP: Default, which is probably best for 
most people, and Small, which may be preferable for those with small or low-resolution 
monitors. Clicking on a theme in the list causes it to be applied immediately, so it is easy 
to see the result and change your mind if you don't like it. 

You can also use custom themes, either by downloading them from the net, or by copying 
one of the supplied themes and modifying it. Custom themes should be places in the 
themes subdirectory of your personal GIMP directory: if they are, they will appear in the 
list here. Each theme is actually a directory containing ASCII files that you can edit. They 
are pretty complicated, and the meaning of the contents goes beyond the scope of this 
documentation, but you should feel free to experiment: in the worst case, if you mess 
things up completely, you can always revert back to one of the supplied themes. 

You cannot edit the supplied themes unless you have administrator permissions, and 
even if you do, you shouldn't: if you want to customize a theme, make a copy in your 
personal directory and work on it. If you make a change and would like to see the result 
"on the fly", you can do so by saving the edited theme file and then pressing Reload 
Current Theme. 

Help System 
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Options

Tool Options 
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Options

Toolbox 
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Options

 

This page lets you customize the appearance of the Toolbox, by deciding whether the 
three "context information" areas should be shown at the bottom. 

Image Windows 
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Options

Image Window Appearance 
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The only parts that may need further explanation are the ones related to padding. 
"Padding" is the color shown around the edges of the image, if it does not occupy all of 
the display area (shown in light gray in all the figures here). You can choose among four 
colors for the padding color: to use the color specified by the current theme; to use the 
light or dark colors specified for checks, such as represent transparent parts of the image; 
or to use a custom color, which can be set using the color button for "Custom padding 
color". 

Image Window Title and Statusbar 
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Choosing a Format

You can choose among several predesigned formats, or you can create one of your own, 
by writing a format string in the entry area. Here is how to understand a format string: 
anything you type is shown exactly as you type it, with the exception of variables, whose 
names all begin with "%". Here is a list of the variables you can use: 

Display 
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Options

 

Input Devices 
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Input Controllers 
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This dialog has two tabs that allow you to assign actions to the mouse wheel and to 
keyboard keys: 

Main Mouse Wheel tab  

You will find an example of these notions in Creating a variable size brush . 

Window Managment 
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This page lets you customize the way windows are handled in GIMP. You should note that 
GIMP does not manipulate windows directly, instead it sends requests to the window 
manager (i. e., to Windows if you are running in Windows; to Metacity if you are running 
in a standard Gnome setup in Linux; etc). Because there are many window managers, and 
not all of them are well behaved, it cannot be guaranteed that the functions described 
here will actually work as described. However, if you are using a modern, standards-
compliant window manager, they ought to. 

Options

Environment 
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Options

Folders 
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This page allows you to set the locations for two important folders used by GIMP for 
temporary files. The pages below it allow you to customize the locations searched for 
resources such as brushes etc.; see Data Folders for a description that applies to them. 
You can change the folders here by editing the entries, or by pressing the buttons on the 
right to bring up a file chooser window. 

Data Folders 
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GIMP uses several types of resources – such as brushes, patterns, gradients, etc. – for 
which a basic set are supplied by GIMP when it is installed, and others can be created or 
downloaded by the user. For each such resource type, there is a Preference page that 
allows you to specify the search path: the set of directories from which items of the type 
in question are automatically loaded when GIMP starts. These pages all look very much 
the same: the page for brushes is shown to the right as an example. 

By default, the search path includes two folders: a system folder, where items installed 
along with GIMP are placed, and a personal folder, inside your personal GIMP directory, 
where items added by you should be placed. The system folder should not be marked as 
writable, and you should not try to alter its contents. The personal folder must be marked 
as writable or it is useless, because there is nothing inside it except what you put there. 

You can customize the search path with the buttons at the top of the dialog. 

Device Status dialog 
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This window gathers together the current options of Toolbox, for each of your input 
devices: the mouse (named "Core pointer") or either the tablet, if you have one. These 
options are represented by icons: foreground and background colors, brush, pattern and 
gradient. Excepted for colors, clicking on an icon opens the window which lets you select 
another option; the tool-box will be updated when changing. 

In addition, you can add tabs and other dialog by click-and-drag. 

The "Record device status" button at the bottom of the window, seems to have the same 
action as the "Record device status now" option in the Input Devices section in 
preferences. 

Activate Dialog 
You will find this dialog in the Toolbox menu bar through File Dialogs Device Status 

Error Console 
The Error console offers more possibilities than the single "GIMP Message". This is a log of 
all errors occuring while GIMP is running. You can save all this log or only a selected part. 

Activate Dialog 
• You will find this command in the toolbox menu bar through File Dialogs Error 

Console , 

The Error Console Dialog 
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• Clear errors: This button lets you delete all errors in the log.  

• Save all errors: This button lets you save the whole log. You can also select a part of 
the log (by click-and-dragging the mouse pointer or by using the ShiftArrow keys key 
combination) and save only this selected part by pressing the Shift key. 

A dialog window Save Error Log to File lets you choose the name and the destination 
directory of this file: 

 

You will as well find these button actions in the dialog sub-menu by clicking on  . 
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Chapter
Menus 
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Introduction to the GIMP Menus 

 

There are many places in GIMP where you can find menus. The aim of this chapter is to 
explain all the commands that are accessible from the menus in the Toolbox and Image 
windows. All the context menus and the menu entries for the other dialogs are described 
elsewhere in the chapters that describe the dialogs themselves. 

Context Menus 
If you right-click on certain parts of the GIMP interface, a "context menu" opens, which 
leads to a variety of functions. Some places where you can access context menus are: 

• Clicking on an image window displays the Image menu. This is useful when you are 
working in full-screen mode, without a menubar. 

• Clicking on a layer in the Layers Dialog or on a channel in the Channels Dialog 
displays functions for the selected layer or channel. 

• Right-clicking on the image menubar has the same effect as left-clicking. 

• Right-clicking on the title bar displays functions which do not belong to GIMP, but to 
the window manager program on your computer. 

Detachable Submenus 
There is an interesting property associated with some of the menus in GIMP. These are 

any of the menus from the Toolbox menubar and any of their submenus, as well as the 
Image context menu you get by right-clicking on the image window and any of its 
submenus. (You can tell that a menu item leads to a submenu because there is an  icon 
next to it.) When you bring up any of these menus, there is a dotted line at the top of it. 
By clicking on this dotted line, you detach the menu under it and it becomes a separate 
window. 
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Detached submenus originating from the Toolbox are only visible when the Toolbox is 
active. Detached submenus originating from the Image window are actually independent. 
They are always visible, their functions always apply to the current image, and they 
persist when all of the images are closed. You can close a detached submenu by clicking 
on the dotted line again or closing the window from the window manager on your 
computer (often by clicking on an X icon in the upper right corner of the window). 
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Toolbox File Menu 

Toolbox File Menu 

 

The Toolbox is the heart of the GIMP. It contains the most commonly used controls, and 
the highest-level menus. Two of the menus, File and Help, can also be accessed from the 
menubars located above each image display, although their contents are somewhat 
different. The Toolbox is the only place to access the Xtns (Extensions) menu. 

•

•

•

•

•

You may find other entries in this menubar which are not described here. They are not 
part of standard GIMP, but have been added by some of the plug-ins. You can find more 
information about the additional menu entries in the documentation for the plug-ins. 

Acquire 

 

The Acquire submenu of the Toolbox's File menu contains a list of ways you can import 
images into the GIMP. This allows you to import images from sources other than a disk or 
the network, such a screen capture or an image from a scanner. 

Activating the Submenu 
• You can access this command in the Toolbox menu: File Acquire 

Submenu entries 
These commands vary somewhat, depending upon your system, since the GIMP makes 
calls to system functions. 
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The Preferences command 
The File Preferences command displays the Preferences dialog, which lets you alter a 
variety of settings that affect the look, feel, and performance of the GIMP. 

Activating the Command 
• You can access this command in the Toolbox menu bar through File Preferences 

The Dialogs sub-menu 

 

The Dialogs submenu of the Toolbox's File menu contains a list of available dialogs that 
you can use while you are editing an image -- patterns, palettes, brushes, etc. You can 
open and close dialogs as needed, or, if you want them to stay around, you can dock 
them. Dialogs are described in detail in 

Accessing the Dialogs Submenu 
• You can access this submenu in the Toolbox through: File Dialogs 
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Xtns 

Introduction to the Xtns menu 

 

The Xtns menu gets its somewhat cryptic name from the term, "Extensions". Accordingly, 
you will find various commands for managing extensions (also known as "plug-ins") and 
for accessing scripts here. 

Besides the commands presented here, you might find other entries on this menu. They 
are not part of GIMP itself, but are extensions to it. You can find descriptions of their 
capabilities in the documentation for the extensions. 

The Module Manager 
With the Module Manager command, you can show the various extension modules which 
are available and control which of them should be loaded. Modules perform functions 
such as choosing colors and display filtering. Any changes you make to the settings with 
the Module Manager command will take effect the next time you start GIMP. These 
changes affect GIMP's functional capabilities, its size in memory and its startup time. 

Activating the Command 
• You can access this command from the toolbox menubar through Xtns Module 

Manager 

Description of the Module Manager Dialog 
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The scrolled window of the Module Manager shows the loadable modules. You can click on 
the boxes in the Autoload column to check or uncheck them. The directory path for each 
module is shown in the Module path column. Information about the selected module is 
displayed at the bottom of the dialog. 

The Unit Editor 
The Unit Editor command displays a dialog which shows information about the units of 
measurement that are currently being used by GIMP. It also allows you to create new units 
which can be used by GIMP in a variety of situations. 

Activating the Command 
• You can access this command from the toolbox menubar through Xtns Unit Editor> . 

Description of the Unit Editor dialog window 
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The figure above shows the "Unit Editor" dialog window. The list shows the units of 
measurement which are currently defined. You can click on the New button or the 
Duplicate button to create a new measurement unit, as described below. 

Description of the list elements 

• Saved: If this column is checked, a unit definition will be saved when GIMP exits. 
Some units are always kept, even if they are not marked with a check. These are 
highlighted in the list. 

• ID: The string GIMP uses to identify the unit in its configuration files. 

• Factor: How many units make up an inch. 

• Digits: This field is a hint for numerical input fields. It specifies how many decimal 
digits the input field should provide to get approximately the same accuracy as an 
"inch" input field with two decimal digits. 

• Symbol: The unit's symbol if it has one (e.g. " for inches). The unit's abbreviation is 
used if doesn't have a symbol. 

• Abbreviation: The unit's abbreviation (e.g. "cm" for centimeters). 

• Singular: The unit's singular form, which GIMP can use to display messages about 
the unit. 

• Plural: The unit's plural form, which GIMP can use to display messages about the 
unit. 

Defining New Units 

 

You can display the dialog shown above by clicking on either the New button or the 
Duplicate button on the Unit Editor dialog. The input fields on the dialog are described 
above. 

If you click on the New button, the dialog looks as shown. If you click on the Duplicate 
button, the values initially displayed in the input fields of the dialog are the values of the 
unit you have currently selected in the Unit Editor dialog. You can then edit the values to 
create your new unit. 

Plug-In Browser 
The Plug-In Browser command displays a dialog window which shows all of the extensions 
(plug-ins) which are currently loaded in GIMP, both as a list and as a hierarchical tree 
structure. Since many of the filters are actually plug-ins, you will certainly see many 
familiar names here. Please note that you do not run the extensions from this dialog 
window. Use the appropriate menu entry to do that instead. For example, you can run 
filter plug-ins by using the Filter command on the image menubar. 

Activating the Command 
• You can access this command from the toolbox menubar through Xtns Plug-in 

Browser 

Description of the Plug-In Browser dialog window 
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The figure above shows the list view of the Plug-In Browser. You can click on the name of 
a plug-in in the scrolled window to display more information about it. Select the List View 
by clicking on the tab at the top of the dialog. 

You can search for a plug-in by name by entering part or all of the name in the Search: 
text box and clicking on the Search by Name button. The left part of the dialog then 
displays the matches found. 

 

The figure above shows the tree view of the Plug-In Browser. You can click on the name of 
a plug-in in the scrolled window to display more information about it. You can click on the 
arrowheads to expand or contract parts of the tree. Select the Tree View by clicking on 
the tab at the top of the dialog. 

You can search for a plug-in by name by entering part or all of the name in the Search: 
text box and clicking on the Search by Name button. The left part of the dialog then 
displays the matches found. 

Not everything in these huge dialog windows is visible at the same time. Use the scroll 
bars to view their content. 

The Procedure Browser 
The Procedure Browser command displays the procedures in the PDB, the Procedure 
Database. These procedures are functions which are called by the scripts or plug-ins. You 
can find a more detailed description of the PDB in the glossary. The browser is most useful 
for advanced users who write scripts or plug-ins. 

Activating the Command 
• You can access this command from the toolbox menubar through Xtns Procedure 

Browser 

Description of the Procedure Browser dialog window 
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The figure above shows the Procedure Browser dialog window. If you click on an item in 
the scrolled list on the left, information about it is displayed on the right. You can also 
search for a specific procedure by name by entering part or all of the name of the 
procedure in the Search: text box and clicking on the Search by Name button, or search 
for one by its description by entering a search string in the Search: text box and clicking 
on the Search by Blurb button. 

The Script-Fu submenu 

 

The Script-Fu command displays a submenu which contains a large number of Script-Fu 
scripts and options, including the Script-Fu console. Script-Fu is a language for writing 
scripts, which allow you to run a series of GIMP commands automatically. 

Activating the submenu 
• You can access this command from the toolbox menubar through Xtns Script-Fu 
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The Help Menu of the Toolbox Window 

Introduction to the Help menu 

 

The Help menu contains commands that assist you while you are working with The GIMP. 

You may find other commands besides the ones described here on your computer. These 
commands are not part of The GIMP itself, but have been added by some of the plug-ins. 
Please refer to the documentation on the extensions for more information about these 
menu commands. 

Help 
The Help command displays the GIMP Users Manual in a browser. You can set the browser 
you would like to use in the Help System section of the Preferences dialog, as described in 
. The broswer may be the built-in GIMP help browser, or it may be a web browser. 

If the help does not seem to work, please verify that the "Gimp Users Manual" is installed 
on your system. You can find the most recent help at http://docs.gimp.org/en/index.html 

Activating the Command 
• You can access this command from the toolbox menubar through Help Help , 

• or by using the keyboard shortcut F1. 

Context Help 
The Context Help command makes the mouse pointer context-sensitive and changes its 
shape to a "?". You can then click on a window, dialog or menu entry and GIMP displays 
help about it, if it is available. You can also access context help at any time by pressing 
the F1 key while the mouse pointer is over the object you would like help about. 

Activating the Command 
• You can access this command from the toolbox menu through Help Context Help 

• or by using the keyboard shortcut Shift F1 . 

Tip of the Day 
The Tip of the Day command displays the Tip of the Day dialog. This dialog contains 
useful tips to help you gain a better understanding of some of the subtle points of using 
The GIMP. New users will find it very valuable to pay attention to these, because they 
often suggest ways of doing something that are much easier or more efficient than more 
obvious approaches. 

GNU Image Manipulation Program
Generated by docbook2odf

Page 213 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

Description of the dialog window 

 

A new tip is displayed each time you start The GIMP. You can disable this by un-checking 
the Show tip next time GIMP starts box on the dialog. 

About 
The About command shows the About window, which displays information about the 
version of The GIMP you are running and the many authors who wrote it. 

Activating the About Command 
• You can access this command in the toolbox menu through Help About 

Description of the dialog window 

 

The GIMP Online 

 

The GIMP online command displays a submenu which lists several helpful web sites that 
have to do with various aspects of GIMP. You can click on one of the menu items and your 
web browser will try to connect to the URL. 
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The File Menu of the Image Window 

File menu 

 

 

There is a File menu on both the Toolbox window and the image window. Only some of the 
menu items in these two menus are the same. 

The contents of the File menu on your computer may have different entries than the ones 
shown here. These entries are not part of the GIMP itself, but are added by some of the 
plug-ins. You can get more information about any of these items by reading the 
documentation about the plug-in it belongs to. 

New 
Using the New Image dialog, you can create a new empty image and set its properties. 
The image is shown in a new image window. You may have more than one image on your 
screen at the same time. 

You can access the command from either the Toolbox menubar or the Image menubar 
through: File New , 

or by using the keyboard shortcut Ctrl N . 
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Open 
The Open command activates a dialog that lets you load an existing image from your 
hard-drive or an external medium. For alternative, and sometimes more convenient, ways 
of opening files, see the Files section. 

Activating the Dialog 
• You can access the Open dialog from the toolbox window or from an image window 

through: File Open . 

• You can also open the Dialog by using the keyboard shortcut CtrlO. 

File browsing 
The left panel is divided into two parts. The upper part lists your main directories and 
your storage devices; you cannot modify this list. The lower part lists your bookmarks; 
you can add or remove bookmarks. To add a bookmark, select a directory or a file in the 
middle panel and click on the Add button at the bottom of the left panel. You can also use 
the Add to bookmarks command in the context menu, which you get by clicking the right 
mouse button. You can delete a bookmark by selecting it and clicking on the Remove 
button. 

The middle panel displays a list of the files in the current directory. Change your current 
directory by double left clicking on a directory in this panel. Select a file with a single left 
click. You can then open the file you have selected by clicking on the Open button. Note 
that a double left click opens the file directly; if you have selected a file different from the 
current one, a message warns you before GIMP overwrites your work. 

Right-clicking on the middle panel displays the Open Location dialog that allows you to 
type a path to a file. You can also open this dialog by typing CtrlL . 

The selected image is displayed in the Preview window if it is an image created by GIMP. 
File size, resolution and the image's composition are displayed below the preview window. 

If your image has been modified by another program, click on the Preview window to 
update it. 

The path of the current directory is displayed above the middle panel. You can navigate 
along this path by clicking on one of the buttons. 

This button shows All Files by default. This means that all file types will be displayed in 
the middle panel, even if they are not images. You can filter the list for a particular file 
type. 

The Determine File Type button has a default of Automatic. In most cases you don't need 
to pay any attention to this, because the GIMP can determine the file type automatically. 
In a few rare situations, neither the file extension nor internal information in the file are 
enough to tell GIMP the file type. If this happens, you can set it by selecting it from the 
list. 

Open Location 
The Open Location dialog lets you load an image from a network location, specified by a 
URI, in any of the formats that GIMP supports, or from a path to your hard disk or any 
drive. The default directory name is /home/<username>/ on Linux and C:\Documents and 
Settings\<username>\My Documents\My Images\ on Windows, which is used as the base 
of the relative address. You can also enter an absolute path. 

When you are visiting an Internet site, you can right click on an image and choose "Copy 
link address" in the drop-down menu. Then paste it in the "Open Location" dialog to open 
it in GIMP. 
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Activating the Command 
• You can access this command from the Toolbox menu and the image menu: File 

Open Location 

Description of the dialog window 

 

Open Recent 
Selecting Open Recent displays a submenu with the names of the files that you have 
opened recently in GIMP. Simply click on a name to reopen it. You can customize the 
number of items shown in the menu, by changing the Open Recent Menu Size value in 
the Interface page of the Preferences dialog. See the Document History dialog at the 
bottom of the Open Recent submenu, if you cannot find your image. 

Activating the Dialog 
• This menu item can be accessed from the toolbox or image menus, as File Open 

Recent , 

• or by using the keyboard shortcut Ctrl O . 

Open as Layer 
The Open Image as layer dialog is identical to the Open Image dialog. With this dialog, 
you can open an image file, which is added to the current image as the top layer in the 
stack. 

Activating the Dialog 
• This command can be accessed from the image menu bar as File Open as layer... . 

• The default shortcut is Ctrl Alt O . 

Save 
The Save command saves your image to disk. If you have already saved the image, the 
previous image file is overwritten with the current version. If you have not already saved 
the image, the Save command does the same thing as the Save As command: GIMP 
opens the File Save dialog, so that you can choose the data format, the path and the 
filename of the new image file. 

If the image was previously saved, it is automatically saved to the same location, using 
the same file name, file type, and options. To save it differently in any respect, use either 
Save As or Save A Copy. 

If you quit without having saved your image, GIMP asks you if you really want to do so, if 
the "Confirm closing of unsaved images" option is checked in the Environment page of 
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the Preferences dialog. 

Activating the Dialog 
• You can access this command in the image menu bar through File Save , 

• or from the keyboard by using the shortcut CtrlS. 

Save as 
The Save as command brings up the "File Save" dialog. In its basic form, as shown below, 
this gives you a text box to use to assign a name to the file, and a dropdown list of 
bookmarks to use to select a directory to save it in. Normally the file format is determined 
by the extension you use in the file name (i.e., .jpg for a JPEG file). You can use the Select 
File Type option expander to pick a different file type, but you should avoid doing this 
unless absolutely necessary, to avoid confusion. 

If the directory you want is not in the list of bookmarks, click on Browse for other folders 
to expand the dialog into its full form. You can find an explanation of the layout, and help 
on creating and using bookmarks, in the Files section. 

If you saved the image previously and don't need to change the file name or any of the 
options, you can use the Save command instead. 

Activating the Command 
• You can access this command from the image menubar through File Save as , 

• or by using the keyboard shortcut Shift Ctrl S . 

The Basic Save as Dialog 
There are two different forms of the Save as dialog. The simple form only lets you type in 
the filename and choose the directory the file should be saved in. If the folder you want is 
not on the list, you can type in the path to the directory, along with the filename. You can 
also click on the small triangle to display the full folder browser. You must also choose the 
image format, by selecting the file extension (e.g., .xcf or .png). 

 

The Save Dialog with a Browser 
The left panel is divided into two parts. The upper part lists your main directories and 
your storage devices; you cannot modify this list. The lower part lists your bookmarks; 
you can add or remove bookmarks. To add a bookmark, select a directory or a file in the 
middle panel and click on the Add button at the bottom of the left panel. You can also use 
the Add to bookmarks command in the context menu, which you get by clicking the right 
mouse button. You can delete a bookmark by selecting it and clicking on the Remove 
button. 

The middle panel displays a list of the files in the current directory. Change your current 
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directory by double left-clicking on a directory in this panel. Select a file with a single left 
click. You can then save to the file you have selected by clicking on the Save button. Note 
that a double left click saves the file directly. 

You can right click on the middle panel to access the Show Hidden Files command. 

The selected image is displayed in the Preview window if it is an image created by GIMP. 
File size, resolution and the image's composition are displayed below the preview window. 

If your image has been modified by another program, click on the preview to update it. 

Enter the filename of the new image file here. 

If the image has already been saved, GIMP suggests the same filename to you. If you 
click on Save, the file is overwritten. 

This drop-down list is only available in the basic form of the dialog. It provides a list of 
bookmarks for selecting a directory in which to save your file. 

Above the middle panel, the path of the current directory is displayed. You can navigate 
along this path by clicking on one of the buttons. 

If you want to save the image into a folder that doesn't yet exist, you can create it by 
clicking on Create Folder and following the instructions. 

This button shows All Files by default. This means that all file types will be displayed in 
the middle panel, even if they are not images. You can filter the list for a particular file 
type. 

At Determine File Type, you have to select the file format for saving the file. If you select 
By Extension, the file type is determined by the extension you add to the name, for 
example, ".jpg" for JPEG format. 

To preserve all the components of your image when you save it — the layers, channels, 
etc. — use ".xcf" format, which is the GIMP's native format. 

Save a Copy 
The Save a Copy command does the same thing as the Save command, but with one 
important difference. It always asks for a file name and saves the image into the specified 
file, but it does not change the name of the active image or mark it as "clean". As a 
result, if you try to delete the image, or exit from GIMP, you are informed that the image 
is "dirty" and given an opportunity to save it. 

This command is useful when you want to save a copy of your image in its current state, 
but continue to work with the original file without interruption. 

Activating the Dialog 
• You can access this command from the image menubar as File Save a Copy... . It 

does not have a default shortcut. 

Save as Template 
The Save as Template command creates a template with the same dimensions and color 
space as the current image. A dialog pops up, which asks you to name the new template, 
then the template is saved and becomes available in the New Image dialog. If you give a 
name that already exists, GIMP generates a unique name by appending a number to it. 
You can use the Templates dialog to modify or delete templates. 

Activating the Command 
• You can access this command from the image menubar through File Save as 
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Template . There is no default keyboard shortcut. 

Revert 
The Revert command reloads the image from disk, so that it looks just like it did the last 
time it was saved — unless, that is, you or some application other than GIMP have 
modifed the image file, in which case, the new contents are loaded. 

When GIMP reverts a file, it actually closes the existing image and creates a new image. 
Because of this, reverting an image is not undoable, and causes the undo history of the 
image to be lost. GIMP tries to protect you from losing your work in this way by asking 
you to confirm that you really want to revert the image. 

Activating the Command 
• You can access this command from the image menubar through File Revert . There is 

no default keyboard shortcut. 

Print 
The Print command is not really part of GIMP. It simply calls the printing interface of your 
operating system to set the printer options. 

Activating the Command 
You can access this command from the image menubar through File Print . 

Close 
The Close command closes the image and removes its window. Closing an image is not 
undoable: once it is closed, everything is gone, including the undo history. If the image is 
not "clean" — that is, if you have changed it since the last time you saved it — you are 
asked to confirm that you really want to close it. Note that an image is marked as clean 
when it is saved to a file, even if the file format chosen does not preserve all the 
information in the image, so it is a good idea to think for a moment about what you are 
doing before closing an image. If there is the slightest possibility that you will regret it, it 
can't hurt to save a copy as an XCF file. 

Activating the Command 
• You can access this command from the image menubar through File Close , 

• or by using the keyboard shortcut Ctrl W . 

• For most systems on which the GIMP runs, you can also execute it by clicking on a 
"Close" button somewhere on the image window titlebar. The location and 
appearance of this button are determined by the windowing system and the window 
manager. 

If you close the image window, as described above, GIMP simply closes your image. 
However, if you close the Toolbox window by using the "Close" button, GIMP itself 
exits. 

Quit 
The Quit command causes GIMP to close all images and exit. If there are any open images 
which contain unsaved changes (that is, they are not marked as "clean"), GIMP notifies 
you and displays a list of the unsaved images. You can then choose which images you 
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would like to save, or you can cancel the command. Note that if you have a large number 
of images open, or are using a large part of the RAM on your system, it may take a little 
while for everything to shut down. 

Activating the Command 
• You can access this command from the Toolbox menubar or the image menubar 

through File Quit , 

• or by using the keyboard shortcut Ctrl Q . 

• For most systems on which the GIMP runs, you can also execute it by clicking on a 
"Close" button somewhere on the Toolbox window's titlebar. The location and 
appearance of this button are determined by the windowing system and the window 
manager. 

If you close the image window, as described above, GIMP simply closes your image. 
However, if you close the Toolbox window by using the "Close" button, GIMP itself 
exits. 
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The Edit Menu of the Image Window 

Edit menu entries 

 

In this section, you will find help for commands in the Edit menu item. 

You may find commands in the menu which are not described here. They don't belong to 
GIMP itself, but have been added by some of the plug-ins. You can find a description of 
these menu commands in the documentation for the corresponding plug-ins. 

Undo 
If you have made drawing or editing changes to the image which you don't want to keep, 
the Undo command allows you to undo the last change and return the image to its 
previous state. Almost anything you do to an image can be undone in this way (with the 
exception of scripts, which deactivate this function). Further Undo operations may be 
performed, depending upon the number of Undo levels configured in the Environment 
page of the Preferences Dialog. See the section on Undoing for more information about 
GIMP's very sophisticated "Undo" functions. 

The operation that has been "undone" is not lost immediately: you can get it back by 
using the Redo command right away. But if you perform another operation, the "Undo" 
will be irretrievably lost. 

Activating the Command 
• You can access this command from the image menubar through Edit Undo , 

• by using the keyboard shortcut Ctrl Z , 

• or by simply clicking on the status you want in the Undo History dialog. 

Redo 
The Redo command reverses the effects of the Undo command. Each "Undo" action can 
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be reversed by a single "Redo" action. You can alternate "Undo" and "Redo" as many 
times as you like. Note that you can only "Redo" an operation if the last action you did 
was an "Undo". If you perform any operation on the image after Undoing something, then 
the former Redo steps are lost, and there is no way to recover them. See the Undoing 
section for more information. 

To see the operations which you have done and undone, use the Undo History dialog. 

Activating the Command 
• You can access this command from the image menubar through Edit Redo , 

• by using the keyboard shortcut Ctrl Y , 

• or by simply clicking on the status you want in the Undo History dialog. 

Undo History 
The Undo History command activates the Undo History dialog, which shows you 
thumbnails representing the operations you have done so far on the current image. This 
overview makes it easier for you to undo steps or to redo them. 

Use the arrows for Undo and Redo, or simply click on the thumbnail, to bring the image 
back to a previous state. This is especially useful when you are working on a difficult task, 
where you often need to undo several steps at once. It is much easier to click on step 10 
than to type Ctrl Z ten times. 

The "Clear undo History" command may be useful if you are working on a complex image 
and you want to free some memory. 

Activating the Command 
• You can access this command from the image menubar through Edit Undo History . 

There is no default keyboard shortcut. 

Cut 
The Cut command deletes the contents of the image's selections, and saves them in a 
clipboard so that they can later be pasted using the "Paste", "Paste Into", or "Paste As 
New" commands. If there is no selection, the entire current layer is cut. The areas whose 
contents are cut are left transparent, if the layer has an alpha channel, or filled with the 
layer's background color, otherwise. 

The Cut command only works on the current active layer. Any layers above or below the 
active layer are ignored. 

Activating the Command 
• You can access this command from the image menubar through Edit Cut , 

• or by using the keyboard shortcut Ctrl X . 

Copy 
The Copy command makes a copy of the current selection and stores it in the Clipboard. 
The information can be recalled using the Paste, Paste Into, or Paste As New commands. If 
there is no selection, the entire current layer is copied. "Copy" only works on the current 
active layer. Any layers above or below it are ignored. 

Activating the Command 
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• You can access this command from the image memubar through Edit Copy , 

• or by using the keyboard shortcut Ctrl C . 

Copy Visible 
The Copy Visible command is similar to the Copy command. However, it does not just 
copy the contents of the current layer; it copies the contents of the visible layers (or the 
selection of the visible layers), that is, the ones that are marked with an "eye". 

Please note that the information about the layers is lost when the image data is put in the 
clipboard. When you later paste the clipboard contents, there is only one layer, which is 
the fusion of all the marked layers. 

Activating the Command 
• You can access this command from the image menubar through Edit Copy Visible . 

Paste 
The Paste command puts whatever is in the Clipboard from the last "Copy" or "Cut" 
command into the current image. The pasted section becomes a "floating selection" and 
is shown as a separate layer in the Layers Dialog. 

If there is an existing selection on the canvas, it is used to align the pasted data. If there 
is already a selection, the data is pasted using the selection as a center point. If you want 
the selection to be used as a clipping region for the pasted data, you should use the 
"Paste Into" command. 

You can have only one floating selection at any one time. You cannot work on any other 
layer while there is a floating selection; you have to either anchor it or remove it. 

Activating the Command 
• You can access this command from the image menubar through Edit Paste . 

• or by using the keyboard shortcut Ctrl V . 

Paste Into 
The Paste Into command acts in a similar way to the Paste command. The primary 
difference becomes apparent if there is a selection within the canvas. Unlike the "Paste" 
command, which simply centers the pasted image data over the selection and replaces 
the selection with its own, "Paste Into" clips the pasted image data by the existing 
selection. The new selection can be moved as usual, but it is always clipped by the 
original selection area. 

If no selection exists, the "Paste Into" command places the data from the Clipboard into 
the center of the canvas, as the "Paste" command does. 

Activating the Command 
• You can access this command from the image menubar through Edit Paste Into . 

Paste as New 
The Paste As New command creates a new image and pastes the image data from the 
Clipboard into it. If the data is not rectangular or square in shape, any regions that do not 
extend to the edge of the canvas are left transparent (an Alpha channel is automatically 
created). Of course, you have to Copy your selection before you use this command, so 
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that you get an image with the same dimensions as the selection. 

Activating the Command 
• You can access this command from the image menubar through Edit Paste as New . 

Buffers 

 

The commands in this submenu operate on named buffers. You can use the Buffers dialog 
to view and manage any named buffers you have created. 

Activating the Submenu 
• You can access this submenu from the image menubar through Edit Buffer . 

Cut Named 
The Cut Named command cuts the contents of the selection from the active layer in the 
usual way, but instead of storing the contents in the global clipboard, it stores it in a 
special buffer that you name using a pop-up dialog. 

Activating the Command 

• You can access this command from the image menubar through Edit Buffer Cut , 

• or by using the keyboard shortcut Shift Ctrl X . 

Copy Named 
The Copy Named command copies the contents of the selection from the active layer in 
the usual way, but instead of storing the contents in the global clipboard, it stores it in a 
special buffer that you name using a pop-up dialog. 

Activating the Command 

• You can access this command from the image menubar through Edit Buffer Copy , 

• or by using the keyboard shortcut Shift Ctrl C . 

Paste Named 
The Paste Named command simply brings up the Buffers dialog. By selecting one of the 
listed buffers, and pressing one of the buttons at the bottom, you can either Paste Buffer, 
Paste Buffer Into, or Paste Buffer as New. 

Activating the Command 

• You can access this command from the image menubar through Edit Buffer Paste 

• or by using the keyboard shortcut Shift Ctrl V . 

Clear 
The Clear command deletes everything in the current selection. If there is no current 
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selection, the contents of the active layer are removed. If the active layer has an alpha 
channel, the deleted selection is made transparent. You can restore the original color to 
the transparent area using the Eraser tool, by setting it to Anti-Erase. If the layer does not 
have an alpha channel, the deleted area is filled using the current background color. 

Clearing a selection does not delete the selection itself. Unlike "Cut", "Clear" does not 
place the deleted contents in the Clipboard and the contents of the clipboard are 
unaffected. 

Activating the Command 
• You can access this command from the image menubar through Edit Clear , 

• or by using the keyboard shortcut Ctrl K . 

Fill with FG Color 
The Fill with FG Color command fills the image's selection with the solid color shown in 
the foreground part of the Color Area of the Toolbox. (The color is also shown to the left of 
the menu entry.) If some areas of the image are only partially selected (for example, as a 
result of feathering the selection), they are filled in proportion to how much they are 
selected. 

Please note that if the image has no selection, the whole active layer is filled. 

Activating the Command 
• You can access this command from the image menubar through Edit Fill with FG 

Color , 

• or by using the keyboard shortcut Ctrl , . 

You can also fill a selection by click-and-dragging from the Toolbox foreground color. 

Fill with BG Color 
The Fill with BG Color command fills the active layer selection with the solid color shown 
in the Background part of the Color Area of the Toolbox. (The color is also shown to the 
left of the menu entry.) If some areas of the image are only partially selected (for 
example, as a result of feathering the selection), they are filled in proportion to how much 
they are selected. 

Please note that if the image has no selection, the whole active layer is filled. 

Activating the Command 
• You can access this command from the image menubar through Edit Fill with BG 

Color , 

• or by using the keyboard shortcut Ctrl . . 

You can also fill a selection by click-and-dragging from the Toolbox background color. 

Fill with Pattern 
The Fill with Pattern command fills the image's selection with the pattern shown in the 
Brush/Pattern/Gradient area of the Toolbox. (The pattern is also shown to the left of the 
menu entry.) If some areas of the image are only partially selected (for example, as a 
result of feathering the selection), they are filled in proportion to how much they are 
selected. 

You can select another pattern by using the Pattern Dialog. 
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Please note that if the image has no selection, the whole active layer is filled. 

Activating the Command 
• You can access this command from the image menubar through Edit Fill with Pattern 

, 

• or by using the keyboard shortcut Ctrl ; . 

Stroke Selection 
The Stroke Selection command strokes a selection in the image. There are two ways you 
can stroke the selection, either by using a paint tool or without using one. This means 
that the selection border, which is emphasized in the image with a dotted line, can be 
drawn with a stroke. There are various options which you can use to specify how this 
stroke should look. 

This command is only active if the image has an active selection. 

Activating the Command 
• You can access this command from the image menubar through Edit Stroke 

Selection . 

• You can also access it through the Selection Editor. 

The Stroke Selection dialog 
The options for stroking selections and for stroking paths are the same. You can find the 
documentation about the options in the dialog box in the Stroke Path section. 

Stroke Path 
The Stroke Path command strokes a path in the image. There are two ways you can stroke 
the path, either by using a paint tool, or without using one. There are various options 
which you can use to specify how this stroke should look. 

This command is active only if there is a path in your image. 

Activating the Command 
• You can access this command from the image menubar through Edit Stroke Path . 

• You can also access it by clicking on the button with the same name in the Path 
dialog. 

Description of the Dialog Window 
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The Choose Stroke Style dialog box allows you to choose between stroking the path with 
the options you specify or stroking it with a paint tool. If you stroke the path with a paint 
tool, the current paint tool options are used to draw the stroke. 
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Select 

Introduction to the Select menu 

 

This section explains the commands on the Select menu of the image menubar. 

Besides the commands presented here, you might also find other entries on the menu. 
They are not part of GIMP itself, but are extensions (plug-ins). You can find descriptions of 
these menu entries with the documentation of the plug-ins. 

Select All 
The Select All command creates a new selection which contains everything on the current 
layer. 

Activating the Command 
• You can access this command from the image menubar through Select All , 

• or by using the keyboard shortcut Ctrl A . You can also access it with the Selection 
Editor. 

None 
The None command cancels all selections in the image. If there are no selections, the 
command doesn't do anything. Floating selections are not affected. 

Activating the Command 
• You can access this command from the image menubar through Select None . In 

addition, you can use the Selection Editor to access it. 

• You can also use the keyboard shortcut Shift Ctrl A . 

Invert 
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The Invert command inverts the selection in the current image. That means that all of the 
image contents which were previously outside of the selection are now inside it, and vice 
versa. If there was no selection before, the command selects the entire image. 

Don't mix up this command with the Invert layer command. 

Activating the Command 
• You can access this command from the image menubar through Select Invert . In 

addition, you can use the Selection Editor to access it. 

• You can also use the keyboard shortcut Ctrl I . 

Float 
The Float command converts a normal selection into a "floating selection". You can find 
more information about floating selections in the Glossary. 

In early versions of GIMP, floating selections were used for performing operations on a 
limited part of an image. You can do that more easily now with layers, but you can still 
use this way of working with images. In addition to using the Float command, you can 
also create a floating selection by moving a selection using the "Move" tool, without 
pressing the Alt key (or ShiftAlt in Linux), which automatically creates a floating selection. 
You can also create a temporary layer, named "Floating Selection", with the entries on the 
Layer menu. 

You cannot perform any operations on other layers if the image has a floating selection, 
so after you make the changes you want to the floating selection, you have to anchor it. 
That is, you have to attach it to a normal (non-floating) layer, usually the original layer 
(the one which was active previously). To anchor the floating selection, use the Anchor 
Layer command. You can also anchor it to an existing layer by clicking anywhere on the 
image outside of the floating selection, which then merges it with the background layer. 
You can also anchor it to a new layer by using the New Layer command. 

If you display the layer boundary by using the Show Layer Boundary command, you may 
have difficulty selecting a precise area of the image which you want in a layer. To avoid 
this problem, you can make a rectangular selection, transform it into a floating selection 
and anchor it to a new layer. Then simply remove the original layer. 

Activating the Command 
• You can access this command from the image menubar through Select Float , 

• or by using the keyboard shortcut Shift Ctrl L . 

By Color 
The Select By Color command is an alternate way of accessing the "Select By Color" tool, 
one of the basic selection tools. You can find more information about using this tool in 
Select By Color. 

Activating the Command 
• You can access this command from the image menubar through Select By Color , 

• or by using the keyboard shortcut Shift O . 

From Path 
The From Path command transforms the current path into a selection. If the path is not 
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closed, the command connects the two end points with a straight line. The original path is 
unchanged. 

Activating the Command 
• You can access this command from the image menubar through Select From Path . 

• In addition, you can click on the Path to Selection button  in the Path dialog to 
access the command. 

• You can also use the keyboard shortcut Shift V . 

Selection Editor 

Activating the Command 
• You can access this command from the image menubar through Select Selection 

Editor . 

Description of the Selection Editor dialog window 

 

  

The Selection to Path Advanced Settings dialog 

 

The "Selection to Path Advanced Settings" dialog contains a number of options, most of 
which you can set with either a slider bar or a text box. There is also one check box. 
These options are mostly used by advanced users. They are: 

• Align Threshold: If two endpoints are closer than this value, they are made to be 
equal. 

• Corner Always Threshold: If the angle defined by a point and its predecessors and 
successors is smaller than this, it is a corner, even if it is within Corner Surround 
pixels of a point with a smaller angle. 

• Corner Surround: Number of points to consider when determining if a point is a 
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corner or not. 

• Corner Threshold: If a point, its predecessors, and its successors define an angle 
smaller than this, it is a corner. 

• Error Threshold: Amount of error at which a fitted spline  is unacceptable. If any pixel 
is further away than this from the fitted curve, the algorithm tries again. 

• Filter Alternative Surround: A second number of adjacent points to consider when 
filtering. 

• Filter Epsilon: If the angles between the vectors produced by Filter Surround and 
Filter Alternative Surround points differ by more than this, use the one from Filter 
Alternative Surround. 

• Filter Iteration Count: The number of times to smooth the original data points. 
Increasing this number dramatically, to 50 or so, can produce vastly better results. 
But if any points that "should" be corners aren't found, the curve goes wild around 
that point. 

• Filter Percent: To produce the new point, use the old point plus this times the 
neighbors. 

• Filter Secondary Surround: Number of adjacent points to consider if Filter Surround 
points defines a straight line. 

• Filter Surround: Number of adjacent points to consider when filtering. 

• Keep Knees: This check box says whether or not to remove "knee" points after 
finding the outline. 

• Line Reversion Threshold: If a spline is closer to a straight line than this value, it 
remains a straight line, even if it would otherwise be changed back to a curve. This 
is weighted by the square of the curve length, to make shorter curves more likely to 
be reverted. 

• Line Threshold: How many pixels (on the average) a spline can diverge from the line 
determined by its endpoints before it is changed to a straight line. 

• Reparametrize Improvement: If reparameterization doesn't improve the fit by this 
much percent, the algorithm stops doing it. 

• Reparametrize Threshold: Amount of error at which it is pointless to reparameterize. 
This happens, for example, when the algorithm is trying to fit the outline of the 
outside of an "O" with a single spline. The initial fit is not good enough for the 
Newton-Raphson iteration to improve it. It may be that it would be better to detect 
the cases where the algorithm didn't find any corners. 

• Subdivide Search: Percentage of the curve away from the worst point to look for a 
better place to subdivide. 

• Subdivide Surround: Number of points to consider when deciding whether a given 
point is a better place to subdivide. 

• Subdivide Threshold: How many pixels a point can diverge from a straight line and 
still be considered a better place to subdivide. 

• Tangent Surround: Number of points to look at on either side of a point when 
computing the approximation to the tangent at that point. 

Feather 
The Feather command feathers the edges of the selection. This creates a smooth 
transition between the selection and its surroundings. You normally feather selection 
borders with the "Feather Edges" option of the selection tools, but you may feather them 
again with this command. 
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Activating the Command 
• You can access this command from the image menubar through Select Feather . 

Description of the Feather Selection dialog window 

 

Sharpen 
The Sharpen command reduces the amount of blur or fuzziness around the edge of a 
selection. It reverses the effect of the Feather Selection command. The new edge of the 
selection follows the dotted line of the edge of the old selection. Anti-aliasing is also 
removed. 

Please do not confuse this command with the Sharpen filter. 

Activating the Command 
• You can access this command from the image menubar through Select Sharpen . 

Shrink 
The Shrink command reduces the size of the selected area by moving each point on the 
edge of the selection a certain distance further away from the nearest edge of the image 
(toward the center of the selection). Feathering is preserved, but the shape of the 
feathering may be altered at the corners or at points of sharp curvature. 

Activating the Command 
• You can access this command from the image menubar through Select Shrink... . 

Description of the Shrink dialog 

 

Grow 
The Grow command increases the size of a selection in the current image. It works in a 
similar way to the Shrink command, which reduces the size of a selection. 

Activating the Command 
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• You can access this command from the image menubar through Select Grow . 

Description of the Grow Selection dialog 

 

A Peculiarity of Rectangular Selections 
When you grow a rectangular selection, the resulting selection has rounded corners. The 
reason for this is shown in the image below: 

 

If you do not want rounded corners, you can use the Rounded Rectangle command with a 
0% radius. 

Border 
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The Select Border command creates a new selection along the edge of an existing 
selection in the current image. The edge of the current selection is used as a form and the 
new selection is then created around it. You enter the width of the border, in pixels or 
some other unit, in the dialog window. Half of the new border lies inside of the selected 
area and half outside of it. 

Activating the Command 
• You can access this command from the image menubar through Select Border . 

Description of the Border dialog window 

 

Rounded Rectangle 
This script-fu converts a selection (rectangular, elliptic or else) to a rectangular selection 
with rounded corners. The Radius is a percentage of half the selection width or height, 
whichever the smaller. Select Concave if you want round edges to be indented. Rounded 
Rectangle works by adding circles to or subtracting circles from the selection. 

Activate Dialog 
• This command is found at Select Rounded Rectangle... . 

Options 
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Toggle QuickMask 
It has the same action as clicking on the small button in the bottom left corner of the 
image. See Quick Mask 

Activate Dialog 
• This command is found at Select Toggle QuickMask 

• Default shortcut is ShiftQ 

Save to Channel 
The Select to Channel command saves the selection as a channel. The channel can then 
be used as a channel selection mask. You can find more information about them in the 
Channel Dialog section. 

Activating the Command 
• You can access this command from the image menubar through Select Save to 

Channel . 

• You can also access it from the Selection Editor. 

To Path 
The To Path command converts a selection into a path. The image does not seem to 
change, but you can see the new path in the Paths Dialog. By using the Path tool in the 
Toolbox, you can precisely adapt the outline of the selection. You can find further 
information regarding paths in the Paths dialog section. 

Activating the Command 
• You can access this command from the image menubar through Select To Path . 

• You can also access it from the Selection Editor which offers you a lot of Advanced 
Options. 
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View 

Introduction to the View Menu 

 

This section describes the View menu, which contains commands that affect the visibility 
or appearance of the image and various elements of the interface. 

Besides the commands described here, you may also find other entries in the menu. They 
are not part of GIMP itself, but have been added by extensions (plug-ins). You can find 
information about the functionality of a plug-in by referring to its documentation. 

New View 
The New View command creates a new image window for the current image, which you 
can set up differently from the existing display. You can create multiple views of any 
image, which are numbered .1, .2, etc., but only the zoom factor and other viewing 
options may be different. Any changes, other than viewing changes, which you make in 
one window also appear in the other displays which show the same image. The new views 
are not separate image files; they are simply different aspects of the same image. You 
might use multiple views, for example, if you were working on individual pixels at a high 
zoom factor. You could then see the effects your changes would have on the image at a 
normal size. 

You can delete a view by closing its window. If you close the last window displaying an 
image, the image itself is closed. However, if you have made changes to the image which 
you have not yet saved, you are asked for confirmation. 

Activating the Command 
• You can access this command from the image menubar through View New View . 
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Dot for Dot 
The Dot for Dot command enables and disables "Dot for Dot" mode. If it is enabled 
(checked) and the zoom factor is 100%, every pixel in the image is displayed as one pixel 
on the screen. If it is disabled, the image is displayed at its "real" size, the size it will have 
when it is printed. 

For Dot for Dot mode to work properly, the resolution of the image must be the same as 
the screen resolution in the Preferences menu. 

Enabling this mode is recommended if you are working on icons and web graphics. If you 
are working on images intended to be printed, you should disable Dot-for-Dot mode. 

Activating the Command 
• You can access this command from the image menubar through View Dot for Dot . 

Zoom 

 

The Zoom submenu contains various commands which affect the magnification of the 
image in the image window (zooming). Enlarging an image (zooming in) is useful if you 
need to work with high precision, making pixel-level image modifications or precise 
selections. On the other hand, reducing an image (zooming out) is handy for getting an 
overall impression of the image and seeing the results of changes which affect the entire 
image. Please note that zooming is not undoable, since it does not affect the image data, 
only the way it is displayed. 

Besides the entries in this submenu, there is also a zoom pull-down menu at the bottom 
edge of the image window (if the status bar is displayed). You can also make settings 
regarding zooming in the Navigation dialog. You can also use the Magnify tool which lets 
you zoom a particular area of the image. 

Activating the Submenu 
• You can access this command from the image menubar through View Zoom . Note 

that the "Zoom" label on the "View" menu shows the current zoom factor, for 
example, Zoom (100%). 

Contents of the Zoom submenu 
The various "Zoom" submenu commands are described below, along with their default 
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keyboard shortcuts, if any. 

When you are working at the pixel level, you can use the New view command. This allows 
you to see what is happening to the image at its normal size at the same time. 

Shrink Wrap 
The Shrink Wrap command resizes the window so that it is exactly the same size as the 
image at the current zoom factor. If the image doesn't completely fit on the screen, the 
image window is enlarged so that the largest possible part of the image is shown. Please 
note that GIMP will do this automatically if you set the "Resize window on zoom" and 
"Resize window on image size change" options in the Image Window page of the 
Preferences dialog. 

Please note also that the behavior described here is not performed by GIMP itself, but by 
the "window manager", a part of the operating system of your computer. For that reason, 
the functionality described may be different on your computer, or in the worst case, 
might not be available at all. 

Activating the Command 
• You can access this command from the image menubar through View Shrink Wrap , 

• or by using the keyboard shortcut Ctrl E . 

Full Screen 
The Fullscreen command enables and disables displaying the image window on the entire 
screen. When it is enabled, the image window takes up the whole screen, but the image 
stays the same size. When you enable full-screen mode, the menubar may not be 
displayed, but if this happens, you can right-click on the image to access the image 
menu. You can set the default appearance for full-screen mode in the Preferences menu. 

If you use GIMP on an Apple Macintosh computer, full-screen mode may not work, since 
Apple doesn't provide the necessary functionality. Instead, you can maximize the image 
window by clicking on the Green Button, so the image occupies most of the screen. 

Activating the Command 
• You can access this command from the image menubar through View Full Screen , 

• or by using the keyboard shortcut F11. 

Info Window 
The Info Window command displays general information about the current image, as well 
as information about the pixel which is currently under the mouse pointer. 

Activating the Command 
• You can access this command from the image menubar through View Info window , 

• or by using the keyboard shortcut Shift Ctrl I . 

Description of the Info Window 
The Info Window displays basic information about the current image, including its name 
and a thumbnail, as well as about the pixel which is currently under the mouse pointer. 
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Navigation Window 
The Navigation Window command opens the navigation window. This allows you to easily 
navigate through the image, to set zoom levels and to move the visible parts of the 
image. You can find more information about using it in the Navigation dialog chapter. 

Activating the Command 
• You can access this command from the image menubar through View Navigation 

Window , 

• or by using the keyboard shortcut Shift Ctrl N . 

• You can also access it more rapidly by clicking on the  icon in the lower right corner 
of the image window. 

Display Filters 
The images you create, we hope, will be seen by many people on many different systems. 
The image which looks so wonderful on your screen may look somewhat different to 
people with sight deficiencies or on a screen with different settings from yours. Some 
information might not even be visible. 

Display Filters allow you to view your image as if it were seen by people with a sight 
deficiency or on a different screen. Don't worry, the filters display the image in a different 
way, but they never change the image. Besides that, if you save the image that is 
displayed, the original image is saved. For the same reason, you can't undo the action of 
a filter with CtrlZ. 

The filters available are called "Color Deficient Vision", "Gamma", "Contrast" and "Color 
Proof": 

Activating the Command 
• You can access this command from the image menubar through View Display Filters . 

Description of the Display Filters Dialog 
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This dialog has two small windows. The left window displays the Available Filters. You can 
move a filter to the right window by selecting it and clicking on the right arrow button. 
The Active Filters window on the right displays filters you have chosen and which will be 
applied if the adjacent box is checked. You can move filters from the right window to the 
left window by using the left arrow button. If you select a filter by clicking on its name, its 
options are displayed below the two windows, in the Configure Selected Filter area. 

Color Deficient Vision 
Description of the "Color Deficient Vision" dialog  

In this drop-down menu you can select from among: 

Gamma 
The "Gamma" dialog  

The correspondence between electrical intensity and color brightness is not exact and it 
depends upon the device (the camera, the scanner, the monitor, etc.). "Gamma" is a 
coefficient used to correct this correspondence. Your image must be visible in both dark 
and bright areas, even if it is displayed on a monitor with too much luminence or not 
enough. The "Gamma" Display Filter allows you to get an idea of the appearance of your 
image under these conditions. 

Contrast 
The "Contrast" dialog  

Here, we are back in the medical domain. "Contrast Sensitivity" is the capacity of the 
visual system to distinguish slight differences in contrast. Some people with cataracts 
(which means that the lens has opaque crystals that scatter light over the retina) or 
retinal disease (for instance, due to diabetes, which destroys the rods and cones) have a 
deficiency in sensitivity to contrast: for example, they would have difficulties 
distinguishing spots on a dress. 

With the "Contrast" Filter, you can see the image as if you were suffering from cataracts. 
You may have to increase the contrast of the image so that your grandmother can see it 
well. In most cases, only very low values of the Contrast Cycles parameter are of interest. 
Higher values create a side-effect which doesn't interest us here: if you increase the 
luminosity value above 255, the complementary color appears. 

If you are interested in this subject, you can browse the Web for "contrast sensitivity". 

Color Proof 
The various systems for reproducing colors cannot represent the infinity of colors 
available. Even if there are many colors in common between the various systems and 
nature, some of the colors will not be the same. The "gamut" is the color range of a 
system. Color Profiles allow you to compensate for these differences. 

Before you print an image, it may be useful for you to see if you will get the result you 
want by applying a profile. The "Color Proof" filter shows you how your image will look 
after a color profile has been applied. 
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You can apply the filter you have selected in one of four ways: 

Show Selection 
The Show Selection command enables and disables displaying the dotted line surrounding 
the selection in the image window. Please note that the selection still exists, even if 
displaying this line is disabled. 

You can set the default for displaying the selection in the Image Window Appearance 
dialog. 

Activating the Command 
• You can access this command from the image menubar through View Show Selection 

, 

• or by using the keyboard shortcut Ctrl T . 

Show Layer Boundary 
The Show Layer Boundary command enables and disables displaying the yellow dotted 
line that surrounds a layer in the image window. The dotted line is actually only visible 
when the layer is smaller than the image window. When the layer is the same size as the 
image window, the layer boundary is obscured by the image border. 

You can set the default for the layer boundary in the Image Window Appearance dialog. 

Activating the Command 
• You can access this command from the image menubar through View Show Layer 

Boundary . 

Show Guides 
The Show Guides command enables and disables diplaying of Guides in the image 
window. 

You can set the default for the guides in the Image Window Appearance dialog. 
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Activating the Command 
• You can access this command from the image menubar through View Show Guides , 

• or by using the keyboard shortcut Shift Ctrl T . 

Snap to Guides 
The Snap to Guides command enables and disables snap to guides. When snap to guides 
is enabled, the guides you set (see Show Guides) almost seems magnetic; when you 
move a layer or selection, the guides appear to pull on it when it approaches. This is 
enormously useful for accurate placement of image elements. 

Activating the Command 
• You can access this command from the image menubar through View Snap to Guides 

. 

Show Grid 
By using the Show Grid command, you can enable and disable displaying the grid. When 
you enable it, the grid overlays the image and makes it easier for you to line up selected 
image elements. 

You can set the default for the grid in the Image Window Appearance dialog. 

See also the Configure Grid command and the Snap to Grid command. 

Activating the Command 
• You can access this command from the image menubar through View Show Grid . 

Snap to Grid 
The Snap to Grid command enables and disables snap to grid. When snap to grid is 
enabled, the grid you set (see Show Grid) almost seems magnetic; when you move a 
layer or selection, the grid points appear to pull on it when it approaches. This is 
enormously useful for accurate placement of image elements. 

Activating the Command 
• You can access this command from the image menubar through View Snap to Grid . 

Padding Color 

 

You can change the color of the canvas which surrounds the image by using the Padding 
Color command. The canvas is the surface the image lies on. It looks like a frame around 
the image in the image window. This is just a matter of personal preference, since the 
padding color does not have any effect on the image itself. Please note that this color is 
not the same as the color used by the Fill tool. 
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Activating the submenu 
• You can access this command from the image menubar through View Padding Color . 

Padding Color Options 
• From Theme: The color of the theme defined in Preferences Theme is used. 

• Light/Dark Check Color: The check representing transparency, which is defined in 
Preferences Display is used. 

• Select Custom Color: Opens the Color Selector window to let you choose a color to 
use. 

• As in Preferences: The color selected in the Image Window Appearance is used. 

Show Menubar 
The Show Menubar command enables and disables displaying the menubar. It may be 
useful to disable it if you are working in full-screen mode. If the menubar is not displayed, 
you can right-click on the image to access the menubar entries. 

You can set the default for the menubar in the Image Window Appearance dialog. 

Activating the Command 
• You can access this command from the image menubar through View Show Menubar 

. 

Show Rulers 
The Show Rulers command enables and disables displaying the rulers. It may be useful to 
disable them if you are working in full-screen mode. 

You can set the default for the rulers in the Image Window Appearance dialog. 

Activating the Command 
• You can access this command from the image menubar through View Show Rulers , 

• or by using the keyboard shortcut Shift Ctrl R . 

Show Scrollbars 
The Show Scrollbars command enables and disables displaying the scrollbars. It may be 
useful to disable them if you are working in full-screen mode. 

You can set the default for the scrollbars in the Image Window Appearance dialog. 

Activating the Command 
• You can access this command from the image menubar through View Show 

Scrollbars . 

Show Statusbar 
The Show Statusbar command enables and disables displaying the status bar. It may be 
useful to disable it when you are working in full-screen mode. 

You can set the default for the status bar in the Image Window Appearance dialog. 
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Activating the Command 
• You can access this command from the image menubar through View Show 

Statusbar . 
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The Image Menu of the Image Window 

The Image Menu of the Image Window 

 

The Image menu contains commands which use or affect the entire image in some way, 
not just the active layer or some other specific part of the image. 

You may find other commands in the menu besides the ones described here. These 
commands are not part of The GIMP itself, but are added by some of the plug-ins. Please 
refer to the documentation on the extensions for more information about these menu 
commands. 

Duplicate 
The Duplicate image command creates a new image which is an exact copy of the current 
one, with all of its layers, channels and paths. The GIMP Clipboard and the History are not 
affected. 

Activating the command 
• You can access this command from the image menu through Image Duplicate , 

• or by using the keyboard shortcut Ctrl D . 

Mode 
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The Mode submenu contains commands which let you change the color model of the 
image. There are three modes. 

Activating the Submenu 
• You can access this submenu from the image menubar through Image Mode . 

The Contents of the Mode Submenu 
• RGB 

• Grayscale 

• Indexed 

• Compose 

• Decompose 

RGB mode 
The RGB command converts your image to RGB mode. See the RGB description in the 
Glossary for more information. Normally, you work in this mode, which is well-adapted to 
the screen. It is possible to convert an RGB image to Grayscale or Indexed mode, but be 
careful: once you have saved the image, you can no longer retrieve the RGB colors, so 
you should work on a copy of your image. 

Activating the command 
• You can access this command from the image menu bar through Image Mode RGB . 

Grayscale mode 
You can use the Grayscale command to convert your image to grayscale with 256 levels 
of gray, from 0 (black) to 255 (white). See the glossary for more information about 
grayscale mode. 

Activating the Command 
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• You can access this command from the image menubar through Image Mode 

Grayscale . 

Indexed mode 
The Indexed command converts your image to indexed mode. See indexed colors in the 
Glossary for more information about Indexed Color Mode. 

Activating the Dialog 
• You can access this command from the image menu bar through Image Mode 

Indexed . 

The Convert Image to Indexed Colors dialog 
The Indexed command opens the Convert Image to Indexed Colors dialog. 

 

You can edit the color palette of an indexed image by using the Colormap Dialog. 

Decompose 
With the Decompose command, you can decompose an image into its color components. 
You can find more information about using this command in the Decompose filter section. 

Activating the Command 
• You can access this command from the image menubar through Image Mode 

Decompose . 

Compose 
With the Compose command, you can re-compose an image that has been decomposed 
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into its color components. You can find more information about using this command in the 
Compose filter section. 

Activating the Command 
• You can access this command from the image menubar through Image Mode 

Compose . 

Transform 

 

The items on the Transform submenu transform the image by flipping it, rotating it or 
cropping it. 

Activating the Submenu 
• You can access this submenu from the image menubar through Image Transform . 

The Contents of the Transform Submenu 
The Transform submenu has the following commands: 

• Flip Horizontally; Flip Vertically 

• Rotate 90° CW; Rotate 90° CCW; Rotate 180° 

• Guillotine 

Flip Horizontally; Flip Vertically 
You can flip the image, or turn it over like a card, by using the Flip Horizontally or Flip 
Vertically commands. These commands work on the whole image. To flip a selection, use 
the Flip Tool. To flip a layer, use the functions of the Layer Transform menu or the Flip Tool. 

Activating the Commands 
• You can access the horizontal flip command from the image menubar through Image 

Transform Flip Horizontally . 

• You can access the vertical flip command from the image menubar through Image 
Transform Flip Vertically . 

Rotation 
You can rotate the image 90° clockwise or counter-clockwise, or rotate it 180°, by using 
the rotation commands on the Transform submenu of the Image menu. These commands 
can be used to change between Portrait and Landscape orientation. They work on the 
whole image. If you want to rotate the image at a different angle, rotate a selection or 
rotate a layer, use the Rotate Tool. You can also rotate a layer by using the Layer 
Transform menu. 
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Activating the Commands 
You can access these three commands from the image menubar through 

• Image Transform Rotate 90 degrees CW , 

• Image Transform Rotate 90 degrees CCW and 

• Image Transform Rotate 180° . 

Guillotine 
The Guillotine command slices up the current image, based on the image's guides. It cuts 
the image along each guide, similar to slicing documents in an office with a guillotine 
(paper cutter) and creates new images out of the pieces. For further information on 
guides, see the glossary entry for Guides. 

Activating the Command 
• You can access this command from the image menubar through Image Transform 

Guillotine . 

Canvas Size 
The "canvas" is the visible area of the image. By default the size of the canvas coincides 
with the size of the layers. The Canvas Size command lets you enlarge or reduce the 
canvas size without modifying the contents of the layers in the image. When you enlarge 
the canvas, you create free space around the contents of the image. When you reduce it, 
the visible area is cropped, however the layers still extend beyond the canvas border. 

Activating the Command 
• You can access this command from the image menubar through Image Canvas Size . 

Description of the Canvas size dialog 
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The Offset values are used to place the image on the canvas. The preview window 
displays the image in a frame with a thin border. When the canvas is smaller than the 
image, the preview window shows it in a frame with a thin black border. 

When you click on the Resize button, the canvas is resized, but the pixel information and 
the drawing scale of the image are unchanged. 

If the layers of the image did not extend beyond the borders of the canvas before you 
changed its size, there are no layers on the part of the canvas that was added by resizing 
it. Therefore, this part of the canvas is transparent and displayed with a checkered 
pattern, and it is not immediately available for painting. You can either flatten the image, 
in which case you will get an image with a single layer that fits the canvas exactly, or you 
can use the Layer to Image Size command to resize only the active layer, without 
changing any other layers. You can also create a new layer and fill it with the background 
you want. By doing this, you create a digital "passe-partout" (a kind of glass mount with a 
removable back for slipping in a photograph). 

Print Size 
You can use the Print Size dialog to change the dimensions of a printed image and its 
resolution. This command does not change the number of pixels in the image and it does 
not resample the image. (If you want to change the size of an image by resampling it, use 
the Scale Image command.) 

Options in the Print Size Dialog 
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The output resolution determines the number of pixels used per unit length for the 
printed image. Do not confuse the output resolution with the printer resolution, which is 
expressed in dpi (dots per inch); several dots are used to print a pixel. 

When the dialog is displayed, the resolution shown in the boxes is the resolution of the 
original image. If you increase the output resolution, the printed page will be smaller, 
since more pixels are used per unit of length. Conversely, and for the same reason, 
resizing the image modifies the resolution. 

Increasing the resolution results in increasing the sharpness of the printed page. This is 
quite different from simply reducing the image size by scaling it, since no pixels (and no 
image information) are removed. 

Fit Canvas to Layers 
The Fit Canvas to Layers command adapts the canvas size (that is, the drawing area) to 
the size of the largest layer in the image, in both width and height. 

Activating the command 
• You can access this command from the image menubar through Image Fit Canvas to 

Layers . 

Scale Image 
The Scale Image command enlarges or reduces the physical size of the image by 
changing the number of pixels it contains. It changes the size of the contents of the 
image and resizes the canvas accordingly. 

It operates on the entire image. If your image has layers of different sizes, making the 
image smaller could shrink some of them down to nothing, since a layer cannot be less 
than one pixel wide or high. If this happens, you will be warned before the operation is 
performed. 

If you only want to scale a particular layer, use the Scale Layer command. 

If scaling would produce an image larger than the "Maximum new image size" set in the 
Environment page of the Preferences dialog (which has a default of 64Mb), you are 
warned and asked to confirm the operation before it is performed. You may not 
experience any problems if you confirm the operation, but you should be aware that very 
large images consume a lot of resources and extremely large images may take more 
resources than you have, causing GIMP to crash or not perform well. 

Activating the Command 
• You can access this command from the image menubar through Image Scale image . 

The Scale Image Dialog 
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See also the Scale tool, which lets you scale a layer, a selection or a path. 

Crop Image 
The Crop Image command crops the image to the boundary of the selection by removing 
any strips at the edges whose contents are all completely unselected. Areas which are 
partially selected (for example, by feathering) are not cropped. If there is no selection for 
the image, the menu entry is insensitive and grayed out. 

This command crops all of the image layers. To crop just the active layer, use the Crop 
Layer command. 

Activating the command 
• You can access this command on the image menu bar through Image Crop Image . 

Autocrop Image 
The Autocrop Image command removes the borders from an image. It searches the active 
layer for the largest possible border area that is all the same color, and then crops this 
area from the image, as if you had used the Crop tool. 

Note carefully that this command only uses the active layer of the image to find borders. 
If other layers have color variations extending into the border zone of the active layer, 
they are cropped away. 

Activating the Command 
• You can access this command from the image menubar through Image Autocrop 

Image . 

Zealous Crop 
The Zealous Crop command crops an image using a single solid color as a guide. It crops 
the edges, as with the Autocrop command, but it also crops the areas in the middle of the 
image which have the same color (at least, in principle). 

Please note that Autocrop crops all of the layers, although it only analyzes the active 
layer. This may lead to a loss of information from the other layers. 
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Example 

  

  

  

Activating the Command 
• You can access this command from the image menubar through Image Zealous Crop 

. 

Merge Visible Layers 
The Merge Visible Layers command merges the layers which are visible into a single 
layer. Visible layers are those which are indicated on the Layers dialog with an "eye" icon. 

Activating the Command 
• You can access this command from the image menubar through Image Merge Visible 

Layers , 

• or by using the keyboard shortcut Ctrl M . 

Description of the Merge Visible Layers Dialog 
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Flatten Image 

 

The Flatten Image command merges all of the layers of the image into a single layer with 
no alpha channel. After the image is flattened, it has the same appearance it had before. 
The difference is that all of the image contents are in a single layer without transparency. 
If there are any areas which are transparent through all of the layers of the original 
image, the background color is visible. 

This operation makes significant changes to the structure of the image. It is normally only 
necessary when you would like to save an image in a format which does not support 
levels or transparency (an alpha channel). 

Activating the Command 
• You can access this command from the image menubar through Image Flatten 

Image . 

Guides 

 

The Guides submenu contains various commands for the creation and removal of guides. 

GNU Image Manipulation Program
Generated by docbook2odf

Page 255 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

Activating the Submenü 
• You can access this submenu from the image menubar through Image Guides . 

The Contents of the Guides Submenu 
The Guides submenu contains the following commands: 

• New Guide 

• New Guide (by Percent) 

• New Guides from Selection 

• Remove all Guides 

Remove all guides 
The Remove all Guides command removes all guides from the image. 

Activating the Command 
• You can access this command from the image menubar through Image Guides 

Remove all guides . 

New Guide (by Percent) 
The New Guide (by Percent) command adds a guide to the image. The position of the 
guide is specified as a percentage of the Height and Width. 

You can add guides to the image more quickly by simply clicking and dragging guides 
from the image rulers and positioning them where you would like. Guides you draw with 
click-and-drag are not as precisely positioned as those you draw with this command, 
however. 

Activating the Command 
• You can access this command from the image menubar through Image Guides New 

Guide (by Percent) . 

New Guide (by Percent) Options 

 

New Guide 
The New Guide command adds a guide to the image. For more information about guides, 
see the glossary entry on Guides. 

You can add guides to the image more quickly, but less accurately, by simply clicking and 
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dragging guides from the image rulers and positioning them where you would like. 

Activating the Command 
• You can access this command from the image menubar through Image Guides New 

Guide 

New Guide Options 

 

New Guides from Selection 
The New Guides from Selection command adds four guide lines, one for each of the 
upper, lower, left and right edges of the current selection. If there is no selection in the 
current image, no guides are drawn. 

Activating the Command 
• You can access this command from the image menubar through Image Guides New 

Guides from Selection . 

Configure Grid 
The Configure Grid command lets you set the properties of the grid which you can display 
over your image while you are working on it. The GIMP provides only Cartesian grids. You 
can choose the color of the grid lines, and the spacing and offsets from the origin of the 
image, independently for the horizontal and vertical grid lines. You can choose one of five 
different grid styles. 

Activating the Command 
• You can access this command from the image menubar through Image Configure 

Grid . 

Description of the Configure Grid dialog 
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In the Configure Image Grid dialog, you can set the properties of the grid which is shown 
when you turn on the image grid. 
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Layers 

Introduction to the Layer Menu 

 

The items on the Layer menu allow you to work on layers. In addition to accessing the 
Layer menu from the Image menubar and by right-clicking on the image window, you can 
get to it by right-clicking on the thumbnail of a layer in the Layers dialog. You can also 
perform several of the operations on this menu by clicking on buttons in the Layers 
dialog, for example, resizing a layer, managing layer transparency and merging layers. 

This menu can contain other entries besides the ones described in this section. They are 
not part of GIMP itself, but are extensions (plug-ins). Please refer to the documentation 
about the plug-ins for more information. 

New Layer 
The New Layer command adds a new, empty layer to the layer stack of the image, just 
above the active layer. The command displays a dialog in which you can specify the size 
of the new layer. 

Activating the Command 
• You can access this command from the image menubar through Layer New Layer . 

Description of the New Layer Dialog 
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Duplicate layer 
The Duplicate Layer command adds a new layer to the image which is a nearly identical 
copy of the active layer. The name of the new layer is the same as the name of the 
original layer, but with " copy" appended to it. 

If you duplicate a background layer which does not have an alpha channel, the new layer 
is provided with one. In addition, if there are any "parasites" attached to the active layer, 
they are not duplicated. (If your understanding of the word "parasites" is limited to small, 
unpleasant creatures, please ignore the last sentence.) 

Activating the Command 
• You can access this command from the image menubar through Layer Duplicate 

Layer 

Anchor layer 
When you move or paste a selection, a temporary layer, called a "floating layer" or 
"floating selection", is added to the layer stack. As long as the floating layer persists, you 
can work only on it. To work on the rest of the image, you must "anchor" the floating layer 
to the former active layer with the Anchor layer command. If the image does not contain 
a floating selection, this menu entry is insensitive and grayed out. 

If there is an active selection tool, the mouse pointer is displayed with an anchor icon 
when it is outside of the selection. A left click then anchors the floating selection. 

You may also click on the New layer command on the Layers dialog, which anchors the 
floating selection to a new layer. See . 

Activating the Command 
• You can access this command from the image menubar through Layer Anchor layer , 

• or by using the keyboard shortcut Ctrl H . 

Merge Down 
The Merge Down command merges the active layer with the layer just below it in the 
stack, taking into account the various properties of the active layer, such as its opacity 
and combination mode. 
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Activating the Command 
• You can access this command from the image menubar through Layer Merge Down . 

Delete Layer 
The Delete Layer command deletes the active layer from the image. 

Activating the Command 
• You can access this command from the image menu-bar through Layer Delete Layer 

. 

The Stack Submenu 

 

The layer stack is simply the list of layers in the Layers dialog. The Stack submenu 
contains operations which either select a new layer as the active layer, or change the 
position of the active layer in the layer stack. 

Activating the Submenu 
• You can access this submenu from the image menubar through Layer Stack . 

The Contents of the Stack Submenu 
The Stack submenu contains the following commands: 

•

•

•

•

•

•

•

•

Select Previous Layer 
The Select Previous Layer command selects the layer just above the active layer in the 
layer stack. The command highlights the layer in the Layers Dialog and makes it the new 
active layer. If the active layer is already at the top of the stack, this menu entry is 
insensitive and grayed out. 
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Note that on a standard Windows-style English keyboard, the default shortcut Page_Up 
does not refer to the key on the numeric keypad, but to the other Page_Up key in the 
group of six keys to the left of the numeric keypad. 

The keyboard shortcuts for Select Previous Layer and Select Next Layer may be very 
useful if you frequently pick colors from one layer to use for painting on another layer, 
especially when you use them with the color-picker tool, which you get by holding down 
the Ctrl key with most of the painting tools. 

Activating the Command 
• You can access this command from the image menubar through Layer Stack Select 

Previous Layer , 

• or by using the keyboard shortcut Page_Up, 

• or the "Up-arrow" key, 

• or simply by clicking on the layer name in the Layers Dialog. 

Select Next Layer 
The Select Next Layer command selects the layer just underneath the active layer in the 
layer stack. The command highlights the layer in the Layers Dialog and makes it the new 
active layer. If the active layer is already at the bottom of the stack, this menu entry is 
insensitive and grayed out. 

Note that on a standard Windows-style English keyboard, the default shortcut Page_Down 
does not refer to the key on the numeric keypad, but to the other Page_Down key in the 
group of six keys to the left of the numeric keypad. 

Activating the Command 
• You can access this command from the image menubar through Layer Stack Select 

Next Layer , 

• or by using the keyboard shortcut Page_Down, 

• or the "Down-arrow" key, 

• or simply by clicking on the layer name in Layers Dialog. 

Select Top Layer 
The Select Top Layer command makes the top layer in the stack the active layer for the 
image and highlights it in the Layers dialog. If the active layer is already the top layer in 
the stack, this menu entry is insensitive and grayed out. 

Note that on a standard Windows-style English keyboard, the default keyboard shortcut 
Home does not refer to the key on the numeric keypad, but to the other Home key in the 
group of six keys to the left of the numeric keypad. 

Activating the Command 
• You can access this command from the image menubar through Layer Stack Select 

Top Layer , 

• or by using the keyboard shortcut Home, 

• or simply by clicking on the layer name in the Layers Dialog. 

Select Bottom Layer 
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With the Select Bottom Layer command, you can make the bottom layer in the stack 
become the active layer for the image. It is then highlighted in the Layers dialog. If the 
bottom layer of the stack is already the active layer, this menu entry is insensitive and 
grayed out. 

Note that on a standard Windows-style English keyboard, the default keyboard shortcut 
refers to the End key in the group of six keys to the left of the numeric keypad, not to the 
one in the numeric keypad. 

Activating the Command 
• You can access this command from the image menubar through Layer Stack Select 

Bottom Layer , 

• by using the keyboard shortcut End, 

• or simply by clicking on the name of the layer in the Layers dialog. 

Raise Layer 
The Raise Layer command raises the active layer one position in the layer stack. If the 
active layer is already at the top or if there is only one layer, this menu entry is 
insensitive and grayed out. If the active layer is at the bottom of the stack and it does not 
have an alpha channel, it cannot be raised until you add an alpha channel to it. 

Activating the Command 
• You can access this command from the image menubar through Layer Stack Raise 

Layer , 

• or by clicking on the up-arrow icon at the bottom of the Layers dialog. 

Lower Layer 
The Lower layer command lowers the active layer one position in the layer stack. If the 
active layer is already at the bottom of the stack or if there is only one layer, this menu 
entry is insensitive and grayed out. 

Activating the Command 
• You can access this command from the image menubar through Layer Stack Lower 

Layer , 

• or by clicking on the down-arrow icon at the bottom of the Layers dialog. 

Layer to Top 
The Layer to Top command raises the active layer to the top of the layer stack. If the 
active layer is already at the top or if there is only one layer, this menu entry is 
insensitive and grayed out. If the active layer is at the bottom of the stack and it does not 
have an alpha channel, you cannot raise it until you add an alpha channel to it. 

Activating the Command 
• You can access this command from the image menubar through Layer Stack Layer to 

Top , 

• or by pressing the Shift key and clicking on the up-arrow icon at the bottom of the 
Layers dialog. 
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Layer to Bottom 
The Layer to bottom command lowers the active layer to the bottom of the layer stack. If 
the active layer is already at the bottom of the stack or if there is only one layer, this 
menu entry is insensitive and grayed out. 

Activating the Command 
• You can access this command from the image menubar through Layer Stack Layer to 

Bottom , 

• or by pressing the Shift key and clicking on the down-arrow icon at the bottom of the 
Layers dialog. 

The Colors Submenu 

 

The Colors submenu contains operations which alter colors within the active layer. The 
operations at the top of the list access the Color tools for the image. These are described 
in the Toolbox chapter. 

This command operates only on the layer which is active at the time the command is 
called. Even after you make another layer the active layer, the operation continues to 
affect the layer on which you performed the command. 

Activating the submenu 
• You can access this submenu from the image menubar through Layer Colors . 

Contents of the Colors Submenu 
In addition to the menu items relating to the color tools which are at the top of the list, 
the Colors submenu contains the following menu items: 

•

•

•

Desaturate 
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By using the Desaturate command, you can convert all of the colors on the active layer to 
corresponding shades of gray. This differs from converting the image to grayscale in two 
respects. First, it only operates on the active layer and second, the colors on the layer are 
still RGB values with three components. This means that you can paint on the layer, or 
individual parts of it, using color at a later time. 

This command only works on layers of RGB images. If the image is in Grayscale or 
Indexed mode, the menu entry is insensitive and grayed out. 

Activating the Command 
• You can access this command from the image menubar through Layer Colors 

Desaturate . 

Invert 
The Invert command inverts all the pixel colors and brightness values in the current layer, 
as if the image were converted into a negative. Dark areas become bright and bright 
areas become dark. Hues are replaced by their complementary colors. For more 
information about colors, see the Glossary entry about Color Model. 

This command only works on layers of RGB and Grayscale images. If the current image is 
Indexed, the menu entry is insensitive and grayed out. 

Don't mix up this command with the Invert Selection command. 

Activating the Command 
• You can access this command from the image menubar through Layer Colors Invert . 

Example 

  

  

The Auto Submenu 

 

The Auto submenu contains operations which automatically adjust the distribution of 
colors in the active layer, without requiring any input from the user. Several of these 
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operations are actually implemented as plugins. 

Activating the submenu 
• You can access this submenu from the image window through Layer Colors Auto . 

Contents of the Auto Submenu 
The Auto submenu contains the following entries: 

•

•

•

•

•

Equalize 
The Equalize command stretches every R, G and B component between 0 and 255. The 
results of this command can vary quite a bit. Sometimes Equalize works very well to 
enhance the contrast in an image, bringing out details which were hard to see before. 
Other times, the results look very bad. It is a very powerful operation and it is worth 
trying it to see if it will improve your image. 

Activating the Command 
• You can access this command from the image menubar through Layer Colors Auto 

Equalize , 

• or by using the keyboard shortcut Shift Page Down . 

Example 
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Stretch Contrast 
This command is somewhat similar to Normalize plug-in in its effects, except that it works 
on each color channel of the layer individually, rather than just the brightness values. 
This usually leads to color shifts within the image, so it may not produce the result you 
are looking for. Stretch Contrast operates on layers from RGB, Grayscale, and Indexed 
images. 

Activate Dialog 
• This command can be accessed from an image menubar as Layer Color Auto Stretch 

Contrast . 

Color Enhance 
"Color Enhance" increases the saturation range of colors in the layer without altering 
brightness or hue. It does this by converting the colors in HSV space, measuring the 
range of saturation values across the image, then stretching this range to be as large as 
possible, and finally converting the colors back to RGB. It works on layers from RGB and 
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Indexed images. If the image is Grayscale, the menu entry will be insensitive. 

Activate Dialog 
• This command can be accessed from an image menubar as Layer Color Auto Color 

Enhance . 

Stretch HSV 
This command does the same thing as Stretch Contrast, except that it works in HSV color 
space rather than RGB color space. Thus, it independently stretches the hue channel, the 
saturation channel, and the value channel. Occasionally the results are good, often they 
are a bit odd. Stretch HSV operates on layers from RGB and Indexed images. If the image 
is Grayscale, the menu entry will be insensitive. 

Activate Dialog 
• This command can be accessed from an image menubar as Layer Colors Auto 

Stretch HSV . 

Normalize 
This command scales brightness values across the active layer so that the darkest point 
becomes black, and the brightest point becomes as bright as possible without altering its 
hue. This is often a "magic fix" for images that are dim or washed out. Normalize works 
on layers from RGB, Grayscale, and Indexed images. 

Activate Dialog 
• This command can be accessed from an image menubar as Layer Color Auto 

Normalize . 

The Mask Submenu 

 

The Mask submenu of the Layer menu contains commands which work with masks: 
creating a mask, applying a mask, deleting a mask or converting a mask into a selection. 
See the Layer Masks section for more information on layer masks and how to use them. 

Activating the Submenu 
• You can access this submenu from the image menubar through Layer Mask . 

The Contents of the Mask Submenu 
The Mask submenu contains the following commands: 
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•

•

•

•

•

•

•

•

•

•

Add Layer Mask 
The Add Layer Mask command adds a layer mask to the active layer. It displays a dialog 
in which you can set the initial properties of the mask. If the layer already has a layer 
mask, or if it cannot have one because it does not have an alpha channel, the menu entry 
is insensitive and grayed out. 

A layer mask lets you define which parts of the layer are opaque, semi-transparent or 
transparent. See the Layer Mask section for more information. 

Activating the Command 
• You can access this command from the image menubar through Layer Mask Add 

Layer Mask 

• or from the pop-up menu you get by right-clicking on the active layer in the Layers 
Dialog. 

Description of the Add Layer Mask Dialog 

 

When you click on the OK button, a thumbnail of the layer mask appears to the right of 
the thumbnail of the layer in the Layers Dialog. 
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Apply Layer Mask 
The Apply Layer Mask command merges the layer mask with the active layer. The 
transparency information in the layer mask is transferred to the alpha channel and the 
layer mask is removed. If the active layer does not have a layer mask, the menu entry is 
insensitive and grayed out. See the Layer Masks section for more information. 

Activating the Command 
• You can access this command from the image menubar through Layer Mask Apply 

Layer Mask , 

• or from the pop-up menu you get by right-clicking on the active layer in the Layers 
Dialog. 

Delete Layer Mask 
The Delete Layer Mask command deletes the active layer's layer mask, without modifying 
the active layer itself. If the active layer does not have a layer mask, the menu entry is 
insensitive and grayed out. 

Activating the Command 
• You can access this command from the image menubar through Layer Mask Delete 

Layer Mask , 

• or from the pop-up menu you get by right-clicking on the active layer in the Layers 
Dialog. 

Edit Layer Mask 
When you click on the Edit Layer Mask item on the Layer Mask submenu, a check is 
displayed next to it, the layer mask becomes the active component of the current layer 
and the layer mask is displayed in the Layers Dialog with a white border. When you 
uncheck it, the layer itself becomes the active component and it is displayed with a white 
border. You can also activate the component you want more simply by clicking on it in the 
Layers Dialog. 

Activating the Command 
• You can access this command from the image menubar through Layer Mask Edit 

Layer Mask . 

• You can undo this action by unchecking the menu entry in the LayerMask menu or 
by clicking on the layer component in the Layers Dialog. 

Disable Layer Mask 
As soon as you create a layer mask, it acts on the image. The Disable Layer Mask 
command allows you to suspend this action. When you click on the menu entry, a check 
is displayed next to it and the border of the layer mask's thumbnail in the Layers Dialog 
turns red. 

Activating the Command 
• You can access this command from the image menubar through Layer Mask Disable 

Layer Mask , 

• or by holding down the Alt key ( Ctrl Alt on some systems) and single-clicking on the 
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layer mask's thumbnail in the Layers Dialog. 

• You can undo this action by unchecking the menu entry in the LayerMask menu or 
by Alt-clicking (or Ctrl Alt -clicking) again on the layer mask's thumbnail. 

Show Layer Mask 
The Show Layer Mask command lets you see the layer mask better by turning the image 
invisible. When you click on the menu entry, a check is displayed next to it and the layer 
mask's thumbnail in the Layers Dialog is shown with a green border. The layer itself is not 
modified; you can turn it visible again later. 

Activating the Command 
• You can access this command from the image menubar through Layer Mask Show 

Layer Mask , 

• or by holding down the Alt key ( Ctrl Alt on some systems) and single-clicking on the 
layer mask's thumbnail in the Layers Dialog. 

• You can undo this action by unchecking the menu entry in the LayerMask submenu 
or by Alt-clicking (or Ctrl Alt -clicking) again on the layer mask's thumbnail. 

Mask to Selection 
The Mask to Selection command converts the layer mask of the active layer into a 
selection, which replaces the selection that is already active in the image. White areas of 
the layer mask are selected, black areas are not selected, and gray areas are converted 
into feathered selections. The layer mask itself is not modified by this command. 

  

Activating the Command 
• You can access this command from the image menubar through Layer Mask Mask to 

Selection , 

• or from the pop-up menu you get by right-clicking on the active layer in the Layers 
Dialog. 

Add Layer Mask to Selection 
The Add to Selection command converts the layer mask of the active layer into a 
selection, which is added to the selection that is already active in the image. White areas 
of the layer mask are selected, black areas are not selected, and gray areas are 
converted into feathered selections. The layer mask itself is not modified by this 
command. 
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Activating the Command 
• You can access this command from the image menubar through Layer Mask Add to 

Selection , 

• or from the pop-up menu you get by right-clicking on the active layer in the Layers 
Dialog. 

Subtract Layer Mask from Selection 
The Subtract from Selection command converts the layer mask of the active layer into a 
selection, which is subtracted from the selection that is already active in the image. White 
areas of the layer mask are selected, black areas are not selected, and gray areas are 
converted into feathered selections. The layer mask itself is not modified by this 
command. 

  

Activating the Command 
• You can access this command from the image menubar through Layer Mask Subtract 

from Selection , 

• or from the pop-up menu you get by right-clicking on the active layer in the Layers 
Dialog. 

Intersect Layer Mask with Selection 
The Intersect with Selection command converts the layer mask of the active layer into a 
selection. The intersection of this selection and the selection that is already active form 
the new selection for the image. White areas of the layer mask are selected, black areas 
are not selected, and gray areas are converted into feathered selections. The layer mask 
itself is not modified by this command. 

  

Activating the Command 
• You can access this command from the image menubar through Layer Mask 

Intersect with Selection , 

• or from the pop-up menu you get by right-clicking on the active layer in the Layers 
Dialog. 

The Transparency Submenu of the Layer menu 
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The Transparency submenu contains commands which use or affect the alpha channel of 
the active layer. 

Activating the Submenu 
• You can access this submenu from the image menubar through Layer Transparency . 

The Contents of the Transparency Submenu 
The Transparency submenu contains the following commands: 

•

•

•

•

•

•

•

•

Add Alpha Channel 
The Add Alpha Channel command adds an alpha channel to the active layer. Without an 
alpha channel, a layer cannot have transparency or a layer mask. If the active layer 
already has an alpha channel (and it must, unless it is the bottom layer of the image), the 
menu entry is insensitive and grayed out. 

Activating the Command 
• You can access this command from the image menubar through Layer Transparency 

Add alpha Channel . 

Color to Alpha 
You can make colors of the active layer transparent by using the Color to Alpha command. 
You can find a description of this command in the section about the filter. 

This command operates only on the layer which is active at the time the command is 
called. Even after you choose another layer to be the active layer, the operation 
continues to affect the layer on which you performed the command. 

Activating the Command 
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• You can access this command from the image menubar through Layer Transparency 

Color to Alpha . 

Semi-flatten 
The Semi-Flatten command is described in the Semi-flatten filter chapter. The command 
is useful when you need an anti-aliased image with indexed colors and transparency. 

Activating the Command 
• You can access this command from the image menubar through Layer Transparency 

Semi-flatten . 

Threshold Alpha 
This command converts partial transparency into all-or-none transparency, by applying a 
user-specified cutoff threshold to the layer's alpha channel. It only works on alpha-
channel-possessing layers from RGB images: if the image is Grayscale or Indexed, or the 
layer lacks an alpha channel, the menu entry will be insensitive. If Keep transparency has 
been toggled on in the Layers dialog, the command will show an error message and 
refuse to operate. 

Activate Dialog 
• This operation can be accessed from an image menubar as Layer Transparency 

Threshold Alpha . 

Dialog window description 

 

Alpha to Selection 
The Alpha to Selection command creates a selection in the image from the active layer's 
alpha channel, which encodes transparency. Opaque areas are fully selected, transparent 
areas are unselected, and translucent areas are partially selected. This selection replaces 
the existing selection. The alpha channel itself is not changed. 

The other commands in this group of operations are similar, except that instead of 
completely replacing the existing selection with the selection produced from the alpha 
channel, they either add the two selections, subtract the alpha selection from the existing 
selection, or create a selection that is the intersection of the two. 

Activating the Command 
• You can access this command from the image menubar through Layer Transparency 

Alpha to Selection 

• or from the pop-up menu which appears when you right-click on the active layer in 
the Layer Dialog. 

Example 
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Add to Selection 
The Add to Selection command creates a selection in the image from the pixels of the 
active layer according to their transparency. Opaque areas are fully selected, transparent 
areas are unselected, and translucent areas are partially selected. This selection is added 
to an existing selection. The alpha channel itself is not changed. 

The other commands in this group of operations are similar, except that instead of adding 
to the existing selection with the selection produced from the active layer, they either 
completely replace the selection with a selection produced from the alpha selection, 
subtract the alpha selection from the existing selection, or create a selection that is the 
intersection of the two. 

Activating the Command 
• You can access this command from the image menubar through Layer Transparency 

Add to Selection . 

Example 

 

  

Subtract from Selection 
The Subtract from Selection command creates a selection in the image from the pixels of 
the active layer according to their transparency. Opaque areas are fully selected, 
transparent areas are unselected, and translucent areas are partially selected. This 
selection is subtracted from an existing selection. The alpha channel itself is not changed. 
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Activating the Command 
• You can access this command from the image menubar through Layer Transparency 

Subtract from Selection 

• or from the pop-up menu which appears when you right-click on the active layer in 
the Layer Dialog. 

Example 

 

  

Intersect with Selection 
The Intersect with Selection command creates a selection in the image from the pixels of 
the active layer according to their transparency. Opaque areas are fully selected, 
transparent areas are unselected, and translucent areas are partially selected. This 
selection is intersected with an existing selection: only common parts of both selections 
are kept. The alpha channel itself is not changed. 

Activating the Command 
• You can access this command from the image menubar through Layer Transparency 

Intersect with Selection 

• or from the pop-up menu which appears when you right-click on the active layer in 
the Layers Dialog. 

Example 
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The Transform Submenu 

 

The Transform submenu of the Layer menu contains commands which flip or rotate the 
active layer of the image. 

Activating the Submenu 
• You can access this submenu from the image menubar through Layer Transform . 

The Contents of the Transform Submenu 
The Transform submenu contains the following commands: 

•

•

•

•

•

•

•

Flip Horizontally 
The Flip Horizontally command reverses the active layer horizontally, that is, from left to 
right. It leaves the dimensions of the layer and the pixel information unchanged. 

Activating the Command 
• You can access this command from the image menubar through Layer Transform Flip 

Horizontally . 

Example 
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Flip Vertically 
The Flip Vertically command reverses the active layer vertically, that is, from top to 
bottom. It leaves the dimensions of the layer and the pixel information unchanged. 

Activating the Command 
• You can access this command from the image menubar through Layer Transform Flip 

Vertically . 

Rotate 90 degrees CW 
The Rotate 90 degrees CW command rotates the active layer by 90° around the center of 
the layer, with no loss of pixel data. The shape of the layer is not altered, but the rotation 
may cause the layer to extend beyond the bounds of the image. This is allowed in GIMP 
and it does not mean that the layer is cropped. However, you will not be able to see the 
parts which extend beyond the boundary of the image unless you resize the image 
canvas or move the layer. 

Activating the Command 
• You can access this command from the image menubar through Layer Transform 

Rotate 90 degrees CW . 

Rotate 90 degrees CCW 
The Rotate 90 degrees CCW command rotates the active layer by 90° counter-clockwise 
around the center of the layer, with no loss of pixel data. The shape of the layer is not 
altered, but the rotation may cause the layer to extend beyond the bounds of the image. 
This is allowed in GIMP and it does not mean that the layer is cropped. However, you will 
not be able to see the parts which extend beyond the boundary of the image unless you 
resize the image canvas or move the layer. 

Activating the Command 
• You can access this command from the image menubar through Layer Transform 

Rotate 90 degrees CCW . 

Rotate 180 degrees 
The Rotate 180 degrees command rotates the active layer by 180° around the center of 
the layer, with no loss of pixel data. The shape of the layer is not altered, but the rotation 
may cause the layer to extend beyond the bounds of the image. This is allowed in GIMP 
and it does not mean that the layer is cropped. However, you will not be able to see the 
parts which extend beyond the boundary of the image unless you resize the image 
canvas or move the layer. 

Activating the Command 
• You can access this command from the image menubar through Layer Transform 

Rotate 180 degrees . 
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Arbitrary Rotation 
The Arbitrary Rotation command rotates a layer by a specified angle. It is an alternate 
way of accessing the Rotate tool. See the section about that tool for more information. 

Activating the Command 
• You can access this command from the image menubar through Layer Transform 

Arbitrary Rotation , 

• or by using the keyboard shortcut Shift R . 

Offset 
The Offset command shifts the contents of the active layer. Anything shifted outside the 
layer boundary is cropped. This command displays a dialog which allows you to specify 
how much to shift the layer and how to fill the space that is left empty by shifting it. 

Activating the Command 
• You can access this command from the image menubar through Layer Transform 

Offset , 

• or by using the keyboard shortcut Shift Ctrl O . 

Description of the Offset dialog 

 

Layer Boundary Size 
In GIMP, a layer is not always the same size as the image it belongs to. It might be 
smaller or it might be larger, in which case some parts of it are hidden. The Layer 
Boundary Size command displays a dialog in which you can set the dimensions for the 
active layer. This command changes the dimensions of the layer, but it does not scale its 
contents. 

Activating the Command 
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• You can access this command from the image menubar through Layer Layer 

Boundary Size . 

Description of the Layer Boundary Size dialog 

 

Layer to Image Size 
The Layer to Image Size command resizes the layer boundaries to match the image 
boundaries, without moving the contents of the layer with respect to the image. 

Activating the Command 
• You can access this command from the image menubar through Layer Stack Layer to 

Image Size . 

Scale Layer 
The Scale Layer command resizes the layer and its contents. The image loses some of its 
quality by being scaled. The command displays a dialog where you can set parameters 
concerning the size of the layer and the image quality. 

Activating the Command 
• You can access this command from the image menubar through Layer Scale Layer . 

Description of the Scale Layer Dialog 
 

GNU Image Manipulation Program
Generated by docbook2odf

Page 280 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

Crop Layer 
The Crop Layer command crops only the active layer to the boundary of the selection by 
removing any strips at the edge whose contents are all completely unselected. Areas 
which are partially selected (for example, by feathering) are not cropped. If there is no 
selection for the image, the menu entry is insensitive and grayed out. 

Activating the Command 
• You can access this command from the image menubar through Layer Crop layer . 

Example 

   

Autocrop Layer 
The Autocrop Layer command automatically crops the current layer by removing a border. 
It looks for the the largest possible area around the outside edge which all has the same 
color and then crops this area from the layer. You can use it to isolate an object from a 
single-color background. 

Activating the Command 
• You can access this command from the image menubar through Layer Autocrop 

Layer . 

Align Visible Layers 
With the Align Visible Layers command, you can very precisely position the visible layers 
(those marked with the "eye" icon). This degree of precision is especially useful when you 
are working on animations, which typically have many small layers. Clicking on Align 
Visible Layers displays a dialog which allows you to choose how the layers should be 
aligned. 

In GIMP 1.2, the default base for the alignment was the top visible layer in the stack. In 
GIMP 2, the default alignment base is the edge of the canvas. You can still align the image 
on the bottom layer of the stack, even if it is invisible, by checking Use the (invisible) 
bottom layer as the base in the dialog. 
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Activating the Command 
• You can access this command from the image menubar through Layer Align Visible 

layers . There is no default keyboard shortcut. 

Description of the Layer Align dialog 
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Tools 

Introduction to the Tools Menu 

 

The menu entries on the Tools menu access the GIMP tools. All of the tools available in 
GIMP are extensively described in the Toolbox section. 
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The Filters Menu of the Image Window 

Introduction to the Filters menu 

 

In GIMP terminology, a filter is a plug-in that modifies the appearance of an image, in 
most cases just the active layer of the image. Not all of the entries in this menu meet that 
definition, however; the word "filter" is often mis-used to mean any plug-in, regardless of 
what it does. Indeed, some of the entries in this menu do not modify images at all. 

With the exception of the top three items of the Filters menu, all of the entries are 
provided by plug-ins. Each plug-in decides for itself where it would like its menu entry to 
be placed. Therefore, the appearance of this menu can be completely different for each 
user. In practice, though, the appearance does not vary very much, because most plug-
ins come with GIMP when it is installed, and of course they are always in the same places 
in the menu. 

Plug-ins are not restricted to just the Filters menu: a plug-in can place entries in any 
menu. Indeed, a number of GIMP's basic functions (for example, Semi-flatten in the Layer 
menu) are implemented by plug-ins. But the Filters menu is the default place for a plug-in 
to place its menu entries. 

For general information on plug-ins and how to use them, see the section on Plug-ins. You 
can find information on the filters that are provided with GIMP in the Filters chapter. For 
filters you install yourself, please refer to the information which came with them. 

Repeat Last 
The Repeat Last command performs the action of the most recently executed plug-in 
again, using the same settings as the last time it was run. It does not show a dialog or 
request confirmation. 

Please note that this command repeats the most recently executed plug-in, regardless of 
whether it is in the Filters menu or not. 
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Activating the Command 
• You can access this command from the image menubar through Filters Repeat filter , 

• or by using the keyboard shortcut Ctrl F . 

Re-show Last 
The Re-show Last command interactively runs the most recently executed plug-in. Unlike 
the "Repeat Last" command, which does not display a dialog, the "Re-show Last" 
command displays a dialog window, if the plug-in has one. It is displayed with the settings 
you used the last time you ran the plug-in (assuming that the plug-in follows the GIMP 
programming conventions). 

Please note that this command repeats the most recently executed plug-in, regardless of 
whether it is in the Filters menu or not. 

When you are using a plug-in, especially one that does not have a preview window, you 
may very well have to adjust the parameters several times before you are satisfied with 
the results. To do this most efficiently, you should memorize the shortcuts for Undo and 
Re-show Last: Ctrl Z followed by Ctrl Shift F . 

Activating the Command 
• You can access this command from the image menubar through Filters Re-show filter 

, 

• or by using the keyboard shortcut Ctrl Shift F . 

Reset All Filters 
Normally, each time you run an interactive plug-in, its dialog is displayed with all of the 
settings initialized to the ones you used the last time you ran it. This may be a problem if 
you made a mistake setting the values and you can't remember what they were originally. 
One way to recover is to exit GIMP and start again, but the Reset all Filters command is a 
slightly less drastic solution: it resets the values for all plug-ins to their defaults. Because 
it is a dramatic step, it asks you to confirm that you really want to do it. Be careful: you 
cannot undo this command. 

Activating the Command 
• You can access this command from the image menubar through Filters Reset all 

Filters . 
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Filter introduction 
A filter is a special kind of tool designed to take an input layer or image, apply a 
mathematical algorithm to it, and return the input layer or image in a modified format. 
The GIMP uses filters to achieve a variety of effects and those effects are discussed here. 

• Blur

• Colors

• Noise

• Edge-Detect

• Enhance

• Generic

• Glass Effects

• Light Effects

• Distorts

• Artistic

• Map

• Render

• Web

• Animation

• Combine
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Blur filters 

Blur filters introduction 

 

This is a set of filters that blur images, or parts of them, in various ways. If there is a 
selection, only the selected parts of an image will be blurred. There may, however, be 
some leakage of colors from the unblurred area into the blurred area. To help you pick the 
one you want, we will illustrate what each does when applied to the image shown at right. 
These are, of course, only examples: most of the filters have parameter settings that 
allow you to vary the magnitude or type of blurring. 

 

The most broadly useful of these is the Gaussian blur. (Don't let the word "Gaussian" 
throw you: this filter makes an image blurry in the most basic way.) It has an efficient 
implementation that allows it to create a very blurry blur in a relatively short time. 

 

If you only want to blur the image a little bit--to soften it, as it were--you might use the 
simple "Blur" filter. In Gimp 2.2 this runs automatically, without creating a dialog. The 
effect is subtle enough that you might not even notice it, but you can get a stronger 
effect by repeating it. In Gimp 2.0 the filter shows a dialog that allows you to set a 
"repeat count". If you want a strong blurring effect, this filter is too slow to be a good 
choice: use a Gaussian blur instead. 

 

The Selective Blur filter allows you to set a threshold so that only pixels that are similar to 
each other are blurred together. It is often useful as a tool for reducing graininess in 
photos without blurring sharp edges. (In the example, note that the graininess of the 
background has been reduced.) The implementation is much slower than a Gaussian blur, 
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though, so you should not use it unless you really need the selectivity. 

 

The Pixelize filter produces the well-known "Abraham Lincoln" effect by turning the image 
into a set of large square pixels. (The Oilify filter, in the Artistic Filters group, has a similar 
effect, but with irregular blobs instead of perfectly square pixels.) 

You can find a nice explanation of the Abraham Lincoln effect at . 

 

The Motion Blur filter blurs in a specific direction at each point, which allows you to create 
a sense of motion: either linear, radial, or rotational. 

Finally, the Tileable Blur filter is really the same thing as a Gaussian blur, except that it 
wraps around the edges of an image to help you reduce edge effects when you create a 
pattern by tiling multiple copies of the image side by side. 

Tileable Blur is actually implemented by a Script-Fu script that invokes the Gaussian blur 
plug-in. 

Blur 

Overview 
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The simple Blur filter produces an effect similar to that of an out of focus camera shot. To 
produce this blur effect, the filter takes the average of the present pixel value and the 
value of adjacent pixels and sets the present pixel to that average value. 

Filter advantage is its calculation speed. It suits big images. 

Filter disadvantage is that its action is hardly perceptible on big images, but very strong 
on small images. 

Activate the filter 
This filter can be called from the image menu: Filters Blur Blur 

Gaussian Blur 

Overview 
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You can find this filter in the image menu under Filters Blur Gaussian Blur 

The IIR Gaussian Blur plug-in acts on each pixel of the active layer or selection, setting its 
Value to the average of all pixel Values present in a radius defined in the dialog. A higher 
Value will produce a higher amount of blur. The blur can be set to act in one direction 
more than the other by clicking the Chain Button so that it is broken, and altering the 
radius. GIMP supports two implementations of Gaussian Blur: IIR G.B. and RLE G.B. They 
both produce the same results, but each one can be faster in some cases. 

Options 

 

Selective Gaussian Blur 

Overview 
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You can find this filter in the image menu under Filters Blur Selective Gaussian Blur 

Contrary to the other blur plug-ins, the Selective Gaussian Blur plug-in doesn't act on all 
pixels: blur is applied only if the difference between its value and the value of the 
surrounding pixels is less than a defined Delta value. So, contrasts are preserved because 
difference is high on contrast limits. It is used to blur a background so that the foreground 
subject will stand out better. This add a sense of depth to the image with only a single 
operation. 

Options 

 

Motion Blur 

Overview 
  

GNU Image Manipulation Program
Generated by docbook2odf

Page 292 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
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You can find this filter in the image menu under Filters Blur Motion Blur 

The Motion Blur filter creates a movement blur. The filter is capable of Linear, Radial, and 
Zoom movements. Each of these movements can be further adjusted, with Length, or 
Angle settings available. 

Options 

 

Pixelise 

Overview 
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You can find this filter in the image menu under Filters Blur Pixelise 

The Pixelize filter renders the image using large color blocks. It is very similar to the effect 
seen on television when obscuring a criminal during trial. It is used for the "Abraham 
Lincoln effect": see . 

Options 

 

Tileable Blur 

Overview 
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You can find this filter in the image menu under Filters Blur Tileable Blur 

This tool is used to soften tile seams in images used in tiled backgrounds. It does this by 
blending and blurring the boundary between images that will be next to each other after 
tiling. 

If you want to treat only images borders, you can't apply filter to the whole image. The 
solution to get the wanted effect is as follows: 

Duplicate layer( Layer Duplicate Layer ) and select it to work on it. 

Apply "Tileable Blur" filter with a 20 pixels radius to this layer. 

Select all ( CtrlA) and reduce selection ( Selection Shrink ) to create a border with the 
wanted width. 

Delete selection with CtrlK. 

Merge layers with Layer Merge down 

Options 
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Color filters 

Introduction to Color Filters 
The Color filters group contains several filters to modify colors in an image, a layer or a 
selection. You can find filters to compose, decompose, uncolor colors, and many other 
effects. 

Adjust FG-BG 

Overview 
This filter is found in Filters Colors Map Adjust FG-BG . 

Adjust FG-BG belongs to color map filters which make connection between a color source 
and an image. Here, image pixels having ForeGround color will turn to black while pixels 
having BackGround color will turn to white. Other colors will turn to their complementary 
color. There will be no change if FG is black and BG is white. 
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Options 
This filter has no option. 

Alien Map 2 

Overview 

 

 

This filter is found in Filters Colors Map Alien map 2 . 

This filter renders very modified colors by applying trigonometric functions. Alien Map 2 
can work on RGB and HSV. 

Options 
 

GNU Image Manipulation Program
Generated by docbook2odf

Page 298 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

Two Colors Exchange 

Overview 
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This filter is found in Filters Colors Map Color Exchange . 

This filter replaces a color with another one. 

Options 
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Colormap Rotation 

 

Overview 
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This filter is found in Filters Colors Map Color Map Rotation . 

Colormap Rotation lets you exchange one color range to another range. 

Main Options 
You have there two color circles, one for the "From" color range and the other for the "To" 
color range: 

Grey Options 

  

In this tab, you can specify how to treat gray. By default, grey is not considered as a color 
and is not taken in account by the rotation. Here, you can convert slightly saturated 
colors into grey and you can also convert grey into color. 

Previews 

Units 
You can select here the angle unit used to locate colors in the Hue/Saturation circle. This 
choice is valid only for the current filter session: don't click on Valid just after selecting 
unit, return to the wanted tab! 

Map Color Range 
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Overview 
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This filter is found in Filters Colors Map Color Range Mapping . 

Unlike Exchange filter, Map Color Range maps a defined color range against another 
defined color range. 

Options 

Sample Colorize 
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Overview 

 

 

This filter is found in Filters Colors Map Sample Colorize . 

This filter allows you to colorize old black-and-white images by mapping a color source 
image or a gradient against it. 

Your gray-tone image must be changed to RGB before using this filter 
(Image/Image>Mode>RGB). 

Options 
The filter window is divided into two parts: Destination on the left, Sampling on the right. 

Gradient Map 

Overview 
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This filter uses the current gradient, as shown in the Brush/Pattern/Gradient area of the 
Toolbox, to recolor the active layer or selection of the image to which the filter is applied. 
To use it, first choose a gradient from the Gradients Dialog. Then select the part of the 
image you want to alter, and activate the filter by choosing Filters Colors Map Gradient 
Map from the image menu. The filter runs automatically, without showing any dialog or 
requiring any further input. It uses image color intensities (0 - 255), mapping the darkest 
pixels to the left end color from the gradient, and the lightest pixels to the right end color 
from the gradient. Intermediate values are set to the corresponding intermediate colors. 

Border Average 

 

Overview 
This filter is found in Filters Colors Border Average . 

This tool calculates the average color in a border around active layer or selection. 
Calculated color becomes the foreground color in Toolbox. This filter is interesting when 
you have to find a Web page color background that differs as less as possible from your 
image border. The action of this filter is not registered in Undo History and can't be 
deleted with Ctrl+Z. 

Options 

Channel Mixer 

Overview 
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This filter is found in Filters Colors Channel Mixer . 

This filter combines values of the RGB channels. It works with images with or without an 
alpha channel. It has monochrome mode and a preview. 

Options 

 

Buttons 

Colorcube Analysis 
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Overview 

 

 

This filter is found in Filters Colors Colorcube Analysis . 

It gives data about image: dimensions, file size, color number, compression ratio... 

Options 
This filter has no option. 

Colorify 

Overview 
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This filter is found in Filters Colors Colorify . 

It renders a greyscaled image like it is seen through colored glass. 

Options 

 

Color to Alpha 
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Overview 
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This filter is found in Filters Colors Color to Alpha . 

The Color to Alpha filter makes transparent all pixels with a selected color. An Alpha 
channel is created. It will attempt to preserve anti-aliasing information by using a partially 
intelligent routine that replaces weak color information with weak alpha information. In 
this way, areas that contain an element of the selected color will maintain a blended 
appearance with their surrounding pixels. 

Options 

Compose 

Overview 
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This filter is found in Filters Colors Compose This filter is active in Filters/Colors after using 
Decompose. 

This filter reconstructs an image from its RGB, HSV... components. 

Options 

 

Decompose 

Overview 
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This filter is found in Filters Colors Decompose 

This filter separates an image into its different components (RGB, HSV...). 

Options 

 

Filter Pack 

Overview 
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This tool offers you a collection of unified filters to treat the image. Of course, same 
functions can be performed by particular filters, but you have here an interesting, 
intuitive, overview. 

Starting filter 
This filter is found in the image menu, via Filters Colors Filter Pack . 

Options 
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Hot 

 

Overview 
This filter is found in the image menu via Filters Colors Hot 

It identifies and modifies pixels which might cause problem when displayed onto PAL or 
NTSC TV screen. 

Options 

Max RGB 

 

Overview 
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This filter is found in the image menu via Filters Colors Max RGB . 

For every pixel of the image, this filter holds the channel with the maximal / minimal 
intensity. 

Options 

Retinex 

Overview 
This filter is found in the image window menu under Filters Colors Retinex . 

"Retinex" improves visual rendering of an image when lighting conditions are not good. 
While our eye can see colors correctly when light is low, cameras and video cams can't 
manage this well. The MSRCR (MultiScale Retinex with Color Restoration) algorithm, which 
is at the root of the "Retinex" filter, is inspired by the eye biological mecanisms to adapt 
itself to these conditions. "Retinex" stands for Retina + cortex. 

Besides digital photography, Retinex algorithm is used to make the information in 
astronomical photos visible and detect, in medicine, poorly visible structures in X-rays or 
scanners. 

Options 
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These options call for notions that only mathematicians can understand. In actual 
practice, user has to grope about for the best setting. 
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Semi-Flatten 

Overview 
This filter is found in the image menu through Filters Colors Semi-Flatten It is available if 
your image holds an Alpha channel (<Image>Layers/Transparency/Add an alpha 
channel). Otherwise, it is greyed out. 

The Semi-flatten filter helps those in need of a solution to anti-aliasing indexed images 
with transparency. The GIF indexed format supports complete transparency (0 or 255 
alpha value), but not semi-transparency (1 - 254): semi-transparent pixels will be 
transformed to no transparency or complete transparency, ruining anti-aliasing you 
applied to the logo you want to put onto your Web page. 

Before applying the filter, it's essential that you should know the background color of your 
Web page. Use the color-picker to determine the exact color which pops up as the 
Foreground color of the Toolbox. Invert FG/BG colors so that BG color is the same as Web 
background color. 

Semi-flatten process will combine FG color to layer (logo) color, proportionally to 
corresponding alpha values, and will rebuild correct anti-aliasing. Completely transparent 
pixels will not take the color. Very transparent pixels will take a few color and weakly 
transparent will take much color. 

Smooth Palette 

 

Overview 
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This filter is found in the image menu via Filters Colors Smooth Palette . 

It creates a striped palette from colors in active layer or selection. The main purpose of 
this filter is to create color-maps to be used with the Flame filter. 

Options 

Value invert 

Overview 
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This filter is found in Filters Colors Value Invert 

This filter inverts Value (luminosity) of the active layer or selection. Hue and Saturation 
will not be affected, although the color will sometimes be slightly different because of 
round-off error. If you want to invert Hue and Saturation also, use Layers Colors Invert . 

Note that hue and saturation can be distorted quite a bit by this filter for colors with a 
high luminosity ( for instance, HSV 102°,100%, 98%, a bright green, gives HSV 96°, 
100%, 2%) . Thus, you should not expect to be able to apply this filter twice in a row and 
get back the image you started with. 

Options 
This filter has no options. 
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Noise filters 

Noise filters introduction
Noise filters add noise to the image. To remove small defects from an image, see 
Despeckle filter. 

Hurl 

 

Overview 
This filter is found in Filters Noise Hurl . 

The Hurl filter changes each affected pixel to a random color, so it produces real random 
noise. All color channels, including an alpha channel (if it is present) are randomized. All 
possible values are assigned with the same probability. The original values are not taken 
into account. All or only some pixels in an active layer or selection are affected, the 
percentage of affected pixels is determined by the Randomization (%) option. 

Options 

Scatter RGB 
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Overview 
This filter is found in the image window menu under Filters Noise Scatter RGB . 

The Scatter RGB filter adds a normally distributed noise to a layer or a selection. It uses 
the RGB color model to produce the noise (noise is added to red, green and blue values of 
each pixel). A normal distribution means, that only slight noise is added to the most pixels 
in the affected area, while less pixels are affected by more extreme values. (If you apply 
this filter to an image filled with a solid grey color and then look at its histogram, you will 
see a classic bell-shaped Gaussian curve.) 

The result is very naturally looking noise. 

Options 

Pick 

 

Overview 
This filter is found in Filters Noise Pick . 

The Pick filter replaces each affected pixel by a pixel value randomly chosen from its 
eight neighbours and itself (from a 3×3 square the pixel is center of). All or only some 
pixels in an active layer or selection are affected, the percentage of affected pixels is 
determined by the Randomization (%) option. 

Options 

Scatter HSV 
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Overview 
This filter is found in Image>Filters/Noise/Scatter HSV 

The Scatter HSV filter creates noise in the active layer or selection by using the Hue, 
Saturation, Value (luminosity) color model. 

Options 

Slur 

 

Overview 
This filter is found in Filters Noise Slur . 

Slurring produces an effect resembling melting the image downwards; if a pixel is to be 
slurred, there is an 80% chance that it is replaced by the value of a pixel directly above it; 
otherwise, one of the two pixels to the left or right of the one above is used. All or only 
some pixels in an active layer or selection are affected, the percentage of affected pixels 
is determined by the Randomization (%) option. 

Options 

Spread 
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Overview 
This filter is found in Filters Noise Spread . 

The Spread filter swaps each pixel in the active layer or selection with another randomly 
chosen pixel by a user specified amount. It works on color transitions, not on plain color 
areas. No new color is introduced. 

Options 
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Edge-detect filters 

Edge-detect introduction 
Edge detect filters search for borders between different colors and so can detect contours 
of objects. 

They are used to make selections and for many artistic purposes. 

 

Most of them are based on gradient calculation methods and give thick border lines. Look 
at fig.1 which represents color intensity variations. On the left is a slow color gradient 
which is not a border. On the right is a quick variation which is an edge. Now, let us 
calculate the gradient, the variation speed, of this edge, i.e the first derivative (fig.2). We 
have to decide that a border is detected when gradient is more than a threshold value 
(the exact border is at top of the curve, but this top varies according to borders). In most 
cases, threshold is under top and border is thick. 

The Laplacian edge detection uses the second derivative (fig.3). The top of the curve is 
now at zero and clearly identified. That's why Laplace filter renders a thin border, only a 
pixel wide. But this derivative gives several zeros corresponding to small ripples, resulting 
in false edges. 

Some blurring before applying edge filters is often necessary: it flattens small ripples in 
signal and so prevents false edges. 

Difference of Gaussians 
 

GNU Image Manipulation Program
Generated by docbook2odf

Page 325 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

Overview 
This filter is located at Filters Edge detect Difference of Gaussians 

This filter is new in GIMP 2.2. It does edge detection using the so-called "Difference of 
Gaussians" algorithm, which works by performing two different Gaussian blurs on the 
image, with a different blurring radius for each, and subtracting them to yield the result. 
This algorithm is very widely used in artificial vision (maybe in biological vision as well!), 
and is pretty fast because there are very efficient methods for doing Gaussian blurs. The 
most important parameters are the blurring radii for the two Gaussian blurs. It is probably 
easiest to set them using the preview, but it may help to know that increasing the smaller 
radius tends to give thicker-appearing edges, and decreasing the larger radius tends to 
increase the "threshold" for recognizing something as an edge. In most cases you will get 
nicer results if Radius 2 is smaller than Radius 1, but nothing prevents you from reversing 
them, and in situations where you have a light figure on the dark background, reversing 
them may actually improve the result. 

Options 

Edge 
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Overview 
This filter is found in Image>/Filters/Edge-Detect/Edge 

Options 

Laplace 

Overview 
This filter is found in Filtres Edge detect Laplace . 

This filter detects edges in the image using Laplacian method, which produces thin, pixel 
wide borders. 

Sobel 

 

Overview 
This filter is found in Filters Edge detect Sobel . 

Sobel's filter detects horizontal and vertical edges separately on a grey-level image. Color 
images are turned into grey-levels. 

Options 
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Enhance filters 

Enhance filters introduction 
Enhance filters are used to compensate for image imperfections. Such imperfections 
include dust particles, noise, interlaced frames (coming usually from a TV frame-grabber) 
and insufficient sharpness. 

Deinterlace 

 

Overview 
This filter is found in Image>Filters/Enhance/Deinterlace 

Images captured by videocards, especially when fast movement is recorded, may look 
blurred and stripped, with splitted objects. This is due to how cameras work. They don't 
record 25 images per second, but 50, with half vertical resolution. There are two 
interlaced images in one frame. First line of first image is followed by first line of second 
image followed by second line of first image... etc. So, if there have been an important 
move between the two images, objects will appear splitted, shifted, stripped. 

The Deinterlace filter keeps only one of both images and replaces missing lines by a 
gradient between previous and following lines. The resulting image, or selection, will be 
somewhat blurred, but can be improved by enhance filters 

A test image can be found at www.alparysoft.com 

Options 

Despeckle 
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Overview 
This filter is found in Image>Filters/Enhance/Despeckle 

It is used to remove small defects due to dust, or scratches, on a scanned image, and 
also moiré effect on image scanned from a magazine. You ought to select isolated defects 
before applying filter. 

Options 

Destripe 

 

Overview 
This filter is found in Image>Filters/Enhance/Destripe... 

It is used to remove vertical stripes caused by poor quality scanners. It works by adding a 
pattern that will interfere with the image, removing stripes if setting is good. This 
"negative" pattern is calculated from vertical elements of the image, so don't be 
surprised if you see stripes on the preview of an image that has none. And if pattern 
"strength" is too high, you image will be striped. 

If, after a first pass, a stripe persists, rectangular-select it and apply filter again (all other 
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selection type may worsen the result). 

Options 

NL Filter 

 

Overview 
This filter is found in Filters Enhance NL Filter . NL means "Non Linear". Derived from the 
Unix pnmnlfilt program, it joins smoothing, despeckle and sharpen enhancement 
functions. It works on the whole image, not on the selection. 

This is something of a swiss army knife filter. It has 3 distinct operating modes. In all of 
the modes each pixel in the image is examined and processed according to it and its 
surrounding pixels values. Rather than using the 9 pixels in a 3x3 block, 7 hexagonal area 
samples are taken, the size of the hexagons being controlled by the radius parameter. A 
radius value of 0.3333 means that the 7 hexagons exactly fit into the center pixel (ie. 
there will be no filtering effect). A radius value of 1.0 means that the 7 hexagons exactly 
fit a 3x3 pixel array. 

Options 

Operating Modes 
This filter can perform several distinct functions, depending on the value of the parameter 
alpha. 

Sharpen 
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Overview 
This filter is found in Image>Filters/Enhance/Sharpen 

Most of digitized images need correction of sharpness. This is due to digitizing process 
that must chop a color continuum up in points with slightly different colors: elements 
thiner than sampling frequency will be averaged into an uniform color. So sharp borders 
are rendered a little blurred. The same phenomenon appears when printing color dots on 
paper. 

The Sharpen filter accentuates edges but also any noise or blemish and it may create 
noise in graduated color areas like the sky or a water surface. It competes with the 
Unsharp Mask filter, which is more sophisticated and renders more natural results. 

Options 

Unsharp Mask 

 

Overview 
This filter is found in Image>Filters/Enhance/Unsharp Mask 

Out-of-focus photographs and most digitized images often need a sharpness correction. 
This is due to the digitizing process that must chop a color continuum up in points with 
slightly different colors: elements thinner than sampling frequency will be averaged into 
an uniform color. So sharp borders are rendered a little blurred. The same phenomenon 
appears when printing color dots on paper. 

The Unsharp Mask filter (what an odd name!) sharpens edges of the elements without 
increasing noise or blemish. It is the king of the sharpen filters. 

Some scanners apply a sharpen filter while scanning. It's worth disabling it so that you 
keep control on your image. 
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Options 

More information 
To prevent color distortion while sharpening, Decompose your image to HSV and work 
only on Value. Then Compose the image to HSV. Go to Image/Mode and click on 
Decompose. Make sure the "Decompose to Layers" box is checked. Choose HSV and click 
OK. You will get a new grey-level image with three layers, one for Hue, one for Saturation, 
and one for Value. (Close the original image so you won't get confused). Select the Value 
layer and apply your sharpening to it. When you are done, with that same layer selected, 
reverse the process. Go to Image/Mode and click on Compose. Again choose HSV and 
click OK. You will get back your original image except that it will have been sharpened in 
the Value component 
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Generic filters 

Generic filters introduction 
Generic filters are filters you can build your own filters with. That looks complicated? See 
Convolution Matrix filter and you will understand better. 

Convolution matrix 

 

Overview 
You can find this filter via the image menu under Filters Generic Convolution Matrix 

Here is a mathematician's domain. Most of filters are using convolution matrix. With the 
Convolution Matrix filter, if the fancy takes you, you can build a custom filter. 

What is a convolution matrix? It's possible to get a rough idea of it without using 
mathematical tools that only a few ones know. Convolution is the treatment of a matrix 
by another one which is called "kernel". 

The Convolution Matrix filter uses a first matrix which is the Image to be treated. The 
image is a bi-dimensional collection of pixels in rectangular coordinates. The used kernel 
depends on the effect you want. 

GIMP uses 5x5 or 3x3 matrices. We will consider only 3x3 matrices, they are the most 
used and they are enough for all effects you want. If all border values of a kernel are set 
to zero, then system will consider it as a 3x3 matrix. 

The filter studies successively every pixel of the image. For each of them, which we will 
call the "initial pixel", it multiplies the value of this pixel and values of the 8 surrounding 
pixels by the kernel corresponding value. Then it adds the results, and the initial pixel is 
set to this final result value. 

A simple example: 
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On the left is the image matrix: each pixel is marked with its value. The initial pixel has a 
red border. The kernel action area has a green border. In the middle is the kernel and, on 
the right is the convolution result. 

Here is what happened: the filter read successively, from left to right and from top to 
bottom, all the pixels of the kernel action area. It multiplied the value of each of them by 
the kernel corresponding value and added results: 
(100*0)+(50*1)+(50*0)*(100*0)+(100*0) +(100*0)+(100*0)+(100*0)+(100*0)+(100*0) 
= 50. The initial pixel took the value 50. Previously, when the initial pixel had value=50, it 
took the value 100 of the above pixel (the filter doesn't work on the image but on a copy) 
and so disappeared into the "100" background pixels. As a graphical result, the initial 
pixel moved a pixel downwards. 

Options 

Examples 
Design of kernels is based on high levels mathematics. You can find ready-made kernels 
on the Web. Here are a few examples: 
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Dilate 

Overview 
This filter is found in Filters Generic Dilate 

This filter widens and enhances dark areas of the active layer or selection. 

For every image pixel, it brings the pixel Value (luminosity) into line with the lowest Value 
(the darkest) of the 8 neighbouring pixels (3x3 matrix). So, a dark pixel is added around 
dark areas. An isolated pixel on a brighter background will be changed to a big "pixel", 
composed of 9 pixels, and that will create some noise in the image. 
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In this image, the studied pixel has a red border and the studied matrix has a green 
border. I hope you have understood how to go on with the process and get a 3x3 pixel 
block: when the "I" pixel is inside the green border, the studied pixel turns to black. 

A larger dark area will dilate by one pixel in all directions: 

 

The filter was applied 3 times. 

On more complex images, dark areas are widenned and enhanced the same, and 
somewhat pixellated. Here, the filter was applied 3 times: 

 

Of course, if background is darker than foreground, it will cover the whole image. 

Options 
This filter has no options. 

Examples 

 

 

Erode 

Overview 

 

This filter is found in Filters Generic Erode 

This filter widens and enhances bright areas of the active layer or selection. 

For every image pixel, it brings the pixel Value (luminosity) into line with the upper Value 
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(the brightest) of the 8 neighbouring pixels (3x3 matrix). So, a bright pixel is added 
around bright areas. An isolated pixel on a darker background will be changed to a big 
"pixel", composed of 9 pixels, and that will create some noise in the image. A larger bright 
area will dilate by one pixel in all directions. 

On more complex images, bright areas are widened and enhanced the same, and 
somewhat pixellated. 

Options 
This filter has no option. 
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Glass Effects filters 

Glass Effects filters introduction 
Glass Effects filters result in an image as if it were seen through a lens or glass tiles. 

Apply Lens 

 

Overview 
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You can find this filter via the image menu under Filters Glass effects Apply Lens 

After applying this filter, a part of the image is rendered as through a spherical lens. 

Options 

 

Glass Tile 
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Overview 

 

 

You can find this filter via the image menu under Filters Glass effects Glass Tile 

After applying this filter, the active layer or selection is rendered as through a glass brick 
wall. 

Options 
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Light Effects filters 

Light Effects filters introduction 
Light Effects filters render several illumination effects of the image. 

FlareFX 

 

Overview 
This filter is found in Filters Light Effectsender FlareFX 

This filter gives the impression that sun hit the objective when taking a shot. You can 
locate the reflection with a reticule you can move, but you have not the possibilities that 
Gflare filter offers. 

Options 

Gflare 
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Overview 
This filter is found in Filters Light Effectsender Gflare 

Gflare effect reminds the effect you get when you take a photograph of a blinding light 
source, with a halo and radiations around the source. The Gflare image has three 
components: Glow which is the big central fireball, Rays and Second Flares 

Options 
The Settings tab allows you to set manually the parameters while the Selector tab let you 
choose presets in a list. 

Settings 

Selector 
The Selector tab allows you to select a Gflare pattern, to change it and save it. 

Gflare Editor 
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Lighting Effects 

 

Overview 
 

GNU Image Manipulation Program
Generated by docbook2odf

Page 344 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

 

This filter is found in Filters Light Effectsender Lighting Effects 

This filter simulates the effect you get when you light up a wall with a spot. It doesn't 
produce any drop shadows and, of course, doesn't reveal any new details in dark zones. 

Options 

Sparkle 

 

Overview 
You can find this filter in the image menu under Filters Light Effects Sparkle 
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This filter adds sparkles to your image. It uses the lightest points according to a threshold 
you have determined. It is difficult to foresee where sparkles will appear. But you can put 
white points on your image where you want sparkles to be. 

Parameter Settings 
Sliders and input boxes allow you to set values. 

SuperNova 

 

Overview 
This filter is found in Filters Light Effectsender Super Nova 

This filter creates a big star reminding a super-nova. It works with RGB and GRAY images. 
Light effect decreases according to 1/r where r is the distance from star center. 

Dieses Filter erzeugt einen grossen Stern im Bild, der an eine Supernova erinnert. Sie 
können das Filter sowohl auf Farb- als auch auf Graustufenbilder anwenden. 

Parameter Settings 
 

GNU Image Manipulation Program
Generated by docbook2odf

Page 346 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

Distort filters 

Distort filters introduction 
The distort filters transform your image in many different ways. 

Blinds 

 

Overview 
This filter is found in Image>Filters/Distorts/Blinds 

It generates a blind effect with horizontal or vertical battens. You can lift or close these 
battens, but not lift the whole blind up. 

GNU Image Manipulation Program
Generated by docbook2odf

Page 347 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

Options 

Example 

 

Curve Bend 

 

Overview 
This filter is found in Filters Distorts Curve Bend . 

This filter allows you to create a curve that will be used to distort the active layer or 
selection. The distortion is applied gradually from an image or selection border to the 
other 

Options 

Example 
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Emboss 

 

Overview 
This filter is found in Image>Filters/Distorts/Emboss. 

You can use it only with RGB images. If your image is grayscale, it will be grayed out in 
the menu. 

It stamps and carves the active layer or selection, giving it relief with bumps and hollows. 
Bright areas are raised and dark ones are carved. You can vary the lighting. 

Options 

IWarp 
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Overview 
This filter is found in Image>Filters/Distorts/IWarp 

This filter allows you to deform interactively some parts of the image and, thanks to its 
Animate option, to create the elements of a fade in/fade out animation between the 
original image and the deformed one, that you can play and use in a Web page. 

To use it, first select a deform type then click on the Preview and drag the mouse pointer. 

Settings 

Example 

 

Mosaic 
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Overview 
This filter is found in Image>Filters/Distorts/Mosaic... 

It cuts the active layer or selection into many squares or polygons which are slightly 
raised and separated by joins, giving so an aspect of mosaic. 

Options 

Page Curl 

 

Overview 
This filter is found in Image>Filters/Distorts/Pagecurl 

It curls a corner of the current layer or selection into a kind of cornet showing the 
underlying layer in the cleared area. A new "Curl Layer" and a new Alpha channel are 
created. The part of the initial layer corresponding to this cleared area is also transparent. 
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Options 

Example 

 

Polar Coords 

 

Overview 
This filter is found in Filters Distorts Polar Coords . 

It gives a circular or a rectangular representation of your image with all the possible 
intermediates between both. 

Options 

Examples 
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Ripple 

 

Overview 
This filter is found in Image>Filters/Distorts/Rippel... 

It displaces the pixels of the active layer or selection to waves or ripples reminding a 
reflection on disturbed water. 

Options 

Shift 

 

Overview 
This filter is found in Filters Distorts Sift . 

It shifts all pixel rows, horizontally or vertically, in the current layer or selection, on a 
random distance and within determined limits. 
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Options 

Newsprint 

 

Overview 
This filter is found in Image>Filters/Distorts/Newsprint 

This filter halftones the image using a clustered-dot dither. Halftoning is the process of 
rendering an image with multiple levels of grey or colour (i.e. a continuous tone image) 
on a device with fewer tones; often a bi-level device such as a printer or typesetter. 

The basic premise is to trade off resolution for greater apparent tone depth (this is known 
as spatial dithering). 

There are many approaches to this, the simplest of which is to throw away the low-order 
bits of tone information; this is what the posterize filter does. Unfortunately, the results 
don't look too good. However, no spatial resolution is lost. 

This filter uses a clustered-dot ordered dither, which reduces the resolution of the image 
by converting cells into spots which grow or shrink according to the intensity that cell 
needs to represent. 

Imagine a grid super-imposed on the original image. The image is divided into cells by the 
grid - each cell will ultimately hold a single spot made up of multiple output pixels in order 
to approximate the darkness of the original image in that cell. 

Obviously, a large cell size results in a heavy loss in resolution! The spots in the cells 
typically start off as circles, and grow to be diamond shaped. This change in shape is 
controlled by a spot function. By using different spot functions, the evolution in the shape 
of the spots as the cell goes from fully black to fully white may be controlled. 
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Options 
More explanations, illustrative diagrams, a gallery and a tutorial are to be found on the 
plug-in author site: http://www.cl.cam.ac.uk/~and1000/newsprint/ You are strongly 
encouraged to visit it, since halftoning is a large and complex area. 

Here is an example, from the author's gallery: 

 

Video 

 

Overview 
This filter is found in Image>Filters/Distorts/Video. 

Apply low dotpitch RGB simulation to the specified drawable. 

Options 

Value Propagate 
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Overview 
This filter is found in Image>Filters/Distorts/Value Propagate 

It works on color borders. It spreads pixels that have a Value between selected thresholds, 
in selected directions. 

Options 

Waves 

 

Overview 
This filter is found in Image>Filters/Distorts/Waves. 

With this filter you get the same effect as a stone thrown in a quiet pond, giving 
concentric waves. 

Options 

Whirl and Pinch 
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Overview 
This filter is found in Filters Distorts Whirl and Pinch 

"Whirl and Pinch" distorts your image in a concentric way. 

"Whirl" distorts the image much like the little whirlpool that appears when you empty 
your bath. 

"Pinch" can be compared to applying your image to a soft rubber surface and squeezing 
the edges or corners. If the Pinch amount slider is set to a negative value, it will look as if 
someone tried to push a round object up toward you from behind the rubber skin. If the 
Pinch amount is set to a positive value, it looks like someone is dragging or sucking on 
the surface from behind, and away from you. 

The "pinch" effect can sometimes be used to compensate for image distortion produced 
by telephoto or fisheye lenses ("barrel distortion"). 
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Parameter Settings 

Wind 

 

Overview 
This filter is found in Image>Filters/Distorts/Wind. 

The Wind filter can be used to create motion blur, but it can also be used as a general 
distort filter. What is characteristic about this filter is that it will render thin black or white 
lines. Wind will detect the edges in the image, and stretch out thin white or black lines 
from that edge. This is why you can create the illusion of motion, because the edges are 
what will be blurred in a photograph of a moving object. 

Parameter Settings 
The interface is quite simple. You can set the Strength of the wind and a Threshold value. 
Threshold will restrict the effect to fewer areas of the image. Strength controls the 
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amount of wind, so a high value will render a storm. You can also increase the effect by 
setting the Style to Blast, which will produce thicker lines than Wind. 

You can only set the wind in two directions, either Left or Right. However, you can control 
which edge the wind will come from using the values Leading, Trailing or Both. Because 
Trailing will produce a black wind, it creates a less convincing motion blur than Leading, 
which will produce white wind. 

The following illustrations are based on this image:  
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Artistic filters 

Artistic filters introduction 
Artistic filters create artistic effects like cubism, oil painting, canvas... 

Apply Canvas 

Overview 

 

 

This filter is found in Image>Filters/Artistic/Apply Canvas... 

This filter applies a canvas-like effect to the current layer or selection. It textures the 
image as if it were an artist's canvas. 

Options 
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Cartoon 

Overview 
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This filter is found in Filters Artistic Cartoon 

The Cartoon filter modifies the active layer or selection so that it looks like a cartoon 
drawing. Its result is similar to a black felt pen drawing subsequently shaded with color. 
This is achieved by darkening areas that are already distinctly darker than their 
neighborhood. 

Options 

 

Cubism 

 

Overview 
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This filter is found in Filters Artitic Cubism 

The Cubism plug-in modifies the image so that it appears to be constructed of small 
squares of semitransparent tissue paper. 

If setting possibilities of this filter are not enough for you, see GIMPressionist filter which 
offers more options. 

Options 

 

If you are using this to generate background images for web pages and the like, work with 
a small range of colors painted randomly on a small square. Then apply the Cubism filter 
with the desired settings. As a last step, try Filters/Map/Make Seamless to adjust the 
image so it will tile seamlessly in your background. 

GIMPressionist 

Overview 
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You can find this filter via the image menu under Filters Artistic GIMPressionist 

It's the king of Artistic filters. It can do what Cubism and Apply Canvas do and much 
more. It gives your image the look of a painting. All is going as if your image was painted 
again on a paper and with a brush you'd have choosen. It works on the active layer or 
selection. 

Parameter Settings 

GIMPressionist- Orientation Map Editor 

Overview 
The Orientation-map editor is an annexe of the GIMPressionist filter. You can get to it by 
clicking on the Edit button in the "Orientation" tab. With this editor, you can set the 
direction that brush strokes given by filter will have. 

Parameter Settings 
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You can place one or several vectors. You can set their direction and their strength. They 
will act ont the corresponding area of the image. 

GIMPressionist- Size Map Editor 

Overview 
The Size-map editor is an annexe of the GIMPressionist filter. You can get to it by clicking 
on the Edit button in the "Size" tab. With this editor, you can set the size that brush 
strokes given by filter will have. 

Parameter Settings 

 

You can place one or several vectors. You can set their strength. They will act on the 
corresponding area of the image. 

Oilify 
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Overview 

 

 

This filter is found in Filters Artistic Oilify... 

This filter makes the image look like an oil painting. The Mask Size controls the outcome: 
a high value gives the image less detail, as if you had used a larger brush. 

The Gimpressionist filter can produce similar effects, but allows a much wider variety of 
options. 
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Options 

 

Photocopy 

Overview 
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The Photocopy filter modifies the active layer or selection so that it looks like a black and 
white photocopy, as if toner transfered was based on the relative darkness of a particular 
region. This is achieved by darkening areas of the image which are measured to be darker 
than a neighborhood average, and setting other pixels to white. 

Starting filter 
You can find this filter from the image menu through Filters Artistic Photocopy . 

Options 

 

Soft Glow 

Mode of action 
 

GNU Image Manipulation Program
Generated by docbook2odf

Page 368 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

 

This filter lights the image with a soft glow. Soft Glow produces this effect by making 
brigth areas of the image brighter. 

Starting filter 
You can find this filer in the Image menu: Filters Atistic Soft Glow . 

Options 
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Map filters 

Map filters introduction 
Map filters use an object named map to modify an image: you map the image to the 
object. So, you can create 3D effects by mapping your image to another previously 
embossed image ("Bumpmap" Filter) or to a sphere ("Map Object" filter). You can also 
map a part of the image elsewhere into the same image ("Illusion" and "Make Seamless" 
filters), bend a text along a curve ("Displace" filter)... 

Bump Map 

Overview 
This filter is found in the image window menu under Filters Map Bump Map . 

This filter creates a 3D effect by embossing an image (the card) and then mapping it to 
another image. Bump heigth depends on pixel luminosity and you can set light direction. 
See Emboss for more informations about embossing. You can bump map any type of 
image, unlike the Emboss filter. 

Options 

 

Displace 
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Overview 
You can find this filter from the image menu Filters M Displace 

This filter uses a 'displace-map' to displace corresponding pixels of the image. This filter 
displaces the content of the specified drawable (active layer or selection) by the amounts 
specified in X and Y Displacement multiplied by the intensity of the corresponding pixel in 
the 'displace map' drawables. Both X and Y displace maps must be gray-scale 
images and have the same size as the drawable . This filter allows interesting 
distortion effects. 

Options 

Using gradient to bend a text
Follow following steps: 

Start with opening your image. 

Duplicate this image. Activate this duplicate and make it gray-scaled 
(<IMAGE>/Image/Mode/GrayScale). Fill it with the wanted gradient. This image will be 
your Displacement map, with the dimensions of original image. 

 

Activate original image. Create a Text Layer with your text. Set layer to image size: right-
click on the layer in layer dialog and, in the pop-menu, click on "Layer to image size". 
Note that letters in text layer lie on transparent background; now this filter doesn't 
displace transparent pixels. Only letters will be displaced. 
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Activate text layer. Open Displace filter window. Set parameters particularly displacement 
coefficient according to the result in Preview. OK. 

 

This method also applies to standard layers: 

 

To get the wanted gradient, first draw a black to white gradient. Then use the Curves tool 
to modify the gradient curve. 

Fractal Trace 

Overview 
This filter transforms the image with the Mandelbrot fractal: it maps the image to the 
fractal. 

You get to this filter via the Image menu through Filters Map Fractal trace 

Options 
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Illusion 

Overview 
This filter is found in the image window menu under Filters Map Illusion . 

With this filter, your image (active layer or selection) looks like a kaleidoscope. This filter 
duplicates your image in many copies, more or less dimmed and split, and puts them 
around center of image. 

Options 

 

Make Seamless 

Overview 
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You can find this filter in image menu under Filters Map Make Seamless 

This filter modifies the image for tiling by creating seamless edges. Such an image can be 
used as a pattern for a web-page. This filter has no option, and result may need 
correction. 

Map Object 

Overview 
This filter maps a picture to an object (plane, sphere, box or cylinder). 

This filter is found in the image window menu under Filters Map Map Oject . 

Preview domain 
This preview has several possibilities: 

General Options tab 

 

Light tab 
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Material tab 

 

Orientation tab 
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Box tab 
This tab appears only when you select the Box object. 

 

Cylinder tab 
This tab appears only when you select the Cylinder object. 

 

Paper Tile 

Overview 

GNU Image Manipulation Program
Generated by docbook2odf

Page 376 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 
This filter is found in the image window menu under Filters Map Paper Tile . 

This filter cuts the image (active layer or selection) into several pieces, with square form, 
and then slides them so that they, more or less, overlap or move apart. They can go out 
image borders a little. 

 

 

Options 

 

Small Tiles 

Overview 
This filter is found in the image window menu under Filters Map Small Tiles . 

This filter reduces the image (active layer or selection) and displays it in many copies 
inside the original image. 

Options 

GNU Image Manipulation Program
Generated by docbook2odf

Page 377 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 

 

Tile 

Overview 

 

  

This filter is found in the image window menu under Filters Map Tile . 

This filter makes several copies of the original image, in a same or reduced size, into a 
bigger (new) image. 
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Warp 

Overview 
This filter is found in the image window menu under Filters Map Warp . This filter has no 
Preview. 

This filter displaces pixels of active layer or selection according to grey levels of a 
Displacement map. Pixels are displaced according to the gradient slope in the 
displacement map. Pixels corresponding to solid areas are not displaced; the higher the 
slope, the higher the displacement. 

  

  

  

This filter offers the possibility of masking a part of the image to protect it against filter 
action. 

Options 
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Van Gogh (LIC) 

Overview 
This filter is found in the image window menu under Filters Map Van Gogh (LIC) . 

"LIC" stands for Line Integral Convolution, a mathematical method. Plug-in author uses 
mathematical terms to name his options... This filter is used to apply a directional blur to 
an image, or to create textures. It could be called "Astigmatism" as it blurs certain 
directions in the image. 

It uses a blur map. Unlike other maps, this filter doesn't use grey levels of this blur map. 
Filter takes in account only gradient direction(s). Image pixels corresponding to solid 
areas of the map are ignored. 

  

Options 
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• To create a blur, check With Source Image . Only Filter Length slider and perhaps 
Intregation Steps slider, are useful. 

• To create a texture, check With White Noise . All sliders can be useful. 
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Rendering filters 

Render filters introduction 
Most Gimp filters act on a layer by transforming its contents, but the filters in the 
"Render" group are a bit different. They create patterns from scratch, in most cases 
obliterating anything that was previously in the layer. Some create random or noisy 
patterns, others regular of fractal patterns, and one (Gfig) is a general-purpose (but 
rather limited) vector graphics tool. 

Plasma 

 

Overview 

 

You can find this filter in image menu following Filters Render Clouds Plasma 

Plasma generates colorful clouds, which can be used for textures. You control the 
turbulence in the plasma cloud with the Turbulence slide. 

All of the colors produced by Plasma are completely saturated. Sometimes the strong 
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colors may be distracting, and a more interesting surface will appear when you 
desaturate the image using Layer/Colors/Desaturate. 

An enhanced version of the Plasma plug-in, called Plasma2, with many more options and 
parameters, is available from the Gimp Plugin Registry. 

Options 

Solid Noise 

 

Overview 

 

You can find this filter from the image menu through Filters Render Clouds Solid noise 

Solid Noise is a great texture maker. Note that this noise is always gray, even if you 
applied it to a very colorful image (it doesn't matter what the original image looks like -- 
this filter completely overwrites any existing background in the layer it is applied to). This 
is also a good tool for creating displacement maps for the plug-in or for the plug-in. With 
the "turbulence" setting active, the results look quite a bit like real clouds. An example is 
shown below. 

Options 

Flame 
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Overview 
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This filter is found in Filters Render Nature Flame 

With the Flame filter, you can create stunning, randomly generated fractal patterns. You 
can't control the fractals as you can with the Ifs Compose filter, but you can steer the 
random generator in a certain direction, and choose from variations of a theme you like. 

In the main window, you can set Rendering and Camera parameters. The first three 
parameters in the Render display are Brightness, Contrast and Gamma. The result of 
these options is visible in the Preview window, but it's generally better to stick to the 
default values, and correct the rendered image later with Image/Colors. 

The other three parameters affect the rendering process and don't show in the preview 
window. Sample Density, which controls the resolution of the rendered pattern, is the 
most important of these. The Camera parameters allow you to zoom and offset the flame 
pattern, until you're happy with what you see in the preview window. Flame also offers 
the possibility to store and load your favorite patterns. 

Options 

IFS Compose 
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Overview 
This filter is found in Filters Render Nature IFS fractal 

This fractal-based plug-in is truly wonderful! With this versatile instrument, you can 
create amazingly naturalistic organic shapes, like leaves, flowers, branches, or even 
whole trees. ("IFS" stands for "Iterated Function System".) 

The key to using this plug-in lies in making very small and precise movements in fractal 
space. The outcome is always hard to predict, and you have to be extremely gentle when 
you change the pattern. If you make a component triangle too big, or if you move it too 
far (even ever so slightly), the preview screen will black out, or more commonly, you'll get 
stuck with a big shapeless particle cloud. 

A word of advice: When you have found a pattern you want to work with, make only small 
changes, and stick to variations of that pattern. It's all too easy to lose a good thing. 
Contrary to what you might believe, it's really much easier to create a leaf or a tree with 
IFS Compose than to make a defined geometrical pattern (where you actually know what 
you're doing, and end up with the pattern you had in mind). 

For a brief introduction to IFS's see Foley and van Dam, et al,. Computer Graphics, 
Principles and Practice, 2nd Ed., (Addison Wesley, 1990). 

Options 

A Brief Tutorial 
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This is a rather complex plug-in, so to help you understand it, we'll guide you through an 
example where you'll create a leaf or branch. 

Many forms of life, and especially plants, are built like mathematical fractals, i.e., a shape 
that reproduces or repeats itself indefinitely into the smallest detail. You can easily 
reproduce the shape of a leaf or a branch by using four (or more) fractals. Three fractals 
make up the tip and sides of the leaf, and the fourth represents the stem. 

1. Before invoking the filter: Select File New Image Add a transparent layer with 
Layers Layers and Channels New Layer Set the foreground color in the toolbox to black, 
and set the background to white. 

2. Open IFS Compose. Start by rotating the right and bottom triangles, so that they 
point upward. You'll now be able to see the outline of what's going to be the tip and 
sides of the leaf. (If you have problems, it may help to know that the three vertices of a 
triangle are not equivalent.) 

  

3. To make the leaf symmetrical, adjust the bottom triangle to point slightly to the left, 
and the right triangle to point slightly to the right. 

4. Press New to add a component to the composition. This is going to be the stem of 
the leaf, so we need to make it long and thin. Press Stretch, and drag to stretch the 
new triangle. Don't be alarmed if this messes up the image, just use Scale to adjust the 
size of the overlong triangle. You'll probably also have to move and rotate the new 
fractal to make it look convincing. 

  

5. You still have to make it look more leaf-like. Increase the size of the top triangle, 
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until you think it's thick and leafy enough. Adjust all fractals until you're happy with the 
shape. Right-click to get the popup menu, and choose Select all. Now all components 
are selected, and you can scale and rotate the entire leaf. 

  

6. The final step is to adjust color. Click on the Color Transformation tab, and choose a 
different color for each fractal. To do this, check Simple and press the right color 
square. A color circle appears, where you can click or select to choose a color. 

  

7. Press OK to apply the image, and voilà, you've just made a perfect fractal leaf! Now 
that you've got the hang of it, you'll just have to experiment and make your own 
designs. All plant-imitating fractals (be they oak trees, ferns or straws) are more or less 
made in this fashion, which is leaves around a stem (or several stems). You just have to 
twist another way, stretch and turn a little or add a few more fractals to get a totally 
different plant. 

Diffraction Patterns 
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Overview 
This filter is found in Filters Render Patterns Diffraction Patterns . 

This filter lets you make diffraction or wave interference textures. You can change the 
Frequency, Contours and Sharp Edges for each of the RGB channels. You can also set 
Brightness, Scattering and Polarization of the texture. There is no automatic preview, so 
you must press the preview button to update. On a slow system, this may take a bit of 
time. 

This is a very useful filter if you want to create intricate patterns. It's perfect for making 
psychedelic, batik-like textures, or for imitating patterns in stained glass (as in a church 
window). 

It seems clear that the plugin works by simulating the physics of light striking a grating. 
Unfortunately, the original authors never got around to writing down the theory behind it, 
or explaining what the parameters mean. The best approach, then, is just to twiddle 
things and see what happens. Fortunately, almost anything you do seems to produce 
interesting results. 

CML Explorer 

Overview 
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This filter is the king of texture creating filters. It is extremely efficient but very complex. 
It uses a mathematical method named Cellular Automata. 

Starting filter 
You can find this filter from the image menu through Filters Render Pattern CML Explorer 

Options 

Grid 

 

Overview 
This filter is found in Filters Render Pattern Grid . 

It renders a Cartesian grid in the active layer, on top of the existing contents. The width, 
spacing, offsets, and colors of the grid lines can all be set by the user. By default, the 
lines are with the Gimp's foreground color. (Note: this plugin was used to create 
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demonstration images for many of the other plugins.) 

If you set the grid line widths to 0, then only the intersections will be drawn, as plus-
marks. 

Options 
There are separate options for controlling the horizontal grid lines, vertical grid lines, and 
intersections. By default, the horizontal and vertical settings are locked together, so that 
all changes are applied symmetrically. If you want to change just one of them, click on the 
"chain" symbol below it to unlock them. The results of changing the "intersection" 
parameters are rather complex. 

Besides, for some options, you can select the unit of measurement thanks to a drop-down 
list. 

Maze 

 

Overview 

GNU Image Manipulation Program
Generated by docbook2odf

Page 391 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 
 

You can find this filter in image menu following Filters Render Pattern Maze 

This filter generates a random black and white maze pattern. The result completely 
overwrites the previous contents of the active layer. A typical example is shown below. 
Can you find the route from the center to the edge? 

Options 

Jigsaw 

 

Overview 
You can find this filter in Filters Render Pattern Jigsaw 
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This filter will turn your image into a jigsaw puzzle. The edges are not anti-aliased, so a 
little bit of smoothing often makes them look better (i. e., Gaussian blur with radius 1.0). 

If you want to be able to easily select individual puzzle-piece areas, as for the example 
above, render the jigsaw pattern on a separate layer filled with solid white, and set the 
layer mode to Multiply. You can then select puzzle pieces using the magic wand (fuzzy 
select) tool on the new jigsaw layer. 

Options 

Qbist 

 

Overview 
You can find this filter from the image menu through Filters Render Pattern Qbist 

The Qbist filter generates random textures. A starting texture is displayed in the middle 
square, and different variations surround it. If you like one of the alternative textures, 
click on it. The chosen texture now turns up in the middle, and variations on that specific 
theme are displayed around it. When you have found the texture you want, click on it and 
then click OK. The texture will now appear on the currently active layer, completely 
replacing its previous contents. 
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Options 

Checkerboard 

Overview 
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This filter creates a checkerboard pattern replacing the current layer content. Colors used 
for pattern are current Fore- and Back ground colors of toolbox. 

Starting filter 
You can find this filter in image menu following Filters Render Pattern Checkerboard 

Options 

 

Sinus 
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Overview 

 

You can find this filter from the image menu through Filters Render Pattern Sinus 

The Sinus filter lets you make sinusoidally based textures, which look rather like watered 
silk or maybe plywood. This plug-in works by using two different colors that you can 
define in the Colors tab. These two colors then create wave patterns based on a sine 
function. 

You can set the X and Y scales, which determine how stretched or packed the texture will 
be. You can also set the Complexity of the function: a high value creates more 
interference or repetition in the pattern. An example is shown below. 

Options 

Fractal Explorer 

Overview 
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Starting filter 
This filter is found in Filters Render Nature Fractal Explorer 

Options 

 

Gfig 

Overview 
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This filter is a tool: You can create geometrical figures to add them to the image. It is very 
complex. I hope this paper will help you. 

When using this filter, elements inserted in the image will be placed in a new layer. So the 
image will not be modified, all modifications occuring in this layer. 

Starting filter 
You get to this filter via the Image menu through Filters Render Gfig 

Options 
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Combine filters 

Combine filters introduction 
The combine filters associate two or more images into a single image. 

Depth Merge 
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Depth Merge is a Combine Filter that is useful to combine two different pictures. 

Overview 
It combines the two pictures selected as "sources" by blending them. Darkest values are 
predominant in the resulting image. This could be done using blending modes but in this 
case there aren't any options. 

To work with this filter, at least two images are needed that have to be same sized. 

Accessing this Filter 
This filter is in Filters/Combine/Depth Merge 

Options 

Film 

 

Overview 
Film filter allows the user to merge several pictures into a photographic film drawing. 

This filter does not invert colors, so it does not imitate negative film of the sort used to 
produce prints. Instead you should think of the result as an imitation of slide film or 
cinema film. 

Accessing this Filter 
This filter is in Image/Filters/Combine/Film 

Options 
Double click on the tool buttons opens the Tool Options dialog.
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Click on the colors to change the colors.

These open a new dialog window if it wasn't open yet, otherwise the corresponding dialog 
gets focus. 

This accepts the new value you typed in a text field and returns focus to canvas. 

Menus can also be activated by Alt with the letter underscored in the menu name. 

This fits the windows to the image size.

Scrolling by keys is accelerated, i.e. it speeds up when you press Shift+arrows, or jumps 
to the borders with Ctrl+arrows. 

Drag off the horizontal or vertical ruler to create a new guideline. Drag a guideline onto 
the ruler to delete it. 

This places a copy of the selection to the GIMP clipboard.

Refers to transparency. An Alpha Channel allows transparency control. Certain image 
formats may only contain a single Alpha Channel allowing a transparency of on or off. 
Other formats allow a variable level of transparency. The smaller the alpha value of a 
pixel, the more visible the color of the pixel on the level below it. A pixel with an alpha 
value of 0 is completely transparent. 

Antialiasing is the process of reversing an alias, that is, lessening the "jaggies. 
Antialiasing produces smoother curves by adjusting the boundary between the 
background and the pixel region that is being antialiased. Generally, pixel intensities or 
opacities are changed so a smoother merge with the background is achieved. With 
selections, the selection edge is affected so that the selection edge opacity is lowered. 

  

An uncompressed bitmap format used by Microsoft Windows for displaying 
graphics. Color depth is typically 1, 4 or 8 bits, although the format does 
support more. 

"From The Free On-line Dictionary of Computing (13 Mar 01) : bitmap A data 
file or structure which corresponds bit for bit with an image displayed on a screen, 
probably in the same format as it would be stored in the display's video memory or 
maybe as a device independent bitmap. A bitmap is characterised by the width and 
height of the image in pixels and the number of bits per pixel which determines the 
number of shades of grey or colours it can represent. A bitmap representing a coloured 
image (a "pixmap") will usually have pixels with between one and eight bits for each of 
the red, green, and blue components, though other colour encodings are also used. The 
green component sometimes has more bits that the other two to cater for the human 
eye's greater discrimination in this component. " 

Each image is divided up into separate channels and then recombined before being sent 
to the output device. An output device is most usually a screen. The channels that are 
used when rendering images to a screen are Red, Green, and Blue. Other output devices 
may use different channels. 

Channels can be useful when working on images that need adjustment to one particular 
color. If, for example, the removal of "red-eye" is the goal, work on the Red channel is 
most obviously a ready solution. Channels can be seen as masks that allow or restrict the 
output of the color that the channel represents. By running filters against this channel 
information, many varied and subtle effects can be put in to play by the experienced 
GIMP user. 

Clipboard is the term used to describe a temporary area of memory that is used to 
transfer data between applications or documents. The GIMP uses slightly different 
clipboard approaches when used under different operating systems. Under Linux/XFree, 
the XFree clipboard is used for text and The GIMP internal image clipboard is used for 
images that are being transferred between image documents. When The GIMP is used 
with other operating systems, differences may be apparent. Any differences should be 
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outlined in the operating system specific documentation for the individual GIMP package. 

The most fundamental operations provided by a clipboard interface allow for Cut, Copy, 
and Paste. Cut is used to denote the removal of an item that is sent to the clipboard. Copy 
leaves the item in the document and copies it to the clipboard. Paste copies to the 
document whatever happens to be in the clipboard. The GIMP will make an intelligent 
decision about what to paste depending upon the target. If the target is a canvas, then 
paste operation will use the image clipboard. If the target is a text entry box, then the 
paste operation will use the text clipboard. 

Dithering refers to the math and voodoo involved in rendering an image that has few 
colors seem like it has many. Dithering is accomplished in different ways depending on 
the output device and the program. One particularly effective method is clustering pixels 
of color together in an attempt to simulate another color. This is achieved by the human 
eye and the tendency for it to mix colors while viewing complex color patterns. A 
common dithering effect is seen on television screens or in newspaper print.From a 
distance the images seem to be constructed of many varied colors or shades, but upon 
closer inspection this is certainly not the case. A color television uses only three colors 
clustered together in various states of on or off. A black and white newspaper uses only 
black ink, yet pictures in newspapersappear to be constructed of grey tones. Furthermore, 
there are techniques used to achieve greater success in dithering. 

The GIMP can use the Floyd-Steinberg dithering technique, for example. This dithering 
method is simply put, a mathematical way of clustering the pixels to accomplish better 
results thanother dithering methods. Of course, there are always exceptions and there are 
many different dithering models that are in usetoday. 

A way that an image is written. You should select a file format which is suitable for your 
situation. JPEG and PostScript are examples of file formats. 

Feathering is a process by which the edges of a region are softly blended with the 
background. 

 

Floating selections are similar in function to layers except that floating selections must be 
anchored before work can resume on any other layers in the image. While a selection is 
floating, any number of functions can be used to alter the image data contained within 
the float. 

There are two methods available for anchoring a float. The first, and most useful, is to 
change the float into a new layer. This is achieved by creating a new layer while the float 
is active. The second method involves anchoring the float to an already existing layer. 
This is done by clicking anywhere on the image except on the float. Doing so will merge 
the float with the background layer. 

Any pasted selection will be first rendered as a floating selection. 

This method of dithering looks at the current pixel color and retrieving the closest values 
from the palette. These colors are then distributed to the pixel areas below and to the 
right of the original pixel. 

Trademarked by CompuServe, with LZW compression patented by Unisys. GIF images are 
in 8 bit indexed color and support binary transparency (but not semi-transparency). They 
can also be loaded in interlaced form by some programs. The GIF format also supports 
animations and comments. Use GIF for transparent Web graphics and GIF animations. For 
most purposes, though, PNG can be used in place of GIF and is a better choice. 

GNU's Not Unix, is a project of a free (Unix like) operative system. The project was started 
back in 1983 thanks to the effort of the Free Software Fundation, an organization devoted 
to the creation and support of free software. GIMP is an official GNU application. You can 
find a better definition on the wikipedia site. 

To place a guide, left-click-and-hold on a ruler and drag the mouse pointer in to the 
image. A guide appears and follows the pointer. You can so place two guides, a horizontal 
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one and a vertical one. They appear as blue dashed lines. They do not print. 

Guides are a convenient way to position a selection or a layer. As soon as a guide is 
created, the Move tool is selected and the mouse pointer turns to a move icon. 

Guide behaviour depends on the Affect mode selected in the Move tool. When the 
Transform Layer mode is selected, the mouse pointer turns to a small hand when it 
reaches a guide that becomes red and active. You can then move it by a click and drag. 
When the Transform Selection mode is selected you can place a guide, but you can no 
longer move it after quitting it. 

To make positioning easier you can 'magnetize' guides with the option Snap to Guides 

You can abort displaying guides without removing them by the option Show Guides 

A way of representing color in the form #rrggbb where "rr" represents red, "gg" green, 
and "bb" blue. Commonly used in web design. 

Hue Saturation Value, a way of representing color. The Hue is the color like red or blue, 
the Saturation is how strong the color is and the Value is the brightness. This is 
sometimes called HSB or Hue Saturation Brightness. 

Image Hoses are special brushes that contain many different frames. An example of this 
might be a footstep brush that contains two images. One of a left footprint and one of a 
right footprint. During the application of this hypothetical hose brush, one would see the 
left footprint followed by that of the right in a continuous fashion. This method of 
animation for brushes is very powerful. 

This paint mode renders each brush stroke directly onto the active layer. If incremental 
mode is not set, there is a canvas buffer that is composited with the active layer. 

  

The two images above were created using a brush with spacing set to sixty. 
The image on the left shows non-incremental painting and the image on the 
right shows the difference that incremental painting can produce. 
Incremental paint mode results in each brush application, through the 
duration of a stroke, being rendered in addition to any previous brush 

renderings. 

When you enlarge an image pixels become apart if image resolution is not enough. These 
missing pixels are replaced by pixels that are calculated from surrounding pixels, by 
interpolation. Interpolation methods in The GIMP are labelled with a speed marker. Faster 
methods lead to lower quality transformations whereas slower methods lead to higher 
quality transformations. 

This format supports compression and works at all color depths. The image compression 
is adjustable, but beware: Too high a compression could severely reduce image quality, 
since JPEG compression is lossy. Use JPEG to create TrueColor Web graphics, or if you 
don't want your image to take up a lot of space. JPEG is a good format for photographs. 

JPEG files usually have an extension .jpg, .JPG, or .jpeg. It is a very widely used format, 
because it compresses images very efficiently, while minimizing the loss of image quality. 
No other format comes close to achieving the same level of compression. It does not, 
however, support transparency, or multiple layers. For this reason, saving images as JPEG 
often requires them to be exported. 
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When you save a file in JPEG format, you get a dialog that allows you to set the Quality 
level, which ranges from 1 to 100. Values above 95 are generally not useful, though. The 
default quality of 85 usually produces excellent results, but in many cases it is possible to 
set the quality substantially lower without noticably degrading the image. You can test 
the effect of different quality settings by checking "Show Preview in image window" in the 
JPEG dialog. Checking this causes each change in quality (or any other JPEG parameter) to 
be visualized in the image display. (This does not alter the image, though: it reverts back 
to its original state when the JPEG dialog is closed.) 

The JPEG algorithm is quite complex, and involves a bewildering number of options, 
whose meaning is beyond the scope of this documentation. Unless you are a JPEG expert, 
the Quality parameter is probably the only one you will benefit from adjusting. 

 

JPEG files from many digital cameras contain extra information called EXIF data, 
specifying camera settings and other information concerning the circumstances under 
which the image was created. Gimp's ability to handle EXIF data depends on whether the 
library "libexif" is available on your system; it is not automatically packaged with Gimp. If 
Gimp has been built with libexif support, then EXIF data is preserved if you open an JPEG 
file, work with the resulting image, and then save as JPEG. The EXIF data is not altered in 
any way when you do this (which means that certain fields within it are no longer valid). If 
Gimp is not built with EXIF support, this does not prevent files with EXIF data from being 
opened, but it means that the EXIF data will not be present when the resulting image is 
later saved. 

   

You can think of layers as a stack of slides or clothes on your body. Each part of clothes 
you're wearing is a layer in the layers dialog. Layers are stacked on top of each other. The 
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bottom layer is the background of the image and the components in the foreground of the 
image come above it. 

Representation of an image with layers:

 

The final image:

 

This term describes the dotted line which surrounds a selection. 
The line is animated, so it looks as if little ants are running around 
behind each other. 

You can disable the marching ants by unchecking the View Show 
Selection option or by using the CtrlT key combination. 

GIMP offers 21 layer modes. The layer mode is used on the layers 
that are under the selected layer. If there is only one layer, the layer mode has no effect. 
It is therefore highly likely that at least two layers are required. The example images show 
the effects of each of the modes. The left image is the normal state and the right image 
shows the results of the layer mode. 

Masks are special elements associated with a layer or a selection. They modify the 
transparency of the layer or selection. 

They belong to two types:

• Layer Mask: Every layer can have its own mask. The layer mask represents the 
Alpha channel of the layer and allows you to manage the transparency of the layer. 
By painting on the layer mask, you can make some parts of the layer opaque or 
transparent: painting with black makes the layer transparent and painting with white 
makes the layer opaque. You can use all of the tools to paint on the mask. You can 
use the Layer mask for transition effects, volume effects, merging elements from 
another image, etc. See Layer Mask for more details. 

• Channel Mask, also called Selection Mask: this mask represents the Alpha channel of 
the image. By painting on it with white, you remove the mask and increase the 
selection; with black, you reduce the selection. This procedure lets you create a 
selection very precisely. Moreover, Channel Masks let you save your selections; you 
can retrieve them later by using the "Channel to selection" command from the 
Channel menu. Channel masks are so important in Gimp that a special type has 
been implemented: the Quick mask. See Selection mask for more details. 

Markeringsmaske, av og til også kalla Kanalmaske: Denne maska representerer 
alfakanalen til biletet. Ved å mala med kvitt fjernar du maska og aukar markeringa. 
Maler du med svart, blir markeringa redusert. På denne måten kan du avgrensa 
markeringa heilt nøyaktig. Ved hjelp av kanalmaskene kan du også lagra 
markeringane og henta dei tilbake etter ønskje med kommandoen "Kanal til maske" 
i kanalmenyen. Kanalmaskene er mykje brukte i GIMP. Difor finn du også ei 
spesialmaske som bli kalla Snarmaske. Sjå meir om dette i Markeringsmasker. 

A path is a one-dimensional tracing, either polygonal, or curved, or a mixture of segments 
of both types. In GIMP, the main uses of paths are either to form the boundaries of 
selections, or to be stroked to create visible curves on an image. See the Paths section for 
basic information on paths, and the Path Tool section for information on how paths can be 
created and edited. 

In the Procedure Database (PDB), all of the functions which GIMP and its extensions make 
available are registered. Developers can look up useful information in the database about 
the functions provided. 

PDF (Portable Document Format) was developed by Adobe to address some of the 
deficiencies of Postscript: most importantly, PDF files tend to be much smaller than 
equivalent Postscript files. As with Postscript, Gimp's support of the PDF format is via 
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Ghostscript. 

Created by Adobe, PostScript is a page description language mainly used by printers and 
other output devices. It's also an excellent way to distribute documents. Gimp does not 
support Postscript directly: it depends on a powerful free software program called 
Ghostscript. 

The great power of Postscript is its ability to represent vector graphics–lines, curves, text, 
paths, etc–in a resolution-independent way. Postscript is not very efficient, though, when 
it comes to representing pixel-based raster graphics. For this reason, postscript is not a 
good format to use for saving images that are later going to be edited using Gimp or 
another graphics program. 

Linux distributions almost always come with Ghostscript already installed (not necessarily 
the most recent version). For other operating systems, you may have to install it yourself. 
Here are instructions for installing it on Windows: 

• Go to the Ghostscript project page on Sourceforge . 

• Look for package gnu-gs or ghostscript (non-commercial use only) and go to the 
download section. 

• Download a prepared Windows distribution like gs650w32.exe or gs700w32.exe. 

• Start the executable and follow the instructions of the installation procedure. 

• Copy the executable gswin32c.exe from the directory bin of the ghostscript 
installation to the Windows directory (or any other directory that is contained in the 
PATH). As an alternative, advanced users can set an environment variable GS_PROG 
to point to gswin32c.exe (e.g. c:\gs\gsX.YY\bin\gswin32c.exe) 

Now you should be able to read PostScript files with GIMP. Please note that you must not 
move the directories of ghostscript once the installation has finished. Registry entries 
have been created that allow ghostscript to find libraries. (These instructions courtesy of 
http://www.kirchgessner.net.) 

The format that is supposed to replace the GIF format and thus provide a solution to GIF's 
trademark and patent issues. Indexed color, grayscale, and truecolor images are 
supported, plus an optional alpha channel. PNG also uses compression, but unlike JPEG it 
doesn't lose image information. 

PSD is Adobe Photoshop's native file format, and thus is comparable to XCFin complexity. 
Gimp's ability to handle PSD files is sophisticated but limited: some features of PSD files 
are not loaded, and only PSD versions XX or less are supported. Unfortunately, Adobe has 
now made the Photoshop Software Development Kit  which includes their file format 
specifications  proprietary, and only available to a limited set of developers blessed by 
Adobe. This does not include the Gimp development team; and the lack of information 
makes it very difficult to maintain up-to-date support for PSD files. 

 

RGB in an acronym for Red-Green-Blue. These are the three additive primary colors. 
Blending together three light sources with these colors with different relative intensity, 
you can get any visible color combination, starting from black (all three sources with 
intensities equal to zero) to white (all three sources equal and at full light). For more 
information see Color model in this glossary. 
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Sample Merge is a technique useful when working with more than one layer where 
operations that affect one layer may take advantage of color or pixel information on all 
visible layers. Consider selection by color as an example of a time that this function may 
be useful. 

With this technique, GIMP uses more pixels to calculate a transitional color, for instance, 
for interpolation. This technique results in a better image, but it requires more time for 
the calculations. 

TGA (Targa Image File) format supports compression to 8, 16, 24 or 32 bits per pixel. It 
was originally developed by the Truevision company. 

TIFF (Tagged Image File Format) was developed primarily for scanned raster graphics for 
color separation. Six different encoding routines are supported, each with one of three 
different image modes: black and white, grayscale and color. Uncompressed TIFF images 
may be 1, 4, 8 or 24 bits per pixel. TIFF images compressed using the LZW algorithm may 
be 6, 8 or 24 bits per pixel. Besides Postscript format, TIFF is one of the most important 
formats for preliminary stages of printing. It is a high quality file format, which is perfect 
for images you want to import to other programs like FrameMaker or CorelDRAW. 

A URL (Uniform Resource Locator) is a subdivision of Uniform Resource Identifiers (URIs). 
URLs identify a resource over a primary access mechanism (commonly http or ftp) and 
the location of the resource in the computer network. The name of the URI scheme is 
therefore derived from the network protocol used for it as a rule. Examples of that are 
http or ftp. 

Since URLs are the first and most common kinds of URIs, the terms are often used as 
synonyms. 

A Uniform Resource Identifier (URI) is a string of characters that serves to identify an 
abstract or a physical resource. URIs are used for the identification of resources in the 
Internet (such as web pages, miscellaneous data, calling up web services, but also for 
receivers of e-mail, for example) and they are especially used in the Worldwide Web. 

The XCF file type is special because it is GIMP's native file type: that is, it was designed 
specifically to store all of the data that goes to make up a GIMP image. Because of this, 
XCF files may be quite complicated, and there are few programs other than GIMP that can 
read them. 

When an image is stored as an XCF file, the file encodes nearly everything there is to 
know about the image: the pixel data for each of the layers, the current selection, 
additional channels if there are any, paths if there are any, and guides. The most 
important thing that is not saved in an XCF file is the undo history. 

The pixel data in an XCF file is represented in a raw, uncompressed form: each byte of 
image data equals one byte in the XCF file. Thus, XCF files for even modestly sized 
images can be quite large: for example, a 1000x1000 RGB image with 3 layers will 
produce an XCF file of over 10 megabytes. It is not at all difficult to get XCF files of over 
100 megabytes. Fortunately, although XCF files do not intrinsically compress their data, 
GIMP allows you to compress the files themselves, using either the gzip or bzip2 
compression methods, both of which are fast, efficient, and freely available. Compressing 
an XCF file will often shrink it by a factor of 10 or more. The pixel data in an XCF file is 
represented in a lossless compressed form: the image byte blocks are compressed using 
the lossless RLE algorithm. This means that no matter how many times you load and save 
an image using this format: not a single pixel or other image data will be lost or modified 
because of this format. 

The GIMP developers have made a great effort to keep the XCF file format compatible 
across versions. If you create a file using GIMP 2.0, it ought to be possible to open the file 
in GIMP 1.2. However, some of the information in the file may not be usable: for example, 
GIMP 2.0 has a much more sophisticated way of handling text than GIMP 1.2, so a text 
layer from a GIMP 2.0 XCF file will appear as an ordinary image layer if the file is opened 
in GIMP 1.2. 

GNU Image Manipulation Program
Generated by docbook2odf

Page 407 of 421 

G
e

n
e

r
a

t
e

d
 

b
y

 
d

o
c

b
o

o
k

2
o

d
f
 



 
The YCbCr color model was developed for the PAL television standard as a color model 
that is an easy deviation from the YUV color model. In the meantime, it has become the 
CCIR-601 standard for image and video recording. For example, it is used for JPEG 
pictures and MPEG videos, and therefore also on DVDs, video CDs and for most other 
widespread digital video standards. Note that a color model is still not a color space, since 
it doesn't determine which colors are actually meant by "red", "green" and "blue". For a 
color space, there still needs to be a reference to a specific absolute color value. 

There are color models which do not express a color by the additive basic colors, red, 
green and blue (RGB), but by other properties, for example, the brightness-color model. 
Here, the criteria are the basic brightness of the colors (from black, through gray, to 
white), the colors with the largest portion (red, orange, yellow, green, blue, violet, or 
other pure colors that lie between them) and the saturation of the colors ("gaudy" to 
pale). This color model is based on the ability of the eye to recognize small differences in 
lunminosity better than small color differences, and to recognize those better than small 
differences in saturation. That makes gray text written on a black background easy to 
read, but blue text on a red background very hard to read, even with the same basic 
brightness. Such color models are called brightness-color models. 

The YCbCr model is a slight adaptation of such a brightness-color model. An RBG color 
value is divided into a basic brightness, Y, and two components, Cb and Cr, where Cb is a 
measurement of the deviation from gray in the blue direction, or if it is less that 0.5, in 
the direction of yellow. Cr is the corresponding measurement for the difference in the 
direction of red or turquoise. This representation uses the peculiarity of the eye of being 
especially sensitive to green light. That is why most of the information about the 
proportion of green is in the basic brightness, Y, an only the deviations for the red and 
blue portions need to be represented. The Y values have twice the resolution of the other 
two values, Cb and Cr, in most practical applications, such as on DVDs. 

The YUV color model uses two components to represent the color information, luma (the 
strength of the light per area) and the chrominance, or proportion of color (chroma), 
where the chrominance again consists of two components. The development of the YUV 
color model also goes back to the development of color television (PAL), where ways were 
sought for transmitting the color information, in addition to the black and white signal, in 
order to achieve backwards compatibility with old black and white televisions without 
having to maintain the available transmission bandwidth. From the YUV color model of 
the analog television techiques, the YCrCb color model was developed, which is used for 
most kinds of digital image and video compression. Erroneously, the YUV color model is 
also often spoken about in those areas, although the YCbCr model is actually used. This 
often causes confusion. 

For the calculation of the luma signals (also *Leuchtdichte* signal), the underlying RGB 
data is first *verrechnet* with the gamma value of the output device, and an R'G'B' signal 
is obtained. The three individual components are added together with different weights, 
to form the brightness information, which also functions as the BAS signal for the old 
black and white televisions. 

Y=R+G+B

The exact calculation is more complicated, however, since some aspects of the color 
perception of the human eye have to be taken into account. For example, green is 
perceived to be lighter than red, and this is perceived to be lighter than blue. 
Furthermore, gamma correction of the basic color is first performed in some systems. 

The chrominance signals, and also the color difference signals, contain the color 
information. They are formed by the difference of blue minus luma or red minus luma. 

U=B-Y

V=R-Y

From the three generated components, Y, U and V, the individual color proportions of the 
basic color can be calculated again later: 
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Y + U = Y + ( B - Y ) = Y - Y + B = B

Y + V = Y + ( R - Y ) = Y - Y + R = R

Y - B - R = ( R + G + B ) - B - R = G

Furthermore, because of the construction of the retina of the human eye, it turns out that 
the brightness information is perceived at a higher resolution that the color, so that many 
formats based on the YUV color model compress the chrominance to save on the 
bandwidth during transmission. 
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The very beginning 
According to Peter Mattis and Spencer Kimball, the original creators of GIMP, in their 
announcement of GIMP 0.54: 

The GIMP arose from the ashes of a hideously crafted cs164 (compilers) class project. The 
setting: early morning. We were both weary from lack of sleep and the terrible strain of 
programming a compiler in LISP. The limits of our patience had long been exceeded, and 
yet still the dam held. 

And then it happened. Common LISP messily dumped core when it could not allocate the 
17 MB it needed to generate a parser for a simple grammar using yacc. An unbelieving 
moment passed, there was one shared look of disgust, and then our project was vapor. 
We had to write something... ANYTHING... useful. Something in C. Something that did not 
rely on nested lists to represent a bitmap. Thus, the GIMP was born. 

Like the phoenix, glorious, new life sprung out of the burnt remnants of LISP and yacc. 
Ideas went flying, decisions were made, the GIMP began to take form. 

An image manipulation program was the consensus. A program that would at the very 
least lessen the necessity of using commercial software under `Windoze' or on the 
`Macintoy.' A program that would provide the features missing from the other X painting 
and imaging tools. A program that would help maintain the long tradition of excellent and 
free UNIX applications. 

Six months later, we've reached an early beta stage. We want to release now to start 
working on compatibility issues and cross-platform stability. Also, we feel now that the 
program is actually usable and would like to see other interested programmers 
developing plug-ins and various file format support. 
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The early days of GIMP 
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The One to change the world 
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New in GIMP 2 
Sad to say, no version of GIMP has yet been absolutely perfect. Even sadder, it is likely 
that no version ever will be. In spite of all efforts to make everything work, a program as 
complicated as GIMP is bound to screw things up occasionally, or even crash. 

But the fact that bugs are unavoidable does not mean that they should be passively 
accepted. If you find a bug in GIMP, the developers would like to know about it so they 
can at least try to fix it. 

Suppose, then, that you have found a bug, or at least think you have: you try to do 
something, and the results are not what you expect. What should you do? How should 
you report it? 

The procedure for making an enhancement request–that is, for asking the developers to 
add a missing feature–is nearly the same as the procedure for reporting a bug. The only 
thing you do differently is to mark the report as an "enhancement" at the appropriate 
stage, as described below. 

In common with many other free software projects, GIMP uses a bug-reporting 
mechanism called Bugzilla. This is a very powerful web-based system, capable of 
managing thousands of bug reports without losing track. In fact, GIMP shares its Bugzilla 
database with the entire Gnome project. At the time this is being written, Gnome Bugzilla 
contains 148632 bug reports–no, make that 148633. 
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Making sure it's a Bug 
The first thing you should do, before reporting a bug, is to make an effort to verify that 
what you are seeing really is a bug. It is hard to give a method for doing this that applies 
to all situations, but reading the documentation will often be useful, and discussing the 
question on IRC or a mailing list may also be quite helpful. If you are seeing a crash, as 
opposed to mere misbehavior, the odds that it is a true bug are pretty high: well written 
software programs are not designed to crash under any circumstances. In any case, if you 
have made an conscientious effort to decide whether it is really a bug, and at the end still 
aren't sure, then please go ahead and report it: the worst that can happen is that you will 
waste a bit of time for the development team. 

Actually there are a few things that are known to cause GIMP to crash but have turned out 
to be too inconvenient to be worth fixing. One of them is asking GIMP to do something 
that requires vast amounts of memory, such as creating an image one million pixels on a 
side. 

You should also make sure that you are using an up-to-date version of GIMP: reporting 
bugs that have already been fixed is just a waste of everybody's time. (GIMP 1 is no 
longer maintained, so if you use it and find bugs, either upgrade to GIMP 2 or live with 
them.) Particularly if you are using the development version of GIMP, make sure that you 
can see the bug in the latest release before filing a report. 

If after due consideration you still think you have a legitimate bug report or enhancement 
request, the next step is to go to GIMP's bugzilla query page 
(http://bugzilla.gnome.org/query.cgi), and try to see whether somebody else has already 
reported the same thing. The query page allows you to search the bug database in a 
variety of ways. Unfortunately this page is a bit more complicated to use than it really 
ought to be, but here is basically what you should do: 

When you have set these things up, click on the "Search" button at either the top or 
bottom; they both do the same thing. The result is either a list of bug reports–hopefully 
not too long–or a message saying "Zarro boogs found". If you don't find a related bug 
report by doing this, it may be worth trying another search with different terms. If in spite 
of your best efforts, you file a bug report and it ends up being resolved as "Duplicate", 
don't be too upset: it has happened repeatedly to the author of this documentation, who 
works with GIMP Bugzilla nearly every day. 
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Reporting the Bug 
Okay, so you have done everything you could to make sure, and you still think it's 
probably a bug. You should then go ahead and file a bug report. To do this, begin by going 
to http://bugzilla.gnome.org/enter_bug.cgi, and go down the page until you can select the 
component "GIMP". 

The first time you file a bug report, you will be asked to create a Bugzilla account. The 
process is easy and painless, and you probably won't even get any spam as a result. 

This takes you to the bug report form, which you should fill out as follows. Note that most 
of the information you enter can be changed later by the developers if you get it wrong, 
so try to get it right but don't be obsessive about it. 

You can ignore the rest. When you have filled out all of these things, press the "Commit" 
button and your bug report will be submitted. It will be assigned a number, which you 
may want to make note of; you will, however, be emailed any time somebody makes a 
comment on your bug report or otherwise alters it, so you will receive reminders in any 
case. You can see the current state of your bug report at any time by going to 
http://bugzilla.gnome.org and, at the bottom of the page, in the "Actions:" area, entering 
the bug number and pressing the "Find" button. 

Sometimes it is very helpful to augment a bug report with a screenshot or some other 
type of data. If you need to do this, go to the web page for your bug report, click on the 
link "Create a New Attachment", and follow the directions. But please don't do this unless 
you think the attachment is really going to be useful–and if you need to attach a 
screenshot, don't make it any larger than necessary. Bug reports are likely to remain on 
the system for years, so there is no sense in wasting memory. 
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What Happens to a Bug Report after you 
Submit it 
At any time after it is submitted, a bug report has a "Status" that describes how it is 
currently being handled. Here are the possible values of Status and what they mean: 

Copyright (C) 2000,2001,2002 Free Software Foundation, Inc. 59 Temple Place, 
Suite 330, Boston, MA 02111-1307 USA Everyone is permitted to copy and 
distribute verbatim copies of this license document, but changing it is not 
allowed. 

The purpose of this License is to make a manual, textbook, or other functional and useful 
document "free" in the sense of freedom: to assure everyone the effective freedom to 
copy and redistribute it, with or without modifying it, either commercially or 
noncommercially. Secondarily, this License preserves for the author and publisher a way 
to get credit for their work, while not being considered responsible for modifications made 
by others. 

This License is a kind of "copyleft", which means that derivative works of the document 
must themselves be free in the same sense. It complements the GNU General Public 
License, which is a copyleft license designed for free software. 

We have designed this License in order to use it for manuals for free software, because 
free software needs free documentation: a free program should come with manuals 
providing the same freedoms that the software does. But this License is not limited to 
software manuals; it can be used for any textual work, regardless of subject matter or 
whether it is published as a printed book. We recommend this License principally for 
works whose purpose is instruction or reference. 

This License applies to any manual or other work, in any medium, that contains a notice 
placed by the copyright holder saying it can be distributed under the terms of this 
License. Such a notice grants a world-wide, royalty-free license, unlimited in duration, to 
use that work under the conditions stated herein. The "Document", below, refers to any 
such manual or work. Any member of the public is a licensee, and is addressed as "you". 
You accept the license if you copy, modify or distribute the work in a way requiring 
permission under copyright law. 

A "Modified Version" of the Document means any work containing the Document or a 
portion of it, either copied verbatim, or with modifications and/or translated into another 
language. 

A "Secondary Section" is a named appendix or a front-matter section of the Document 
that deals exclusively with the relationship of the publishers or authors of the Document 
to the Document's overall subject (or to related matters) and contains nothing that could 
fall directly within that overall subject. (Thus, if the Document is in part a textbook of 
mathematics, a Secondary Section may not explain any mathematics.) The relationship 
could be a matter of historical connection with the subject or with related matters, or of 
legal, commercial, philosophical, ethical or political position regarding them. 

The "Invariant Sections" are certain Secondary Sections whose titles are designated, as 
being those of Invariant Sections, in the notice that says that the Document is released 
under this License. If a section does not fit the above definition of Secondary then it is not 
allowed to be designated as Invariant. The Document may contain zero Invariant 
Sections. If the Document does not identify any Invariant Sections then there are none. 

The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts 
or Back-Cover Texts, in the notice that says that the Document is released under this 
License. A Front-Cover Text may be at most 5 words, and a Back-Cover Text may be at 
most 25 words. 
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A "Transparent" copy of the Document means a machine-readable copy, represented in a 
format whose specification is available to the general public, that is suitable for 
revisingthe document straightforwardly with generic text editors or (for images composed 
of pixels) generic paint programs or (for drawings) some widely available drawing editor, 
and that is suitable for input to text formatters or for automatic translation to a variety of 
formats suitable for input to text formatters. A copy made in an otherwise Transparent file 
format whose markup, or absence of markup, has been arranged to thwart or discourage 
subsequent modification by readers is not Transparent. An image format is not 
Transparent if used for any substantial amount of text. A copy that is not "Transparent" is 
called "Opaque". 

Examples of suitable formats for Transparent copies include plain ASCII without markup, 
Texinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and 
standard-conforming simple HTML, PostScript or PDF designed for human modification. 
Examples of transparent image formats include PNG, XCF and JPG. Opaque formats 
include proprietary formats that can be read and edited only by proprietary word 
processors, SGML or XML for which the DTD and/or processing tools are not generally 
available, and the machine-generated HTML, PostScript or PDF produced by some word 
processors for output purposes only. 

The "Title Page" means, for a printed book, the title page itself, plus such following pages 
as are needed to hold, legibly, the material this License requires to appear in the title 
page. For works in formats which do not have any title page as such, "Title Page" means 
the text near the most prominent appearance of the work's title, preceding the beginning 
of the body of the text. 

A section "Entitled XYZ" means a named subunit of the Document whose title either is 
precisely XYZ or contains XYZ in parentheses following text that translates XYZ in another 
language. (Here XYZ stands for a specific section name mentioned below, such as 
"Acknowledgements", "Dedications", "Endorsements", or "History".) To "Preserve the 
Title" of such a section when you modify the Document means that it remains a section 
"Entitled XYZ" according to this definition. 

The Document may include Warranty Disclaimers next to the notice which states that this 
License applies to the Document. These Warranty Disclaimers are considered to be 
included by reference in this License, but only as regards disclaiming warranties: any 
other implication that these Warranty Disclaimers may have is void and has no effect on 
the meaning of this License. 

You may copy and distribute the Document in any medium, either commercially or 
noncommercially, provided that this License, the copyright notices, and the license notice 
saying this License applies to the Document are reproduced in all copies, and that you 
add no other conditions whatsoever to those of this License. You may not use technical 
measures to obstruct or control the reading or further copying of the copies you make or 
distribute. However, you may accept compensation in exchange for copies. If you 
distribute a large enough number of copies you must also follow the conditions in 
section3. 

You may also lend copies, under the same conditions stated above, and you may publicly 
display copies. 

If you publish printed copies (or copies in media that commonly have printed covers) of 
the Document, numbering more than 100, and the Document's license notice requires 
Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all 
these Cover Texts: Front-Cover Texts on the front cover, and Back-Cover Texts on the back 
cover. Both covers must also clearly and legibly identify you as the publisher of these 
copies. The front cover must present the full title with all words of the title equally 
prominent and visible. You may add other material on the covers in addition. Copying with 
changes limited to the covers, as long as they preserve the title of the Document and 
satisfy these conditions, can be treated as verbatim copying in other respects. 

If the required texts for either cover are too voluminous to fit legibly, you should put the 
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first ones listed (as many as fit reasonably) on the actual cover, and continue the rest 
onto adjacent pages. 

If you publish or distribute Opaque copies of the Document numbering more than 100, 
you must either include a machine-readable Transparent copy along with each Opaque 
copy, or state in or with each Opaque copy a computer-network location from which the 
general network-using public has access to download using public-standard network 
protocols a complete Transparent copy of the Document, free of added material. If you 
use the latter option, you must take reasonably prudent steps, when you begin 
distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain 
thus accessible at the stated location until at least one year after the last time you 
distribute an Opaque copy (directly or through your agents or retailers) of that edition to 
the public. 

It is requested, but not required, that you contact the authors of the Document well 
before redistributing any large number of copies, to give them a chance to provide you 
with an updated version of the Document. 

You may copy and distribute a Modified Version of the Document under the conditions of 
sections 2 and 3 above, provided that you release the Modified Version under precisely 
this License, with the Modified Version filling the role of the Document, thus licensing 
distribution and modification of the Modified Version to whoever possesses a copy of it. In 
addition, you must do these things in the Modified Version: 

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the 
Document, and from those of previous versions (which should, if there were any, be 
listed in the History section of the Document). You may use the same title as a previous 
version if the original publisher of that version gives permission. 

B. List on the Title Page, as authors, one or more persons or entities responsible for 
authorship of the modifications in the Modified Version, together with at least five of 
the principal authors of the Document (all of its principal authors, if it has fewer than 
five), unless they release you from this requirement. 

C. State on the Title page the name of the publisher of the Modified Version, as the 
publisher. 

D. Preserve all the copyright notices of the Document. 

E. Add an appropriate copyright notice for your modifications adjacent to the other 
copyright notices. 

F. Include, immediately after the copyright notices, a license notice giving the public 
permission to use the Modified Version under the terms of this License, in the form 
shown in the Addendum below. 

G. Preserve in that license notice the full lists of Invariant Sections and required Cover 
Texts given in the Document's license notice. 

H. Include an unaltered copy of this License. 

I. Preserve the section Entitled "History", Preserve its Title, and add to it an item 
stating at least the title, year, new authors, and publisher of the Modified Version as 
given on the Title Page. If there is no section Entitled "History" in the Document, create 
one stating the title, year, authors, and publisher of the Document as given on its Title 
Page, then add an item describing the Modified Version as stated in the previous 
sentence. 

J. Preserve the network location, if any, given in the Document for public access to a 
Transparent copy of the Document, and likewise the network locations given in the 
Document for previous versions it was based on. These may be placed in the "History" 
section. You may omit a network location for a work that was published at least four 
years before the Document itself, or if the original publisher of the version it refers to 
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gives permission. 

K. For any section Entitled "Acknowledgements" or "Dedications", Preserve the Title of 
the section, and preserve in the section all the substance and tone of each of the 
contributor acknowledgements and/or dedications given therein. 

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in 
their titles. Section numbers or the equivalent are not considered part of the section 
titles. 

M. Delete any section Entitled "Endorsements". Such a section may not be included in 
the Modified Version. 

N. Do not retitle any existing section to be Entitled "Endorsements" or to conflict in 
title with any Invariant Section. 

O. Preserve any Warranty Disclaimers. 

If the Modified Version includes new front-matter sections or appendices that qualify as 
Secondary Sections and contain no material copied from the Document, you may at your 
option designate some or all of these sections as invariant. To do this, add their titles to 
the list of Invariant Sections in the Modified Version's license notice. These titles must be 
distinct from any other section titles. 

You may add a section Entitled "Endorsements", provided it contains nothing but 
endorsements of your Modified Version by various parties--for example, statements of 
peer review or that the text has been approved by an organization as the authoritative 
definition of a standard. 

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 
25 words as a Back-Cover Text, to the end of the list of Cover Texts in the Modified 
Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be added 
by (or through arrangements made by) any one entity. If the Document already includes a 
cover text for the same cover, previously added by you or by arrangement made by the 
same entity you are acting on behalf of, you may not add another; but you may replace 
the old one, on explicit permission from the previous publisher that added the old one. 

The author(s) and publisher(s) of the Document do not by this License give permission to 
use their names for publicity for orto assert or imply endorsement of any Modified 
Version. 

You may combine the Document with other documents released under this License, under 
the terms defined in section 4 above for modified versions, provided that you include in 
the combination all of the Invariant Sections of all of the original documents, unmodified, 
and list them all as Invariant Sections of your combined work in its license notice, and 
that you preserve all their Warranty Disclaimers. 

The combined work need only contain one copy of this License, and multiple identical 
Invariant Sections may be replaced with a single copy. If there are multiple Invariant 
Sections with the same name but different contents, make the title of each such section 
unique by adding at the end of it, in parentheses, the name of the original author or 
publisher of that section if known, or else a unique number. Make the same adjustment to 
the section titles in the list of Invariant Sections in the license notice of the combined 
work. 

In the combination, you must combine any sections Entitled "History" in the various 
original documents, forming one section Entitled "History"; likewise combine any sections 
Entitled "Acknowledgements", and any sections Entitled "Dedications". You must delete 
all sections Entitled "Endorsements". 

You may make a collection consisting of the Document and other documents released 
under this License, and replace the individual copies of this License in the various 
documents with a single copy that is included in the collection, provided that you follow 
the rules of this License for verbatim copying of each of the documents in allother 
respects. 
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You may extract a single document from such a collection, and distribute it individually 
under this License, provided you insert a copy of this License into the extracted 
document, and follow this License in all other respects regarding verbatim copying of that 
document. 

A compilation of the Document or its derivatives with other separate and independent 
documents or works, in or on a volume of a storage or distribution medium, is called an 
"aggregate" if the copyright resulting from the compilation is not used to limit the legal 
rights of the compilation's users beyond what the individualworks permit. When the 
Document is included in an aggregate, this License does not apply to the other works in 
the aggregate which are not themselves derivative works of the Document. 

If the Cover Text requirement of section 3 is applicable to these copies of the Document, 
then if the Document is less than one half of the entire aggregate, the Document's Cover 
Texts may be placed on covers that bracket the Document within the aggregate, or the 
electronic equivalent of covers if the Document is in electronic form. Otherwise they must 
appear on printed covers that bracket the whole aggregate. 

Translation is considered a kind of modification, so you may distribute translations of the 
Document under the terms of section 4. Replacing Invariant Sections with translations 
requires special permission from their copyright holders, but you may include translations 
of some or all Invariant Sections in addition to the original versions of these Invariant 
Sections. You may include a translation of this License, and all the license notices in the 
Document, and any Warranty Disclaimers, provided that you also include the original 
English version of this License and the original versions of those notices and disclaimers. 
In case of a disagreement between the translation and the original version of this License 
or a notice or disclaimer, the original version will prevail. 

If a section in the Document is Entitled "Acknowledgements", "Dedications", or "History", 
the requirement (section 4) to Preserve its Title (section 1) will typically require changing 
the actual title. 

You may not copy, modify, sublicense, or distribute the Document except as expressly 
provided for under this License. Any other attempt to copy, modify, sublicense or 
distribute the Document is void, and will automatically terminate your rights under this 
License. However, parties who have received copies, or rights, from you under this 
License will not have their licenses terminated so long as such parties remain in full 
compliance. 

The Free Software Foundation may publish new, revised versions of the GNU Free 
Documentation License from time to time. Such new versions will be similar in spirit to 
the present version, but may differ in detail to address new problems or concerns. See 
http://www.gnu.org/copyleft/. 

Each version of the License is given a distinguishing version number. If the Document 
specifies that a particular numbered version of this License "or any later version" applies 
to it, you have the option of following the terms and conditions either of that specified 
version or of any later version that has been published (not as a draft) by the Free 
Software Foundation. If the Document does not specify a version number of this License, 
you may choose any version ever published (not as a draft) by the Free Software 
Foundation. 

To use this License in a document you have written, include a copy of the License in the 
document and put the following copyrightand license notices just after the title page: 

Copyright (c) YEAR YOUR NAME. Permission is granted to copy, distribute and/or 
modify this document under the terms of the GNU Free Documentation License, 
Version 1.2 or any later version published by the Free Software Foundation; with 
no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts. A copy of 
the license is included in the section entitled "GNU Free Documentation License". 

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the 
"with...Texts." line with this: 
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with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts 
being LIST, and with the Back-Cover Texts being LIST. 

If you have Invariant Sections without Cover Texts, or some other combination of the 
three, merge those two alternatives to suitthe situation. 

If your document contains nontrivial examples of program code, we recommend releasing 
these examples in parallel under your choice of free software license, such as the GNU 
General Public License, to permit their use in free software. 

Sorry, but a help item is missing for the function you're looking for. 

Feel free to join us and fill the gap by writing documentation for the Gimp. For more 
information, visit our project page on the Gimp Wiki. There is also a Mailing list available. 
Generally, it's a good idea to check the Gimp project page. 
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